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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a stationary analysis of the resonator, with an applied DC bias. It is 
used as a basis for all the subsequent analyses.

Model Definition

Ref. 1 describes a polysilicon resonator, which is manufactured through a surface 
micromachining process. The details of this process are outlined in the Stationary Analysis 
of a Biased Resonator—3D documentation. For this 2D study, a simplified version of the 
3D geometry is considered. For simplicity, the resonator is modeled as a 2 μm thick 
rectangular beam with a length of 45 μm. A Fixed Constraint boundary is applied to each 
end of the resonator to act as the anchor points at which the resonator is attached to the 
substrate wafer. The wafer substrate is not explicitly modeled, instead only a 0.1985 μm 
thick air gap between the resonator and the substrate is included. The effects of the driving 
electrode are included using Electric Potential boundary conditions applied directly to the 
underside of the air gap, as shown in Figure 1.

Note that although the structure has a plane of symmetry, which vertically bisects the 
device, we do not use a symmetry boundary condition. A subsequent model considers the 
normal modes of the structure, and a symmetry condition eliminates the anti-symmetric 
modes from this analysis.

Figure 1: The model geometry. The rectangular resonator and the air gap are highlighted in 
red and green outline, respectively. The boundaries to which the driving voltage is applied are 

Resonator

Driving voltage applied to 
these boundaries

Air gap
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highlighted in blue. Note that the vertical dividing lines are not part of the physical geometry 
of the resonator, but are included to allow a suitable swept mesh to be easily created.

In operation the bottom surface of the silicon resonator is grounded and a driving 
electrode applies an electric potential to the central portion of the air gap, as shown in 
Figure 1. Typically a DC bias of 35 V is applied in normal operation of the device. In this 
model the deformation of the structure is computed with the applied DC bias. 

E L E C T R O M E C H A N I C A L  F O R C E S

Within a vacuum or other medium, forces between charged bodies can be computed on 
the assumption that a fictitious state of stress exists within the field. The Electromagnetic 
or Maxwell stress tensor can be used to compute the induced stresses in a material as a 
result of an electric field as well as surface forces acting on bodies in air or vacuum. Within 
a material, COMSOL Multiphysics uses the following form of the stress tensor TEM,S, 
which is appropriate for isotropic materials (Ref. 2):

where E is the electric field, D is the electric displacement field, I is the identity tensor, and 
ε0 is the permittivity of free space and a1 and a2 are material parameters that specify the 
electrostrictive properties of the material (for this device, assume a1 = a2 = 0 because the 
field is in any case very low within the material). This additional stress is applied to the 
material by the electromechanical solid node. Note that mechanical stresses are usually 
induced in the material as a result of the net forces acting on the surfaces, in addition to 
the stress induced by the electric field.

The forces on the surfaces of a solid body can be computed by applying a similar stress 
term within the vacuum of the form:

A net force on the surface typically results from the discontinuity of the stress tensor at the 
interface. However, since it is undesirable to apply a stress term throughout the vacuum, 
the force is only available on the surface of solid bodies, via the electromechanical interface 
node. The surface force is given by:

where n1 is the surface normal, pointing out from the mechanical body.

TEM S,
1
2
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Results and Discussion

Figure 2 shows the y displacement of the structure with an applied DC bias. As expected 
the structural displacement is maximal at the center of the geometry. The maximum 
displacement is 11.2 nm. 

The electric potential contours are shown in Figure 3. The fringing fields extend 
approximately 1 μm into the gap either side of the driving electrode. Note that the 
fringing fields are not well resolved due to the structure of the swept mesh. In order to 
investigate these fields the mesh must be refined on either side of the electrode. Also note 
that the surface of the resonator is assumed to be perfectly grounded. This is a result of 
the potential boundary condition used and is equivalent to the assumption that the silicon 
is a perfect conductor. Although the author’s of Ref. 1 do not explicitly give the doping in 
the polysilicon, it is likely that this assumption is relatively poor given the estimated 
depletion region width of approximately 0.7 μm that is quoted. This model could be 
extended to include the effects of semiconductor transport and an improvement on this 
assumption could be made by adding the electric currents which are induced inside the 
resonator.
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Figure 2: The y-displacement of the resonator as a function of position. The maximum 
displacement occurs in the center of the resonator, immediately over the biasing electrode.

Figure 3: Electric potential contours in the gap between the grounded resonator and the biased 
driving electrode.
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Application Library path: MEMS_Module/Actuators/biased_resonator_2d_basic

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Structural Mechanics>Electromechanics (emi).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 22.5.

4 In the Height text field, type 2.
6 |  S T A T I O N A R Y  A N A L Y S I S  O F  A  B I A S E D  R E S O N A T O R — 2 D



5 Locate the Position section. In the x text field, type -22.5.

6 In the y text field, type 0.1985.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 22.5.

4 In the Height text field, type 0.1985.

5 Locate the Position section. In the x text field, type -22.5.

Rectangle 3 (r3)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 10.

4 In the Height text field, type 2.1985.

5 Locate the Position section. In the x text field, type -10.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Click the Select Box button on the Graphics toolbar.

3 Click in the Graphics window and then press Ctrl+A to select all objects.

4 In the Settings window for Mirror, locate the Input section.

5 Select the Keep input objects check box.

6 Click Build All Objects.

7 Click the Zoom Extents button on the Graphics toolbar.

Add materials to the model.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Semiconductors>Si - Polycrystalline Silicon.

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.
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2 In the tree, select Built-In>Air.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Air (mat2).

2 Select Domains 1, 3, 5, and 7 only.

Set the air material property to be non-solid, to ensure the interface solves the 
electrostatic equation in the spatial frame.

3 In the Settings window for Material, click to expand the Material properties section.

4 Locate the Material Properties section. From the Material type list, choose Nonsolid.

5 On the Home toolbar, click Add Material to close the Add Material window.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Set up the solid mechanics and electrostatics boundary conditions.

Add a Linear Elastic Material feature to the resonator.

E L E C T R O M E C H A N I C S  ( E M I )

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromechanics (emi) and choose Linear Elastic Material.

2 Select Domains 2, 4, 6, and 8 only.

Apply a Fixed Constraint to both ends of the resonator.

Fixed Constraint 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Structural>Fixed Constraint.

Name Expression Value Description

Vdc 35[V] 35 V DC bias voltage
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2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 3 22 in the Selection text field.

5 Click OK.

Apply the Ground condition to the bottom edge of the resonator.

Ground 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 4 9 14 19 in the Selection text field.

5 Click OK.

Set the bias voltage on the driving electrode with the Electric Potential feature.

Electric Potential 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Electric Potential.

2 In the Settings window for Electric Potential, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 7 12 in the Selection text field.

5 Click OK.

6 In the Settings window for Electric Potential, locate the Electric Potential section.

7 In the V0 text field, type Vdc.

Modify the default mesh settings to suit the model geometry.

A mapped mesh allows good resolution of the small air gap between the driving 
electrode and the resonator.

M E S H  1

Distribution 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Mapped.

2 Right-click Mapped 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Boundary Selection section.
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4 Click Paste Selection.

5 In the Paste Selection dialog box, type 5 10 15 20 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 In the Number of elements text field, type 15.

Distribution 2
1 Right-click Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1 3 in the Selection text field.

5 Click OK.

6 In the Settings window for Distribution, locate the Distribution section.

7 In the Number of elements text field, type 10.

8 Click Build All.

9 Click the Zoom Extents button on the Graphics toolbar.

S T U D Y  1

1 In the Model Builder window, right-click Study 1 and choose Rename.

2 In the Rename Study dialog box, type Stationary in the New label text field.

3 Click OK.

4 On the Home toolbar, click Compute.

R E S U L T S

Displacement (emi)
1 In the Model Builder window, under Results right-click Displacement (emi) and choose 

Rename.

2 In the Rename 2D Plot Group dialog box, type Biased Displacement in the New label 
text field.

3 Click OK.

Surface 1
1 In the Model Builder window, expand the Results>Biased Displacement node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Expression section.
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3 In the Expression text field, type v.

Biased Displacement
1 In the Model Builder window, under Results click Biased Displacement.

2 On the Biased Displacement toolbar, click Plot.

3 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with that in .

Create a plot to show the electric potential contours in the gap.

Contour 1
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Model Builder window, right-click 2D Plot Group 3 and choose Contour.

3 In the Settings window for Contour, locate the Levels section.

4 In the Total levels text field, type 10.

2D Plot Group 3
Compare the resulting plot with that in .

1 In the Model Builder window, under Results click 2D Plot Group 3.

2 On the 2D Plot Group 3 toolbar, click Plot.

3 Right-click Results>2D Plot Group 3 and choose Rename.

4 In the Rename 2D Plot Group dialog box, type Electric Potential in the New label 
text field.

5 Click OK.
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a frequency-domain analysis of the structure, which is also biased 
with its operating DC offset. The analysis begins from the stationary analysis performed in 
the accompanying model Stationary Analysis of a Biased Resonator—2D; please review 
this model first.

Model Definition

The geometry, fabrication, and operation of the device are discussed for the Stationary 
Analysis of a Biased Resonator—2D model.

For the frequency-domain analysis of the structure, consider an applied drive voltage 
consisting of a 35 V DC offset with a 100 mV drive signal added as a harmonic 
perturbation. Solve the linearized problem to compute the response of the system.

D A M P I N G

To obtain the response of the system, you need to add damping to the model. For this 
study, assume that the damping mechanism is Rayleigh damping or material damping. 

To specify the damping, two material constants are required (αdM and βdK). For a system 
with a single degree of freedom (a mass-spring-damper system) the equation of motion 
with viscous damping is given by

where c is the damping coefficient, m is the mass, k is the spring constant, u is the 
displacement, t is the time, and f(t) is a driving force.

In the Rayleigh damping model, the parameter c is related to the mass, m, and the stiffness, 
k, by the equation:

md2u

dt2
---------- cdu

dt 
------- ku+ + f t( )=

c αdMm βdKk+=
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The Rayleigh damping term in COMSOL Multiphysics is proportional to the mass and 
stiffness matrices and is added to the static weak term. 

The damping coefficient, c, is frequently defined as a damping ratio or factor, expressed as 
a fraction of the critical damping, c0, for the system such that

where for a system with one degree of freedom

Finally note that for large values of the quality factor, Q,

The material parameters αdM and βdK are usually not available in the literature. Often the 
damping ratio is available, typically expressed as a percentage of the critical damping. It is 
possible to transform damping factors to Rayleigh damping parameters. The damping 
factor, ξ, for a specified pair of Rayleigh parameters, αdM and βdK, at the frequency, f, is

Using this relationship at two frequencies, f1 and f2, with different damping factors, ξ1 and 
ξ2, results in an equation system that can be solved for αdM and βdK:

The damping factors for this model are provided as αdM = 4189 Hz and βdK = 8.29·10−

13 s, consistent with the observed Quality factor of 8000 for the fundamental mode.

Results and Discussion

Figure 1 shows the frequency response of the resonator. A clear anti-resonance structure 
for the frequency response is observable. This response can be compared to that shown in 
Figure 15 (a) in Ref. 1. Although the experimental results are from a pair of coupled 

ξ c
c0
-----=

c0 2 km=

ξ 1
2Q
--------≅

ξ 1
2
---

αdM
2πf
----------- βdK2πf+ 
 =

1
4πf1
------------ πf1

1
4πf2
------------ πf2

αdM

βdK

ξ1

ξ2

=
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resonators in this instance, the two resonances are sufficiently separate in frequency space 
that it is possible to distinguish the two modes. If the details of the external circuits were 
available, a terminal boundary condition with an attached circuit could be used to 
compute the electrical response of the system for a more direct comparison with the 
experimental results

Figure 1: Frequency response of the fundamental mode of the resonator.

Reference

1. F.D. Bannon III, J.R. Clark and C.T.-C. Nguyen, “High-Q HF 
Microelectromechanical Filters,” IEEE Journal of Solid State Circuits, vol. 35, no. 4, pp. 
512–526, 2000.

Application Library path: MEMS_Module/Actuators/biased_resonator_2d_freq
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Modeling Instructions

Open the existing stationary study (filename: biased_resonator_2d_basic.mph).

From the File menu, choose Open.

Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_2d_basic.mph.

Create parameters for the material damping factors.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

C O M P O N E N T  1  ( C O M P 1 )

In the Model Builder window, expand the Component 1 (comp1) node.

E L E C T R O M E C H A N I C S  ( E M I )

Add damping to the physics settings.

Linear Elastic Material 1
In the Model Builder window, expand the Component 1 (comp1)>Electromechanics (emi) 
node.

Damping 1
1 Right-click Linear Elastic Material 1 and choose Damping.

2 In the Settings window for Damping, locate the Damping Settings section.

3 In the αdM text field, type alpha.

4 In the βdK text field, type beta.

Add a Harmonic Perturbation to the DC bias term, to represent the AC drive voltage.

Name Expression Value Description

alpha 4189[Hz] 4189 Hz Damping parameter - alpha

beta 8.29e-13[s] 8.29E-13 s Damping parameter - beta
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Harmonic Perturbation 1
1 In the Model Builder window, under Component 1 (comp1)>Electromechanics (emi) right-

click Electric Potential 1 and choose Harmonic Perturbation.

2 In the Settings window for Harmonic Perturbation, locate the Electric Potential section.

3 In the V0 text field, type 0.1.

Set up the frequency domain study.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Frequency Domain.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 2: Frequency-Domain Perturbation
1 In the Model Builder window, under Study 2 click Step 2: Frequency-Domain Perturbation.

2 In the Settings window for Frequency-Domain Perturbation, locate the Study Settings 
section.

3 In the Frequencies text field, type range(7.95[MHz],0.01[MHz],8.25[MHz]).

4 In the Model Builder window, right-click Study 2 and choose Rename.

5 In the Rename Study dialog box, type Frequency domain in the New label text field.

6 Click OK.

7 In the Settings window for Study, locate the Study Settings section.

8 Clear the Generate default plots check box.

9 On the Home toolbar, click Compute.

Produce a plot of the frequency response of the system.

R E S U L T S

1D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.
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3 From the Data set list, choose Frequency domain/Solution 2 (sol2).

4 Right-click 1D Plot Group 4 and choose Rename.

5 In the Rename 1D Plot Group dialog box, type Frequency Domain in the New label text 
field.

6 Click OK.

Point Graph 1
1 Right-click Frequency Domain and choose Point Graph.

2 In the Settings window for Point Graph, locate the Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 9 in the Selection text field.

5 Click OK.

6 In the Settings window for Point Graph, locate the y-Axis Data section.

7 In the Expression text field, type v.

8 On the Frequency Domain toolbar, click Plot.

Compare the resulting plot with .
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a modal analysis on the resonator, with and without an applied DC 
bias. The analysis begins from the stationary analysis performed in the accompanying 
model Stationary Analysis of a Biased Resonator—2D; please review this model first. 

Model Definition

The geometry, fabrication, and operation of the device are discussed for the “Stationary 
Analysis of a Biased Resonator” model.

This model performs a modal analysis on the structure, with and without applied DC 
voltage biases of different magnitudes. The bias already exists as a parameter in the model 
so the prestressed eigenfrequency solver needs no adjustment to the physics settings. To 
compute the unbiased eigenfrequency, the solver settings are adjusted to solve only the 
structural mechanics problem.

Results and Discussion

Figure 1 shows the mode shapes for the resonator under different bias conditions.

The mode shape does not change significantly with applied bias and the first three modes 
have the expected shapes for a clamped-clamped beam. The frequency of the fundamental 
is reduced significantly by the applied bias, an effect known as spring softening (the 
response of higher-order modes was not computed as a function of applied bias).
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Figure 1: Mode shapes for the resonator under different bias conditions (top line: 0 V; bottom 
line: 45 V). The mode frequencies are indicated in the figure. The colors visualize the relative 
y-displacement magnitude.
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The spring softening effect can be seen in detail in Figure 2. A clear decrease in the 
resonant frequency is evident with increasing bias voltage. This figure should be compared 
with Figure 16 of Ref. 1, where the same effect is apparent.

Figure 2: Mode frequency shown against the applied DC voltage bias. The spring softening 
effect is evident. Compare with Fig. 16 of Ref. 1.

Notes About the COMSOL Implementation 

This model excludes certain dependent variables from the solver settings in order to 
compute the unbiased eigenfrequency. By not computing for the electric potential or the 
displacement of the air domains, the model is equivalent to a pure solid mechanics 
problem, solved in the absence of external forces. Excluding dependent variables in the 
solver in this manner can be useful for debugging models as well as for computing 
uncoupled problems in this manner.

Reference

1. F.D. Bannon III, J.R. Clark, and C. T.-C. Nguyen, “High-Q HF 
Microelectromechanical Filters”, IEEE Journal of Solid State Circuits, vol. 35, no. 4, pp. 
512–526, 2000.
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Application Library path: MEMS_Module/Actuators/biased_resonator_2d_modes

Modeling Instructions

Open the existing stationary study (filename: biased_resonator_2d_basic.mph).

From the File menu, choose Open.

Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_2d_basic.mph.

R O O T

Add an unbiased eigenfrequency study. The settings for this study need to be modified so 
that only the structural part of the problem is solved.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Custom Studies>

Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Eigenfrequency
1 In the Model Builder window, under Study 2 click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box.

4 In the associated text field, type 3.

5 In the Model Builder window, right-click Study 2 and choose Rename.

6 In the Rename Study dialog box, type Unbiased Eigenfrequency in the New label text 
field.

7 Click OK.

Set up the solver to solve only for the solid mechanics variables.
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Solution 2 (sol2)
On the Study toolbar, click Show Default Solver.

U N B I A S E D  E I G E N F R E Q U E N C Y

Solution 2 (sol2)
1 In the Model Builder window, expand the Solution 2 (sol2) node, then click 

Dependent Variables 1.

2 In the Settings window for Dependent Variables, locate the General section.

3 From the Defined by study step list, choose User defined.

4 In the Model Builder window, expand the Unbiased Eigenfrequency>

Solver Configurations>Solution 2 (sol2)>Dependent Variables 1 node, then click 
Electric potential (comp1.V).

5 In the Settings window for Field, locate the General section.

6 Clear the Solve for this field check box.

7 Clear the Store in output check box.

8 In the Model Builder window, under Unbiased Eigenfrequency>Solver Configurations>

Solution 2 (sol2)>Dependent Variables 1 click Spatial coordinates (comp1.xy).

9 In the Settings window for Field, locate the General section.

10 Clear the Solve for this field check box.

11 Clear the Store in output check box.

12 In the Model Builder window, click Unbiased Eigenfrequency.

13 In the Settings window for Study, locate the Study Settings section.

14 Clear the Generate default plots check box.

15 On the Study toolbar, click Compute.

Set the data set to be in the material frame for post-processing. This allows the use of 
the deformation plot attribute.

R E S U L T S

Unbiased Eigenfrequency/Solution 2 (sol2)
1 In the Model Builder window, expand the Results>Data Sets node, then click 

Unbiased Eigenfrequency/Solution 2 (sol2).

2 In the Settings window for Solution, locate the Solution section.
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3 From the Frame list, choose Material (X, Y, Z).

Plot the mode shapes.

2D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Data set list, choose Unbiased Eigenfrequency/Solution 2 (sol2).

4 Right-click 2D Plot Group 4 and choose Rename.

5 In the Rename 2D Plot Group dialog box, type Unbiased Modes in the New label text 
field.

6 Click OK.

Surface 1
1 Right-click Unbiased Modes and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type v.

Deformation 1
1 Right-click Results>Unbiased Modes>Surface 1 and choose Deformation.

2 On the Unbiased Modes toolbar, click Plot.

3 Click the Zoom Extents button on the Graphics toolbar.

Compare the mode shapes with those shown in  for all the modes computed. To switch 
between the modes click Unbiased Modes and choose a different value from the 
Eigenfrequency list.

R O O T

Add a Prestressed Analysis, Eigenfrequency study.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.
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S T U D Y  3

Step 1: Stationary
1 In the Model Builder window, right-click Study 3 and choose Rename.

2 In the Rename Study dialog box, type Biased Eigenfrequency in the New label text 
field.

3 Click OK.

Create a parametric sweep over DC bias voltage.

Parametric Sweep
On the Study toolbar, click Parametric Sweep.

B I A S E D  E I G E N F R E Q U E N C Y

Parametric Sweep
1 In the Settings window for Parametric Sweep, locate the Study Settings section.

2 Click Add.

3 Click Range.

4 In the Range dialog box, type 5 in the Start text field.

5 In the Step text field, type 5.

6 In the Stop text field, type 45.

7 Click Add.

Solve for only the first eigenfrequency.

Step 2: Eigenfrequency
1 In the Model Builder window, under Biased Eigenfrequency click Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box.

4 In the associated text field, type 1.

Disable the default plots.

5 In the Model Builder window, click Biased Eigenfrequency.

6 In the Settings window for Study, locate the Study Settings section.

7 Clear the Generate default plots check box.

8 On the Study toolbar, click Compute.
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R E S U L T S

Biased Eigenfrequency/Parametric Solutions 1 (sol5)
1 In the Model Builder window, under Results>Data Sets click Biased Eigenfrequency/

Parametric Solutions 1 (sol5).

2 In the Settings window for Solution, locate the Solution section.

3 From the Frame list, choose Material (X, Y, Z).

Unbiased Modes 1
1 In the Model Builder window, under Results right-click Unbiased Modes and choose 

Duplicate.

2 Right-click Unbiased Modes 1 and choose Rename.

3 In the Rename 2D Plot Group dialog box, type Biased Modes in the New label text field.

4 Click OK.

5 In the Settings window for 2D Plot Group, locate the Data section.

6 From the Data set list, choose Biased Eigenfrequency/Parametric Solutions 1 (sol5).

7 On the Biased Modes toolbar, click Plot.

8 Click the Zoom Extents button on the Graphics toolbar.

Confirm the mode shape is similar to the unbiased fundamental mode.

Create a plot of eigenfrequency vs. applied DC voltage.

1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Biased Eigenfrequency/Parametric Solutions 1 (sol5).

4 Right-click 1D Plot Group 6 and choose Rename.

5 In the Rename 1D Plot Group dialog box, type Eigenfrequency vs DC voltage in the 
New label text field.

6 Click OK.

Point Graph 1
1 Right-click Eigenfrequency vs DC voltage and choose Point Graph.

2 In the Settings window for Point Graph, locate the Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1 in the Selection text field.

5 Click OK.
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6 In the Settings window for Point Graph, locate the y-Axis Data section.

7 In the Expression text field, type emi.freq.

8 Locate the x-Axis Data section. From the Axis source data list, choose Outer solutions.

9 Click to expand the Title section. From the Title type list, choose Custom.

10 Find the Type and data subsection. Clear the Type check box.

11 Clear the Description check box.

12 Find the User subsection. In the Prefix text field, type Eigenfrequency vs DC 
Voltage.

13 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose None.

14 Find the Line markers subsection. From the Marker list, choose Square.

15 From the Positioning list, choose In data points.

Compare this plot with that in . Note the spring softening effect.

16 On the Eigenfrequency vs DC voltage toolbar, click Plot.

17 Click the Zoom Extents button on the Graphics toolbar.
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a pull-in analysis of the structure, to predict the point at which the 
biased system becomes unstable. The analysis begins from the stationary analysis 
performed in the accompanying model Stationary Analysis of a Biased Resonator—2D; 
please review this model first. 

Model Definition

The geometry, fabrication, and operation of the device are discussed for the “Stationary 
Analysis of a Biased Resonator” model.

This model computes the pull-in voltage for the resonator by solving an inverse problem. 
The y-coordinate of the resonator midpoint is computed using an integration operator 
(intop1). The inverse problem that COMSOL solves computes the DC voltage that must 
be applied to the beam in order to move the midpoint to a set y-coordinate, yset. This is 
achieved by adding a global equation for the DC voltage, VdcSP, applied to the resonator. 
The equation intop1(y)-yset=0 is solved to determine the value of VdcSP. This means 
that VdcSP is adjusted until the midpoint of the resonator has a y-coordinate given by the 
set value, yset. Essentially COMSOL is being asked to find the voltage that allows the 
beam to exist in equilibrium (stable or unstable) at a given displacement. Solving the 
problem in this manner avoids complications with trying to solve a problem with no 
solution (which is what happens if the voltage is continuously ramped up eventually 
exceeding the pull-in voltage). The result of the analysis is a displacement versus voltage 
plot, with a minimum at the pull-in voltage. Note that for a linear spring, the pull-in 
displacement corresponds to 1/3 of the gap distance. Although the inclusion of geometric 
nonlinearities in the solid mechanics solver means that the pull-in displacement changes 
slightly from this value, it is usually most efficient to search around this point for the pull-
in voltage.
2 |  P U L L - I N  V O L T A G E  F O R  A  B I A S E D  R E S O N A T O R — 2 D



Results and Discussion

Figure 1 shows the voltage-displacement curve for the resonator at equilibrium, for y-
coordinates that correspond to displacements of around 1/3 of the gap size. The pull-in 
voltage is 63.3 V.

Figure 1: Voltage required to achieve a set displacement versus the target displacement. The 
pull-in voltage is the minimum of the plot: 63.3 V.
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Figure 2: y-displacement of the resonator at pull-in. The displacement at pull-in is 74 nm. For 
a linear spring the displacement at pull in would be 66 nm.

Figure 2 shows the y-displacement of the resonator at the pull-in voltage. The maximum 
displacement at pull-in is 74 nm. This is comparable to the (approximate) linear spring 
value of 66 nm.

Notes About the COMSOL Implementation

To compute the voltage required to generate the desired displacement of the beam, use a 
global equation. A common use of global equations is for computing the value of a 
dependent variable based on an ordinary differential equation in the dependent variable 
itself. However, it is also possible to couple a global equation with the other PDEs in the 
model as a powerful tool to solve certain kinds of inverse problems. This model uses a 
global equation to compute the potential applied to the drive electrode. The equation 
takes the form

y0 yset=
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where y0 is the y-coordinate of the midpoint of the beam’s underside and yset is the 
desired y-coordinate. COMSOL Multiphysics computes the voltage to satisfy the 
constraint implied by the above equation.

Reference

1. F.D. Bannon III, J.R. Clark and C.T.-C. Nguyen, “High-Q HF 
Microelectromechanical Filters,” IEEE Journal of Solid State Circuits, vol. 35, no. 4, pp. 
512–526, 2000.

Application Library path: MEMS_Module/Actuators/
biased_resonator_2d_pull_in

Modeling Instructions

Open the existing stationary study (filename: biased_resonator_2d_basic.mph).

From the File menu, choose Open.

Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_2d_basic.mph.

Add a parameter to set the y-coordinate of the midpoint of the resonator.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Add an integration operator to compute the actual displacement.

Name Expression Value Description

yset 100[nm] 1E-7 m Set point y-coordinate
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D E F I N I T I O N S

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 8 in the Selection text field.

6 Click OK.

Change the drive potential to the value VdcSP - which will be solved for in a global 
equation.

E L E C T R O M E C H A N I C S  ( E M I )

Electric Potential 1
1 In the Model Builder window, expand the Component 1 (comp1)>Electromechanics (emi) 

node, then click Electric Potential 1.

2 In the Settings window for Electric Potential, locate the Electric Potential section.

3 In the V0 text field, type VdcSP[V].

4 In the Model Builder window’s toolbar, click the Show button and select 
Advanced Physics Options in the menu.

Add a global equation to compute the voltage for a given displacement, VdcSP.

Global Equations 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose Global>

Global Equations.

2 In the Settings window for Global Equations, locate the Global Equations section.

3 In the table, enter the following settings:

Set up a parametric sweep over the displacement set point, yset.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

Name f(u,ut,utt,t) (1) Initial value 
(u_0) (1)

Initial value 
(u_t0) (1/s)

Description

VdcSP (intop1(y)-yset)/yset 0 0
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3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Stationary
1 In the Model Builder window, right-click Study 2 and choose Rename.

2 In the Rename Study dialog box, type Pull In in the New label text field.

3 Click OK.

P U L L  I N

Step 1: Stationary
1 In the Settings window for Stationary, click to expand the Study extensions section.

2 Locate the Study Extensions section. Select the Auxiliary sweep check box.

3 Click Add.

4 In the table, enter the following settings:

The problem is highly non-linear due to the presence of the global equation, so the 
solver settings need to be adjusted accordingly.

Solution 2 (sol2)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 2 (sol2) node.

3 In the Model Builder window, expand the Pull In>Solver Configurations>Solution 2 (sol2)>

Stationary Solver 1 node, then click Fully Coupled 1.

4 In the Settings window for Fully Coupled, click to expand the Method and termination 
section.

5 Locate the Method and Termination section. From the Nonlinear method list, choose 
Automatic highly nonlinear (Newton).

6 On the Study toolbar, click Compute.

Determine the pull-in voltage by plotting VdcSP vs. yset.

Parameter name Parameter value list Parameter unit

yset range(115[nm],2[nm],140[nm])
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R E S U L T S

1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 6 and choose Rename.

3 In the Rename 1D Plot Group dialog box, type Pull In Plot in the New label text field.

4 Click OK.

Global 1
1 Right-click Pull In Plot and choose Global.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Pull In/Solution 2 (sol2).

4 Locate the y-Axis Data section. In the table, enter the following settings:

5 Locate the x-Axis Data section. From the Parameter list, choose Expression.

6 In the Expression text field, type yset.

7 On the Pull In Plot toolbar, click Plot.

8 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with . The pull in voltage is the minimum of the curve: 63.3 
V at yset=125 nm.

Produce a plot of the y displacement of the structure at pull-in.

Biased Displacement 1
1 In the Model Builder window, under Results right-click Biased Displacement and choose 

Duplicate.

2 Right-click Biased Displacement 1 and choose Rename.

3 In the Rename 2D Plot Group dialog box, type Pull In Displacement in the New label 
text field.

4 Click OK.

5 In the Settings window for 2D Plot Group, locate the Data section.

6 From the Data set list, choose Pull In/Solution 2 (sol2).

7 From the Parameter value (yset (m)) list, choose 1.25E-7.

8 On the Pull In Displacement toolbar, click Plot.

Expression Unit Description

VdcSP 1 Voltage required to reach set point
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9 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with .
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. This 
sequence of models analyzes in detail a surface micromachined MEMS resonator, designed 
as part of a micromechanical filter. The resonator is based on that developed in Ref. 1.

This model performs a stationary analysis of the resonator, with an applied DC bias. It 
serves as a basis for all the subsequent analyses.

Model Definition

The model consists of a poly-silicon resonator, which is manufactured through a surface 
micromachining process. Initially, a silicon wafer is coated with 0.75 μm of oxide and 
0.15 μm of silicon nitride to isolate the micromachined parts from the wafer ground plane. 
Polysilicon electrodes with a thickness of 0.3 μm are deposited next. A sacrificial layer of 
oxide is then deposited to a thickness of 198.5 nm. Note that in Ref. 1 the sacrificial oxide 
is actually 1.3 μm, but the gap thickness was adjusted to this value for the purposes of 
simulation to account for the depletion layer in the silicon. This model uses the same 
adjustment to enable the simulations to be directly compared with those presented in the 
paper. Holes are etched in the sacrificial layer (to provide anchor points for the resonator) 
and the structural polysilicon is deposited with a thickness of 1.9 μm.

The structure has a plane of symmetry, so it is possible to model only half of the geometry 
explicitly, although care must be taken to mirror the geometry before performing a modal 
analysis. Figure 1 shows the geometry.
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Figure 1: Top: Device geometry. The wafer itself is not shown explicitly, but is represented in 
the model by a ground plane on the underside of the geometry. Bottom: The model geometry as 
it appears in COMSOL.

The layers of deposited material from the ground plane up are: silicon oxide, silicon nitride 
(too thin to see clearly), polysilicon electrodes/air gap (etched sacrificial oxide), 
polysilicon resonator, and air.

In operation, both the silicon resonator and the underlying wafer are grounded and an 
electric voltage is applied to the driving electrode, which is bisected by the symmetry plane. 

mirror symmetry plane

resonator anchor

drive electrode

polysilicon resonator

thin nitride layer

oxide layer
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Typically a DC bias of 35 V is applied in normal operation of the device. The assumption 
is made that the polysilicon is a perfect conductor, so the bias voltage is applied on all 
exterior surfaces of the resonator and its anchor as a potential boundary condition. In this 
model, the deformation of the structure is computed with the applied DC bias. Note that 
the silicon oxide and nitride are assumed to be rigid for the solid mechanics simulations, 
so the structure is anchored at the base of its electrode, and these domains are not included 
in the solid mechanics equations.

E L E C T R O M E C H A N I C A L  F O R C E S

Within a vacuum or other medium, forces between charged bodies can be computed on 
the assumption that a fictitious state of stress exists within the field. The Electromagnetic 
or Maxwell stress tensor can be used to compute the induced stresses in a material as a 
result of an electric field as well as surface forces acting on bodies in air or vacuum. In this 
model, it is assumed that the polysilicon is doped sufficiently heavily that it can be treated 
as a perfect conductor. The electric field is assumed to be zero inside the resonator, which 
means that the Maxwell stress tensor is zero inside the material and there are no volumetric 
electrical forces. The Maxwell stress tensor in the medium surrounding the resonator, 
where the electric field is non-zero is (Ref. 2)

A net force on the surface typically results from the discontinuity of the stress tensor at the 
interface. However, because it is undesirable to apply a stress term throughout the 
vacuum, the force is only computed on the surface of the resonator, and is applied by the 
Electromechanical Interface node. The surface force is given by

where n1 is the surface normal, pointing out from the mechanical body.

Results and Discussion

Figure 2 shows the z displacement of the structure with an applied DC bias. As expected 
the structural displacement is maximal on the symmetry plane at the center of the device. 
The maximum displacement is 13  nm. Electric potential isosurfaces are also shown in 
Figure 2. As expected, the isobars are uniformly distributed and closest together between 
the resonator and the electrode. This corresponds to a region of uniform electric field. 
Around the electrode the fringing fields can also be seen. Note that the surface of the 
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resonator is assumed to be perfectly grounded. This is a result of the potential boundary 
condition used and is equivalent to the assumption that the polysilicon is a perfect 
conductor.

Figure 2: The z-displacement of the resonator as a function of position. The maximum 
displacement occurs in the center of the resonator, immediately over the biasing electrode. 
Electric potential isosurfaces with values of 10 V (green), 20 V (yellow), and 30 V (red) are 
also shown.
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Application Library path: MEMS_Module/Actuators/biased_resonator_3d_basic
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Electromechanics (emi).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

For convenience, the device geometry is inserted from an existing file. You can read the 
instructions for creating the geometry in the .

G E O M E T R Y  1

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_3d_geom_sequence.mph.

3 On the Geometry toolbar, click Build All.

Add a parameter for the applied DC bias.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Create selections to facilitate easy set up of the boundary conditions.

Name Expression Value Description

Vdc 35[V] 35 V DC bias voltage
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D E F I N I T I O N S

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.

3 Select the All domains check box.

4 Right-click Explicit 1 and choose Rename.

5 In the Rename Explicit dialog box, type All domains in the New label text field.

6 Click OK.

Box 1
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Box Limits section.

3 In the z minimum text field, type -2.

4 In the z maximum text field, type -1.

5 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

6 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

7 Right-click Box 1 and choose Rename.

8 In the Rename Box dialog box, type Ground Plane in the New label text field.

9 Click OK.

Box 2
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Box Limits section.

3 In the z minimum text field, type -1.

4 In the z maximum text field, type -0.9.

5 Right-click Box 2 and choose Rename.

6 In the Rename Box dialog box, type Oxide in the New label text field.

7 Click OK.

Box 3
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Box Limits section.

3 In the z minimum text field, type -0.4.
7 |  S T A T I O N A R Y  A N A L Y S I S  O F  A  B I A S E D  R E S O N A T O R — 3 D



4 In the z maximum text field, type -0.35.

5 Right-click Box 3 and choose Rename.

6 In the Rename Box dialog box, type Nitride in the New label text field.

7 Click OK.

Box 4
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Box Limits section.

3 In the x minimum text field, type -0.1.

4 In the x maximum text field, type 0.1.

5 In the y minimum text field, type -4.2.

6 In the z minimum text field, type -0.15.

7 In the z maximum text field, type -0.1.

8 Right-click Box 4 and choose Rename.

9 In the Rename Box dialog box, type Electrode in the New label text field.

10 Click OK.

Ball 1
1 On the Definitions toolbar, click Ball/Disk.

2 In the Settings window for Ball, locate the Ball Center section.

3 In the z text field, type 1.

4 Locate the Ball Radius section. In the Radius text field, type 0.1.

Box 5
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Box Limits section.

3 In the y maximum text field, type 4.8.

4 In the z minimum text field, type -0.35.

5 In the z maximum text field, type 0.05.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 6
1 Right-click Box 5 and choose Duplicate.

2 In the Settings window for Box, locate the Box Limits section.
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3 In the x minimum text field, type -15.

4 In the x maximum text field, type 15.

Difference 1
1 On the Definitions toolbar, click Difference.

2 In the Settings window for Difference, locate the Input Entities section.

3 Under Selections to add, click Add.

4 In the Add dialog box, In the Selections to add list, choose Ball 1 and Box 5.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog box, select Box 6 in the Selections to subtract list.

9 Click OK.

10 Right-click Difference 1 and choose Rename.

11 In the Rename Difference dialog box, type Resonator in the New label text field.

12 Click OK.

Union 1
1 On the Definitions toolbar, click Union.

2 In the Settings window for Union, locate the Input Entities section.

3 Under Selections to add, click Add.

4 In the Add dialog box, In the Selections to add list, choose Electrode and Resonator.

5 Click OK.

6 Right-click Union 1 and choose Rename.

7 In the Rename Union dialog box, type PolySi in the New label text field.

8 Click OK.

Difference 2
1 On the Definitions toolbar, click Difference.

2 In the Settings window for Difference, locate the Input Entities section.

3 Under Selections to add, click Add.

4 In the Add dialog box, select All domains in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.
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7 Under Selections to subtract, click Add.

8 In the Add dialog box, In the Selections to subtract list, choose Oxide, Nitride, and PolySi.

9 Click OK.

10 Right-click Difference 2 and choose Rename.

11 In the Rename Difference dialog box, type Air in the New label text field.

12 Click OK.

Adjacent 1
1 On the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, locate the Input Entities section.

3 Under Input selections, click Add.

4 In the Add dialog box, select Resonator in the Input selections list.

5 Click OK.

6 Right-click Adjacent 1 and choose Rename.

7 In the Rename Adjacent dialog box, type Resonator Boundaries in the New label text 
field.

8 Click OK.

Adjacent 2
1 On the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, locate the Input Entities section.

3 Under Input selections, click Add.

4 In the Add dialog box, select Electrode in the Input selections list.

5 Click OK.

6 Right-click Adjacent 2 and choose Rename.

7 In the Rename Adjacent dialog box, type Electrode Boundaries in the New label text 
field.

8 Click OK.

Adjacent 3
1 On the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, locate the Input Entities section.

3 Under Input selections, click Add.

4 In the Add dialog box, select Nitride in the Input selections list.
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5 Click OK.

6 Right-click Adjacent 3 and choose Rename.

7 In the Rename Adjacent dialog box, type Nitride Boundaries in the New label text 
field.

8 Click OK.

Adjacent 4
1 On the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, locate the Input Entities section.

3 Under Input selections, click Add.

4 In the Add dialog box, select All domains in the Input selections list.

5 Click OK.

6 Right-click Adjacent 4 and choose Rename.

7 In the Rename Adjacent dialog box, type Geometry Exterior Boundaries in the 
New label text field.

8 Click OK.

Difference 3
1 On the Definitions toolbar, click Difference.

2 In the Settings window for Difference, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, select Resonator Boundaries in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog box, select Geometry Exterior Boundaries in the Selections to subtract 
list.

10 Click OK.

11 Right-click Difference 3 and choose Rename.

12 In the Rename Difference dialog box, type Resonator Exterior Boundaries in the 
New label text field.

13 Click OK.
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Difference 4
1 On the Definitions toolbar, click Difference.

2 In the Settings window for Difference, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, select Electrode Boundaries in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog box, select Geometry Exterior Boundaries in the Selections to subtract 
list.

10 Click OK.

11 Right-click Difference 4 and choose Rename.

12 In the Rename Difference dialog box, type Electrode Exterior Boundaries in the 
New label text field.

13 Click OK.

Intersection 1
1 On the Definitions toolbar, click Intersection.

2 In the Settings window for Intersection, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click Add.

5 In the Add dialog box, In the Selections to intersect list, choose Resonator Boundaries and 
Nitride Boundaries.

6 Click OK.

7 Right-click Intersection 1 and choose Rename.

8 In the Rename Intersection dialog box, type Fixed Boundaries in the New label text 
field.

9 Click OK.

Box 7
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.
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4 Locate the Box Limits section. In the x minimum text field, type -0.1.

5 In the x maximum text field, type 0.1.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

7 Right-click Box 7 and choose Rename.

8 In the Rename Box dialog box, type Symmetry Boundaries in the New label text field.

9 Click OK.

M A T E R I A L S

Add materials to the model.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Semiconductors>Si - Polycrystalline Silicon.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Si - Polycrystalline Silicon (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Si -

Polycrystalline Silicon (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose PolySi.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select MEMS>Insulators>Si3N4 - Silicon nitride.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Si3N4 - Silicon nitride (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Si3N4 -

Silicon nitride (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Nitride.
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A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select MEMS>Insulators>SiO2 - Silicon oxide.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

SiO2 - Silicon oxide (mat3)
1 In the Model Builder window, under Component 1 (comp1)>Materials click SiO2 -

Silicon oxide (mat3).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Oxide.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Air.

3 Click Add to Component in the window toolbar.

4 On the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Air (mat4)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Air (mat4).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Air.

Set the air material property to be non-solid, to ensure the interface solves the 
electrostatics equations in the spatial frame.

4 Click to expand the Material properties section. Locate the Material Properties section. 
From the Material type list, choose Nonsolid.

E L E C T R O M E C H A N I C S  ( E M I )

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromechanics (emi) and choose Linear Elastic Material.

2 In the Settings window for Linear Elastic Material, locate the Domain Selection section.

3 From the Selection list, choose Resonator.
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Fixed Constraint 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Structural>Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Fixed Boundaries.

Symmetry 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose Symmetry Boundaries.

Fixed Mesh 2
1 Right-click Electromechanics (emi) and choose the domain setting Deformed Mesh>

Fixed Mesh.

2 In the Settings window for Fixed Mesh, locate the Domain Selection section.

3 From the Selection list, choose Oxide.

Fixed Mesh 3
1 Right-click Component 1 (comp1)>Electromechanics (emi)>Fixed Mesh 2 and choose 

Duplicate.

2 In the Settings window for Fixed Mesh, locate the Domain Selection section.

3 From the Selection list, choose Nitride.

Fixed Mesh 4
1 Right-click Component 1 (comp1)>Electromechanics (emi)>Fixed Mesh 3 and choose 

Duplicate.

2 In the Settings window for Fixed Mesh, locate the Domain Selection section.

3 From the Selection list, choose Electrode.

Prescribed Mesh Displacement 2
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Deformed Mesh>Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection 
section.

3 From the Selection list, choose Symmetry Boundaries.

4 Locate the Prescribed Mesh Displacement section. Clear the Prescribed y displacement 
check box.
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5 Clear the Prescribed z displacement check box.

Ground 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 From the Selection list, choose Resonator Exterior Boundaries.

Ground 2
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 From the Selection list, choose Ground Plane.

Electric Potential 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Electric Potential.

2 In the Settings window for Electric Potential, locate the Electric Potential section.

3 In the V0 text field, type Vdc.

4 Locate the Boundary Selection section. From the Selection list, choose 
Electrode Exterior Boundaries.

M E S H  1

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Free Triangular Mesh.

4 Click Build Selected.

Swept 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.
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2 In the Settings window for Swept, click Build Selected.

S T U D Y  1

1 In the Model Builder window, right-click Study 1 and choose Rename.

2 In the Rename Study dialog box, type Stationary in the New label text field.

3 Click OK.

4 On the Home toolbar, click Compute.

R E S U L T S

3D Plot Group 3
1 On the Results toolbar, click More Data Sets and choose Mirror 3D.

2 On the Results toolbar, click 3D Plot Group.

3 In the Settings window for 3D Plot Group, locate the Data section.

4 From the Data set list, choose Mirror 3D 1.

Volume 1
1 Right-click 3D Plot Group 3 and choose Volume.

2 In the Settings window for Volume, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>

Electromechanics (Solid Mechanics)>Displacement>

Displacement field (material and geometry frames)>w - Displacement field, Z component.
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3 Locate the Coloring and Style section. Select the Reverse color table check box.

Isosurface 1
1 In the Model Builder window, under Results right-click 3D Plot Group 3 and choose 

Isosurface.

2 In the Settings window for Isosurface, click Replace Expression in the upper-right corner 
of the Expression section. From the menu, choose Component 1>

Electromechanics (Electrical Quasistatics)>Electric>V - Electric potential.

3 Locate the Levels section. From the Entry method list, choose Levels.

4 In the Levels text field, type 10 20 30.

5 Locate the Coloring and Style section. From the Color table list, choose Traffic.

6 Clear the Color legend check box.

3D Plot Group 3
1 Right-click 3D Plot Group 3 and choose Rename.

2 In the Rename 3D Plot Group dialog box, type Biased Displacement in the New label 
text field.

3 Click OK.

Compare the resulting plot with .
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a frequency-domain analysis of the structure, which is also biased 
with its operating DC offset. The analysis begins from the stationary analysis performed in 
the accompanying model Stationary Analysis of a Biased Resonator—3D; please review 
this model first.

Model Definition

The geometry, fabrication, and operation of the device are discussed for the “Stationary 
Analysis of a Biased Resonator—3D” model.

For the frequency-domain analysis of the structure, consider an applied drive voltage 
consisting of a 35 V DC offset with a 100 mV drive signal added as a harmonic 
perturbation. Solve the linearized problem to compute the response of the system.

In general, for resonant structures like this model, a very fine mesh is required to achieve 
accurate frequency response results. In the interest of saving time, we choose to use a 
relatively coarse mesh for this tutorial. As a result the resonant peak will shift if a more 
refined mesh is used.

D A M P I N G

To obtain the response of the system, you need to add damping to the model. For this 
study, assume that the damping mechanism is Rayleigh damping or material damping. 

To specify the damping, two material constants are required (αdM and βdK). For a system 
with a single degree of freedom (a mass-spring-damper system) the equation of motion 
with viscous damping is given by

where c is the damping coefficient, m is the mass, k is the spring constant, u is the 
displacement, t is the time, and f(t) is a driving force.

md2u

dt2
---------- cdu

dt 
------- ku+ + f t( )=
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In the Rayleigh damping model, the parameter c is related to the mass, m, and the stiffness, 
k, by the equation:

The Rayleigh damping term in COMSOL Multiphysics is proportional to the mass and 
stiffness matrices and is added to the static weak term. 

The damping coefficient, c, is frequently defined as a damping ratio or factor, expressed as 
a fraction of the critical damping, c0, for the system such that

where for a system with one degree of freedom

Finally note that for large values of the quality factor, Q,

The material parameters αdM and βdK are usually not available in the literature. Often the 
damping ratio is available, typically expressed as a percentage of the critical damping. It is 
possible to transform damping factors to Rayleigh damping parameters. The damping 
factor, ξ, for a specified pair of Rayleigh parameters, αdM and βdK, at the frequency, f, is

Using this relationship at two frequencies, f1 and f2, with different damping factors, ξ1 and 
ξ2, results in an equation system that can be solved for αdM and βdK:

The damping factors for this model are provided as αdM = 4189 Hz and βdK = 8.29·10−
13 s, consistent with the observed Quality factor of 8000 for the fundamental mode.

c αdMm βdKk+=

ξ c
c0
-----=

c0 2 km=

ξ 1
2Q
--------≅

ξ 1
2
---

αdM
2πf
----------- βdK2πf+ 
 =

1
4πf1
------------ πf1

1
4πf2
------------ πf2

αdM

βdK

ξ1

ξ2
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Results and Discussion

Figure 1 shows the frequency response of the resonator. This response can be compared 
to that shown in Figure 4 in Ref. 1. Although the experimental results in Ref. 1 are from 
a pair of coupled resonators in this instance, the two resonances are sufficiently separate in 
frequency space that it is possible to distinguish the two modes. If the details of the 
external circuits were available, a terminal boundary condition with an attached circuit 
could be used to compute the electrical response of the system for a more direct 
comparison with the experimental results.

Figure 1: Frequency response of the fundamental mode of the resonator.
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Application Library path: MEMS_Module/Actuators/biased_resonator_3d_freq

Modeling Instructions

Open the existing stationary study (filename: biased_resonator_3d_basic.mph).

From the File menu, choose Open.

Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_3d_basic.mph.

Create parameters for the material damping factors.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Add damping to the physics settings.

C O M P O N E N T  1  ( C O M P 1 )

In the Model Builder window, expand the Component 1 (comp1) node.

E L E C T R O M E C H A N I C S  ( E M I )

Linear Elastic Material 1
In the Model Builder window, expand the Component 1 (comp1)>Electromechanics (emi) 
node.

Name Expression Value Description

Q 8000 8000 Resonator quality factor

f0 8[MHz] 8E6 Hz Approximate resonance 
frequency

alpha 4*pi*f0/(3*Q) 4189 Hz Damping parameter

beta 1/(6*pi*f0*Q) 8.289E-13 s Damping parameter
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Damping 1
1 Right-click Linear Elastic Material 1 and choose Damping.

2 In the Settings window for Damping, locate the Damping Settings section.

3 In the αdM text field, type alpha.

4 In the βdK text field, type beta.

Add a Harmonic Perturbation to the DC bias term, to represent the offset AC drive 
voltage.

Harmonic Perturbation 1
1 In the Model Builder window, under Component 1 (comp1)>Electromechanics (emi) right-

click Electric Potential 1 and choose Harmonic Perturbation.

2 In the Settings window for Harmonic Perturbation, locate the Electric Potential section.

3 In the V0 text field, type 0.1.

Set up the frequency domain study.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Frequency Domain.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 2: Frequency-Domain Perturbation
1 In the Model Builder window, under Study 2 click Step 2: Frequency-Domain Perturbation.

2 In the Settings window for Frequency-Domain Perturbation, locate the Study Settings 
section.

3 In the Frequencies text field, type range(7.69[MHz],0.002[MHz],7.73[MHz]).

4 In the Model Builder window, right-click Study 2 and choose Rename.

5 In the Rename Study dialog box, type Frequency Domain in the New label text field.

6 Click OK.

Disable the default plots.

7 In the Settings window for Study, locate the Study Settings section.
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8 Clear the Generate default plots check box.

9 On the Home toolbar, click Compute.

Produce a plot of the frequency response of the system.

R E S U L T S

1D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Frequency Domain/Solution 2 (sol2).

Point Graph 1
1 Right-click 1D Plot Group 4 and choose Point Graph.

2 Select Point 254 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.

4 In the Expression text field, type abs(w).

5 On the 1D Plot Group 4 toolbar, click Plot.

6 Click the y-Axis Log Scale button on the Graphics toolbar.

1D Plot Group 4
1 In the Model Builder window, under Results right-click 1D Plot Group 4 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Frequency Domain in the New label text 
field.

3 Click OK.

Compare the resulting plot with .
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a modal analysis on the resonator, with and without an applied DC 
bias. The analysis begins from the stationary analysis performed in the accompanying 
model Stationary Analysis of a Biased Resonator—3D; please review this model first.

Model Definition

The geometry, fabrication, and operation of the device are discussed for the “Stationary 
Analysis of a Biased Resonator—3D” model. In this example it is no longer possible to 
model half of the geometry using symmetry boundary conditions, because doing so 
excludes all the antisymmetric vibrational modes. The geometry is therefore mirrored 
prior to performing the analyses, as shown in Figure 1. Note that the model could still be 
solved with the original geometry and symmetry boundary conditions, however the 
antisymmetric modes would be excluded from the solutions.

This model performs a modal analysis on the structure, with and without applied DC 
voltage biases of different magnitudes. The bias already exists as a parameter in the model 
so the prestressed eigenfrequency solver needs no adjustment to the physics settings. To 
compute the unbiased eigenfrequency, the solver settings are adjusted to solve only the 
structural mechanics problem.
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Figure 1: Model geometry. In order to capture the anti-symmetric vibrational modes, it is 
necessary to mirror the symmetric geometry prior to solving the model. The original symmetry 
plane is in the center of the geoemtry.The resonator itself is shown highlighted.

Results and Discussion

Figure 2 shows the normal modes of the device, together with the eigenfrequency, in the 
unbiased state. The lowest three normal modes are symmetric and anti-symmetric bending 
modes and a torsional mode. 

The symmetric bending mode is employed during the operation of the device, and its 
shape does not change significantly with applied bias. However, the frequency of the mode 
is reduced significantly by the applied bias, an effect known as spring softening. The spring 
softening effect can be seen in detail in Figure 2. A clear decrease in the resonant frequency 
is evident with increasing bias voltage. This figure should be compared with Figure 16 of 
Ref. 1 which shows measured experimental data for the same device. Data extracted from 
Ref. 1 is shown in Figure 3 along with the simulation results. The agreement between the 
model and the data is excellent.
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Figure 2: Normal modes of the unbiased device, together with the frequency of the mode.

8.3 MHz

21.9 MHz

26.9 MHz
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Figure 3: Resonant frequency of the first normal mode (a symmetric bending mode) as a 
function of applied DC bias. Both the COMSOL simulation data and the experimental data 
from Ref. 1 are shown in the plot.

Reference

1. F.D. Bannon III, J.R. Clark and C.T.-C. Nguyen, “High-Q HF 
Microelectromechanical Filters,” IEEE Journal of Solid State Circuits, vol. 35, no. 4, pp. 
512–526, 2000.

Application Library path: MEMS_Module/Actuators/biased_resonator_3d_modes

Modeling Instructions

R O O T

Open the existing stationary study (filename: biased_resonator_3d_basic.mph).

1 From the File menu, choose Open.
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2 Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_3d_basic.mph.

R E S U L T S

Biased Displacement
Mirror the geometry so that asymmetric eigenmodes can be modeled.

G E O M E T R Y  1

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Normal Vector to Plane of Reflection section.

3 In the z text field, type 0.

4 In the x text field, type 1.

5 Click in the Graphics window and then press Ctrl+A to select both objects.

6 Locate the Input section. Select the Keep input objects check box.

7 Click Build All Objects.

8 Click the Zoom Extents button on the Graphics toolbar.

Import experimental data into the model for comparison with the simulation.

D E F I N I T I O N S

Interpolation 1 (int1)
1 On the Home toolbar, click Functions and choose Local>Interpolation.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Data source list, choose File.

4 Click Browse.

5 Browse to the model’s Application Libraries folder and double-click the file 
biased_resonator_3d_modes_experiment.txt.

6 Click Import.

7 Locate the Units section. In the Arguments text field, type Hz.

8 In the Function text field, type V.

9 Locate the Interpolation and Extrapolation section. From the Extrapolation list, choose 
Specific value.
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10 In the Value outside range text field, type NaN.

Disable the symmetry node to allow anti-symmetric nodes.

E L E C T R O M E C H A N I C S  ( E M I )

Symmetry 1
1 In the Model Builder window, expand the Component 1 (comp1)>Electromechanics (emi) 

node.

2 Right-click Symmetry 1 and choose Disable.

R O O T

Add a study to compute the unbiased vibrational modes.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Custom Studies>

Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Eigenfrequency
Solve for the first three modes.

1 In the Model Builder window, click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box.

4 In the associated text field, type 3.

Disable the electric potential and mesh displacement degrees of freedom to solve only 
the structural problem. This will give the vibrational modes in the absence of an electric 
field.

Solution 2 (sol2)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 2 (sol2) node, then click 
Dependent Variables 1.
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3 In the Settings window for Dependent Variables, locate the General section.

4 From the Defined by study step list, choose User defined.

5 In the Model Builder window, expand the Study 2>Solver Configurations>

Solution 2 (sol2)>Dependent Variables 1 node, then click Electric potential (comp1.V).

6 In the Settings window for Field, locate the General section.

7 Clear the Solve for this field check box.

8 Clear the Store in output check box.

9 In the Model Builder window, under Study 2>Solver Configurations>Solution 2 (sol2)>

Dependent Variables 1 click Spatial coordinates (comp1.xyz).

10 In the Settings window for Field, locate the General section.

11 Clear the Solve for this field check box.

12 Clear the Store in output check box.

13 In the Model Builder window, right-click Study 2 and choose Rename.

14 In the Rename Study dialog box, type Unbiased Eigenfrequency in the New label text 
field.

15 Click OK.

16 In the Settings window for Study, locate the Study Settings section.

17 Clear the Generate default plots check box.

18 On the Study toolbar, click Compute.

Change the data set frame to show results in the material frame. This allows the use of 
the deformation plot attribute.

R E S U L T S

Unbiased Eigenfrequency/Solution 2 (sol2)
1 In the Model Builder window, expand the Results>Data Sets node, then click 

Unbiased Eigenfrequency/Solution 2 (sol2).

2 In the Settings window for Solution, locate the Solution section.

3 From the Frame list, choose Material (X, Y, Z).

Create a plot that shows the unbiased modes.

3D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, locate the Data section.
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3 From the Data set list, choose Unbiased Eigenfrequency/Solution 2 (sol2).

Volume 1
1 Right-click 3D Plot Group 4 and choose Volume.

2 In the Settings window for Volume, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Model>Component 1>

Electromechanics (Solid Mechanics)>Displacement>emi.disp - Total displacement.

3 Locate the Coloring and Style section. Clear the Color legend check box.

3D Plot Group 4
1 Right-click Results>3D Plot Group 4>Volume 1 and choose Deformation.

2 In the Model Builder window, under Results right-click 3D Plot Group 4 and choose 
Rename.

3 In the Rename 3D Plot Group dialog box, type Unbiased Modes in the New label text 
field.

4 Click OK.

Compare the mode shapes with those shown in  for all the modes computed. To switch 
between the modes click Unbiased Modes and choose a different value from the 
Eigenfrequency list.

Add a Prestressed Analysis, Eigenfrequency study.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  3

Step 1: Stationary
1 In the Model Builder window, right-click Study 3 and choose Rename.

2 In the Rename Study dialog box, type Biased Eigenfrequency in the New label text 
field.

3 Click OK.

Create a parametric sweep over DC bias voltage.
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Parametric Sweep
On the Study toolbar, click Parametric Sweep.

B I A S E D  E I G E N F R E Q U E N C Y

Parametric Sweep
1 In the Settings window for Parametric Sweep, locate the Study Settings section.

2 Click Add.

3 In the table, enter the following settings:

4 Click Range.

5 In the Range dialog box, type 5 in the Start text field.

6 In the Stop text field, type 45.

7 In the Step text field, type 5.

8 Click Add.

Solve for only the first eigenfrequency.

Step 2: Eigenfrequency
1 In the Model Builder window, under Biased Eigenfrequency click Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box.

4 In the associated text field, type 1.

Disable the default plots.

5 In the Model Builder window, click Biased Eigenfrequency.

6 In the Settings window for Study, locate the Study Settings section.

7 Clear the Generate default plots check box.

8 On the Study toolbar, click Compute.

Create a plot of eigenfrequency vs. applied DC voltage.

R E S U L T S

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

Parameter name Parameter value list Parameter unit

Vdc
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3 From the Data set list, choose Biased Eigenfrequency/Parametric Solutions 1 (sol5).

Point Graph 1
1 Right-click 1D Plot Group 5 and choose Point Graph.

2 Select Point 1 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.

4 In the Expression text field, type emi.freq.

5 Locate the x-Axis Data section. From the Axis source data list, choose Outer solutions.

6 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose None.

7 Find the Line markers subsection. From the Marker list, choose Square.

8 From the Positioning list, choose In data points.

9 Click to expand the Legends section. Select the Show legends check box.

10 From the Legends list, choose Manual.

11 In the table, enter the following settings:

Point Graph 2
1 Right-click Results>1D Plot Group 5>Point Graph 1 and choose Duplicate.

2 In the Settings window for Point Graph, locate the Data section.

3 From the Data set list, choose Unbiased Eigenfrequency/Solution 2 (sol2).

4 From the Eigenfrequency selection list, choose First.

5 Locate the Coloring and Style section. From the Color list, choose Blue.

6 Locate the Legends section. Clear the Show legends check box.

Global 1
1 In the Model Builder window, under Results right-click 1D Plot Group 5 and choose 

Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

Legends

COMSOL Solution

Expression Unit Description

int1(Vdc)
11 |  N O R M A L  M O D E S  O F  A  B I A S E D  R E S O N A T O R — 3 D



4 Locate the x-Axis Data section. From the Axis source data list, choose Outer solutions.

5 From the Parameter list, choose Expression.

6 In the Expression text field, type Vdc.

7 Click to expand the Legends section. From the Legends list, choose Manual.

8 In the table, enter the following settings:

1D Plot Group 5
1 In the Model Builder window, under Results click 1D Plot Group 5.

2 In the Settings window for 1D Plot Group, click to expand the Title section.

3 From the Title type list, choose Manual.

4 In the Title text area, type Eigenfrequency vs. DC voltage.

5 Locate the Plot Settings section. Select the x-axis label check box.

6 In the associated text field, type DC Bias (V).

7 Select the y-axis label check box.

8 In the associated text field, type Resonant Frequency (Hz).

9 Right-click Results>1D Plot Group 5 and choose Rename.

10 In the Rename 1D Plot Group dialog box, type Eigenfrequency vs DC Voltage in the 
New label text field.

11 Click OK.

Compare this plot with that in . Note the spring softening effect.

Legends

Experiment: Bannon et. al.
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Introduction

Silicon micromechanical resonators have long been used for designing sensors and are now 
becoming increasingly important as oscillators in the consumer electronics market. In this 
sequence of models, a surface micromachined MEMS resonator, designed as part of a 
micromechanical filter, is analyzed in detail. The resonator is based on that developed in 
Ref. 1.

This model performs a pull-in analysis of the structure, to predict the point at which the 
biased system becomes unstable. The analysis begins from the stationary analysis 
performed in the accompanying model Stationary Analysis of a Biased Resonator—3D; 
please review this model first. 

Model Definition

The geometry, fabrication, and operation of the device are discussed for the “Stationary 
Analysis of a Biased Resonator—3D” model.

This model computes the pull-in voltage for the resonator by solving an inverse problem. 
The z-coordinate of the resonator midpoint is computed using an integration operator 
(intop1). The inverse problem that COMSOL solves computes the DC voltage that must 
be applied to the beam in order to move the midpoint to a set z-coordinate, zset. This is 
achieved by adding a global equation for the DC voltage, VdcSP, applied to the resonator. 
The equation intop1(z)-zset=0 is solved to determine the value of VdcSP. This means 
that VdcSP is adjusted until the midpoint of the resonator has a z-coordinate given by the 
set value, zset. Essentially COMSOL is being asked to find the voltage that allows the 
beam to exist in equilibrium (stable or unstable) at a given displacement. Solving the 
problem in this way avoids complications with trying to solve a problem with no solution 
(which is what happens if the voltage is continuously ramped up eventually exceeding the 
pull-in voltage). The result of the analysis is a displacement versus voltage plot, with a 
minimum at the pull-in voltage. Note that for a linear spring, the pull-in displacement 
corresponds to 1/3 of the gap distance. Although the inclusion of geometric nonlinearities 
in the solid mechanics solver means that the pull-in displacement changes slightly from this 
value, it is usually most efficient to search around this point for the pull-in voltage.

Results and Discussion

Figure 1 shows the voltage-displacement curve for the resonator at equilibrium. The y-
coordinate at which the pull in occurs corresponds to a displacements around 1/3 of the 
gap size. The pull-in voltage is 59.1 V.
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Figure 1: Voltage required to achieve a set displacement versus the target displacement. The 
pull-in voltage is the minimum of the plot: 59.4 V.
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Figure 2: z-displacement of the resonator at pull-in. The displacement at pull-in is 75 nm. For 
a linear spring the displacement at pull in would be 66 nm.

Figure 2 shows the z-displacement of the resonator at the pull-in voltage. The maximum 
displacement at pull-in is 75 nm. This is comparable to the linear spring value of 66 nm.

Notes About the COMSOL Implementation

To compute the voltage required to generate the desired displacement of the beam, use a 
global equation. A common use of global equations is for computing the value of a 
dependent variable based on an ordinary differential equation in the dependent variable 
itself. However, it is also possible to couple a global equation with the other PDEs in the 
model as a powerful tool to solve certain kinds of inverse problems. This model uses a 
global equation to compute the potential applied to the drive electrode. The equation 
takes the form

where z0 is the z-coordinate of the midpoint of the beam’s underside and zset is the desired 
z-coordinate. COMSOL Multiphysics computes the voltage to satisfy the constraint 
implied by the above equation. Note that the large difference in scale between the set-

z0 zset=
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point displacement (10−7 m) and the applied voltages (102 V) means that care must be 
taken with the dependent variable scaling in the solver settings.

Reference

1. F.D. Bannon III, J.R. Clark and C.T.-C. Nguyen, “High-Q HF 
Microelectromechanical Filters,” IEEE Journal of Solid State Circuits, vol. 35, no. 4, pp. 
512–526, 2000.

Application Library path: MEMS_Module/Actuators/
biased_resonator_3d_pull_in

Modeling Instructions

Open the existing stationary study (filename: biased_resonator_3d_basic.mph).

From the File menu, choose Open.

Browse to the application’s Application Libraries folder and double-click the file 
biased_resonator_3d_basic.mph.

Add a parameter to set the z-coordinate of the midpoint of the resonator.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Add an integration operator to compute the actual displacement.

D E F I N I T I O N S

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

Name Expression Value Description

zset 100[nm] 1E-7 m Set point z-coordinate
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2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.

4 Select Point 253 only.

Change the drive potential to the value VdcSP - which will be solved for in a global 
equation.

E L E C T R O M E C H A N I C S  ( E M I )

Electric Potential 1
1 In the Model Builder window, expand the Component 1 (comp1)>Electromechanics (emi) 

node, then click Electric Potential 1.

2 In the Settings window for Electric Potential, locate the Electric Potential section.

3 In the V0 text field, type VdcSP.

Add a global equation to compute the voltage for a given displacement, VdcSP.

4 In the Model Builder window’s toolbar, click the Show button and select 
Advanced Physics Options in the menu.

Global Equations 1
1 On the Physics toolbar, click Global and choose Global Equations.

2 In the Settings window for Global Equations, locate the Global Equations section.

3 In the table, enter the following settings:

Set up a parametric sweep over zset.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

Name f(u,ut,utt,t) (1) Initial value 
(u_0) (1)

Initial value 
(u_t0) (1/s)

Description

VdcSP intop1(z)-zset 0 0 Applied bias required 
to reach zset (V)
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S T U D Y  2

Step 1: Stationary
1 In the Model Builder window, under Study 2 click Step 1: Stationary.

2 In the Settings window for Stationary, click to expand the Study extensions section.

3 Locate the Study Extensions section. Select the Auxiliary sweep check box.

4 Click Add.

5 In the table, enter the following settings:

6 Click Range.

7 In the Range dialog box, type 120e-9 in the Start text field.

8 In the Step text field, type 2e-9.

9 In the Stop text field, type 140e-9.

10 Click Replace.

The dependent variables require scaling correctly in order to assist the solver.

Solution 2 (sol2)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 2 (sol2) node, then click 
Dependent Variables 1.

3 In the Settings window for Dependent Variables, locate the General section.

4 From the Defined by study step list, choose User defined.

5 In the Model Builder window, expand the Study 2>Solver Configurations>

Solution 2 (sol2)>Dependent Variables 1 node, then click Electric potential (comp1.V).

6 In the Settings window for Field, locate the Scaling section.

7 From the Method list, choose Manual.

8 In the Scale text field, type 100.

9 In the Model Builder window, under Study 2>Solver Configurations>Solution 2 (sol2)>

Dependent Variables 1 click Spatial coordinates (comp1.xyz).

10 In the Settings window for Field, locate the Scaling section.

11 From the Method list, choose Manual.

12 In the Scale text field, type 1e-6.

Parameter name Parameter value list Parameter unit

zset
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13 In the Model Builder window, under Study 2>Solver Configurations>Solution 2 (sol2)>

Dependent Variables 1 click Applied bias required to reach zset (V) (comp1.ODE1).

14 In the Settings window for State, locate the Scaling section.

15 From the Method list, choose Manual.

16 In the Scale text field, type 100.

The problem is highly non-linear, so the solver settings need to be adjusted accordingly.

17 In the Model Builder window, expand the Study 2>Solver Configurations>

Solution 2 (sol2)>Stationary Solver 1 node.

18 Right-click Study 2>Solver Configurations>Solution 2 (sol2)>Stationary Solver 1 and 
choose Fully Coupled.

19 In the Settings window for Fully Coupled, locate the General section.

20 From the Linear solver list, choose Direct.

21 Click to expand the Method and termination section. Locate the Method and Termination 
section. From the Nonlinear method list, choose Automatic highly nonlinear (Newton).

22 In the Model Builder window, right-click Study 2 and choose Rename.

23 In the Rename Study dialog box, type Pull In in the New label text field.

24 Click OK.

25 On the Study toolbar, click Compute.

R E S U L T S

Displacement (emi) 1
Determine the pull-in voltage by plotting VdcSP vs. zset.

1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Pull In/Solution 2 (sol2).

Global 1
1 Right-click 1D Plot Group 6 and choose Global.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Electromechanics>VdcSP -

Applied bias required to reach zset (V).

3 Locate the x-Axis Data section. From the Parameter list, choose Expression.

4 In the Expression text field, type zset.
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1D Plot Group 6
1 In the Model Builder window, under Results right-click 1D Plot Group 6 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Pull-In Plot in the New label text field.

3 Click OK.

4 On the Pull-In Plot toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with . The pull in voltage is the minimum of the curve: 59.4 
V at zset=126 nm.

Now look at the displacement at pull in. The default plot group can be used.

Displacement (emi) 1
1 In the Model Builder window, under Results click Displacement (emi) 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (zset) list, choose 1.24E-7.

4 On the Displacement (emi) 1 toolbar, click Plot.

Compare the resulting plot with . The displacement at pull-in is 75 nm.
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Introduction

Capacitive pressure sensors are gaining market share over their piezoresistive counterparts 
since they consume less power, are usually less temperature sensitive and have a lower 
fundamental noise floor. This model performs an analysis of a hypothetical sensor design 
discussed in Ref. 1, using the electromechanics interface. The effect of a rather poor choice 
of packaging solution on the performance of the sensor is also considered. The results 
emphasize the importance of considering packaging in the MEMS design process.

Model Definition

The model geometry is shown in Figure 1. The pressure sensor is part of a silicon die that 
has been bonded to a metal plate at 70 °C. Since the geometry is symmetric, only a single 
quadrant of the geometry needs to be included in the model, and it is possible to use 
symmetry boundary condition. 

Figure 1: The model geometry. Left: The symmetric device geometry, with one quadrant 
highlighted in blue, showing the symmetry planes. Right: In COMSOL only the highlighted 
quadrant is modeled, and the symmetry boundary condition is used on the cross section walls.

A detailed 2D section through the functional part of the device is shown in Figure 2. A 
thin membrane is held at a fixed potential of 1 V. The membrane is separated from a 
ground plane chamber sealed under high vacuum. The sides of the chamber are insulating 
to prevent a connection between the membrane and the ground plane (for simplicity the 
insulating layer is not modeled explicitly in the COMSOL model—this approximation has 
little effect on the results of the study.).
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Figure 2: Cross section through the device showing the capacitor. The vertical axis has been 
expanded to emphasize the gap.

When the pressure outside of the sealed chamber changes, the pressure difference causes 
the membrane to deflect. The thickness of the air gap now varies across the membrane and 
its capacitance to ground therefore changes. This capacitance is then monitored by an 
interfacing circuit, such as the switched capacitor amplifier circuit discussed in Ref. 1.

Thermal stresses are introduced into the structure as a result of the thermal conductivity 
mismatch between the silicon die and the metal plate, and the elevated temperature used 
for the bonding process. These stresses change the deformation of the diaphragm in 
response to applied pressures and alter the response of the sensor. In addition, because the 
stresses are temperature dependent, they introduce an undesired temperature dependence 
to the device output.

Initially the sensor is analyzed in the case where there are no packaging stresses. Then the 
effect of the packaging stress is considered. First, the device response at fixed temperature 
is evaluated with the additional packaging stress. Finally the temperature dependence of 
the device response at a fixed applied pressure is assessed.

Results and Discussion

Figure 3 shows the deformation of the membrane when a pressure of 25 kPa is applied to 
it, in the absence of packaging stresses. Figure 4 shows the potential on a plane located 
between the plates. The deformation of the membrane is of the form expected, and results 
in a nonuniform potential between the plates.

Membrane biased 
with IV potential

Sealed 
chamber

Grounded part 
of the die

Insulator
3 |  C A P A C I T I V E  P R E S S U R E  S E N S O R



Figure 3: Quadrant deflection when the pressure difference across the membrane is 25 kPa. As 
expected the deflection is greatest in the center of the membrane

Figure 4: Electric potential in the air chamber, plotted on a slice between the two plates of the 
capacitor. The potential has become nonuniform as a result of the pressure-induced 
deformation of the diaphragm.
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Figure 5: Maximum and mean displacement of the membrane as a function of the applied 
pressure.

Figure 6: Capacitance of the membrane as a function of applied pressure, both with and 
without the packaging stresses. The linearized zero pressure capacitance variation, taken from 
Ref. 1, is also shown for comparison.
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Figure 5 shows the mean and maximum displacements of the membrane as a function of 
applied pressure. At an applied pressure of 10 kPa the diaphragm displacement in the 
center is 0.89 μm. The average displacement of the diaphragm is 0.27 μm. These values 
are in good agreement with the approximate model given in Ref. 1 (maximum 
displacement 0.93 μm, average displacement 0.27 μm).

Figure 6 shows that the capacitance of the device increases nonlinearly with applied 
pressure. The gradient of the curve plotted is a measure of the sensitivity of the sensor. At 
zero applied pressure the sensitivity of the model (1/4 of the whole sensor) is 7.3×10-6 
pF/Pa (compare to the value of 6.5×10-6 pF/Pa given in Ref. 1). The device sensitivity is 
therefore 29×10-6 pF/Pa (compare to 26×10-6 pF/Pa. calculated in Ref. 1). Assuming 
the interfacing electronics use the switched capacitor amplifier circuit presented in Ref. 1 
this corresponds to a sensor transfer function of 29 μV/Pa (compared to 26 μV/Pa from 
Ref. 1). Using a smaller pressure step to produce the plot improves the agreement leading 
to a response at the origin of 6.7×10-6 pF/Pa (27×10-6 pF/Pa for the device, 
corresponding to 27 μV/Pa). The response is nonlinear, so that at 20 kPa the model 
output is 14.3×10-6 pF/Pa (device output 57 pF/Pa or 57 μV/Pa)). This nonlinear 
response adds to the complexity of designing the interfacing circuitry. Note that, for 
comparison with these figures, the circuitry proposed in Ref. 1, has a noise floor 
corresponding to a capacitance of 17×10-6 pF, or 0.6 Pa at zero applied pressure 
(assuming an average of 100 consecutive measurements). This resolution is approximately 
four times the fundamental sensitivity of the device imposed by mechanical noise from 
thermal fluctuations.

Next the response of the device is considered when packaging stresses are present in the 
model. For this part of the discussion it is assumed that the device is operated at 20°C and 
that the system was stress and displacement free at the bonding temperature (70°C). 
Figure 7 shows the displacement of the structure at the room temperature operating 
point, with an applied pressure of 25 kPa. The membrane displacement at its center is 
shown in Figure 5. The complex interaction between the thermal stresses and the stresses 
introduced as a result of the applied pressure has resulted in both an initial offset 
displacement and an increased dependence of the displacement on the pressure.
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Figure 7: The displacement of the structure due to an applied pressure of 25 kPa when 
packaging stresses are also included in the model. Displacements are shown at the operating 
temperature of 20 °C, and are assumed to be zero at the die bonding temperature of 70 °C.

Figure 8: Temperature dependence of the capacitance of the packaged device. The capacitance 
varies with temperature as a result of temperature induced changes in the packaging stress 
within the diaphragm.
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The response of the device with the additional packaging stresses is shown in Figure 6. At 
zero applied pressure the sensitivity of the COMSOL model has increased from 6.5×10-

6 pF/Pa to 10×10-6 pF/Pa (40×10-6 pF/Pa for the entire device). The effect is even 
more pronounced at a pressure of 20 kPa, where the model that includes thermal stresses 
shows a pressure sensitivity of 25×10-6 pF/Pa (100 pF/Pa for the entire device) compared 
to the unstressed value of 14.3×10-6 pF/Pa. The sensitivity of the device to pressure has 
almost doubled. While this effect might seem desirable, an unwanted dependence on 
temperature has been introduced into the device response. Since the thermal stresses are 
temperature dependent, the response of the device is also now temperature dependent. 
The final study in the model assesses this issue.

Figure 8 shows the capacitance of the device, with an applied pressure of 20 kPa, as the 
temperature is varied. The temperature sensitivity of the model response is given by the 
gradient of this curve, approximately 3.5×10-3 pF/K (14×10-3 pF/K for the whole 
device). With a pressure sensitivity of 25×10-6 pF/Pa at 20 kPa (for a single quadrant of 
the device) this corresponds to an equivalent pressure of 140 Pa/K in the sensor output. 
Compared to the unstressed performance of the sensor (0.6 Pa with the circuit proposed 
in Ref. 1) this number is very large. The model shows the importance of carefully 
considering the packaging in the MEMS design process.

Reference

1. V. Kaajakari, Practical MEMS, Small Gear Publishing, Las Vegas, 2009.

Application Library path: MEMS_Module/Sensors/capacitive_pressure_sensor

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Electromechanics (emi).

3 Click Add.
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4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

For convenience, the device geometry is inserted from an existing file. You can read the 
instructions for creating the geometry in the .

G E O M E T R Y  1

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
capacitive_pressure_sensor_geom_sequence.mph.

3 On the Geometry toolbar, click Build All.

Add parameters to the model. These will be used subsequently to perform parametric 
studies.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

SI units or their multiples, such as Pa and kPa, as well as non-SI units, such as degrees 
Celsius can be entered in the COMSOL Desktop enclosed by square brackets.

Next, add a component coupling operator to compute a derived global quantity from 
the model. These operators can be convenient for results processing and COMSOL’s 
solvers can also use them during the solution process, for example to include integral 
quantities in the equation system. Here, an Average operator is added so that the average 
displacement of the diaphragm can be computed and a point integration is used to make 
available the displacement of the center point of the diaphragm.

D E F I N I T I O N S

Average 1 (aveop1)
1 On the Definitions toolbar, click Component Couplings and choose Average.

2 In the Settings window for Average, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundary 12 only.

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.

4 Select Point 4 only.

Next, define selections to simplify the set up of materials and physics.

Box 1
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x maximum text field, type 1e-6.

Name Expression Value Description

p0 20[kPa] 2E4 Pa Pressure

T0 20[degC] 293.2 K Operating temperature

Tref 70[degC] 343.2 K Die Bonding temperature
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5 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

6 Right-click Box 1 and choose Rename.

7 In the Rename Box dialog box, type YZ Symmetry Plane in the New label text field.

8 Click OK.

Box 2
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Box Limits section. In the y maximum text field, type 1e-6.

5 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

6 Right-click Box 2 and choose Rename.

7 In the Rename Box dialog box, type XZ Symmetry Plane in the New label text field.

8 Click OK.

Box 3
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Box Limits section.

3 In the z maximum text field, type -100[um].

4 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

5 Right-click Box 3 and choose Rename.

6 In the Rename Box dialog box, type Steel Base in the New label text field.

7 Click OK.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 Select Domain 3 only.

3 Right-click Explicit 1 and choose Rename.

4 In the Rename Explicit dialog box, type Cavity in the New label text field.

5 Click OK.

Explicit 2
1 On the Definitions toolbar, click Explicit.
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2 In the Settings window for Explicit, locate the Input Entities section.

3 Select the All domains check box.

4 Right-click Explicit 2 and choose Rename.

5 In the Rename Explicit dialog box, type All domains in the New label text field.

6 Click OK.

Difference 1
1 On the Definitions toolbar, click Difference.

2 In the Settings window for Difference, locate the Input Entities section.

3 Under Selections to add, click Add.

4 In the Add dialog box, select All domains in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog box, select Cavity in the Selections to subtract list.

9 Click OK.

10 Right-click Difference 1 and choose Rename.

11 In the Rename Difference dialog box, type Linear Elastic in the New label text field.

12 Click OK.

Next, add the physics settings to the model. These include the pressure forces acting on 
the sensor, the applied sense voltage, and other appropriate boundary conditions.

E L E C T R O M E C H A N I C S  ( E M I )

In the Electromechanics interface, use a Linear Elastic Material node to solve the equations 
of structural mechanics only. The electric field does not penetrate these regions.

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromechanics (emi) and choose Linear Elastic Material.

2 In the Settings window for Linear Elastic Material, locate the Domain Selection section.

3 From the Selection list, choose Linear Elastic.

Apply the structural symmetry boundary condition on the symmetry boundaries.
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Symmetry 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Structural>Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose XZ Symmetry Plane.

Symmetry 2
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose YZ Symmetry Plane.

Note that the electrical symmetry boundary condition (the Zero Charge feature) is 
applied by default.

The motion of the structure is constrained in most directions by the structural 
symmetry boundary conditions. However, the whole device can still slide up and down 
the z-axis. Apply a point constraint to prevent this.

Prescribed Displacement 2
1 Right-click Electromechanics (emi) and choose Points>Prescribed Displacement.

2 Select Point 44 only.

3 In the Settings window for Prescribed Displacement, locate the Prescribed Displacement 
section.

4 Select the Prescribed in z direction check box.

Apply a Boundary Load to represent the pressure acting on the surface of the diaphragm.

Boundary Load 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Boundary Load.

2 Select Boundary 13 only.

3 In the Settings window for Boundary Load, locate the Force section.

4 From the Load type list, choose Pressure.

5 In the p text field, type p0.

Moving mesh boundary conditions must be applied on boundaries where the air 
domain deforms and where the default Electromechanical Interface boundary condition 
does not apply. The Electromechanical Interface boundary condition automatically 
obtains its selection from the interface between structural and deforming air domains. 
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It applies the appropriate electrical forces to the structural layer and constrains the 
deformation of the air domain to be equal to that of the structure.

Prescribed Mesh Displacement 1
1 In the Model Builder window, under Component 1 (comp1)>Electromechanics (emi) click 

Prescribed Mesh Displacement 1.

2 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

3 Clear the Prescribed z displacement check box.

Doing this allows the membrane (and the mesh) to move in the z-direction.

Add Terminal and Ground features to the model to apply boundary conditions for the 
electrostatics parts of the problem.

Terminal 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Electrical>Terminal.

2 Select Boundary 12 only.

3 In the Settings window for Terminal, locate the Terminal section.

4 From the Terminal type list, choose Voltage.

The default value of 1 V is fine in this instance.

Ground 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Ground.

2 Select Boundary 9 only.

The pressure sensor consists of a silicon die with an enclosed cavity held at a low 
pressure. The pressure sensor is bonded onto a cylindrical steel plate during the 
packaging process. COMSOL includes a Material Library with many predefined material 
properties. This model uses a predefined material for the steel plate, but sets up the 
silicon as a user-defined material with isotropic material parameters to allow comparison 
with . The cavity also needs ‘material’ properties (to define the relative permittivity) and 
a user defined material is used to set the relative permittivity to 1 in this region.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.
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2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

4 Right-click Component 1 (comp1)>Materials>Material 1 (mat1) and choose Rename.

5 In the Rename Material dialog box, type Silicon in the New label text field.

6 Click OK.

By default, the silicon is in all domains. Some of these selections will be overridden as 
other materials are added.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Cavity.

4 Locate the Material Contents section. In the table, enter the following settings:

5 Click to expand the Material properties section. Locate the Material Properties section. 
From the Material type list, choose Nonsolid.

6 Right-click Component 1 (comp1)>Materials>Material 2 (mat2) and choose Rename.

7 In the Rename Material dialog box, type Vacuum in the New label text field.

8 Click OK.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Steel AISI 4340.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 11.7 1 Basic

Young’s modulus E 170[GPa] Pa Basic

Poisson’s ratio nu 0.06 1 Basic

Density rho 2330 kg/m³ Basic

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic
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4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Steel AISI 4340 (mat3)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Steel AISI 4340 (mat3).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Steel Base.

Next set up a structured mesh to solve the problem on.

M E S H  1

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Edit Physics-Induced Sequence.

Size
Disable the default free tetrahedral mesh.

Free Tetrahedral 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 right-click 

Free Tetrahedral 1 and choose Disable.

Set a maximum element size on the sensor diaphragm.

Size 1
1 Right-click Mesh 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. Select the Maximum element size check box.

5 In the associated text field, type 50[um].

6 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.

7 Select Boundary 3 only.

Create a mapped mesh on the lower surface of the device.

Mapped 1
1 Right-click Mesh 1 and choose More Operations>Mapped.

2 Select Boundaries 3, 16, and 32 only.
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3 In the Settings window for Mapped, click Build All.

Sweep the surface mesh through the structure.

Swept 1
1 Right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, click Build All.

Set up a study that sweeps over a range of applied pressures, so that the response of the 
sensor can be assessed.

S T U D Y  1

Step 1: Stationary
1 In the Model Builder window, expand the Study 1 node, then click Step 1: Stationary.

2 In the Settings window for Stationary, click to expand the Study extensions section.

3 Locate the Study Extensions section. Select the Auxiliary sweep check box.

4 Click Add.

The continuation parameter p0 (Pressure) is added by default. This is the correct 
parameter to sweep over.

5 Click Range.

6 In the Range dialog box, type 0 in the Start text field.
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7 In the Step text field, type 5000.

8 In the Stop text field, type 25000.

9 Click Add.

10 On the Home toolbar, click Compute.

R E S U L T S

Displacement (emi)
Much of the structure is not displaced in this initial study. To facilitate results analysis, add 
a selection to the solution. This will ensure that only the domains of interest are displayed 
in the plots.

Study 1/Solution 1 (sol1)
In the Model Builder window, expand the Results>Data Sets node, then click Study 1/

Solution 1 (sol1).

Selection
1 On the Results toolbar, click Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 3 and 4 only.
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Displacement (emi)
1 Click the Zoom Extents button on the Graphics toolbar.

The plot now shows the displacement of the diaphragm only, which, as expected, is 
maximum in the center of the sensor.

Next, plot the electric potential in an xy-orientated plane between the sensor diaphragm 
and the ground plane.

Slice 1
1 In the Model Builder window, expand the Potential (emi) node, then click Slice 1.

2 In the Settings window for Slice, locate the Plane Data section.

3 From the Plane list, choose xy-planes.

4 In the Planes text field, type 1.

5 Select the Interactive check box.

6 In the Shift text field, type -5.8E-6.
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7 On the Potential (emi) toolbar, click Plot.

Due to the deformation of the diaphragm the potential is non-uniformly distributed in 
the plane.

Next, plot the deformation of the diaphragm as a function of the pressure differential 
across it. Include both average and maximum displacements.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 3 and choose Global.

Use the point integration and surface average operators defined earlier to evaluate the 
displacement at the mid-point of the membrane and the average displacement.

3 In the Settings window for Global, locate the y-Axis Data section.

4 In the table, enter the following settings:

1D Plot Group 3
1 In the Model Builder window, under Results click 1D Plot Group 3.

Expression Unit Description

intop1(w) um Maximum Displacement

aveop1(w) um Average Displacement
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2 In the Settings window for 1D Plot Group, click to expand the Title section.

3 From the Title type list, choose Manual.

4 In the Title text area, type Diaphragm displacement.

5 Locate the Plot Settings section. Select the x-axis label check box.

6 In the associated text field, type Pressure (Pa).

7 Select the y-axis label check box.

8 In the associated text field, type Displacement (\mu m).

9 Click to expand the Legend section. From the Position list, choose Lower left.

10 Right-click Results>1D Plot Group 3 and choose Rename.

11 In the Rename 1D Plot Group dialog box, type Diaphragm Displacement vs 
Pressure in the New label text field.

12 Click OK.

13 On the Diaphragm Displacement vs Pressure toolbar, click Plot.

At an applied pressure of 10 kPa the diaphragm displacement in the centre is 0.89 um. 
The average displacement of the diaphragm is 0.27 υm. These values are in good 
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agreement with the approximate model given in  (maximum displacement 0.93 υm, 
average displacement 0.27 υm).

Now plot the sensor capacitance as a function of the applied pressure. If the switched 
capacitor amplifier described in  is used to produce the output, the sensor output or 
transfer function is directly proportional to the change in capacitance.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 4 and choose Global.

Since the Terminal boundary condition was used for the underside of the diaphragm, 
COMSOL automatically computes its capacitance with respect to ground. The value of 
the capacitance is available as a variable in results analysis.

3 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Electromechanics>

Terminals>emi.C11 - Maxwell capacitance.

Next, compare the computed capacitance with the small-displacement, linearized 
analytic expression derived in .

4 Locate the y-Axis Data section. In the table, enter the following settings:

1D Plot Group 4
1 In the Model Builder window, under Results click 1D Plot Group 4.

2 In the Settings window for 1D Plot Group, locate the Title section.

3 From the Title type list, choose Manual.

4 In the Title text area, type Model Capacitance vs Pressure.

5 Locate the Plot Settings section. Select the x-axis label check box.

6 In the associated text field, type Pressure (Pa).

7 Select the y-axis label check box.

8 In the associated text field, type Capacitance (pF).

9 Locate the Legend section. From the Position list, choose Upper left.

10 Right-click Results>1D Plot Group 4 and choose Rename.

Expression Unit Description

emi.C11 pF Capacitance

0.738[pF]*(1+8.87e-6[1/Pa]*p0) pF Linearized Analytic 
Capacitance
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11 In the Rename 1D Plot Group dialog box, type Model Capacitance vs Pressure in 
the New label text field.

12 Click OK.

13 On the Model Capacitance vs Pressure toolbar, click Plot.

The capacitance of the sensor increases with applied pressure. The gradient of the curve 
plotted gives a useful measure of the response of the device. At the origin, the response 
of the model (1/4 of the whole sensor) is 7e-6 pF/Pa, compared to the analytical 
response of 6.5e-6 pf/Pa. The response for the whole sensor is 29e-6 pF/Pa compared 
to the analytic value of 26e-6 pF/Pa. With the measurement circuit proposed in  this 
corresponds to a sensor transfer function of 29 υV/Pa for the COMSOL model and 26 
υV/Pa for the simple analytic model. The response is nonlinear, so that at 20 kPa the 
model output is 14e-6 pf/Pa (device output 57 pF/Pa).

Next, add thermal expansion to the model to assess the effects of packaging stresses on 
the device performance.
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E L E C T R O M E C H A N I C S  ( E M I )

Thermal Expansion 1
1 In the Model Builder window, under Component 1 (comp1)>Electromechanics (emi) right-

click Linear Elastic Material 1 and choose Thermal Expansion.

The model temperature should be set to the previously defined room temperature 
parameter, T0.

2 In the Settings window for Thermal Expansion, locate the Model Inputs section.

3 In the T text field, type T0.

The reference temperature indicates the temperature at which the structure had no 
thermal strains. In this case, set it to the previously defined parameter, Tref, which 
represents the temperature at which the silicon die was bonded to the metal carrier 
plate.

4 Locate the Thermal Expansion Properties section. In the Tref text field, type Tref.

The user defined properties you added previously for silicon did not include its thermal 
expansivity, so this must be added.

M A T E R I A L S

Silicon (mat1)
COMSOL shows a warning in the material properties settings to indicate a missing 
property.

1 In the Model Builder window, under Component 1 (comp1)>Materials click Silicon (mat1).

2 In the table, add a value for the thermal expansivity of silicon to the appropriate row:

Add a new study to compute the system response including thermal expansivity effects.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Stationary
1 In the Model Builder window, under Study 2 click Step 1: Stationary.
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2 In the Settings window for Stationary, locate the Study Extensions section.

3 Select the Auxiliary sweep check box.

4 Click Add.

The continuation parameter p0 (Differential Pressure) is added by default. This 
is the correct parameter to sweep over.

5 Click Range.

6 In the Range dialog box, type 0 in the Start text field.

7 In the Step text field, type 5000.

8 In the Stop text field, type 25000.

9 Click Add.

10 On the Home toolbar, click Compute.

R E S U L T S

Displacement (emi) 1
Create a mirrored dataset to visualize a cross section of the device.

Mirror 3D 1
1 On the Results toolbar, click More Data Sets and choose Mirror 3D.

2 In the Settings window for Mirror 3D, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Displacement (emi) 1
1 In the Model Builder window, under Results click Displacement (emi) 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Mirror 3D 1.
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4 On the Displacement (emi) 1 toolbar, click Plot.

Notice that the entire structure is now displaced at room temperature as a result of 
thermal expansion.

Now look at the effect of the thermal stress on the response of the sensor.

Add an additional Global node to the previously defined plot. This separate node can 
point to a different data set, enabling a plot of the displacement of the thermally stressed 
device alongside the unstressed plot.

Global 2
1 In the Model Builder window, under Results>Diaphragm Displacement vs Pressure right-

click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Note that the aveop1(w) expression has been removed from the table.
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4 On the Diaphragm Displacement vs Pressure toolbar, click Plot.

The maximum displacement of the membrane is now non-zero at zero applied pressure, 
as a result of the packaging stress. The gradient of the displacement-pressure line has 
also changed.

Model Capacitance vs Pressure
Now add the thermally stressed results to the Capacitance vs Pressure plot.

Global 2
1 In the Model Builder window, under Results right-click Model Capacitance vs Pressure and 

choose Global.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

4 Click Replace Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromechanics>Terminals>emi.C11 - Maxwell capacitance.

5 Locate the y-Axis Data section. In the table, enter the following settings:

Expression Unit Description

emi.C11 pF Capacitance with Package Stress
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6 On the Model Capacitance vs Pressure toolbar, click Plot.

The packaging stress causes a significant change in the response of the device. At zero 
applied pressure the sensitivity of the COMSOL model has increased to 10e-6 pF/Pa 
(40e-6 pF/Pa for the entire device). Compare to the unstressed value of 6.5e-6 pf/Pa 
(29e-6 pF/Pa for the entire device). The effect is even more pronounced at a pressure 
of 20 kPa, where the model that includes thermal stresses shows a pressure sensitivity of 
25e-6 pf/Pa (100 pF/Pa for the entire device), compared to the unstressed pressure 
sensitivity of 14.3e-6 pf/Pa (sensor output 57 pF/Pa).

It may be possible to calibrate the device to remove the effect of the packaging strains. 
However, the addition of the thermal stresses to the system has created an additional 
issue, since the response of the sensor has now become temperature dependent - due to 
the temperature sensitivity of the thermal strains. This effect is assessed in the final study.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.
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S T U D Y  3

Step 1: Stationary
1 In the Model Builder window, under Study 3 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Study Extensions section.

3 Select the Auxiliary sweep check box.

Sweep over operating temperature at constant applied pressure, to assess the 
temperature sensitivity of the device.

4 Click Add.

5 In the table, enter the following settings:

6 Click Range.

7 In the Range dialog box, type 290 in the Start text field.

8 In the Step text field, type 5.

9 In the Stop text field, type 300.

10 Click Add.

For this study disable the default plots, as these will be very similar to those already 
generated by Study 2.

11 In the Model Builder window, click Study 3.

12 In the Settings window for Study, locate the Study Settings section.

13 Clear the Generate default plots check box.

14 On the Home toolbar, click Compute.

Add a plot to show how the sensor response varies with temperature. The response is 
computed at an applied pressure set by the value of the parameter p0, defined as 20 kPa.

R E S U L T S

1D Plot Group 7
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 3/Solution 3 (sol3).

Parameter name Parameter value list Parameter unit

T0
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Global 1
1 Right-click 1D Plot Group 7 and choose Global.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Electromechanics>

Terminals>emi.C11 - Maxwell capacitance.

3 Locate the y-Axis Data section. In the table, enter the following settings:

1D Plot Group 7
1 In the Model Builder window, under Results click 1D Plot Group 7.

2 In the Settings window for 1D Plot Group, locate the Title section.

3 From the Title type list, choose Manual.

4 In the Title text area, type Model Capacitance vs Operating Temperature.

5 Locate the Plot Settings section. Select the x-axis label check box.

6 In the associated text field, type Operating Temperature (K).

7 Right-click Results>1D Plot Group 7 and choose Rename.

8 In the Rename 1D Plot Group dialog box, type Capacitance vs Operating 
Temperature in the New label text field.

9 Click OK.

Expression Unit Description

emi.C11 pF Capacitance
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10 On the Capacitance vs Operating Temperature toolbar, click Plot.

At a pressure of 20 kPa the temperature sensitivity of the model is given by the gradient 
of this curve, approximately 3.5e-3 pF/K (14e-4 pF/K for the whole device). Given the 
pressure sensitivity of 25e-6 pF/Pa at 20 kPa this corresponds to equivalent pressure of 
140 Pa/K in the sensor output. Compared to the noise floor of the measuring circuit 
proposed in  (0.6Pa) this number is very large. This model shows that a naive choice of 
packaging can have a highly detrimental effect on sensor performance.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Blank Model.

R O O T

On the Home toolbar, click Component and choose Add Component>3D.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.
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2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 1.2.

4 In the Depth text field, type 1.2.

5 In the Height text field, type 1.51.

6 Locate the Position section. In the z text field, type -1.1.

7 Click to expand the Layers section. In the table, enter the following settings:

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 0.5.

4 In the Depth text field, type 0.5.

5 In the Height text field, type 1.51.

6 Locate the Position section. In the z text field, type -1.1.

Partition Domains 1 (pard1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Partition Domains.

2 On the object blk1, select Domains 1–4 only.

3 In the Settings window for Partition Domains, locate the Partition Domains section.

4 From the Partition with list, choose Objects.

5 Select the object blk2 only.

Hexahedron 1 (hex1)
1 On the Geometry toolbar, click More Primitives and choose Hexahedron.

2 In the Settings window for Hexahedron, locate the Vertices section.

Layer name Thickness (mm)

Layer 1 0.7

Layer 2 0.397

Layer 3 0.003

Layer 4 0.01
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3 In row 2, set x to 0.5.

4 In row 3, set x to 0.5.

5 In row 4, set x to 0.

6 In row 6, set x to 0.78322.

7 In row 7, set x to 0.78322.

8 In row 8, set x to 0.

9 In row 2, set y to 0.

10 In row 3, set y to 0.5.

11 In row 4, set y to 0.5.

12 In row 6, set y to 0.

13 In row 7, set y to 0.78322.

14 In row 8, set y to 0.78322.

15 In row 1, set z to 0.01.

16 In row 2, set z to 0.01.

17 In row 3, set z to 0.01.

18 In row 4, set z to 0.01.

19 In row 5, set z to 0.41.

20 In row 6, set z to 0.41.

21 In row 7, set z to 0.41.

22 In row 8, set z to 0.41.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the object pard1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object hex1 only.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 3.

4 In the Height text field, type 0.7.
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5 Locate the Position section. In the z text field, type -1.1.

Partition Domains 2 (pard2)
1 On the Geometry toolbar, click Booleans and Partitions and choose Partition Domains.

2 On the object cyl1, select Domain 1 only.

3 In the Settings window for Partition Domains, locate the Partition Domains section.

4 From the Partition with list, choose Extended faces.

5 On the object dif1, select Boundaries 17 and 38 only.

6 In the tree, select dif1.

7 Click Build Selected.

8 On the Geometry toolbar, click Delete.

Delete Entities 1 (del1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Delete Entities 1 (del1).

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Domain.

4 On the object pard2, select Domains 1–3 only.

5 On the object blk2, select Domain 1 only.

Form Union (fin)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Form Union (fin).

2 In the Settings window for Form Union/Assembly, click Build Selected.

Explicit Selection 1 (sel1)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type YZ Symmetry Plane in the Label text 
field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 Select the Group by continuous tangent check box.

5 On the object fin, select Boundaries 1, 4, 7, 10, 14, 17, 20, 23, 26, and 30 only.

Explicit Selection 2 (sel2)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.
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2 In the Settings window for Explicit Selection, type XZ Symmetry Plane in the Label text 
field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 Select the Group by continuous tangent check box.

5 On the object fin, select Boundaries 2, 5, 8, 11, 40, 42, 44, 46, 48, and 50 only.

Box Selection 1 (boxsel1)
1 On the Geometry toolbar, click Selections and choose Box Selection.

2 In the Settings window for Box Selection, type Steel Base in the Label text field.

3 Locate the Box Limits section. In the z maximum text field, type -0.1.

4 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Explicit Selection 3 (sel3)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Cavity in the Label text field.

3 On the object fin, select Domain 3 only.

Explicit Selection 4 (sel4)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Geometry in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose Object.

4 Select the object fin only.

Difference Selection 1 (difsel1)
1 On the Geometry toolbar, click Selections and choose Difference Selection.

2 In the Settings window for Difference Selection, type Linear Elastic in the Label text 
field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog box, select Geometry in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference Selection, locate the Input Entities section.

7 Click Add.

8 In the Add dialog box, select Cavity in the Selections to subtract list.

9 Click OK.
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Introduction

This example shows how to set up a piezoelectric transducer model following the work of 
Y. Kagawa and T. Yamabuchi (Ref. 1). The composite piezoelectric ultrasonic transducer 
has a cylindrical geometry that consists of a piezoceramic (NEPEC 6) layer, two aluminum 
layers, and two adhesive layers. The layers are organized as follows: aluminum layer–
adhesive layer–piezoceramic layer–adhesive layer–aluminum layer.

The system applies an AC potential on the electrode surfaces of both sides of the 
piezoceramic layer. The potential in this example has a peak value of 1 V in the frequency 
range 20 kHz to 106 kHz. The goal is to compute the susceptance (the imaginary part of 
the admittance) Y = I/V, where I is the total current and V is the potential, for a frequency 
range around the four lowest eigenfrequencies of the structure.

The first step finds the eigenmodes, and the second step runs a frequency sweep across an 
interval that encompasses the first four eigenfrequencies. Both analyses are fully coupled, 
and COMSOL Multiphysics assembles and solves both the electric and mechanical parts 
of the problem simultaneously.

Although you could analyze this problem using a 2D axisymmetric model, in order to 
illustrate the modeling principles for more complicated problems, this example uses a 3D 
geometry.

When creating the model geometry, you make use of the symmetry by first making a cut 
along a midplane perpendicular to the central axis and then by cutting out a 10-degree 
wedge; doing so reduces memory requirements significantly.

Model Data

The model uses the following material data.
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N E P E C  6  M A T E R I A L  P A R A M E T E R S     

A L U M I N U M  M A T E R I A L  P A R A M E T E R S  

A D H E S I V E  M A T E R I A L  P A R A M E T E R S

Results and Discussion

Figure 1 shows the lowest vibration mode of the piezoelectric transducer, while Figure 2 
shows the transducer’s input susceptance as a function of the excitation frequency.

TABLE 1:  ELASTICITY MATRIX cE

128 GPa 68 GPa 66 GPa 0 0 0

128 GPa 66 GPa 0 0 0

110 GPa 0 0 0

21 GPa 0 0

21 GPa 0

21 GPa

TABLE 2:  COUPLING MATRIX e

0 0 0 0 0 0

0 0 0 0 0 0

-6.1 -6.1 15.7 0 0 0

TABLE 3:  RELATIVE PERMITTIVITY εrS

993.53 0 0

993.53 0

993.53

PARAMETER EXPRESSION/VALUE DESCRIPTION

E 70.3 GPa Young’s modulus

nu 0.345 Poisson’s ratio

rho 2690 Density

PARAMETER EXPRESSION/VALUE DESCRIPTION

E 10 GPa Young’s modulus

nu 0.38 Poisson’s ratio

rho 1700 Density
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Figure 1: The lowest vibration eigenmode of the transducer.

Figure 2: Input susceptance as a function of excitation frequency.
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The result is in agreement with the work in Ref. 1. A small discrepancy close to the 
eigenfrequencies appears because the simulation uses no damping.

Reference

1. Y. Kagawa and T. Yamabuchi, “Finite Element Simulation of a Composite Piezoelectric 
Ultrasonic Transducer,” IEEE Transactions on Sonics and Ultrasonics, vol. SU-26, 
no. 2, pp. 81–88, 1979.

Application Library path: MEMS_Module/Piezoelectric_Devices/
composite_transducer

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>

Eigenfrequency.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Plane Geometry
1 On the Geometry toolbar, click Work Plane.
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2 In the Model Builder window, under Component 1 (comp1)>Geometry 1>

Work Plane 1 (wp1) click Plane Geometry.

Circle 1 (c1)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 27.5.

4 In the Sector angle text field, type 10.

5 Right-click Circle 1 (c1) and choose Build Selected.

6 Click the Zoom Extents button on the Graphics toolbar.

7 In the Model Builder window, click Geometry 1.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

Distances (mm)

5

5.275

15.275
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4 Click Build All Objects.

5 Click Go to Default View.

This completes the geometry modeling stage.

Before defining material properties, select the domains where each physics applies. 
Proceeding in this order enables to preselect required material properties during their 
definition.

S O L I D  M E C H A N I C S  ( S O L I D )

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.

2 In the Settings window for Piezoelectric Material, locate the Domain Selection section.

3 Click Clear Selection.

4 Select Domain 1 only.

E L E C T R O S T A T I C S  ( E S )

On the Physics toolbar, click Solid Mechanics (solid) and choose Electrostatics (es).

1 In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

2 In the Settings window for Electrostatics, locate the Domain Selection section.

3 Click Clear Selection.
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4 Select Domain 1 only.

Now materials can be defined.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Nepec 6 in the Label text field.

3 Locate the Geometric Entity Selection section. Click Clear Selection.

4 Select Domain 1 only.

5 Locate the Material Contents section. In the table, enter the following settings:

Alternatively, to define the symmetric elasticity matrix, cE, and the full coupling matrix, 
eES, you can click the Edit button below the Output properties table under 
Component1>Materials>Nepec 6>Stress-Charge form in the Model builder and 
use the matrix input dialogs to enter the data as given in section .

Property Name Value Unit Property 
group

Elasticity matrix 
(Ordering: xx, yy, 
zz, yz, xz, xy)

{cE11, cE12, cE22, cE13, 
cE23, cE33, cE14, cE24, 
cE34, cE44, cE15, cE25, 
cE35, cE45, cE55, cE16, 
cE26, cE36, cE46, cE56, 
cE66} ; cEij = cEji

{128[GPa], 
68[GPa], 
128[GPa], 
66[GPa], 
66[GPa], 
110[GPa], 
0, 0, 0, 
21[GPa], 0, 
0, 0, 0, 
21[GPa], 0, 
0, 0, 0, 0, 
21[GPa]}

Pa Stress-charge 
form

Coupling matrix {eES11, eES21, eES31, 
eES12, eES22, eES32, 
eES13, eES23, eES33, 
eES14, eES24, eES34, 
eES15, eES25, eES35, 
eES16, eES26, eES36}

{0, 0, -
6.1, 0, 0, 
-6.1, 0, 0, 
15.7, 0, 0, 
0, 0, 0, 0, 
0, 0, 0}

C/m² Stress-charge 
form

Relative 
permittivity

epsilonrS ; epsilonrSii = 
epsilonrS, epsilonrSij = 0

993.53 1 Stress-charge 
form

Density rho 7730 kg/m³ Basic
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Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Adhesive in the Label text field.

3 Select Domain 2 only.

4 Locate the Material Contents section. In the table, enter the following settings:

Material 3 (mat3)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Aluminum in the Label text field.

3 Select Domain 3 only.

4 Locate the Material Contents section. In the table, enter the following settings:

S O L I D  M E C H A N I C S  ( S O L I D )

Now apply the boundary conditions for each physics.

Symmetry 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Solid Mechanics (solid) and choose More Constraints>Symmetry.

2 Select Boundaries 1–5, 7, and 8 only.

Property Name Value Unit Property group

Young’s modulus E 10[GPa] Pa Basic

Poisson’s ratio nu 0.38 1 Basic

Density rho 1700 kg/m³ Basic

Property Name Value Unit Property group

Young’s modulus E 70.3[GPa] Pa Basic

Poisson’s ratio nu 0.345 1 Basic

Density rho 2690 kg/m³ Basic
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3 In the Settings window for Symmetry, click Go to Default View.

E L E C T R O S T A T I C S  ( E S )

Terminal 1
1 In the Model Builder window, under Component 1 (comp1) right-click Electrostatics (es) 

and choose the boundary condition Terminal.

2 Select Boundary 6 only.

3 In the Settings window for Terminal, locate the Terminal section.

4 From the Terminal type list, choose Voltage.

5 In the V0 text field, type 0.5.

This is half of the total peak voltage between the terminals, which accounts for modeling 
only the upper half of the transducer.

Ground 1
1 In the Model Builder window, right-click Electrostatics (es) and choose Ground.

2 Select Boundary 3 only.

D E F I N I T I O N S

Before generating the mesh, define a variable for the susceptance.
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Variables 1
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

In the above expression, the factor 36 compensates for the fact that the total current at 
the Terminal is only computed for a 10 degree wedge of the full transducer. Moreover, 
the factor 1/2 accounts for the fact that only the upper half of the transducer is modeled 
because of symmetry in the z direction and hence only half of the actual voltage is 
applied. Since no damping is modeled, the real part of the admittance es.Y11 will be 
zero. This is why it is suitable to evaluate only the imaginary part of the admittance, i.e. 
the susceptance.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Element size list, choose Finer.

Free Triangular 1
1 Right-click Component 1 (comp1)>Mesh 1 and choose More Operations>Free Triangular.

2 Select Boundary 3 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Free Triangular 1 and choose Distribution.

2 Select Edges 2 and 3 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution properties list, choose Predefined distribution type.

5 In the Number of elements text field, type 20.

6 Click Build Selected.

Swept 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, click Build All.

Name Expression Unit Description

B imag(es.Y11)*36/2 Susceptance
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3 Click the Zoom Extents button on the Graphics toolbar.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Surface 1
1 In the Model Builder window, expand the Mode Shape (solid) node, then click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>w - Displacement field,

Z component.

3 On the Mode Shape (solid) toolbar, click Plot.

Compare the resulting plot to that in .

Multislice 1
In the Model Builder window, expand the Electric Potential (es) node.

Surface 1
1 Right-click Multislice 1 and choose Delete.

2 In the Model Builder window, under Results right-click Electric Potential (es) and choose 
Surface.
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3 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electrostatics>Electric>V -

Electric potential.

4 On the Electric Potential (es) toolbar, click Plot.

Next, add a separate study for the frequency sweep.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Frequency Domain
1 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog box, type 20[kHz] in the Start text field.

5 In the Stop text field, type 106[kHz].

6 In the Step text field, type 2[kHz].

7 Click Replace.

8 On the Home toolbar, click Compute.

R E S U L T S

Multislice 1
In the Model Builder window, expand the Electric Potential (es) 1 node.

Electric Potential (es) 1
1 Right-click Multislice 1 and choose Delete.

2 On the Electric Potential (es) 1 toolbar, click Surface.

Surface 1
1 In the Model Builder window, under Results>Electric Potential (es) 1 click Surface 1.
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2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electrostatics>Electric>V -

Electric potential.

3 On the Electric Potential (es) 1 toolbar, click Plot.

3D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Displacement in the Label text field.

3 Locate the Data section. From the Data set list, choose Study 2/Solution 2 (sol2).

4 From the Parameter value (freq (Hz)) list, choose 1.06E5.

5 On the Displacement toolbar, click Surface.

Surface 1
1 In the Model Builder window, under Results>Displacement click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>w - Displacement field,

Z component.

3 On the Displacement toolbar, click Plot.
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1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Susceptance in the Label text field.

3 Locate the Data section. From the Data set list, choose Study 2/Solution 2 (sol2).

Global 1
1 Right-click Susceptance and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Unit list, choose kHz.

5 On the Susceptance toolbar, click Plot.

Compare the result to that in .

Expression Unit Description

B S Susceptance
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Introduction

The elastic cantilever beam is an elementary structure in MEMS design. This example 
shows the bending of a beam due to electrostatic forces. The model uses the 
electromechanics interface to solve the coupled equations for the structural deformation 
and the electric field. Such structures are frequently tested by means of a low frequency 
capacitance voltage sweep. The model predicts the results of such a test.

Model Definition

Figure 1 shows the model geometry. The beam has the following dimensions:

• Length: 300 μm

• Width: 20 μm

• Thickness 2 μm

Because the geometry is symmetric only half of the beam needs to modeled. The beam is 
made of polysilicon with a Young’s modulus, E, of 153 GPa, and a Poisson’s ratio, ν, of 
0.23. It is fixed at one end but is otherwise free to move. The polysilicon is assumed to be 
heavily doped, so that electric field penetration into the structure can be neglected. The 
beam resides in an air-filled chamber that is electrically insulated. The lower side of the 
chamber has a grounded electrode.

Figure 1: Model Geometry. The beam is 300 μm long and 2 μm thick, and it is fixed at x = 0. 
The model uses symmetry on the zx-plane at y = 0. The lower boundary of the surrounding air 
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domain represents the grounded substrate. The model has 20 μm of free air above and to the 
sides of the beam, while the gap below the beam is 2 μm.

An electrostatic force caused by an applied potential difference between the two electrodes 
bends the beam toward the grounded plane beneath it. To compute the electrostatic force, 
this example calculates the electric field in the surrounding air. The model considers a layer 
of air 20 μm thick both above and to the sides of the beam, and the air gap between the 
bottom of the beam and the grounded layer is initially 2 μm. As the beam bends, the 
geometry of the air gap changes continuously, resulting in a change in the electric field 
between the electrodes. The coupled physics is handled automatically by the 
Electromechanics interface.

The electrostatic field in the air and in the beam is governed by Poisson’s equation:

where derivatives are taken with respect to the spatial coordinates. The numerical model 
represents the electric potential and its derivatives on a mesh which is moving with respect 
to the spatial frame. The necessary transformations are taken care of by the 
Electromechanics interface, which also contains smoothing equations governing the 
movement of the mesh in the air domain.

The cantilever connects to a voltage terminal with a specified bias potential, Vin. The 
bottom of the chamber is grounded, while all other boundaries are electrically insulated. 
The terminal boundary condition automatically computes the capacitance of the system.

The force density that acts on the electrode of the beam results from Maxwell’s stress 
tensor:

where E and D are the electric field and electric displacement vectors, respectively, and n 
is the outward normal vector of the boundary. This force is always oriented along the 
normal of the boundary.

Navier’s equations, which govern the deformation of a solid, are more conveniently 
written in a coordinate system that follows and deforms with the material. In this case, 
these reference or material coordinates are identical to the actual mesh coordinates.

∇ ε V∇( )⋅– 0=

Fes
1
2
--- E D⋅( )n– n E⋅( )D+=
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Results and Discussion

There is positive feedback between the electrostatic forces and the deformation of the 
cantilever beam. The forces bend the beam and thereby reduce the gap to the grounded 
substrate. This action, in turn, increases the forces. At a certain voltage the electrostatic 
forces overcome the stress forces, the system becomes unstable, and the gap collapses. This 
critical voltage is called the pull-in voltage.

At applied voltages lower than the pull-in voltage, the beam stays in an equilibrium 
position where the stress forces balance the electrostatic forces. Figure 2 shows the beam 
displacement and the corresponding displacement of the mesh surrounding it. Figure 3 
shows the electric potential and electric field that generates these displacements. In 
Figure 4 the shape of the cantilever’s deflection is illustrated for each applied voltage, by 
plotting the z-displacement of the underside of the beam at the symmetry boundary. The 
tip deflection as a function of applied voltage is shown in Figure 5. Note that for applied 
voltages higher than the pull-in voltage, the solution does not converge because no stable 
stationary solution exists. This situation occurs if an applied voltage of 6.2 V is tried. The 
pull-in voltage is therefore between 6.1 V and 6.2 V. For comparison, computations in 
Ref. 1 predict a pull-in voltage of 

where c1 = 0.07, c2 = 1.00, and c3 = 0.42; g0 is the initial gap between the beam and the 
ground plane; and 

If the beam has a narrow width (W) relative to its thickness (H) and length (L), Ê is 
Young’s modulus, E. Otherwise, E and Ê, the plate modulus, are related by

where ν is Poisson’s ratio. Because the calculation in Ref. 1 uses a parallel-plate 
approximation for calculating the electrostatic force and because it corrects for fringing 
fields, these results are not directly comparable with those from the simulation. However 
the agreement is still reasonable: setting W = 20 μm results in VPI = 6.07 V.
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Figure 2: z-displacement for the beam and the moving mesh as a function of position. Each 
mesh element is depicted as a separate block in the back half of the geometry.

Figure 3: Electric Potential (color) and Electric Field (arrows) at various cross sections 
through the beam.
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Figure 4: Displacement of the lower surface of the cantilever, plotted along the symmetry 
boundary, for different values of the applied voltage.

Figure 5: Cantilever tip displacements as a function of applied Voltage V0.
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Figure 6: Device capacitance vs applied voltage V0.

Figure 6 shows the DC C-V curve predicted for the cantilever beam. To some extent, this 
is consistent with the behavior of an ideal parallel plate capacitor, whose capacitance 
increases with decreasing distance between the plates. But this effect does not account for 
all the change in capacitance observed. In fact, most of it is due to the gradual softening 
of the coupled electromechanical system. This effect leads to a larger structural response 
for a given voltage increment at higher bias, which in turn means that more charge must 
be added to retain the voltage difference between the electrodes.

Reference

1. R.K. Gupta, Electrostatic Pull-In Structure Design for In-Situ Mechanical Property 
Measurements of Microelectromechanical Systems (MEMS), Ph.D. thesis, MIT, 1997.

Application Library path: MEMS_Module/Actuators/
electrostatically_actuated_cantilever
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Electromechanics (emi).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

G E O M E T R Y  1

Use microns to define the geometry units.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Create the geometry so that a swept mesh can be used subsequently. Three blocks are 
required as to sweep the mesh no change in the Y-Z cross section is allowed.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 320.

4 In the Depth text field, type 10.

5 In the Height text field, type 2.

6 Locate the Position section. In the z text field, type 2.

7 Right-click Block 1 (blk1) and choose Build Selected.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 320.
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4 In the Depth text field, type 40.

5 In the Height text field, type 24.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 300.

4 In the Depth text field, type 40.

5 In the Height text field, type 24.

6 Click Build All Objects.

Add a parameter for the DC voltage applied to the cantilever.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

The cantilever is assumed to be heavily doped so that it acts as a conductor, held at 
constant potential. The Linear Elastic Material feature is therefore used.

E L E C T R O M E C H A N I C S  ( E M I )

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromechanics (emi) and choose Linear Elastic Material.

2 Select Domain 2 only.

Fix one end of the cantilever.

Fixed Constraint 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Structural>Fixed Constraint.

Name Expression Value Description

V0 5[V] 5 V Bias on cantilever
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2 Select Boundary 4 only.

Since only half of the cantilever is included in the model, the symmetry condition 
should be applied on the mid-plane of the solid. The electric field default condition 
(Zero Charge) is equivalent to a symmetry condition, so only the structural symmetry 
boundary condition needs to be applied.

Symmetry 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Symmetry.

2 Select Boundary 5 only.

Use the Terminal feature to set the voltage on the exterior of the cantilever.

Terminal 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Terminal.

2 Select Boundaries 6, 8, 10, and 15 only.

3 In the Settings window for Terminal, locate the Terminal section.

4 From the Terminal type list, choose Voltage.

5 In the V0 text field, type V0.

Set up the ground plane underneath the cantilever.

Ground 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Ground.

2 Select Boundaries 3 and 14 only.

Apply boundary conditions to constrain the mesh deformation.

Prescribed Mesh Displacement 2
1 Right-click Electromechanics (emi) and choose the boundary condition Deformed Mesh>

Prescribed Mesh Displacement.

2 Select Boundaries 2, 7, 13, 16, 18, 23, and 24 only.

3 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

4 Clear the Prescribed z displacement check box.

This way, you allow the mesh nodes to move in the z direction while they are fixed in 
the x and y directions.

Confirm that the default features have acquired the correct selections.
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5 Click the Wireframe Rendering button on the Graphics toolbar.

Prescribed Mesh Displacement 1
The default mesh displacement feature constrains all the remaining boundaries to have 
zero displacement.

Electromechanical Interface 1
The Electromechanical Interface feature applies forces to the exterior boundaries of the 
cantilever.

Zero Charge 1
The Zero Charge feature applies symmetry conditions to the remaining boundaries where 
the electric potential is solved for.

Add Materials to the model.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 Select Domains 1, 3, and 4 only.

Set the material to be non-solid, to ensure the interface solves the electrostatics 
equations in the spatial frame.

3 In the Settings window for Material, click to expand the Material properties section.

4 Locate the Material Properties section. From the Material type list, choose Nonsolid.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 4.5 1 Basic

Young’s modulus E 153[GPa] Pa Basic

Poisson’s ratio nu 0.23 1 Basic

Density rho 2330 kg/m³ Basic
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5 Locate the Material Contents section. In the table, enter the following settings:

Create a swept mesh.

M E S H  1

Mapped 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Mapped.

2 Select Boundary 4 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Distribution.

2 Select Edge 5 only.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extremely fine.

4 Click the Custom button.

5 Locate the Element Size Parameters section. In the Maximum element size text field, type 
4.

Free Quad 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Free Quad.

2 Select Boundary 1 only.

3 In the Settings window for Free Quad, click Build All.

Swept 1
1 Right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 1 and 2 only.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic
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Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Swept 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type 20.

4 Click Build All.

Swept 2
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 3 and 4 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Swept 2 and choose Distribution.

2 In the Settings window for Distribution, click Build All.

Set up a Parametric Sweep over the applied voltage.

S T U D Y  1

Step 1: Stationary
1 In the Settings window for Stationary, click to expand the Study extensions section.

2 Locate the Study Extensions section. Select the Auxiliary sweep check box.

3 Click Add.

4 Click Range.

5 In the Range dialog box, type 1 in the Start text field.

6 In the Step text field, type 1.

7 In the Stop text field, type 6.

8 Click Add.

Add points at 6.05 and 6.1 V to the sweep by adding these points after the range 
statement. The table field should now contain: range(1,1,6) 6.05 6.1.

9 On the Home toolbar, click Compute.

R E S U L T S

Displacement (emi)
Create additional data sets for post processing. First create a mirrored data set.
13 |  E L E C T R O S T A T I C A L L Y  A C T U A T E D  C A N T I L E V E R



Mirror 3D 1
1 On the Results toolbar, click More Data Sets and choose Mirror 3D.

2 In the Settings window for Mirror 3D, locate the Plane Data section.

3 From the Plane list, choose zx-planes.

Then create a data set with some surface selections.

Selection
1 In the Model Builder window, under Results>Data Sets right-click Study 1/

Solution 1 (sol1) and choose Duplicate.

2 On the Results toolbar, click Selection.

3 In the Settings window for Selection, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Boundary.

5 Select Boundaries 3–6, 8, 10, 14, and 15 only.

Finally, mirror this data set.

Mirror 3D 2
1 On the Results toolbar, click More Data Sets and choose Mirror 3D.

2 In the Settings window for Mirror 3D, locate the Data section.

3 From the Data set list, choose Study 1/Solution 1 (2) (sol1).

4 Locate the Plane Data section. From the Plane list, choose zx-planes.

Edit the default displacement plot to show the z-displacement and the corresponding 
mesh deformation.

Displacement (emi)
1 In the Model Builder window, under Results click Displacement (emi).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Mirror 3D 1.

Surface 1
1 In the Model Builder window, expand the Displacement (emi) node, then click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>

Electromechanics (Solid Mechanics)>Displacement>

Displacement field (material and geometry frames)>w - Displacement field, Z component.

3 Locate the Coloring and Style section. Select the Reverse color table check box.
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Volume 1
1 In the Model Builder window, under Results right-click Displacement (emi) and choose 

Volume.

2 In the Settings window for Volume, locate the Data section.

3 From the Data set list, choose Study 1/Solution 1 (1) (sol1).

4 Locate the Expression section. In the Expression text field, type z-Z.

5 Click to expand the Shrink elements section. Locate the Shrink Elements section. In the 
Element scale factor text field, type 0.8.

6 Click to expand the Inherit style section. Locate the Inherit Style section. From the Plot 
list, choose Surface 1.

Slice 1
1 Right-click Displacement (emi) and choose Slice.

2 In the Settings window for Slice, locate the Expression section.

3 In the Expression text field, type z-Z.

4 Click to expand the Inherit style section. Locate the Inherit Style section. From the Plot 
list, choose Surface 1.

5 On the Displacement (emi) toolbar, click Plot.

Edit the default potential plot.

Potential (emi)
1 In the Model Builder window, under Results click Potential (emi).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Mirror 3D 1.

Slice 1
1 In the Model Builder window, expand the Potential (emi) node, then click Slice 1.

2 In the Settings window for Slice, locate the Plane Data section.

3 In the Planes text field, type 7.

Surface 1
1 In the Model Builder window, under Results right-click Potential (emi) and choose 

Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>

Electromechanics (Electrical Quasistatics)>Electric>V - Electric potential.
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3 Locate the Data section. From the Data set list, choose Mirror 3D 2.

4 Click to expand the Inherit style section. Locate the Inherit Style section. From the Plot 
list, choose Slice 1.

Arrow Volume 1
1 Right-click Potential (emi) and choose Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromechanics (Electrical Quasistatics)>Electric>emi.Ex,...,emi.Ez -

Electric field (spatial frame).

3 Locate the Arrow Positioning section. Find the y grid points subsection. In the Points text 
field, type 15.

4 Locate the Coloring and Style section. From the Arrow length list, choose Normalized.

5 On the Potential (emi) toolbar, click Plot.

Add a plot to show the deformed shape of the underside of the cantilever.

Line Graph 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 3 and choose Line Graph.

3 Select Edge 6 only.

4 In the Settings window for Line Graph, click Replace Expression in the upper-right corner 
of the y-axis data section. From the menu, choose Component 1>

Electromechanics (Solid Mechanics)>Displacement>

Displacement field (material and geometry frames)>w - Displacement field, Z component.

5 Click to expand the Legends section. Select the Show legends check box.

1D Plot Group 3
1 In the Model Builder window, under Results click 1D Plot Group 3.

2 In the Settings window for 1D Plot Group, click to expand the Legend section.

3 From the Position list, choose Lower left.

4 Click to expand the Title section. From the Title type list, choose Manual.

5 In the Title text area, type Shape of cantilever displacement for different 
applied voltages.

6 Right-click Results>1D Plot Group 3 and choose Rename.

7 In the Rename 1D Plot Group dialog box, type Displacement vs Applied Voltage in 
the New label text field.
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8 Click OK.

9 On the Displacement vs Applied Voltage toolbar, click Plot.

Add a plot of tip displacement vs applied DC voltage.

Point Graph 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 4 and choose Point Graph.

3 Select Point 10 only.

4 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-axis data section. From the menu, choose Component 1>

Electromechanics (Solid Mechanics)>Displacement>

Displacement field (material and geometry frames)>w - Displacement field, Z component.

1D Plot Group 4
1 In the Model Builder window, under Results right-click 1D Plot Group 4 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Tip Displacement vs Applied 
Voltage in the New label text field.

3 Click OK.

4 On the Tip Displacement vs Applied Voltage toolbar, click Plot.

Finally, plot the DC capacitance of the device vs voltage.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 5 and choose Global.

3 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Electromechanics>

Terminals>emi.C11 - Maxwell capacitance.

Modify the automatically generated expression to account for the symmetry boundary 
condition.

4 Locate the y-Axis Data section. In the table, enter the following settings:

Expression Unit Description

2*emi.C11 fF Capacitance
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1D Plot Group 5
1 In the Model Builder window, under Results right-click 1D Plot Group 5 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type DC C-V Curve in the New label text field.

3 Click OK.

4 On the DC C-V Curve toolbar, click Plot.
18 |  E L E C T R O S T A T I C A L L Y  A C T U A T E D  C A N T I L E V E R



Created in COMSOL Multiphysics 5.3
Ge cko Foo t
This model is licensed under the COMSOL Software License Agreement 5.3.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/


Introduction

In nature, various species apply advanced techniques for specialized tasks. For instance, 
gecko lizards use dry adhesion forces such as van der Waals forces to climb walls. Dry 
adhesion is a phenomenon of interest for sticking because it requires no energy to hold on, 
and no residue is left on the surface. Gecko lizards have inspired researchers to develop 
synthetic gecko foot hairs for use in, for example, robots.

A strand of hair on a gecko foot is a very complex biological structure with hierarchical 
nanosections and microsections. On its feet, a gecko has billions of nanoscale hairs that are 
in contact with surfaces while it climbs. These nanohairs are attached to microscale hairs, 
which are on the tip of the gecko’s toes.

Critical design parameters for nanohairs to achieve optimal sticking are hair length, detach 
angle, distance between nanohairs, and the cross-sectional area of a single strand of hair. 
By varying these parameters, it is possible to design hairs that can stick to very rough 
surfaces. At the same time, they must be stiff enough to avoid sticking to each other. 
Proper material choices help achieving the design goals while providing the required 
adhesion force. Typically the Young’s modulus for materials used in synthetic nanohair 
vary between 1 GPa and 15 GPa.

Model Definition

This model contains the hierarchy of synthetic gecko foot hair where nanoscale and 
microscale cantilever beams describe the seta and spatula parts of a spatular stalk attached 
to a gecko foot. The basis of the analyzed structure is a microscale stalk with the following 
dimensions: width, 4.53 μm; height, 4.33 μm; and length, 75 μm. At the end of the 
microhair, 169 nanohairs are attached and they have dimensions of 0.18 μm, 0.17 μm, and 
3 μm, respectively. The microhair is fixed at the far end, while the contact and friction 
forces appear as surface loads at the end of each nanohair. The free-body diagram of a 
micro/nanohair in Figure 1 illustrates the applied forces, which are set to 0.4 μN for the 
contact force and 0.2 μN for the friction force with 60° contact angle to target surface. 
The structure is made of β-keratin with a Young’s modulus of 2 GPa and a Poisson’s ratio 
of 0.4. The model was inspired by Ref. 1.
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Figure 1: Model of the tip of a gecko foot hair.

Results and Discussion

The plot in Figure 2 shows the von Mises effective stress in the model. Table 1 lists the 
maximum values of the von Mises stress, total displacement, and principal strain:

The maximum von Mises stress in the analyzed model is almost twice the value of the 
material’s yield stress, which clearly indicates that further investigation is required.

The deformed plot in Figure 2 shows that displacement is large, while the results in the 
table above indicate that the maximum strain is moderate. Hence, the next step is to enable 
the geometric nonlinearity within the linear elastic material model. (An alternative would 
be to search for a suitable hyperelastic material model, which would require the 
corresponding material data.)

TABLE 1:  STRESS, DISPLACEMENT, AND PRINCIPAL STRAIN RESULTS IGNORING GEOMETRIC NONLINEARITY.

MAXIMUM VON MISES 
STRESS (N/m2

)
MAXIMUM TOTAL 
DISPLACEMENT (μm)

MAXIMUM FIRST PRINCIPAL STRAIN

9.52·107 12.6 0.0505

Micro hair

Nano hair

Friction force (Ff)

Contact force (Fc)

60 deg.
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Figure 2: Deformed shape plot of the von Mises stress in a synthetic gecko foot ignoring 
geometric nonlinearity. The plot shows the displacements without any scaling.

Figure 3: The result recomputed with the geometric nonlinearity taken into account.
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You include the geometric nonlinearity by selecting the corresponding check box in the 
Linear Elastic Material Model feature node. The resulting changes in the model equations 
are shown under the Equation section therein.

The plot in Figure 3 shows the resulting von Mises stress distribution and the 
deformation, and Table 2 below gives the recomputed maximum values.

The results show that without the geometric nonlinearity taken into account, the model 
overpredicts the maximum von Mises stress by more than a factor of five, and the 
maximum displacement by more than a factor of four. Furthermore, the maximum strain 
computed with the geometric nonlinearity included becomes less than 1%, which 
eliminates the need of further analysis involving more complicated hyperelastic material 
models.
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Application Library path: MEMS_Module/Actuators/gecko_foot

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

TABLE 2:  STRESS, DISPLACEMENT, AND PRINCIPAL STRAIN RESULTS INCLUDING GEOMETRIC NONLINEARITY 
EFFECTS.

MAXIMUM VON MISES 
STRESS (N/m2

)
MAXIMUM TOTAL 
DISPLACEMENT (μm)

MAXIMUM FIRST PRINCIPAL STRAIN

1.73·107 2.93 8.85·10-3
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

Name Expression Value Description

Fc 0.4[uN] 4E-7 N Contact force

Ff 0.2[uN] 2E-7 N Friction force

theta pi/3 1.047 Contact angle

Dm 75[um] 7.5E-5 m Microhair length

Hm 4.33[um] 4.33E-6 m Microhair width

Wm 4.53[um] 4.53E-6 m Microhair height

Dn 3[um] 3E-6 m Nanohair length

Hn 0.17[um] 1.7E-7 m Nanohair width

Wn 0.18[um] 1.8E-7 m Nanohair height

Area Wn*Hn 3.06E-14 m² Cross-sectional area of the 
spatulae
6 |  G E C K O  F O O T



3 In the Width text field, type Wn.

4 In the Depth text field, type Dn.

5 In the Height text field, type Hn.

6 Locate the Position section. In the y text field, type -Dn.

7 Right-click Block 1 (blk1) and choose Rename.

8 In the Rename Block dialog box, type Nanohair in the New label text field.

9 Click OK.

Next, add object selections for the nanohair’s root and end. An object selection is 
defined by a set of geometric entities at a specified level selected from the geometric 
objects that precede the object selection feature in the geometry sequence. Their main 
advantage compared to regular selection features is that object selections propagate 
through the geometry sequence, which make them robust and convenient to apply in 
cases like the present one.

Explicit Selection 1 (sel1)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, locate the Entities to Select section.

3 From the Geometric entity level list, choose Boundary.

4 On the object blk1, select Boundary 3 only.

5 Right-click Explicit Selection 1 (sel1) and choose Rename.

6 In the Rename Explicit Selection dialog box, type Nanohair ends in the New label text 
field.

The use of plural anticipates the fact that you will create an array of nanohairs; this 
object selection will automatically propagate to all of these.

7 Click OK.

Explicit Selection 2 (sel2)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.

2 Click the Wireframe Rendering button on the Graphics toolbar.

3 In the Settings window for Explicit Selection, locate the Entities to Select section.

4 From the Geometric entity level list, choose Boundary.

5 On the object blk1, select Boundary 6 only.

6 Click the Wireframe Rendering button on the Graphics toolbar.

7 Right-click Explicit Selection 2 (sel2) and choose Build Selected.
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8 Right-click Explicit Selection 2 (sel2) and choose Rename.

9 In the Rename Explicit Selection dialog box, type Nanohair roots in the New label text 
field.

10 Click OK.

Array 1 (arr1)
1 On the Geometry toolbar, click Transforms and choose Array.

2 Select the object blk1 only.

3 In the Settings window for Array, locate the Size section.

4 In the x size text field, type 13.

5 In the z size text field, type 13.

6 Locate the Displacement section. In the x text field, type (Wm-Wn)/12.

7 In the z text field, type (Hm-Hn)/12.

8 Right-click Array 1 (arr1) and choose Build Selected.

9 Click the Zoom Extents button on the Graphics toolbar.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type Wm.

4 In the Depth text field, type Dm.

5 In the Height text field, type Hm.

6 Right-click Block 2 (blk2) and choose Build Selected.

7 Right-click Block 2 (blk2) and choose Rename.

8 In the Rename Block dialog box, type Microhair in the New label text field.

9 Click OK.

Explicit Selection 3 (sel3)
1 On the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, locate the Entities to Select section.

3 From the Geometric entity level list, choose Boundary.

4 On the object blk2, select Boundary 3 only.

5 Right-click Explicit Selection 3 (sel3) and choose Build Selected.

6 Right-click Explicit Selection 3 (sel3) and choose Rename.
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7 In the Rename Explicit Selection dialog box, type Microhair end in the New label text 
field.

8 Click OK.

9 In the Settings window for Explicit Selection, click Go to Default View.

Form Union (fin)
Use an assembly to connect parts of the geometry of significantly different dimensions.

1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 
Form Union (fin).

2 In the Settings window for Form Union/Assembly, locate the Form Union/Assembly section.

3 From the Action list, choose Form an assembly.

4 Clear the Create pairs check box.

5 Right-click Component 1 (comp1)>Geometry 1>Form Union (fin) and choose 
Build Selected.

The model geometry is now complete.

D E F I N I T I O N S

Because of the use of assembly, you need to add an identity pair to set up the displacement 
field continuity at the interfaces, where the nanohairs are attached to the microhair. 
Configure the identity to operate on the material frame, because this is the frame used 
within the Solid Mechanics interface.

Identity Boundary Pair 1 (p1)
1 On the Definitions toolbar, click Pairs and choose Identity Boundary Pair.

2 In the Settings window for Pair, locate the Source Boundaries section.

3 From the Selection list, choose Microhair end.

4 Locate the Destination Boundaries section. Select the Active toggle button.

5 From the Selection list, choose Nanohair roots.

Define a rotated coordinate system to account for the contact angle.

Rotated System 2 (sys2)
1 On the Definitions toolbar, click Coordinate Systems and choose Rotated System.

2 In the Settings window for Rotated System, locate the Settings section.

3 Find the Euler angles (Z-X-Z) subsection. In the β text field, type pi/2-theta.
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M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

D E F I N I T I O N S

Set up a maximum operator to compute maximum values of the von Mises stress, total 
displacement, and principal strain over the entire geometry.

Maximum 1 (maxop1)
1 On the Definitions toolbar, click Component Couplings and choose Maximum.

2 In the Settings window for Maximum, locate the Source Selection section.

3 From the Selection list, choose All domains.

Variables 1
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Property Name Value Unit Property group

Young’s modulus E 2e9 Pa Basic

Poisson’s ratio nu 0.4 1 Basic

Density rho 1200 kg/m³ Basic

Name Expression Unit Description

max_v_Mises maxop1(solid.mises) N/m² Maximum von Mises 
stress

max_disp maxop1(solid.disp) m Maximum total 
displacement

max_ep1 maxop1(solid.ep1) Maximum first 
principal strain
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S O L I D  M E C H A N I C S  ( S O L I D )

Fixed Constraint 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Solid Mechanics (solid) and choose Fixed Constraint.

2 Select Boundary 83 only.

Boundary Load 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Boundary Load.

2 In the Settings window for Boundary Load, locate the Boundary Selection section.

3 From the Selection list, choose Nanohair ends.

4 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Rotated System 2 (sys2).

5 Locate the Force section. Specify the FA vector as

Continuity 1
1 Right-click Solid Mechanics (solid) and choose Pairs>Continuity.

2 In the Settings window for Continuity, locate the Pair Selection section.

3 In the Pairs list, select Identity Boundary Pair 1 (p1).

M E S H  1

Mapped 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Mapped.

2 In the Settings window for Mapped, locate the Boundary Selection section.

3 From the Selection list, choose Nanohair ends.

Size 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. Select the Maximum element size check box.

0 x1

-Fc/Area x2

Ff/Area x3
11 |  G E C K O  F O O T



5 In the associated text field, type 0.1.

Mapped 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Mapped 1.

2 In the Settings window for Mapped, click Build Selected.

Swept 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose All domains.

5 Remove Domain 14 from the selection.

6 Right-click Component 1 (comp1)>Mesh 1>Swept 1 and choose Distribution.

7 In the Settings window for Swept, click Build Selected.

Mapped 2
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Mapped.

2 Select Boundary 83 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 2 and choose Distribution.

2 Select Edges 162–164 and 168 only.

Mapped 2
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Mapped 2.

2 In the Settings window for Mapped, click Build Selected.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 2 and choose Distribution.

3 In the Settings window for Distribution, click Build Selected.

The mesh is now complete.

S T U D Y  1

On the Home toolbar, click Compute.
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R E S U L T S

Stress (solid)
Reproduce the plot in  by following these steps:

1 In the Model Builder window, expand the Stress (solid) node.

Deformation
1 In the Model Builder window, expand the Results>Stress (solid)>Surface 1 node, then 

click Deformation.

2 In the Settings window for Deformation, locate the Scale section.

3 Select the Scale factor check box.

4 In the associated text field, type 1.

5 On the Stress (solid) toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot to that in .

Derived Values
Next, calculate the maximum values for von Mises stress, total displacement, and first 
principal strain; compare the results to those shown in .

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>Definitions>

Variables>max_v_Mises - Maximum von Mises stress.

3 Click Evaluate.

Global Evaluation 2
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>Definitions>

Variables>max_disp - Maximum total displacement.

3 Click Table 1 - Global Evaluation 1 (max_v_Mises).

Global Evaluation 3
1 On the Results toolbar, click Global Evaluation.
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2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>Definitions>

Variables>max_ep1 - Maximum first principal strain.

3 Click Table 1 - Global Evaluation 1 (max_v_Mises).

S O L I D  M E C H A N I C S  ( S O L I D )

Linear Elastic Material 1
Now, switch on geometric nonlinearity.

S T U D Y  1

Step 1: Stationary
1 In the Model Builder window, under Study 1 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Study Settings section.

3 Select the Include geometric nonlinearity check box.

4 On the Home toolbar, click Compute.

R E S U L T S

Stress (solid)
Compare the plot in the Graphics window with that in .

Global Evaluation 1
Finally, compute the new maximum values and display them in a new table. Compare the 
results to those in .

1 In the Model Builder window, under Results>Derived Values click Global Evaluation 1.

2 In the Settings window for Global Evaluation, click New Table.

Global Evaluation 2
1 In the Model Builder window, under Results>Derived Values click Global Evaluation 2.

2 In the Settings window for Global Evaluation, click Table 2 -

Global Evaluation 1 (max_v_Mises).

Global Evaluation 3
1 In the Model Builder window, under Results>Derived Values click Global Evaluation 3.

2 In the Settings window for Global Evaluation, click Table 2 -

Global Evaluation 1 (max_v_Mises).
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Introduction

This example contains an analysis of the thermal stress in a layered plate. The plate consists 
of three layers: the coating, the substrate, and the carrier. The coating is deposited on the 
substrate at a temperature of 800 °C. At this temperature both the coating and the 
substrate are stress-free. The temperature of the plate is then lowered to 150 °C, which 
induces thermal stresses in the coating/substrate assembly. At this temperature the 
coating/substrate assembly is epoxied to a carrier plate so that the coating/substrate has 
initial stresses when it is bonded to the carrier. Finally, the temperature is lowered to 20 °C.

Model Definition

The plate is restrained from moving in the z direction. This makes it possible to use the 
plane strain approximation in the 2D Solid Mechanics interface with. The assumption is 
then that the z-component of the strain is zero.

This model contains only thermal loads, which are introduced into the constitutive 
equations according to the following equations:

and

where σ is the stress vector, D is the elasticity matrix, εx, εy, εz, γxy, γyz, γxz are the strain 
components, αvec is the coefficient of thermal expansion, T is the actual temperature, and 
Tref is the reference temperature. 

σ Dεel σ0+ D ε εth– ε0–( ) σ0+= =

εth

εx

εy

εz

γxy

γyz

γxz th

αvec T Tref–( )= =
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The geometry of the plate is shown in Figure ???. The top layer in the geometry is the 
coating, the middle layer is the substrate, and the bottom layer is the carrier.

Figure 1: The plate geometry.

The analysis uses two steps:

S T E P  1

In the first step you lower the temperature from 800 °C to 150 °C, which affects the 
coating layer and the substrate layer. The carrier layer is not active in this step.

In both steps the upper-left corner of the coating is fixed, and the upper-right corner of 
the coating is constrained in the y direction. This prevents rigid-body movements but does 
not affect the stress distribution.

S T E P  2

In this step all three layers are active and you drop the temperature from 150 °C to room 
temperature, 20 °C. This step includes the initial stresses from Step 1.
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Results and Discussion

Figure ??? depicts the normal stress in the x direction from the first analysis step. The 
substrate material has a higher coefficient of thermal expansion than the coating material. 
This means that the substrate shrinks more than the coating, causing tensile stresses in the 
substrate area next to the coating and compressive stresses in the coating.

Figure 2: Normal stress in the x direction for the first analysis step.

Figure ??? shows the residual thermal x-stress in the final step where the temperature is 
lowered to 20 °C. The tensile stress levels have increased somewhat in the substrate area 
next to the coating, as have the compressive stress in the coating compared to the first 
process step. The main stress contribution is clearly the added initial stress from the first 
process step.
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Figure 3: Residual thermal stress at room temperature.

Application Library path: MEMS_Module/Actuators/layered_plate

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

Add two different solid interfaces, one for the structure before adding the carrier, and 
one for the complete structure.
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3 Click Add.

4 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

5 Click Add.

6 Click Study.

7 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

8 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Height text field, type 0.002.

4 In the Width text field, type 0.02.

5 Click Build All Objects.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.02.

4 In the Height text field, type 0.01.

5 Locate the Position section. In the y text field, type 0.002.

6 Click Build All Objects.

Name Expression Value Description

Ttop 800[degC] 1073 K Coating deposition temperature

Tbot 150[degC] 423.2 K Temperature when the coating/
substrate is epoxied to the carrier

Troom 20[degC] 293.2 K Room temperature
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Rectangle 3 (r3)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.02.

4 In the Height text field, type 0.002.

5 Locate the Position section. In the y text field, type 0.012.

6 Click Build All Objects.

7 Click the Zoom Extents button on the Graphics toolbar.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, type Two Layers in the Label text field.

3 Select Domains 2 and 3 only.

TW O  L A Y E R S  ( S O L I D )

On the Physics toolbar, click Solid Mechanics (solid) and choose Two Layers (solid).

Linear Elastic Material 1
In the Model Builder window, expand the Component 1 (comp1)>Two Layers (solid) node.

Thermal Expansion 1
1 Right-click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Thermal Expansion Properties 
section.

3 In the Tref text field, type Ttop.

4 Locate the Model Input section. In the T text field, type Tbot.

Rigid Motion Suppression 1
1 In the Model Builder window, right-click Two Layers (solid) and choose 

Domain Constraints>Rigid Motion Suppression.

2 In the Settings window for Rigid Motion Suppression, locate the Domain Selection section.

3 From the Selection list, choose All domains.

S O L I D  M E C H A N I C S  2  ( S O L I D 2 )

1 In the Model Builder window, under Component 1 (comp1) click 
Solid Mechanics 2 (solid2).

2 In the Settings window for Solid Mechanics, type Three Layers in the Label text field.
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T H R E E  L A Y E R S  ( S O L I D 2 )

On the Physics toolbar, click Solid Mechanics 2 (solid2) and choose Three Layers (solid2).

Thermal Expansion 1
1 In the Model Builder window, under Component 1 (comp1)>Three Layers (solid2) right-

click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Thermal Expansion Properties 
section.

3 In the Tref text field, type Tbot.

4 Locate the Model Input section. In the T text field, type Troom.

Rigid Motion Suppression 1
1 In the Model Builder window, right-click Three Layers (solid2) and choose 

Domain Constraints>Rigid Motion Suppression.

2 In the Settings window for Rigid Motion Suppression, locate the Domain Selection section.

3 From the Selection list, choose All domains.

Linear Elastic Material 1
Use the stresses from the two layer model as initial stresses for the three layer model.

Initial Stress and Strain 1
1 In the Model Builder window, under Component 1 (comp1)>Three Layers (solid2) right-

click Linear Elastic Material 1 and choose Initial Stress and Strain.

2 Select Domains 2 and 3 only.

3 In the Settings window for Initial Stress and Strain, locate the Initial Stress and Strain 
section.

4 In the S0 table, enter the following settings:

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Carrier in the Label text field.

solid.sx solid.sxy 0

solid.sxy solid.sy 0

0 0 solid.sz
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3 Locate the Geometric Entity Selection section. From the Selection list, choose Manual.

4 Click Clear Selection.

5 Select Domain 1 only.

6 Locate the Material Contents section. In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Substrate in the Label text field.

3 Select Domain 2 only.

4 Locate the Material Contents section. In the table, enter the following settings:

Material 3 (mat3)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Coating in the Label text field.

3 Select Domain 3 only.

4 Locate the Material Contents section. In the table, enter the following settings:

Property Name Value Unit Property 
group

Young’s modulus E 2.15e11 Pa Basic

Poisson’s ratio nu 0.3 1 Basic

Density rho 1000 kg/m³ Basic

Coefficient of thermal expansion alpha 6e-6 1/K Basic

Property Name Value Unit Property 
group

Young’s modulus E 1.3e11 Pa Basic

Poisson’s ratio nu 0.28 1 Basic

Density rho 1000 kg/m³ Basic

Coefficient of thermal expansion alpha 3e-6 1/K Basic

Property Name Value Unit Property 
group

Young’s modulus E 7e10 Pa Basic

Poisson’s ratio nu 0.17 1 Basic
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M E S H  1

Size
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Mapped.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extra fine.

4 Click Build All.

S T U D Y  1

Add a static solution for the case with three layers.

Step 2: Stationary 2
1 On the Study toolbar, click Study Steps and choose Stationary>Stationary.

Use only one Solid Mechanics interface per solution by deactivating the other one.

Step 1: Stationary
1 In the Model Builder window, under Study 1 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for Three Layers.

Step 2: Stationary 2
1 In the Model Builder window, under Study 1 click Step 2: Stationary 2.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for Two Layers.

4 On the Study toolbar, click Compute.

R E S U L T S

Surface 1
1 In the Model Builder window, expand the Stress (solid) node, then click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Two Layers>Stress>

Stress tensor (spatial frame)>solid.sx - Stress tensor, x component.

Density rho 1000 kg/m³ Basic

Coefficient of thermal expansion alpha 5e-7 1/K Basic

Property Name Value Unit Property 
group
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3 On the Stress (solid) toolbar, click Plot.

4 Click the Zoom Extents button on the Graphics toolbar.

Surface 1
1 In the Model Builder window, expand the Results>Stress (solid2) node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Three Layers>Stress>

Stress tensor (spatial frame)>solid2.sx - Stress tensor, x component.

3 On the Stress (solid2) toolbar, click Plot.
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Micropumps are key components of microfluidic systems with applications ranging from 
biological fluid handling to microelectronic cooling. This model simulates the mechanism 
of a valveless micropump, that is designed to be effective at low Reynolds numbers, 
overcoming hydrodynamic reversibility. Valveless pumps are often preferred in microfludic 
systems because they minimize the risk of clogging and are gentle on biological material. 
The Fluid-Structure Interaction interface is used to solve for the flow of the fluid and the 
associated deformation of the structure. In addition the Global ODEs and DAEs interface 
is used to demonstrate how to perform a time resolved integration of the total flow 
throughout the pumping cycle.

Introduction

Many valveless pump designs are ineffective when the system has a low Reynolds number, 
and consequently are unsuitable for viscous fluids and applications with small length scales 
or low flow rates. This is largely because without valves it is difficult to achieve sustained 
flow in a given direction.

The mechanism simulated in this model overcomes this limitation by converting 
oscillatory fluid motion, induced by a simple reciprocating pumping mechanism, into a net 
flow in one direction. It is relatively easy to create an oscillatory pumping mechanism in a 
microfluidic system, e.g. a membrane can be vibrated by a piezo oscillator to periodically 
vary the volume of a microchamber. In this model, an oscillatory flow is fed into a channel 
containing bendable microflaps. The deformation of the microflaps in response to the 
motion of the fluid alters the flow and results in a net flow rate in a consistent direction. 
The passive nature of the flow regulator allows for directional control of the flow without 
the use of the complicated synchronized actuation mechanisms that would be required in 
a valve based system.

In this model the Fluid-Stricture Interaction interface is used to specify the input 
oscillatory flow, along with the mechanical properties of the flaps. In addition, some best 
practice guidelines for ensuring good mesh deformation in moving-mesh problems are 
introduced. The deformation of the flaps, and the flow of the fluid, is calculated as a 
function of time for two full cycles of the pumping mechanism. This allows the physical 
mechanism responsible for generating the unidirectional flow to be visualized clearly using 
an animation. As well as visualizing flow rate and direction as a function of time 
throughout the pumping cycle, integration coupling components are used in conjunction 
with the Global ODEs and DAEs interface to calculate the net volumed pumped from left-
to-right as a function of time. This is an example of how the functionality of one 
COMSOL interface can be enhanced by using a custom equation specified in a 
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mathematics interface, and demonstrates the ease with which user defined equations can 
be incorporated into COMSOL models.

Model Definition

The model geometry is shown in Figure 1. It consists of a horizontal channel that is 
600 μm in length and 100 μm high. A vertical chamber connects to the channel at the 
midpoint along its length. Two tilted flaps are attached to the bottom of the channel such 
that they partially obstruct flow along the channel length. The are spaced to be centered 
on the midpoint of the channel length, and they are both angled at 45 degrees to the to 
the horizontal channel edge. Note that this 2D model represents a cross-section through 
the midpoint of the channel in the out-of-plane direction. An out-of-plane thickness of 
10 μm has been used for the purpose of calculating the volume of fluid pumped as a 
function of time. However, as no edge effects due to walls that are out-of-plane are 
included, this is equivalent to modeling a 10 μm deep section of a much thicker channel.

Note the vertical lines that connect the apex of the tilted flaps to the top of the channel. 
These are included as guidelines to aid the meshing algorithm as the structure deforms. 
Point Integration coupling components are applied to the apex of each bendable flap. 
These are then used to compute the horizontal displacement of the flap apex by calculating 
the position of the apex relative to the undeformed geometry. This is achieved by 
evaluating the expression (x-X) using the point Integration coupling components, where 
x and X are the x-coordinate of the apex point in the undeformed and deformed geometry, 
respectively. Thus, (x-X) gives the horizontal shift experienced by the vertical guidelines. 
Prescribed Mesh Displacement features are applied to the guidelines to force the x-
displacement of the mesh along the guidelines to be equal to that of the flap apexes. This 
helps the moving mesh, which is automatically recalculated as the structure deforms, to 
maintain a reasonable structure around the bending flaps. In general, it is good practice to 
take measures like this to ensure that the mesh deforms in an appropriate way. 
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Figure 1: The model geometry consists of a horizontal channel and a vertical chamber. Tilted 
flaps are positioned within the channel, the response of these flaps to the oscillatory fluid motion 
induced via the labeled boundary results in a net flow from left-to-right.

The physics required for the model is configured within the Fluid-Structure Interaction 
interface. The Linear Elastic Material feature is applied to the two tilted flaps, and then the 
Fluid-Solid Interface Boundary feature is automatically assigned to the boundaries 
between the flaps and the fluid in the channel. An Inlet boundary feature is applied to the 
top of the vertical chamber. This specifies the inflow velocity, via a user input expression, 
to vary sinusoidally in time with a period of 1 s. An Outlet boundary feature is applied to 
the left and right boundaries of the channel. Two boundary integration coupling 
components, named intopL() and intopR() for the left and right outlets respectively, 
are also applied to these outlet boundaries. These are used to compute the flow rate out 
of each outlet. This is achieved using some user defined variables in the Definitions node 
within Component 1. The flow rate from each outlet is calculated by integrating the 
depended variable u_fluid, which is the horizontal component of the fluid velocity, and 
multiplying by the out-of-plane length scale of 10 μm. The net flow rate out of the 
channel, UoutNet, is then calculated from the difference between the flow from the left 
and right outlets, such that positive values correspond to a net flow in the left-to-right 
direction.
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A Global ODEs and DAEs interface is added to compute the integrated net flow as a 
function of time. This is achieved using a Global Equation which integrates UoutNet with 
respect to time to obtain Vpump. This step is necessary as UoutNet gives the instantaneous 
net flow rate as a function in time, however a more useful metric for evaluating a pump is 
the total volume pumped throughout an entire pumping cycle. Note that the timeint() 
operator can also be used to visualize the time integration of a variable. However, use of 
timeint() is not as accurate as directly solving for an integrated quantitiy, as the 
timeint() operator only uses the timesteps which are saved in the solution but solving 
directly uses every timestep taken by the solver.

The mesh is configured to be tightest around the tilted flaps, in order to resolve the stress 
within the bending flaps. The mesh is shown in Figure 2.

Figure 2: Initial mesh prior to any structural deformation.

A single time dependent study is performed over a duration of 2 seconds, which 
corresponds to two full oscillations of the inlet velocity. Some minor amendments to the 
default solver sequence, described in the step-by-step instructions, are required to ensure 
reliable results. In particular, the Time Stepping is set to Strict with the maximum step 
set to 0.01 s. This is needed because the feedback between the flap deformation and the 
fluid flow can lead to abrupt changes in the flow. The default time stepping setting allows 
the solver to vary the time step it takes so that larger steps can be taken during times when 
the solution is not rapidly varying. However, because of the potential for sudden changes 
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to the fluid flow in fluid-structure interaction models it can be helpful to impose a 
maximum time step to ensure that rapid changes are not missed.

It should be noted that the geometry is parameterized so that the channel dimensions and 
flap angle can be straightforwardly modified by amending the relevant entry in the Global 
Parameters table. The average flow rate at the inlet and the fluid properties are also 
parameterized in the same way. In addition, the effective Reynolds number can be easily 
changed as the viscosity and average inlet velocity are appropriately scaled by a shared 
coefficient (the parameter coeff) that is computed from the target Reynolds number (the 
parameter Re). Note that the parameter Re_check is provided to confirm that the 
Reynolds number does indeed take the specified value. The model is setup with a Reynolds 
number of 16, but it is straightforward to verify that the pumping action occurs even for 
Reynolds numbers significantly less than one.

Results and Discussion

The mechanism by which the flow direction is regulated can be observed in the Flow and 
Stress default plot group. During the downstroke, when fluid is pushed from the vertical 
chamber into the channel, the right-hand flap is bent down towards the bottom of the 
channel whilst the left-hand flap is bend away from the channel bottom. This 
configuration is shown in Figure 3, which shows the solution at a time of 0.26 s which 
corresponds to when the velocity flowing into the vertical chamber via the inlet is at its 
maximum. Due to the asymmetric bending of the flaps, fluid can more easily flow out of 
the right-hand outlet. During the upstroke, when fluid is drawn from the channel into the 
vertical chamber, the flaps are bent in the opposite directions. This configuration is shown 
in Figure 4, which shows the solution at a time of 0.74 s. Now the right hand flap restricts 
the flow more than the left-hand flap, and the majority of the fluid that is drawn into the 
vertical chamber is from the left-hand outlet.

The result of this behavior is that there is a net flow rate from left-to-right inside the 
channel. This has many possible applications in microfluidic systems. For example, this 
device could be used to deliver fluid from a droplet reservoir connected to the left-hand 
outlet into a microfluidic pathway connected to the right-hand outlet. Alternately, this 
device could be used to create a circulating system where a fluid is pumped around a 
continuous loop to cool a microelectronic system.
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Figure 3: Velocity magnitude and velocity field, along with the von Mises stress within the flaps, 
during the pumping downstroke. 

Figure 4: Velocity magnitude and velocity field, along with von Mises stress within the flaps, 
during the pumping upstroke.
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The net volume of fluid that is pumped from left-to-right is shown in Figure 5. As 
expected, the gradient of the curve, which is the net flow rate, varies sinusoidally with a 
period equal to the inlet velocity. The maximum gradients occur at intervals of odd 
multiples of 0.5 s, which correspond with the peaks in the magnitude of the inlet velocity. 

Figure 5: Net volume pumped from left-to-right as a function of time.

Application Library path: MEMS_Module/Fluid-Structure_Interaction/
micropump_mechanism

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Fluid Flow>Fluid-Structure Interaction (fsi).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Time Dependent.

6 Click Done.

Add some parameters which will be used to control the fluid properties and device 
geometry.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

Next create the geometry for the device. Notice how vertical lines are used to connect 
the tip of each rod to the top of the channel. This is not needed to create the desired 
geometry, however these lines are very helpful for limiting the deformation of the mesh 
elements as the rods bend. It is good practice to include boundaries to guide the 
deformation of a moving mesh.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type L.

4 In the Height text field, type H.

Name Expression Value Description

Re 16 16 Reynolds number

coeff 4/sqrt(Re) 1 Coefficient to 
change Reynolds 
number

dens 1000[kg/m^3] 1000 kg/m³ Fluid density

visc 0.001[Pa*s]*coeff 0.001 Pa·s Fluid dynamic 
viscosity

U 16[cm/s]/coeff 0.16 m/s Average inlet flow 
speed

H 100[um] 1E-4 m Channel height

W 10[um] 1E-5 m Domain width

rp 2[um] 2E-6 m Pillar radius

hp 70[um] 7E-5 m Pillar height

L 600[um] 6E-4 m Length of channel

beta 45[deg] 0.7854 rad Flap tilt angle

x0 150[um] 1.5E-4 m Flap center location

Re_check dens*U*H/(visc) 16 Reynolds number
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5 Locate the Position section. In the x text field, type -L/2.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2*rp.

4 In the Height text field, type 2*hp.

5 Locate the Position section. From the Base list, choose Center.

6 In the x text field, type x0-hp*sin(beta)/2.

7 Locate the Rotation Angle section. In the Rotation text field, type -beta.

Copy 1 (copy1)
1 On the Geometry toolbar, click Transforms and choose Copy.

2 Select the object r1 only.

Intersection 1 (int1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Intersection.

2 Select the objects r1 and r2 only.

3 In the Settings window for Intersection, locate the Intersection section.

4 Clear the Keep interior boundaries check box.

Fillet 1 (fil1)
1 On the Geometry toolbar, click Fillet.

2 On the object int1, select Points 3 and 4 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type rp.

Bézier Polygon 1 (b1)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to x0+hp*sin(beta)/2 and y to hp*
cos(beta).

5 In row 2, set x to x0+hp*sin(beta)/2 and y to H.

Copy 2 (copy2)
1 On the Geometry toolbar, click Transforms and choose Copy.
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2 Select the objects b1 and fil1 only.

3 In the Settings window for Copy, locate the Displacement section.

4 In the x text field, type -2*x0.

Rectangle 3 (r3)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.8*H.

4 In the Height text field, type H.

5 Locate the Position section. In the x text field, type -0.4*H.

6 In the y text field, type H.

7 Click Build All Objects.

Add two Integration Component Coupling operators, one to the boundary which forms 
the left outlet and one to the boundary which forms the right outlet. These operators 
will be used to calculate the flow rate out of each outlet.

D E F I N I T I O N S

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type intopL in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 Select Boundary 1 only.

Integration 2 (intop2)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type intopR in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 Select Boundary 21 only.

Add two more Integration Component Coupling operators. These integration operators 
are used to calculate the change in position of the tip of the rods as they bend, so that 
this information can be used to help control the mesh as it adapts to the changing 
geometry. These will be used when setting the prescribed mesh displacement settings in 
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the Fluid-Structure Interaction physics interface. In general, it is good practice to set up 
guide boundaries to help control how the mesh deforms. This model includes such 
boundaries as an example.

Integration 3 (intop3)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 7 in the Selection text field.

6 Click OK.

Integration 4 (intop4)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 17 in the Selection text field.

6 Click OK.

Create some variables to calculate the net flow rate in the channel. The first two 
variables calculate the average flow rate out of each outlet by performing an average over 
u_fluid, which is the horizontal component of the fluid flow. Note the sign 
convention, that assigns positive values to left-right flow and negative values to right-
left flow. The third variable calculates the difference between the average flow rate out 
of each outlet, positive values correspond to a net flow from left to right.

Variables 1
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, locate the Variables section.
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3 In the table, enter the following settings:

In order to integrate the average net flow rate over time to calculate the volume of fluid 
that is pumped, add a Global ODE and DAEs physics interface to the model.

A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Mathematics>ODE and DAE Interfaces>Global ODEs and DAEs (ge).

4 Click Add to Component in the window toolbar.

G L O B A L  O D E S  A N D  D A E S  ( G E )

On the Home toolbar, click Add Physics to close the Add Physics window.

Global Equations 1
1 In the Model Builder window, under Component 1 (comp1)>Global ODEs and DAEs (ge) 

click Global Equations 1.

2 In the Settings window for Global Equations, locate the Global Equations section.

3 In the table, enter the following settings:

4 Locate the Units section. Find the Dependent variable quantity subsection. From the list, 
choose None.

5 In the Unit text field, type m^3.

6 Find the Source term quantity subsection. From the list, choose None.

7 In the Unit text field, type m^3/s.

Configure the Fluid-Structure Interaction physics interface.

Name Expression Unit Description

UoutL -intopL(u_fluid)*W m³/s Flow rate from left 
outlet

UoutR intopR(u_fluid)*W m³/s Flow rate from right 
outlet

UoutNet UoutR-UoutL m³/s Net flow rate

Name f(u,ut,utt,t) (1) Initial value 
(u_0) (1)

Initial value 
(u_t0) (1/s)

Description

Vpump Vpumpt-UoutNet 0 0 Net volume pumped 
left-to-right
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F L U I D - S T R U C T U R E  I N T E R A C T I O N  ( F S I )

On the Physics toolbar, click Global ODEs and DAEs (ge) and choose Fluid-

Structure Interaction (fsi).

1 In the Model Builder window, under Component 1 (comp1) click Fluid-

Structure Interaction (fsi).

2 In the Settings window for Fluid-Structure Interaction, locate the 
Free Deformation Settings section.

3 From the Mesh smoothing type list, choose Yeoh.

4 Locate the Physical Model section. From the Compressibility list, choose 
Incompressible flow.

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1)>Fluid-

Structure Interaction (fsi) click Linear Elastic Material 1.

2 Select Domains 2 and 5 only.

3 In the Settings window for Linear Elastic Material, locate the Linear Elastic Material 
section.

4 Select the Nearly incompressible material check box.

Inlet 1
1 In the Model Builder window, right-click Fluid-Structure Interaction (fsi) and choose the 

boundary condition Laminar Flow>Inlet.

2 Select Boundary 12 only.

3 In the Settings window for Inlet, locate the Velocity section.

4 In the U0 text field, type U*6*s*(1-s)*sin(2*pi*t/(1[s])).

Outlet 1
1 Right-click Fluid-Structure Interaction (fsi) and choose the boundary condition 

Laminar Flow>Outlet.

2 Select Boundaries 1 and 21 only.

3 In the Settings window for Outlet, locate the Pressure Conditions section.

4 Clear the Suppress backflow check box.

Fixed Constraint 1
1 Right-click Fluid-Structure Interaction (fsi) and choose the boundary condition 

Solid Mechanics>Fixed Constraint.

2 Select Boundaries 4 and 15 only.
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Prescribed Mesh Displacement 2
1 Right-click Fluid-Structure Interaction (fsi) and choose Prescribed Mesh Displacement.

2 Select Boundaries 3, 9, 14, and 20 only.

3 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

4 Clear the Prescribed x displacement check box.

Prescribed Mesh Displacement 3
1 Right-click Fluid-Structure Interaction (fsi) and choose Prescribed Mesh Displacement.

2 Select Boundary 8 only.

3 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

4 Clear the Prescribed y displacement check box.

5 In the dx text field, type intop3(x-X).

Prescribed Mesh Displacement 4
1 Right-click Fluid-Structure Interaction (fsi) and choose Prescribed Mesh Displacement.

2 Select Boundary 19 only.

3 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

4 Clear the Prescribed y displacement check box.

5 In the dx text field, type intop4(x-X).

Prescribed Deformation 1
1 Right-click Fluid-Structure Interaction (fsi) and choose Prescribed Deformation.

2 Select Domain 4 only.

Prescribed Mesh Displacement 5
1 Right-click Fluid-Structure Interaction (fsi) and choose Prescribed Mesh Displacement.

2 Select Boundary 11 only.

With the physics interfaces configured, add materials to the geometry domains. In this 
case, it was beneficial to wait until all the physics settings were configured before adding 
materials, as COMSOL automatically adjusts which materials properties are needed 
depending on the physics assigned to each domain.
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M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Fluid in the Label text field.

3 Select Domains 1, 3, 4, and 6 only.

4 Locate the Material Contents section. In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Solid in the Label text field.

3 Select Domains 2 and 5 only.

4 Locate the Material Contents section. In the table, enter the following settings:

Configure the mesh.

M E S H  1

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Triangular.

2 In the Settings window for Free Triangular, locate the Domain Selection section.

3 From the Geometric entity level list, choose Entire geometry.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

Property Name Value Unit Property group

Density rho dens kg/m³ Basic

Dynamic viscosity mu visc Pa·s Basic

Property Name Value Unit Property group

Young’s modulus E 3.6e5 Pa Basic

Poisson’s ratio nu 0.499 1 Basic

Density rho 970 kg/m³ Basic
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4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
10.

5 In the Minimum element size text field, type 1.4.

6 In the Maximum element growth rate text field, type 1.4.

7 In the Curvature factor text field, type 0.6.

8 In the Resolution of narrow regions text field, type 0.7.

Size 1
1 In the Model Builder window, right-click Mesh 1 and choose Size.

2 Right-click Size 1 and choose Move Up.

3 In the Settings window for Size, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Domain.

5 Select Domains 2 and 5 only.

6 Locate the Element Size section. Click the Custom button.

7 Locate the Element Size Parameters section. Select the Maximum element size check box.

8 In the associated text field, type 2.

9 Select the Minimum element size check box.

10 In the associated text field, type 1.5.

11 In the Model Builder window, click Mesh 1.

12 In the Settings window for Mesh, click Build All.

13 Click the Zoom Extents button on the Graphics toolbar.

Configure the study, some minor changes to the default solver configuration are 
needed.

S T U D Y  1

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver.

Set the time steps and range for the study. Also tighten the time-dependent solver 
tolerance to make the time steps more conservative.

Solution 1 (sol1)
1 In the Settings window for Time Dependent, locate the Study Settings section.

2 In the Times text field, type range(0,0.02,2).

3 From the Tolerance list, choose User controlled.
18 |  M I C R O P U M P  M E C H A N I S M



4 In the Relative tolerance text field, type 0.001.

Alter the time stepping in the Time-Dependent Solver 1 node. By default, the time-
dependent solver varies the time step automatically as it solves. However, for FSI 
simulations it is often useful to constrain this by setting a maximum step size. This 
improves accuracy by ensuring that abrupt changes in flow are not missed.

5 In the Model Builder window, expand the Study 1>Solver Configurations>Solution 1 (sol1) 
node, then click Time-Dependent Solver 1.

6 In the Settings window for Time-Dependent Solver, click to expand the Time stepping 
section.

7 Locate the Time Stepping section. From the Steps taken by solver list, choose 
Intermediate.

8 Select the Maximum step check box.

9 In the associated text field, type 0.005.

The Fully Coupled solver is often most appropriate for FSI simulations. A Fully Coupled 
node can be added to the Time-Dependent Solver 1 sequence, when this is done the 
default Segregated solver is overridden.

10 In the Model Builder window, expand the Study 1>Solver Configurations>

Solution 1 (sol1)>Time-Dependent Solver 1 node.

11 Right-click Study 1>Solver Configurations>Solution 1 (sol1)>Time-Dependent Solver 1 and 
choose Fully Coupled.

12 In the Settings window for Fully Coupled, click to expand the Method and termination 
section.

13 Locate the Method and Termination section. In the Maximum number of iterations text 
field, type 6.

14 From the Jacobian update list, choose Once per time step.

Now the study can be solved.

15 On the Study toolbar, click Compute.

The default Flow and Stress plot group shows a color map of the von Mises stress within 
the flexible rods, as well as the velocity magnitude of the fluid within the channel. An 
Arrow Surface plot is of the fluid velocity is superimposed over the colormap. An 
animation of the data series allows the action of the pump to be visualized.
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R E S U L T S

Animation 1
1 On the Results toolbar, click Animation and choose File.

2 In the Settings window for Animation, locate the Target section.

3 From the Target list, choose Player.

4 Locate the Frames section. From the Frame selection list, choose All.

5 Right-click Animation 1 and choose Play.

The animation demonstrates how the passive motion of the rods as they react to the 
fluid results in a net flow of fluid from left-to-right. During the "downstoke", when 
fluid flows from the inlet down into the channel, the right rod bends towards the 
bottom of the channel whilst the left rod bend away from the bottom. This restricts the 
flow towards the left-hand outlet, relative to the right-hand outlet. During the 
"upstroke", where fluid flows from the channel up towards the inlet, the rods bend in 
the opposite directions. Now the inward flow from the right-hand outlet towards the 
center of the channel is restricted. This results in a net flow from left-to-right, where 
fluid is drawn in from the left-hand outlet and pushed out of the right-hand outlet.

The 1D plot group, which plots Vpump from the Global ODEs and DAEs interface, 
confirms that there is indeed a net flow from left-to-right as expected.

1D Plot Group 3
1 In the Model Builder window, under Results click 1D Plot Group 3.

2 In the Settings window for 1D Plot Group, type Net volume pumped left-to-right 
in the Label text field.

3 Click to expand the Legend section. From the Position list, choose Upper left.
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Introduction

This example illustrates the ability to couple thermal, electrical, and structural analysis in 
one model. This particular application moves a beam by passing a current through it; the 
current generates heat, and the temperature increase leads to displacement through 
thermal expansion. The model estimates how much current and increase in temperature 
are necessary to displace the beam.

Although the model involves a rather simple 3D geometry and straightforward physics, it 
provides a good example of multiphysics modeling.

Model Definition

Figure 1: Microbeam geometry.

A copper microbeam has a length of 13 μm with a height and width of 1 μm. Feet at both 
ends bond it rigidly to a substrate. An electric potential of 0.2 V applied between the feet 
induces an electric current. Due to the material’s resistivity, the current heats up the 
structure. Because the beam operates in the open, the generated heat dissipates into the 
air. The thermally induced stress loads the material and deforms the beam.

As a first approximation, you can assume that the electrical conductivity is constant. 
However, a conductor’s resistivity increases with temperature. In the case of copper, the 
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relationship between resistivity and temperature is approximately linear over a wide range 
of temperatures:

 (1)

α is the temperature coefficient. You obtain the conductor’s temperature dependency 
from the relationship that defines electric resistivity; conductivity is simply its reciprocal (σ 
= 1/ρ).

For the heat transfer equations, set the base boundaries facing the substrate to a constant 
temperature of 323 K. You model the convective air cooling in other boundaries using a 
heat flux boundary condition with a heat transfer coefficient, h, of 5 W/(m2·K) and an 
external temperature, Tinf, of 298 K. Standard constraints handle the bases’ rigid 
connection to the substrate.

Results and Discussion

Figure 2 shows the temperature field on the microbeam surface when solving the model 
using a temperature-dependent resistivity as in Equation 1. Based on the color scale, the 
maximum temperature is about 710 K.

Figure 3 shows the microbeam’s deformation. The displacement for the temperature-
dependent case is 48 nm compared to the maximum displacement for constant electrical 
conductivity, which is 88 nm (the plot scales the deformation by a factor of around 20).

ρ ρ0 1 α T T0–( )+( )=
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Figure 2: Surface temperature with temperature-dependent electrical conductivity.

Figure 3: Microbeam deformation with temperature-dependent electrical conductivity.
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Notes About the COMSOL Implementation

In this example you create the 3D geometry by starting with two 2D work planes. The 
first one views the geometry from above, and the second does so from the side. You create 
cross sections on the work planes, which you then extrude into 3D. As the final step you 
create the resistor beam geometry as the intersection of the extruded objects. You can also 
skip the step-by-step instructions for the geometry creation and import the ready-made 
geometry directly from the Application Libraries.

By using the Joule Heating and Thermal Expansion predefined multiphysics interface 
you automatically add the equations for three physics including the necessary multiphysics 
couplings. In this case the physics equations describe the current and heat conduction and 
structural mechanics problems. The interface also provides suitable defaults for the solver.

Application Library path: MEMS_Module/Actuators/microresistor_beam

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>

Joule Heating and Thermal Expansion.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Bézier Polygon 1 (b1)
1 On the Work Plane toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 2, set xw to 5 and yw to 1.5.

5 Find the Added segments subsection. Click Add Linear.

6 Find the Control points subsection. In row 2, set xw to 18.

7 Find the Added segments subsection. Click Add Linear.

8 Find the Control points subsection. In row 2, set xw to 23 and yw to 0.

9 Find the Added segments subsection. Click Add Linear.

10 Find the Control points subsection. In row 2, set yw to 4.

11 Find the Added segments subsection. Click Add Linear.

12 Find the Control points subsection. In row 2, set xw to 18 and yw to 2.5.

13 Find the Added segments subsection. Click Add Linear.

14 Find the Control points subsection. In row 2, set xw to 5.

15 Find the Added segments subsection. Click Add Linear.

16 Find the Control points subsection. In row 2, set xw to 0 and yw to 4.

Name Expression Value Description

V0 0.2[V] 0.2 V Applied voltage

T0 323[K] 323 K Heat sink temperature

Text 298[K] 298 K External temperature

k 5[W/(m^2*K)] 5 W/(m²·K) Heat transfer coefficient
6 |  M I C R O R E S I S T O R  B E A M



17 Find the Added segments subsection. Click Add Linear.

18 Find the Control points subsection. Click Close Curve.

19 On the Work Plane toolbar, click Build All.

20 Click the Zoom Extents button on the Graphics toolbar.

Work Plane 1 (wp1)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 
Work Plane 1 (wp1).

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

4 Click Build All Objects.

Distances (µm)

3

7 |  M I C R O R E S I S T O R  B E A M



5 Click the Zoom Extents button on the Graphics toolbar.

Work Plane 2 (wp2)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Face parallel.

4 Find the Planar face subsection. Select the Active toggle button.

5 On the object ext1, select Boundary 6 only.

6 In the Offset in normal direction text field, type -1.5.

7 Select the Reverse normal direction check box.

8 Click Show Work Plane.

Plane Geometry
1 In the Settings window for Plane Geometry, locate the Visualization section.

2 Find the In-plane visualization of 3D geometry subsection. Clear the Intersection (cyan) 
check box.

3 Clear the Coincident entities (blue) check box.

Bézier Polygon 1 (b1)
1 On the Work Plane toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.
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3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set xw to -11.5 and yw to -1.5.

5 In row 2, set xw to -6.3 and yw to -1.5.

6 Find the Added segments subsection. Click Add Linear.

7 Find the Control points subsection. In row 2, set yw to 0.5.

8 Find the Added segments subsection. Click Add Linear.

9 Find the Control points subsection. In row 2, set xw to 6.3.

10 Find the Added segments subsection. Click Add Linear.

11 Find the Control points subsection. In row 2, set yw to -1.5.

12 Find the Added segments subsection. Click Add Linear.

13 Find the Control points subsection. In row 2, set xw to 11.5.

14 Find the Added segments subsection. Click Add Linear.

15 Find the Control points subsection. In row 2, set xw to 6.5 and yw to 1.5.

16 Find the Added segments subsection. Click Add Linear.

17 Find the Control points subsection. In row 2, set xw to -6.5.

18 Find the Added segments subsection. Click Add Linear.

19 Find the Control points subsection. Click Close Curve.

20 Click the Zoom Extents button on the Graphics toolbar.

Fillet 1 (fil1)
1 On the Work Plane toolbar, click Fillet.

2 On the object b1, select Points 4 and 6 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type 0.3.
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5 On the Work Plane toolbar, click Build All.

Work Plane 2 (wp2)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 
Work Plane 2 (wp2).

Extrude 2 (ext2)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

Distances (µm)

4
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4 Click Build All Objects.

Intersection 1 (int1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Intersection.

2 Click in the Graphics window and then press Ctrl+A to select both objects.

3 In the Settings window for Intersection, click Build All Objects.

Form Union (fin)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Form Union (fin) and choose Build Selected.

The model geometry is now complete.

D E F I N I T I O N S

Add a set of selections that you can use later when applying boundary conditions.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Model Builder window, right-click Explicit 1 and choose Rename.

3 In the Rename Explicit dialog box, type connector1 in the New label text field.

4 Click OK.

5 In the Settings window for Explicit, locate the Input Entities section.

6 From the Geometric entity level list, choose Boundary.
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7 Select Boundary 1 only.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Model Builder window, right-click Explicit 2 and choose Rename.

3 In the Rename Explicit dialog box, type connector2 in the New label text field.

4 Click OK.

5 In the Settings window for Explicit, locate the Input Entities section.

6 From the Geometric entity level list, choose Boundary.

7 Select Boundary 13 only.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Model Builder window, right-click Explicit 3 and choose Rename.

3 In the Rename Explicit dialog box, type connectors in the New label text field.

4 Click OK.

5 In the Settings window for Explicit, locate the Input Entities section.

6 From the Geometric entity level list, choose Boundary.

7 Select Boundaries 1 and 13 only.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Metals>Cu - Copper.

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Cu - Copper (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Cu -

Copper (mat1).

2 In the Settings window for Material, locate the Material Contents section.
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3 In the table, enter the following settings:

4 Click to expand the Material properties section. Locate the Material Properties section. 
In the Material properties tree, select Electromagnetic Models>Linearized Resistivity>

Reference resistivity (rho0).

5 Click Add to Material.

6 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R I C  C U R R E N T S  ( E C )

Current Conservation 1
1 In the Model Builder window, under Component 1 (comp1)>Electric Currents (ec) click 

Current Conservation 1.

2 In the Settings window for Current Conservation, locate the Conduction Current section.

3 From the σ list, choose Linearized resistivity.

Before solving the two-way coupled model with a temperature-dependent resistivity, 
use a constant resistivity for later comparison:

4 From the α list, choose User defined. Keep the default zero value for α.

Ground 1
1 In the Model Builder window, right-click Electric Currents (ec) and choose Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 From the Selection list, choose connector2.

Electric Potential 1
1 Right-click Electric Currents (ec) and choose Electric Potential.

2 In the Settings window for Electric Potential, locate the Electric Potential section.

3 In the V0 text field, type V0.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic

Property Name Value Unit Property group

Reference resistivity rho0 1.72e-8[ohm*m] Ω·m Linearized resistivity

Resistivity temperature 
coefficient

alpha 0.0039[1/K] 1/K Linearized resistivity

Reference temperature Tref 293[K] K Linearized resistivity
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4 Locate the Boundary Selection section. From the Selection list, choose connector1.

M U L T I P H Y S I C S

1 In the Model Builder window, under Component 1 (comp1)>Multiphysics click 
Thermal Expansion 1 (te1).

2 In the Settings window for Thermal Expansion, locate the Thermal Expansion Properties 
section.

3 In the Tref text field, type Text.

H E A T  TR A N S F E R  I N  S O L I D S  ( H T )

On the Physics toolbar, click Electric Currents (ec) and choose Heat Transfer in Solids (ht).

Initial Values 1
1 In the Model Builder window, under Component 1 (comp1)>Heat Transfer in Solids (ht) 

click Initial Values 1.

2 In the Settings window for Initial Values, type T0 in the T text field.

Heat Flux 1
1 In the Model Builder window, right-click Heat Transfer in Solids (ht) and choose 

Heat Flux.

2 In the Settings window for Heat Flux, locate the Boundary Selection section.

3 From the Selection list, choose All boundaries.

Select all boundaries for simplicity; next you will add a node that overrides this 
boundary condition for the connectors.

4 Locate the Heat Flux section. Click the Convective heat flux button.

5 In the h text field, type k.

6 In the Text text field, type Text.

Temperature 1
1 Right-click Heat Transfer in Solids (ht) and choose Temperature.

2 In the Settings window for Temperature, locate the Temperature section.

3 In the T0 text field, type T0.

4 Locate the Boundary Selection section. From the Selection list, choose connectors.
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S O L I D  M E C H A N I C S  ( S O L I D )

Fixed Constraint 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Solid Mechanics (solid) and choose Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose connectors.

M E S H  1

Size
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Tetrahedral.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Finer.

4 In the Model Builder window, click Mesh 1.

5 In the Settings window for Mesh, click Build All.

S T U D Y  1

You can use the default solver settings for this model.

1 On the Home toolbar, click Compute.

R E S U L T S

Stress (solid)
The first default plot presents a surface plot of the von Mises stress. Modify it to show the 
displacement magnitude.

1 In the Model Builder window, right-click Stress (solid) and choose Rename.

2 In the Rename 3D Plot Group dialog box, type Displacement - Study 1 in the 
New label text field.

3 Click OK.

Surface 1
1 In the Model Builder window, expand the Results>Displacement - Study 1 node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.
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3 Locate the Expression section. From the Unit list, choose nm.

4 On the Displacement - Study 1 toolbar, click Plot.

As the color legend shows, the maximum displacement is roughly 88 nm with a constant 
resistivity.
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Temperature (ht)
The second default surface plot shows the temperature field. Note the maximum 
temperature of roughly 1048 K.

Now restore the temperature-dependence of the resistivity that you temporarily disabled 
and then add a new study and solve the model again.

E L E C T R I C  C U R R E N T S  ( E C )

On the Physics toolbar, click Solid Mechanics (solid) and choose Electric Currents (ec).

Current Conservation 1
1 In the Model Builder window, under Component 1 (comp1)>Electric Currents (ec) click 

Current Conservation 1.

2 In the Settings window for Current Conservation, locate the Conduction Current section.

3 From the α list, choose From material.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.
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S T U D Y  2

Step 1: Stationary
On the Home toolbar, click Compute.

R E S U L T S

Temperature (ht) 1
As you can see from the plot, using the more realistic material model with a temperature-
dependent resistivity has a significant effect on the solution. The maximum temperature is 
now almost 340 K lower.

Stress (solid)
1 In the Model Builder window, under Results right-click Stress (solid) and choose Rename.

2 In the Rename 3D Plot Group dialog box, type Displacement - Study 2 in the 
New label text field.

3 Click OK.

Surface 1
1 In the Model Builder window, expand the Results>Displacement - Study 2 node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.

3 Locate the Expression section. From the Unit list, choose nm.

4 On the Displacement - Study 2 toolbar, click Plot.

Similarly, the maximum displacement has been reduced from 88 nm to around 50 nm.
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Introduction

This example involves a static 2D axisymmetric analysis of a piezoelectric actuator using 
the Piezoelectric Devices multiphysics interface. It models a radially polarized piezoelectric 
tube, as described by S. Peelamedu and co-authors (Ref. 1). An application area where 
radially polarized tubes are employed is in nozzles for fluid control in inkjet printers.

Model Definition

G E O M E T R Y

The tube has a height of 0.62 mm and an inner and outer radius of 0.38 mm and 
0.62 mm, respectively. It is represented in an axisymmetric geometry by a single off-axis 
rectangle, as shown in Figure 1.

Figure 1: The axisymmetric geometry. Length units on x- and y-axes are shown in μm.

B O U N D A R Y  C O N D I T I O N S

The model studies two cases distinguished by different boundary conditions. Case 1 
represents the direct piezoelectric effect, and Case 2 represents the inverse piezoelectric 
effect.
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Case 1—Direct Piezoelectric Effect:

• Structural mechanics boundary condition—constrain the bottom surface from moving 
axially (in the z direction), but also add an internal fluid pressure of 0.1 MPa.

• Electrostatics boundary condition—ground the inner and outer surfaces.

Case 2—Inverse Piezoelectric Effect:

• Structural mechanics boundary condition—constrain the bottom surface from moving 
axially (in the z-direction).

• Electrostatics boundary condition—apply a 1 V potential difference between the tube’s 
inner and outer surfaces.

M A T E R I A L  O R I E N T A T I O N

COMSOL’s material library data is entered in a form which assumes that the crystal 
polarization is aligned with the global co-ordinate z axis. For the radially polarized case 
treated in this model, the orientation must be rotated so that the material polarization 
direction is aligned with the r direction (radially polarized). To do so, specify the co-
ordinate system in the Piezoelectric Material feature. By selecting the co-ordinate system 
as the predefined zx-plane system, you rotate the material so that its z direction is aligned 
with the r direction of the model, and the material’s x direction is aligned with the model’s 
z direction.

The piezoceramic material in this example (PZT-5H) is a transversely isotropic material, 
which is a special class of orthotropic materials. Such a material has the same properties in 
one plane (isotropic behavior) and different properties in the direction normal to this 
plane. Thus you can use either the zx-plane material orientation or the zy-plane material 
orientation; both give the same solution.

Results and Discussion

Figure 2 shows the radial displacement due to the applied pressure in Case 1, and Figure 3 
shows the corresponding induced electric potential. Both the radial displacement and 
potential are shown along a cut line 300 μm above the base of the tube in Figure 4 and 
Figure 5, receptively.
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Figure 2: Deformed shape and radial displacement due to an internal pressure of 0.1 MPa 
(case 1 —the direct piezoelectric effect).

Figure 3: Induced electric potential within the deformed tube due to an internal pressure of 
0.1 MPa (case 1 —the direct piezoelectric effect).
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Figure 4: Radial displacement as a function of r-coordinate at a height of 300 μm above the 
base of the tube. The results are for Case 1—the direct piezoelectric effect. 

Figure 5: Electric potential as a function of r-coordinate at a height of 300 μm above the base 
of the tube. The results are for Case 1—the direct piezoelectric effect.
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Figure 6: Deformed shape and radial displacement of the piezoceramic-tube actuator due to 
the radial electric field (Case 2—Inverse Piezoelectric Effect).

Figure 7: Electric potential applied to the tube to induce the displacements shown in Figure 6 
(Case 2—Inverse Piezoelectric Effect).
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Figure 8: Radial displacement as a function of r-coordinate at a height of 300 μm above the 
base of the tube. The results are for Case 2—the inverse piezoelectric effect.

Figure 9: Electric potential as a function of r-coordinate at a height of 300 μm above the base 
of the tube. The results are for Case 2—the inverse piezoelectric effect.
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Figure 6 shows the radial displacement resulting from the applied potential shown in 
Figure 7. The radial displacement and potential are shown along a cut line 300 μm above 
the base of the tube in Figure 8 and Figure 9, respectively.

These results show good agreement with those from S. Peelamedu (Ref. 1).

Reference

1. S.M. Peelamedu, C.B. Kosaraju, R.V. Dukkipati and N.G. Naganathan, “Numerical 
Approach for Axisymmetric Piezoceramic Geometries towards Fluid Control Applications,
” Proceedings of the Institution of Mechanical Engineers, Part I: J. Systems and Control 
Engineering, vol. 214, no. 2, pp. 87–97, 2000.

Application Library path: MEMS_Module/Piezoelectric_Devices/
piezoceramic_tube

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.
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3 From the Length unit list, choose µm.

Create the tube by adding an off-axis rectangle in the axisymmetric geometry.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 240.

4 In the Height text field, type 620.

5 Locate the Position section. In the r text field, type 380.

6 Click Build All Objects.

Add a PZT 5H to the model.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Piezoelectric>Lead Zirconate Titanate (PZT-5H).

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Material to close the Add Material window.

S O L I D  M E C H A N I C S  ( S O L I D )

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.

2 In the Settings window for Piezoelectric Material, locate the Coordinate System Selection 
section.

3 From the Coordinate system list, choose Material ZX-Plane System (comp1_zx_sys).

By selecting the material orientation as the zx-plane, you rotate the material so that its 
z direction is aligned with the r direction of the model, and the material’s x direction is 
aligned with the model’s z direction.

This example comprises two studies: the direct effect and inverse effect. All loadings for 
both studies are defined together and then a selection of relevant features will be done 
in the study settings.

Add a pressure follower load to the inner surface of the cylinder.
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Boundary Load 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Boundary Load.

2 Select Boundary 1 only.

3 In the Settings window for Boundary Load, locate the Force section.

4 From the Load type list, choose Pressure.

5 In the p text field, type 0.1[MPa].

Constrain the lower surface of the tube with a roller boundary condition.

Roller 1
1 Right-click Solid Mechanics (solid) and choose Roller.

2 Select Boundary 2 only.

E L E C T R O S T A T I C S  ( E S )

Ground both the inner and outer surfaces of the cylinder.

Ground 1
1 In the Model Builder window, under Component 1 (comp1) right-click Electrostatics (es) 

and choose Ground.

2 Select Boundaries 1 and 4 only.

Add an electric potential feature on the outer boundary. This will over-ride the existing 
Ground feature.

Electric Potential 1
1 In the Model Builder window, right-click Electrostatics (es) and choose Electric Potential.

2 Select Boundary 4 only.

3 In the Settings window for Electric Potential, locate the Electric Potential section.

4 In the V0 text field, type 1.

M E S H  1

Create a mapped mesh.

Mapped 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Mapped.

2 In the Settings window for Mapped, click Build All.
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S T U D Y  1

The first study simulates the direct effect. All mechanical loads are kept and the electric 
potential feature is disabled in solver settings. It is automatically replaced by the ground 
feature that was previously overridden.

Step 1: Stationary
1 In the Model Builder window, under Study 1 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 Select the Modify physics tree and variables for study step check box.

4 In the Physics and variables selection tree, select Component 1 (comp1)>

Electrostatics (es)>Electric Potential 1.

5 Click Disable.

6 On the Home toolbar, click Compute.

R E S U L T S

Stress (solid)
The default plot groups show stress in the tube and the induced electric potential. Adapt 
these for comparison with . First replace stress plot by radial displacement.

1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 2D Plot Group, type Radial Displacement (Direct 
Effect) in the Label text field.

Surface 1
1 In the Model Builder window, expand the Results>Radial Displacement (Direct Effect) 

node, then click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>u - Displacement field,

R component.

3 On the Radial Displacement (Direct Effect) toolbar, click Plot.

Stress, 3D (solid)
1 In the Model Builder window, under Results click Stress, 3D (solid).

2 In the Settings window for 3D Plot Group, type Stress, 3D (Direct Effect) in the 
Label text field.
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Electric Potential (es)
1 In the Model Builder window, under Results click Electric Potential (es).

2 In the Settings window for 2D Plot Group, type Electric Potential (Direct 
Effect) in the Label text field.

Electric Potential, Revolved Geometry (es)
Change the data set of the potential plot in order to see a 3D cut view of the potential.

1 In the Model Builder window, under Results click Electric Potential,

Revolved Geometry (es).

2 In the Settings window for 3D Plot Group, type Electric Potential, 3D (Direct 
Effect) in the Label text field.

3 Locate the Data section. From the Data set list, choose Revolution 2D 1.

4 On the Electric Potential, 3D (Direct Effect) toolbar, click Plot.

Data Sets
Create a cross section through the geometry to use for line plots of the electric potential 
and displacement.

Cut Line 2D 1
1 On the Results toolbar, click Cut Line 2D.

2 In the Settings window for Cut Line 2D, locate the Line Data section.

3 In row Point 1, set r to 380 and z to 300.

4 In row Point 2, set r to 620 and z to 300.

Visualize the cross section line.

5 Click Plot.

Add line plots of the radial displacement and the potential along the cross section.

1D Plot Group 5
1 On the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Radial Displacement, cut (Direct 
Effect) in the Label text field.

3 Locate the Data section. From the Data set list, choose Cut Line 2D 1.

Line Graph 1
1 Right-click Radial Displacement, cut (Direct Effect) and choose Line Graph.

2 In the Model Builder window, click Line Graph 1.
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3 In the Settings window for Line Graph, click Replace Expression in the upper-right corner 
of the y-axis data section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>u - Displacement field,

R component.

4 Locate the y-Axis Data section. From the Unit list, choose nm.

5 Locate the x-Axis Data section. From the Parameter list, choose Expression.

6 In the Expression text field, type r.

7 On the Radial Displacement, cut (Direct Effect) toolbar, click Plot.

Radial Displacement, cut (Direct Effect) 1
1 In the Model Builder window, under Results right-click Radial Displacement,

cut (Direct Effect) and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Voltage, Cut (Direct Effect) in 
the Label text field.

Line Graph 1
1 In the Model Builder window, expand the Results>Voltage, Cut (Direct Effect) node, then 

click Line Graph 1.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type abs(V).

4 On the Voltage, Cut (Direct Effect) toolbar, click Plot.

Finally add a new study to compute the results for the inverse effect.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

The second study simulates the inverse effect. All electrical loads are kept and the pressure 
load feature is disabled in solver settings. It is automatically replaced by the Free boundary 
feature that was previously overridden.

Step 1: Stationary
1 In the Model Builder window, under Study 2 click Step 1: Stationary.
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2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 Select the Modify physics tree and variables for study step check box.

4 In the Physics and variables selection tree, select Component 1 (comp1)>

Solid Mechanics (solid)>Boundary Load 1.

5 Click Disable.

6 On the Home toolbar, click Compute.

R E S U L T S

Stress (solid)
1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 2D Plot Group, type Radial Displacement (Inverse 
Effect) in the Label text field.

Surface 1
1 In the Model Builder window, expand the Results>Radial Displacement (Inverse Effect) 

node, then click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>u - Displacement field,

R component.

3 On the Radial Displacement (Inverse Effect) toolbar, click Plot.

Stress, 3D (solid)
1 In the Model Builder window, under Results click Stress, 3D (solid).

2 In the Settings window for 3D Plot Group, type Stress, 3D (Inverse Effect) in the 
Label text field.

Electric Potential (es)
1 In the Model Builder window, under Results click Electric Potential (es).

2 In the Settings window for 2D Plot Group, type Electric Potential (Inverse 
Effect) in the Label text field.

Electric Potential, Revolved Geometry (es)
1 In the Model Builder window, under Results click Electric Potential,

Revolved Geometry (es).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Revolution 2D 3.
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4 In the Label text field, type Electric Potential, 3D (Inverse Effect).

5 On the Electric Potential, 3D (Inverse Effect) toolbar, click Plot.

Create a second Cut Line 2D for the new solution.

Cut Line 2D 2
1 In the Model Builder window, under Results>Data Sets right-click Cut Line 2D 1 and 

choose Duplicate.

2 In the Settings window for Cut Line 2D, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Radial Displacement, cut (Direct Effect) 1
1 In the Model Builder window, under Results right-click Radial Displacement,

cut (Direct Effect) and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Radial Displacement, cut (Inverse 
Effect) in the Label text field.

3 Locate the Data section. From the Data set list, choose Cut Line 2D 2.

4 On the Radial Displacement, cut (Inverse Effect) toolbar, click Plot.

Voltage, Cut (Direct Effect) 1
1 In the Model Builder window, under Results right-click Voltage, Cut (Direct Effect) and 

choose Duplicate.

2 In the Settings window for 1D Plot Group, type Voltage, Cut (Inverse Effect) in 
the Label text field.

3 Locate the Data section. From the Data set list, choose Cut Line 2D 2.

4 On the Voltage, Cut (Inverse Effect) toolbar, click Plot.
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Introduction

Piezoelectric valves are frequently employed in medical and laboratory applications. They 
have a number of advantages over competing technologies, including minimal heat 
dissipation, quiet operation, energy efficiency, durability, low weight and fast response 
times. These valves typically consist of a seal that is pushed up against an opening to close 
the valve, or moved away from the opening to open the valve, by a piezoelectric actuator. 
The actuator itself often has a complex internal structure, with stacked layers of 
piezoelectric separated by thin conducting layers that are connected together in such a way 
that the applied field leads to a large deformation.

This model shows how to model a piezoelectric valve in COMSOL. The valve is actuated 
by a stacked piezoelectric bimorph disc actuator, which compresses a hyper-elastic seal 
against the valve opening to shut off the flow. The detailed construction and operation of 
the stacked actuator is considered in the model.

Note: This application requires the Nonlinear Structural Materials Module.

Model Definition

Figure 1 shows both an axisymmetric slice through the geometry and a 3D rendering of 
the geometry. In this simple valve design a disc actuator compresses a hyperelastic seal 
directly onto an annular opening in a stainless steal support structure. The construction of 
the actuator itself is illustrated in Figure 2. The outer edge of the disc annulus is clamped 
to a stainless steel base and supporting structure. When a voltage is applied to the actuator 
the disc bends causing a vertical motion of the central opening of the annular actuator. 
With an appropriate polarity the opening moves downward, towards an annular opening 
in the base (supported at regular intervals by struts not included in the model). As the 
actuator moves towards the opening a hyperelastic seal is compressed against a mating 
structure, sealing up the opening. Within the model, the contact between the seal and the 
mating structure is modeled in detail, as is the operation of the actuator.
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Figure 1: Axisymmetric model geometry (top) and full 3D geometry (bottom). Key 
components of the geometry are labeled.

Stainless steel base
and support

Piezoelectric actuator

Hyperelastic
seal

Stainless steel
base and support

Through hole

Piezoelectric
actuator

Seal
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Figure 2: Detail of the actuator and seal region, showing the construction of the actuator itself. 
The actuator consists of layers of PZT with metal layers between the various layers. Alternate 
metal layers are connected to ground whilst a voltage is applied to the other layers. Alternate 
layers of PZT are polarized in opposite directions. Two such actuators are stacked in such a 
manner that the applied potential causes contraction of one half of the beam and expansion of 
the other half. This results in a net bending moment acting on the beam.

Results and Discussion

Figure 3 shows the strain in the hyperelastic seal when the applied voltage is 60 V. The 
strain is localized in the vicinity of the contact region. Figure 4 shows the von Mises strain 
in the piezoelectric and its supporting structures at the same applied voltage. The stress is 
maximal in the PZT close to the contact. The potential within the actuator is shown in 
Figure 5. It is clear that the applied potentials match those shown in Figure 2. Finally the 
contact pressure is shown in Figure 6. The maximum pressure is 6×105 Pa on the surface 
of the seal that separates the inlet of the valve from the outlet.

+Z Polarized PZT

Z

R

-Z Polarized PZT

GroundApplied Voltage
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Figure 3: ZZ component of the strain in the vicinity of the contact.

Figure 4: Three-dimensional visualization of the von Mises stress in the valve at an applied 
voltage of 50 V.
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Figure 5: Electric potential inside the actuator in the vicinity of the contact.

Figure 6: Contact pressure as a function of position along the surface of the seal.
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Application Library path: MEMS_Module/Piezoelectric_Devices/
piezoelectric_valve

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

6 Click Done.

For convenience, the device geometry is inserted from an existing file. You can read the 
instructions for creating the geometry in the .

G E O M E T R Y  1

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
piezoelectric_valve_geom_sequence.mph.

3 On the Geometry toolbar, click Build All.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

D E F I N I T I O N S

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 Select Domains 5, 7, 9, 10, 12, 14, 18, 20, 22, 23, 25, 27, 32, 34, 36, 37, 39, 41, 47, 
49, 51, 52, 54, and 56 only.

3 In the Settings window for Explicit, type + Polarized in the Label text field.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type - Polarized in the Label text field.

3 Select Domains 4, 6, 8, 11, 13, 15, 17, 19, 21, 24, 26, 28, 31, 33, 35, 38, 40, 42, 46, 
48, 50, 53, 55, and 57 only.

Union 1
1 On the Definitions toolbar, click Union.

2 In the Settings window for Union, type Piezoelectric in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog box, In the Selections to add list, choose + Polarized and - Polarized.

5 Click OK.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 On the Definitions toolbar, click Explicit.

3 In the Settings window for Explicit, locate the Input Entities section.

4 From the Geometric entity level list, choose Boundary.

5 In the Label text field, type Ground.

6 Select Boundaries 10, 14, 18, 22, 26, 30, 33, 36, 40, 44, 48, 52, 56, 59, 76, 80, 84, 
88, 92, 96, 99, 109, 113, 117, 121, 125, 129, and 133 only.

Explicit 4
1 On the Definitions toolbar, click Explicit.

Name Expression Value Description

V0 50[V] 50 V Applied voltage
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2 In the Settings window for Explicit, type Voltage in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundaries 12, 16, 20, 24, 28, 32, 38, 42, 46, 50, 54, 58, 78, 82, 86, 90, 94, 
98, 111, 115, 119, 123, 127, and 131 only.

Explicit 5
1 In the Model Builder window, under Component 1 (comp1)>Definitions click Explicit 5.

2 In the Settings window for Explicit, type Mapped Mesh Steel in the Label text field.

3 Select Domains 1, 2, 29, 43, and 44 only.

Union 2
1 On the Definitions toolbar, click Union.

2 In the Settings window for Union, locate the Input Entities section.

3 Under Selections to add, click Add.

4 In the Add dialog box, In the Selections to add list, choose Piezoelectric and 
Mapped Mesh Steel.

5 Click OK.

6 In the Settings window for Union, type Mapped Mesh in the Label text field.

Contact Pair 1 (p1)
1 On the Definitions toolbar, click Pairs and choose Contact Pair.

2 Select Boundaries 8, 62, 71, 72, and 150–153 only.

3 In the Settings window for Pair, locate the Destination Boundaries section.

4 Select the Active toggle button.

5 Select Boundaries 61 and 66 only.

Material XZ-Plane System (comp1_xz_sys)
1 In the Model Builder window, under Component 1 (comp1)>Definitions click Material XZ-

Plane System (comp1_xz_sys).

2 In the Settings window for Base Vector System, type +Z Polarized in the Label text 
field.

+Z Polarized 1 (comp1_xz_sys1)
1 Right-click Component 1 (comp1)>Definitions>+Z Polarized and choose Duplicate.

2 In the Settings window for Base Vector System, locate the Settings section.
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3 Find the Base vectors subsection. In the table, enter the following settings:

4 In the Label text field, type -Z Polarized.

S O L I D  M E C H A N I C S  ( S O L I D )

In the Model Builder window, expand the Component 1 (comp1)>Solid Mechanics (solid) 
node.

Piezoelectric Material 2
1 Right-click Solid Mechanics (solid) and choose Material Models>Piezoelectric Material.

2 In the Settings window for Piezoelectric Material, locate the Coordinate System Selection 
section.

3 From the Coordinate system list, choose -Z Polarized (comp1_xz_sys1).

4 Locate the Domain Selection section. From the Selection list, choose - Polarized.

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.

2 In the Settings window for Piezoelectric Material, locate the Domain Selection section.

3 From the Selection list, choose + Polarized.

Hyperelastic Material 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Material Models>Hyperelastic Material.

2 Select Domain 16 only.

3 In the Settings window for Hyperelastic Material, locate the Hyperelastic Material section.

4 From the Material model list, choose Mooney-Rivlin, two parameters.

5 In the κ text field, type 1e4[MPa].

Fixed Constraint 1
1 Right-click Solid Mechanics (solid) and choose Domain Constraints>Fixed Constraint.

2 Select Domains 1, 2, 29, 43, and 44 only.

Contact 1
1 Right-click Solid Mechanics (solid) and choose Pairs>Contact.

r z

x1 1 0

x3 0 -1
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2 In the Settings window for Contact, locate the Pair Selection section.

3 In the Pairs list, select Contact Pair 1 (p1).

E L E C T R O S T A T I C S  ( E S )

1 In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

2 In the Settings window for Electrostatics, locate the Domain Selection section.

3 From the Selection list, choose Piezoelectric.

Terminal 1
1 Right-click Component 1 (comp1)>Electrostatics (es) and choose the boundary 

condition Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.

3 From the Selection list, choose Voltage.

4 Locate the Terminal section. From the Terminal type list, choose Voltage.

5 In the V0 text field, type V0.

Ground 1
1 In the Model Builder window, right-click Electrostatics (es) and choose Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 From the Selection list, choose Ground.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Piezoelectric>Lead Zirconate Titanate (PZT-5H).

4 Click Add to Component 1.

M A T E R I A L S

Lead Zirconate Titanate (PZT-5H) (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Lead Zirconate Titanate (PZT-5H) (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Piezoelectric.

A D D  M A T E R I A L

1 Go to the Add Material window.
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2 In the tree, select Built-In>Steel AISI 4340.

3 Click Add to Component 1.

M A T E R I A L S

Steel AISI 4340 (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Steel AISI 4340 (mat2).

2 Select Domains 1–3, 29, 30, and 43–45 only.

Material 3 (mat3)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Seal in the Label text field.

3 Select Domain 16 only.

4 Locate the Material Contents section. In the table, enter the following settings:

5 On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

Edge 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Edge.

2 Select Boundaries 61, 62, 66, 71, and 150–153 only.

Size 1
1 Right-click Component 1 (comp1)>Mesh 1>Edge 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 Click Clear Selection.

4 Select Boundaries 61 and 66 only.

5 Locate the Element Size section. From the Predefined list, choose Extremely fine.

6 Click the Custom button.

Property Name Value Unit Property group

Density rho 1800[kg/m^3] kg/m³ Basic

Model parameters C10 0.37[MPa] Pa Mooney-Rivlin

Model parameters C01 0.11[MPa] Pa Mooney-Rivlin
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7 Locate the Element Size Parameters section. Select the Maximum element size check box.

8 In the associated text field, type w0/100.

Size 2
1 Right-click Edge 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 Click Clear Selection.

4 Select Boundaries 62, 71, and 150–153 only.

5 Locate the Element Size section. From the Predefined list, choose Extremely fine.

6 Click the Custom button.

7 Locate the Element Size Parameters section. Select the Maximum element size check box.

8 In the associated text field, type w0/50.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extremely fine.

4 Click the Custom button.

5 Locate the Element Size Parameters section. In the Maximum element size text field, type 
w0.

Mapped 1
1 In the Model Builder window, right-click Mesh 1 and choose Mapped.

2 In the Settings window for Mapped, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Mapped Mesh.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Distribution.

2 Select Boundaries 75, 77, 79, 81, 83, 85, 87, 89, 91, 93, 95, and 97 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

Distribution 2
1 Right-click Mapped 1 and choose Distribution.

2 Select Boundaries 36 and 109 only.
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3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 40.

Distribution 3
1 Right-click Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type 1.

4 Select Boundaries 2, 63, 67, and 101 only.

5 In the Model Builder window, right-click Mesh 1 and choose Free Triangular.

6 In the Settings window for Mesh, click Build All.

Compare the resulting mesh with that shown below. Note that there are purposefully 
very few elements in the rigid domains.

S T U D Y  1

Step 1: Stationary
1 In the Settings window for Stationary, click to expand the Study extensions section.

2 Locate the Study Extensions section. Select the Auxiliary sweep check box.

3 Click Add.
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4 In the table, enter the following settings:

5 Click Range.

6 In the Range dialog box, type 0 in the Start text field.

7 In the Step text field, type 5.

8 In the Stop text field, type 60.

9 Click Add.

10 In the Settings window for Stationary, locate the Study Extensions section.

11 In the table, enter the following settings:

When modeling contact both the contact pressure and the auxiliary pressure need to be 
manually scaled. It is good practice to modify the manual scaling of these variables to 
an appropriate value.

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

The contact pressure is expected to be of the order of MPa, so set the scales accordingly.

3 In the Model Builder window, expand the Study 1>Solver Configurations>

Solution 1 (sol1)>Dependent Variables 1 node, then click 
Auxiliary pressure (comp1.solid.pw).

4 In the Settings window for Field, locate the Scaling section.

5 In the Scale text field, type 1e6.

6 In the Model Builder window, under Study 1>Solver Configurations>Solution 1 (sol1)>

Dependent Variables 1 click Contact pressure (comp1.solid.Tn_p1).

7 In the Settings window for Field, locate the Scaling section.

8 In the Scale text field, type 1e6.

9 On the Study toolbar, click Compute.

Parameter name Parameter value list Parameter unit

V0

Parameter name Parameter value list Parameter unit

V0  range(0,5,60) V
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R E S U L T S

2D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Strain (ZZ component) in the Label 
text field.

3 Locate the Plot Settings section. From the Frame list, choose Spatial (r, phi, z).

Surface 1
1 Right-click Strain (ZZ component) and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>Strain>

Strain tensor (material and geometry frames)>solid.eZZ - Strain tensor, ZZ component.

3 Locate the Coloring and Style section. Select the Reverse color table check box.

4 On the Strain (ZZ component) toolbar, click Plot.

Zoom in on the contact region and compare the plot with .

5 Click the Zoom Box button on the Graphics toolbar.

Strain (ZZ component) 1
1 In the Model Builder window, under Results right-click Strain (ZZ component) and choose 

Duplicate.

2 In the Settings window for 2D Plot Group, type Electric Field (Z component) in 
the Label text field.

Surface 1
1 In the Model Builder window, expand the Strain (ZZ component) 1 node, then click 

Results>Electric Field (Z component)>Surface 1.

2 In the Settings window for Surface, click to collapse the Expression section.

3 Click Replace Expression in the upper-right corner of the Expression section. From the 
menu, choose Component 1>Electrostatics>Electric>

Electric field (material and geometry frames)>es.EZ - Electric field, Z component.

4 On the Electric Field (Z component) toolbar, click Plot.

1D Plot Group 7
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Contact Pressure in the Label text 
field.

3 Locate the Data section. From the Parameter selection (V0) list, choose Last.
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Line Graph 1
1 Right-click Contact Pressure and choose Line Graph.

2 Select Boundaries 60, 61, 65, 66, and 73 only.

3 In the Settings window for Line Graph, click Replace Expression in the upper-right corner 
of the y-axis data section. From the menu, choose Component 1>Solid Mechanics>

Contact>solid.Tn - Contact pressure.

4 On the Contact Pressure toolbar, click Plot.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

t0 0.05[mm] 5E-5 m Piezoelectric layer thickness

ID 7[mm] 0.007 m Disc actuator inner diameter

OD 50[mm] 0.05 m Disc actuator outer diameter

n 12 12 Number of layers in actuator

ts 0.2[mm] 2E-4 m Thickness of seal

w0 0.5[mm] 5E-4 m Through hole dimension

w1 ID/2 0.0035 m Clamp region dimension

w2 ID/4 0.00175 m Overall clamp dimension
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G E O M E T R Y  1

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type (OD-ID)/2.

4 In the Height text field, type t0.

5 Locate the Position section. In the r text field, type ID/2.

6 In the z text field, type ts.

7 Click to expand the Layers section. Select the Layers to the left check box.

8 Clear the Layers on bottom check box.

9 In the table, enter the following settings:

Array 1 (arr1)
1 On the Geometry toolbar, click Transforms and choose Array.

2 In the Settings window for Array, locate the Size section.

3 In the z size text field, type n.

4 Locate the Displacement section. In the z text field, type t0.

5 Select the object r1 only.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 3*w0.

4 In the Height text field, type ts.

5 Locate the Position section. In the r text field, type ID/2+0.5*w0.

h0 5*t0*n 0.003 m Base thickness

deltaz 16[um] 1.6E-5 m Contact offset at 0[V]

Layer name Thickness (m)

Layer 1 0.5*w0

Layer 2 3*w0

Name Expression Value Description
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Fillet 1 (fil1)
1 On the Geometry toolbar, click Fillet.

2 On the object r2, select Points 1 and 2 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type ts/3.

Rectangle 3 (r3)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2*w0.

4 In the Height text field, type 2*w0+h0.

5 Locate the Position section. In the r text field, type ID/2-0.5*w0.

6 In the z text field, type -2*w0-deltaz-h0.

Chamfer 1 (cha1)
1 On the Geometry toolbar, click Chamfer.

2 On the object r3, select Point 4 only.

3 In the Settings window for Chamfer, locate the Distance section.

4 In the Distance from vertex text field, type 1.8*w0.

Fillet 2 (fil2)
1 On the Geometry toolbar, click Fillet.

2 On the object cha1, select Points 3 and 5 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type 0.1*w0.

Polygon 1 (pol1)
1 On the Geometry toolbar, click Primitives and choose Polygon.

2 In the Settings window for Polygon, locate the Coordinates section.

3 In the r text field, type ID/2+1.2*w0 ID/2+1.6*w0.

4 In the z text field, type 0 0.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the objects pol1 and fil2 only.

3 In the Settings window for Mirror, locate the Input section.
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4 Select the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the r text field, type ID/2+2*w0.

Rectangle 4 (r4)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type ID/2+1.5*w0.

4 In the Height text field, type h0.

5 Locate the Position section. In the z text field, type -2*w0-deltaz-h0.

Rectangle 5 (r5)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type OD/2+w1-ID/2-2.5*w0.

4 In the Height text field, type h0.

5 Locate the Position section. In the r text field, type ID/2+2.5*w0.

6 In the z text field, type -2*w0-deltaz-h0.

Rectangle 6 (r6)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type w2+w1.

4 In the Height text field, type h0+4*w0+n*t0+deltaz.

5 Locate the Position section. In the r text field, type OD/2-w2.

6 In the z text field, type -2*w0-deltaz-h0.

7 Click Build Selected.
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Introduction

Piezoresistive pressure sensors were some of the first MEMS devices to be commercialized. 
Compared to capacitive pressure sensors, they are simpler to integrate with electronics, 
their response is more linear, and they are inherently shielded from RF noise. They do, 
however, usually require more power during operation, and the fundamental noise limits 
of the sensor are higher than their capacitive counterparts. Historically, piezoresistive 
devices have been dominant in the pressure sensor market.

This example considers the design of the MPX100 series pressure sensors originally 
produced by the semiconductor products division of Motorola Inc. (now Freescale 
Semiconductor Inc.). Although the sensor is no longer in production, a detailed analysis 
of its design is given in Ref. 1, and an archived data sheet is available from Freescale 
Semiconductor Inc. (Ref. 2).

Model Definition

The model consists square membrane with side 1 mm and thickness 20 μm, supported 
around its edges by region 0.1mm wide, which is intended to represent the remainder of 
the wafer. The supporting region is fixed on its underside (representing a connection to 
the thicker handle of the device die). Near to one edge of the membrane an X-shaped 
piezoresistor (or Xducer™)1 and part of its associated interconnects are visible. The 
geometry is shown in Figure 1.

The piezoresistor is assumed to have a uniform p-type dopant density of 1.32×1019 cm−3 
and a thickness of 400 nm. The interconnects are assumed to have the same thickness but 
a dopant density of 1.45×1020 cm−3. Only a part of the interconnects is included in the 
geometry, since their conductivity is sufficiently high that they do not contribute to the 
voltage output of the device (in practice the interconnects would also be thicker in 
addition to having a higher conductivity but this also has little effect on the solution). 

The edges of the die are aligned with the {110} directions of the silicon. The die edges are 
also aligned with the global X and Y axes in the COMSOL model. The piezoresistor is 
oriented at 45 to the die edge, and so lies in the [100] direction of the crystal. In the 

1. Xducer™ is believed to be a trademark of Freescale Semiconductor, Inc. f/k/a Motorola, Inc. Neither
Freescale Semiconductor Inc. nor Motorola, Inc. has in any way provided any sponsorship or endorsement of, nor
do they have any connection or involvement with, COMSOL Multiphysics® software or this model.
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COMSOL model, a coordinate system rotated 45 about the global Z-axis is added to 
define the orientation of the crystal.

Figure 1: Left: Model geometry. Right: Detail showing the piezoresistor geometry.

D E V I C E  P H Y S I C S  A N D  E Q U A T I O N S

The conductivity of the Xducer™ sensor changes when the membrane in its vicinity is 
subject to an applied stress. This effect is known as the piezoresistance effect and is usually 
associated with semiconducting materials. In semiconductors, piezoresistance results from 
the strain-induced alteration of the material’s band structure, and the associated changes 
in carrier mobility and number density. The relation between the electric field, E, and the 
current, J, within a piezoresistor is:

 (1)

where ρ is the resistivity and Δρ is the induced change in the resistivity. In the general case 
both ρ and Δρ are rank 2 tensors (matrices). The change in resistance is related to the 
stress, σ, by the constitutive relationship:

 (2)

where Π is the piezoresistance tensor (SI units: Pa−1Ωm), a material property. Note that 
COMSOL’s definition of Π includes the resistivity in each element of the tensor, rather 
than having a scalar multiple outside of Π (which is possible only for materials with 
isotropic conductivity). Π is in this case a rank-4 tensor; however, it can be represented as 
a matrix if the resistivity and stress are converted to vectors within a reduced subscript 
notation. Within the Voigt notation employed by COMSOL for this purpose, Equation 2 
becomes:

E ρ J⋅ Δρ J⋅+=

Δρ Π σ⋅=
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 (3)

The Δρ vector computed from Equation 3 is assembled into matrix form in the following 
manner in Equation 1:

 (4)

Silicon has cubic symmetry, and as a result the Π matrix can be described in terms of three 
independent constants in the following manner:

For p-type silicon the Π44 constant is two orders of magnitude larger than either the Π11 
or the Π12 coefficients. The Π66 element (which is equal in magnitude to the Π44 element) 
couples the σxy shear stress, with the Δρxy off-diagonal term in the change in resistivity 
matrix. In turn, Δρxy couples a current in the x-direction to an induced electric field in the 
y-direction (and vice versa). This is the principle of the Xducer™ transducer. An applied 
voltage (typically 3 V; see Ref. 2) across the [100] orientated arm of the X produces a 
current (typically 6 mA; see Ref. 2) down this arm. Shear stresses are present in the 
Xducer™ as a result of the pressure induced deformation of the diaphragm in which it is 
implanted. Through the piezoresistance effect, these shear stresses cause an electric field 
or potential gradient transverse to the direction of current flow, in the [010] arm of the X. 
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Across the width of the transducer, the potential gradient sums up to produce an induced 
voltage difference between the [010] arms of the X. According to the device data sheet, 
under normal operating conditions a 60 mV potential difference is generated from a 
100 kPa applied pressure with a 3 V applied bias (Ref. 2). 

The situation is complicated somewhat by the detailed current distribution within the 
device, since the voltage sensing elements increase the width of the current carrying silicon 
wire locally, leading to a “short circuit” effect (Ref. 3) or a spreading out of the current 
into the sense arms of the X.

COMSOL’s Piezoresistivity interfaces solve Equation 3 and an inverse form of 
Equation 4, together with the equations of structural mechanics. In this model the 
Piezoresistivity, Boundary Currents interface is used to model the structural equations 
on the domain level and to solve the electrical equations on a thin layer coincident with a 
boundary in the model geometry.

Results and Discussion

Figure 2 shows the displacement of the diaphragm as a result of a 100 kPa pressure 
difference. At the center of the diaphragm the displacement is 1.2 μm. A simple isotropic 
model for the deform displacement given in Ref. 1 predicts an order of magnitude value 
of 4 μm (assuming a Young’s modulus of 170 GPa and a Poisson’s ratio of 0.06). The 
agreement is reasonable considering the limitations of the analytic model, which is derived 
by a crude variational guess. A more accurate value for the shear stress in local coordinates 
at the midpoint of the diaphragm edge is given in Ref. 1 as:

where P is the applied pressure, L is the length of the diaphragm edge, and H is the 
diaphragm thickness. This equation predicts the magnitude of the local shear stress to be 
35 MPa, in good agreement with the minimum value shown in Figure 3, which is also 
35 MPa. Theoretically the shear stress should be maximal at the midpoint of the edge of 
the diaphragm. Figure 4 shows the shear stress along the edge in the model. This shows a 
maximum magnitude at the center of each of the two edges along which the plot is made, 
but the value of this maximum is less than the maximum stress in the model, in part due 
to the boundary conditions employed on the three dimensional diaphragm. The model: 

σl 12, 0,141 L
H
----- 
  2

P=
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piezoresistive_pressure_sensor_shell.mph shows better agreement with the 
theoretical maximum shear stress along this edge.

Figure 2: Diaphragm displacement as a result of a 100 kPa applied pressure.

Figure 3: Shear stress, shown in the local co-ordinate system of the piezoresistor (rotated 45° 
about the z-axis of the global system). The shear stress is has its highest magnitude close to the 
piezoresistor with a value of approximately -35 MPa.
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Figure 4: Plot of the local shear stress along two edges of the diaphragm.

The output of the model during normal operation shows good agreement with the 
manufacturer’s data sheet, given that the device dimensions and doping levels have been 
guessed. With an applied bias of 3 V a typical operating current of 5.9 mA is obtained 
(compare the current quoted in Ref. 2 of 6 mA). The model produces an output voltage 
of 52 mV, similar to the actual device output of 60 mV quoted in Ref. 2. The detailed 
current and voltage distribution within the Xducer™ is shown in Figure 5. There is clear 
evidence of the current flow “spreading out” into the sense electrodes (which are 
narrower), a phenomena described in Ref. 3 as the “short circuit” effect. The asymmetry 
in the potential, which is induced by the piezoresistive effect, is also apparent in the figure.
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Figure 5: Arrows: Current density, Contours: Electric Potential, for a device driven by a 3 V 
bias with an applied pressure of 100 kPa.
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Application Library path: MEMS_Module/Sensors/
piezoresistive_pressure_sensor

Modeling Instructions

From the File menu, choose New.
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N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Piezoresistivity>Piezoresistivity,

Boundary Currents.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

For convenience, the device geometry is inserted from an existing file. You can read the 
instructions for creating the geometry in the .

4 On the Geometry toolbar, click Insert Sequence.

5 Browse to the model’s Application Libraries folder and double-click the file 
piezoresistive_pressure_sensor_geom_sequence.mph.

6 On the Geometry toolbar, click Build All.

D E F I N I T I O N S

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Piezoresistor in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 46 only.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Connections in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundaries 14, 22, 26, 39, 46, 73, 77, 81, and 104 only.
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Box 1
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, type Membrane (Lower Surface) in the Label text 
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type -501.

5 In the x maximum text field, type 501.

6 In the y minimum text field, type -30.

7 In the y maximum text field, type 1000.

8 In the z maximum text field, type -1.

9 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Membrane (Lower Surface) 1
1 Right-click Membrane (Lower Surface) and choose Duplicate.

2 In the Settings window for Box, type Membrane (Upper Surface) in the Label text 
field.

3 Locate the Box Limits section. In the z minimum text field, type -1.

4 In the z maximum text field, type inf.

Box 3
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, type Lower Surface in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the z maximum text field, type -1.

5 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Lower Surface 1
1 Right-click Lower Surface and choose Duplicate.

2 In the Settings window for Box, type Upper Surface in the Label text field.

3 Locate the Box Limits section. In the z minimum text field, type -1.

4 In the z maximum text field, type inf.

Difference 1
1 On the Definitions toolbar, click Difference.
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2 In the Settings window for Difference, type Fixed in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, select Lower Surface in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog box, select Membrane (Lower Surface) in the Selections to subtract list.

10 Click OK.

Union 1
1 On the Definitions toolbar, click Union.

2 In the Settings window for Union, type Electric Currents in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, In the Selections to add list, choose Piezoresistor and Connections.

6 Click OK.

Rotated System 2 (sys2)
1 On the Definitions toolbar, click Coordinate Systems and choose Rotated System.

2 In the Settings window for Rotated System, locate the Settings section.

3 Find the Euler angles (Z-X-Z) subsection. In the α text field, type -45[deg].

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Piezoresistivity>n-Silicon (single-crystal, lightly doped).

4 Click Add to Component 1.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Piezoresistivity>p-Silicon (single-crystal, lightly doped).

3 Click Add to Component 1.
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M A T E R I A L S

p-Silicon (single-crystal, lightly doped) (mat2)
1 On the Home toolbar, click Add Material to close the Add Material window.

2 In the Model Builder window, under Component 1 (comp1)>Materials click p-

Silicon (single-crystal, lightly doped) (mat2).

3 In the Settings window for Material, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Boundary.

5 From the Selection list, choose Electric Currents.

S O L I D  M E C H A N I C S  ( S O L I D )

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Linear Elastic Material 1.

2 In the Settings window for Linear Elastic Material, locate the Coordinate System Selection 
section.

3 From the Coordinate system list, choose Rotated System 2 (sys2).

4 Locate the Linear Elastic Material section. From the Solid model list, choose Anisotropic.

5 From the Material data ordering list, choose Voigt (XX, YY, ZZ, YZ, XZ, XY).

Fixed Constraint 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Fixed.

Boundary Load 1
1 Right-click Solid Mechanics (solid) and choose Boundary Load.

2 In the Settings window for Boundary Load, locate the Boundary Selection section.

3 From the Selection list, choose Membrane (Upper Surface).

4 Locate the Force section. From the Load type list, choose Pressure.

5 In the p text field, type 100[kPa].

E L E C T R I C  C U R R E N T S ,  S H E L L  ( E C S )

1 In the Model Builder window, under Component 1 (comp1) click Electric Currents,

Shell (ecs).
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2 In the Settings window for Electric Currents, Shell, locate the Boundary Selection section.

3 From the Selection list, choose Electric Currents.

4 Locate the Shell Thickness section. In the ds text field, type 400[nm].

Current Conservation 1
1 In the Model Builder window, under Component 1 (comp1)>Electric Currents, Shell (ecs) 

click Current Conservation 1.

2 In the Settings window for Current Conservation, locate the Model Inputs section.

3 In the nd text field, type 1.45e20[1/cm^3].

4 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Rotated System 2 (sys2).

Piezoresistive Material 1
1 In the Model Builder window, under Component 1 (comp1)>Electric Currents, Shell (ecs) 

click Piezoresistive Material 1.

2 In the Settings window for Piezoresistive Material, locate the Boundary Selection section.

3 From the Selection list, choose Piezoresistor.

4 Locate the Model Input section. In the nd text field, type 1.32e19[1/cm^3].

5 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Rotated System 2 (sys2).

Ground 1
1 In the Model Builder window, right-click Electric Currents, Shell (ecs) and choose Ground.

2 Select Edge 195 only.

Terminal 1
1 Right-click Electric Currents, Shell (ecs) and choose Terminal.

2 Select Edges 30 and 35 only.

3 In the Settings window for Terminal, locate the Terminal section.

4 From the Terminal type list, choose Voltage.

5 In the V0 text field, type 3.

Terminal 2
1 Right-click Electric Currents, Shell (ecs) and choose Terminal.

2 Select Edge 20 only.

Terminal 3
1 Right-click Electric Currents, Shell (ecs) and choose Terminal.
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2 Select Edges 201 and 205 only.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Sequence type list, choose User-controlled mesh.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
60.

5 In the Minimum element size text field, type 0.5.

Size 1
1 In the Model Builder window, right-click Mesh 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Piezoresistor.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 In the associated text field, type 2.

8 Select the Minimum element size check box.

9 In the associated text field, type 0.1.

Size 2
1 Right-click Component 1 (comp1)>Mesh 1>Size 1 and choose Duplicate.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Selection list, choose Connections.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
6.

Size 3
1 Right-click Component 1 (comp1)>Mesh 1>Size 2 and choose Duplicate.

2 In the Settings window for Size, locate the Geometric Entity Selection section.
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3 From the Geometric entity level list, choose Edge.

4 Click the Select Box button on the Graphics toolbar.

5 Select Edges 74, 79, 104, 108, 111, 114, 117, 120, 123, 142, 143, and 146 only.

6 Locate the Element Size Parameters section. In the Maximum element size text field, type 
0.4.

Free Tetrahedral 1
In the Model Builder window, under Component 1 (comp1)>Mesh 1 right-click 
Free Tetrahedral 1 and choose Disable.

Free Triangular 1
1 Right-click Mesh 1 and choose More Operations>Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Upper Surface.

Swept 1
1 Right-click Mesh 1 and choose Swept.

2 On the Home toolbar, click Build Mesh.

3 Click Compute.

R E S U L T S

Stress (solid)
The default plots show the von Mises stress and the electric potential. Now create a plot 
of the total displacement to compare with .

3D Plot Group 3
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Displacement in the Label text field.

Surface 1
1 Right-click Displacement and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.

Deformation 1
1 Right-click Results>Displacement>Surface 1 and choose Deformation.
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2 On the Displacement toolbar, click Plot.

Now create a plot of the shear stress in the local coordinate system of the piezoresistor, 
to compare with .

3D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type In-Plane Shear Stress (Local 
Coordinates) in the Label text field.

Surface 1
1 Right-click In-Plane Shear Stress (Local Coordinates) and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>Stress>

Stress tensor, local coordinate system>solid.sl12 - Stress tensor, local coordinate system,

12 component.

3 On the In-Plane Shear Stress (Local Coordinates) toolbar, click Plot.

Create a line plot of the shear stress in the local coordinate system of the piezoresistor, 
to compare with .

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type In-Plane Shear Stress (Local 
Coordinate System) in the Label text field.

Line Graph 1
1 Right-click In-Plane Shear Stress (Local Coordinate System) and choose Line Graph.

2 Select Edges 16 and 213 only.

3 In the Settings window for Line Graph, click Replace Expression in the upper-right corner 
of the y-axis data section. From the menu, choose Component 1>Solid Mechanics>Stress>

Second Piola-Kirchhoff stress, local coordinate system>solid.Sl12 - Second Piola-

Kirchhoff stress, local coordinate system, 12 component.

4 On the In-Plane Shear Stress (Local Coordinate System) toolbar, click Plot.

Now create a plot of the detailed current and voltage distribution, to compare with .

Study 1/Solution 1 (sol1)
In the Model Builder window, expand the Results>Data Sets node.

Selection
1 Right-click Study 1/Solution 1 (sol1) and choose Duplicate.
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2 On the Results toolbar, click Selection.

3 In the Settings window for Selection, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Boundary.

5 From the Selection list, choose Piezoresistor.

6 Click Zoom to Selection.

7 From the Selection list, choose Electric Currents.

3D Plot Group 6
1 On the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Current and Voltage in the Label text 
field.

3 Locate the Data section. From the Data set list, choose Study 1/Solution 1 (2) (sol1).

Contour 1
1 Right-click Current and Voltage and choose Contour.

2 In the Settings window for Contour, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electric Currents, Shell>

Electric>V - Electric potential.

3 Locate the Levels section. In the Total levels text field, type 40.

4 Locate the Coloring and Style section. From the Color table list, choose Thermal.

5 Select the Reverse color table check box.

Arrow Surface 1
1 In the Model Builder window, under Results right-click Current and Voltage and choose 

Arrow Surface.

2 In the Settings window for Arrow Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>Electric Currents,

Shell>Currents and charge>ecs.tJX,...,ecs.tJZ -

Tangential current density (material and geometry frames).

3 Locate the Coloring and Style section. Select the Scale factor check box.

4 In the associated text field, type 2e-9.

5 In the Number of arrows text field, type 3000.

6 From the Color list, choose Blue.

7 On the Current and Voltage toolbar, click Plot.

Finally evaluate the current drawn by the device and the output voltage.
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Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>

Electric Currents, Shell>Terminals>ecs.I0_1 - Terminal current.

3 Click Add Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Electric Currents, Shell>Terminals>ecs.V0_2 -

Terminal voltage.

4 Locate the Expressions section. In the table, enter the following settings:

5 Click Evaluate.

Expression Unit Description

ecs.I0_1 mA Terminal current

ecs.V0_2-ecs.V0_3 mV Device Output
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Introduction

Piezoresistive pressure sensors were some of the first MEMS devices to be commercialized. 
Compared to capacitive pressure sensors, they are simpler to integrate with electronics, 
their response is more linear and they are inherently shielded from RF noise. They do, 
however, usually require more power during operation and the fundamental noise limits 
of the sensor are higher than their capacitive counterparts. Historically, piezoresistive 
devices have been dominant in the pressure sensor market.

This example considers the design of the MPX100 series pressure sensors originally 
manufactured by Motorola Inc. (now Freescale Semiconductor, Inc.). Although the 
sensor is no longer in production, a detailed analysis of its design is given in Ref. 1, and an 
archived data sheet is available from Freescale Semiconductor Inc. (Ref. 2).

Note: This model requires the MEMS Module and the Structural Mechanics Module.

Model Definition

The model consists square membrane with side 1 mm and thickness 20 μm, supported 
around its edges by region 0.1mm wide, which is intended to represent the remainder of 
the wafer. The supporting region is fixed on its underside (representing a connection to 
the thicker handle of the device die). Near to one edge of the membrane an X-shaped 
piezoresistor (or XducerTM)1 and part of its associated interconnects are visible. The 
geometry is shown in Figure 1.

The piezoresistor is assumed to have a uniform p-type dopant density of 1.32×1019 cm-3 
and a thickness of 400 nm. The interconnects are assumed to have the same thickness but 
a dopant density of 1.45×1020 cm-3. Only a part of the interconnects is included in the 
geometry, since their conductivity is sufficiently high that they do not contribute to the 
voltage output of the device (in practice the interconnects would also be thicker in 
addition to having a higher conductivity but this also has little effect on the solution).

The edges of the die are aligned with the {110} directions of the silicon. The die edges are 
also aligned with the global X- and Y-axes in the COMSOL model. The piezoresistor is 
oriented at 45 to the die edge, and so lies in the [100] direction of the crystal. In the 

1. Xducer™ is believed to be a trademark of Freescale Semiconductor, Inc. f/k/a Motorola, Inc. Neither
Freescale Semiconductor, Inc. nor Motorola, Inc. has in any way provided any sponsorship or endorsement of, nor
do they have any connection or involvement with, COMSOL Multiphysics software or this model.
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COMSOL model, a co-ordinate system rotated 45 about the global Z-axis is added to 
define the orientation of the crystal. 

Figure 1: Left: Model geometry. Right: Detail showing the piezoresistor geometry.

D E V I C E  P H Y S I C S  A N D  E Q U A T I O N S

The conductivity of the XducerTM sensor changes when the membrane in its vicinity is 
subject to an applied stress. This effect is known as the piezoresistance effect and is usually 
associated with semiconducting materials. In semiconductors, piezoresistance results from 
the strain induced alteration of the material’s band structure, and the associated changes 
in carrier mobility and number density. The relation between the electric field, E, and the 
current, J, within a piezoresistor is:

 (1)

where ρ is the resistivity and Δρ is the induced change in the resistivity. In the general case 
both ρ and Δρ are rank 2 tensors (matrices). The change in resistance is related to the 
stress, σ, by the constitutive relationship:

 (2)

where Π is the piezoresistance tensor (SI units: Pa-1Ωm), a material property. Note that 
COMSOL’s definition of Π includes the resistivity in each element of the tensor, rather 
than having a scalar multiple outside of Π (which is possible only for materials with 
isotropic conductivity). Π is in this case a rank 4 tensors, however it can be represented as 
a matrix if the resistivity and stress are converted to vectors within a reduced subscript 
notation. Within the Voigt notation employed by COMSOL for this purpose, Equation 2 
becomes:

E ρ J⋅ Δρ J⋅+=

Δρ Π σ⋅=
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 (3)

The Δρ vector computed from Equation 3 is assembled into matrix form in the following 
manner in Equation 1:

 (4)

Silicon has cubic symmetry, and as a result the Π matrix can be described in terms of three 
independent constants in the following manner:

For p-type silicon the Π44 constant is two orders of magnitude larger than either the Π11 
or the Π12 coefficients. The Π66 element (which is equal in magnitude to the Π44 element) 
couples the σxy shear stress, with the Δρxy off-diagonal term in the change in resistivity 
matrix. In turn, Δρxy couples a current in the x-direction to an induced electric field in the 
y-direction (and vice versa). This is the principle of the XducerTM transducer. An applied 
voltage (typically 3 V (Ref. 2)) across the [100] orientated arm of the X produces a current 
(typically 6 mA (Ref. 2)) down this arm. Shear stresses are present in the XducerTM as a 
result of the pressure induced deformation of the diaphragm in which it is implanted. 
Through the piezoresistance effect, these shear stresses cause an electric field or potential 
gradient transverse to the direction of current flow, in the [010] arm of the X. Across the 
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width of the transducer, the potential gradient sums up to produce an induced voltage 
difference between the [010] arms of the X. According to the device data sheet, under 
normal operating conditions a 60 mV potential difference is generated from a 100 kPa 
applied pressure with a 3 V applied bias (Ref. 2)). 

The situation is complicated somewhat by the detailed current distribution within the 
device, since the voltage sensing elements increase the width of the current carrying silicon 
wire locally, leading to a “short circuit” effect (Ref. 3) or a spreading out of the current 
into the sense arms of the X. 

COMSOL’s Piezoresistance interfaces solve Equation 3 and an inverse form of 
Equation 4, together with the equations of structural mechanics. In this model the 
Piezoresistance, Boundary Currents interface is used to model the structural equations 
on the domain level and to solve the electrical equations on a thin layer coincident with a 
boundary in the model geometry.

Results and Discussion

Figure 2 shows the displacement of the diaphragm as a result of a 100 kPa pressure 
difference applied to the membrane, at its center the displacement is 1.2 μm. A simple 
isotropic model for the deform displacement given in Ref. 1 predicts an order of 
magnitude value for the displacement of 4 μm (assuming a Young’s Modulus of 170 GPa 
and a Poisson’s ratio of 0.06). The agreement is reasonable considering the limitations of 
the analytic model, which is derived by a crude variational guess. A more accurate value 
for the shear stress in local co-ordinates at the midpoint of the diaphragm edge is given in 
Ref. 1 as:

where P is the applied pressure, L is the length of the diaphragm edge and H is the 
diaphragm thickness. This equation predicts the magnitude of the local shear stress to be 
35 MPa, in good agreement with the minimum value shown in Figure 3, which is 35 MPa. 
Theoretically the shear stress should be maximal at the mid point of the edge of the 
diaphragm. Figure 4 shows the shear stress along the edge in the model. This shows a 
maximum magnitude of 38 MPa at the center of each of the two edges along which the 
plot is made.

σl 12, 0,141 L
H
----- 
  2

P=
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Figure 2: Diaphragm displacement as a result of a 100 kPa applied pressure.

Figure 3: Shear stress, shown in the local co-ordinate system of the piezoresistor (rotated 45° 
about the z-axis of the global system). The shear stress is has its highest magnitude close to the 
piezoresistor with a value of approximately -35 MPa.
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Figure 4: Plot of the local shear stress along two edges of the diaphragm.

The output of the model during normal operation shows good agreement with the 
manufacturer’s data sheet, given that the device dimensions and doping levels have been 
guessed. With an applied bias of 3 V a typical operating current of 5.9 mA is obtained (c.f. 
the current quoted in Ref. 2 of 6 mA). The model produces an output voltage of 54 mV, 
similar to the actual device output of 60 mV quoted in Ref. 2. The detailed current and 
voltage distribution within the XducerTM is shown in Figure 5. There is clear evidence of 
the current flow ‘spreading out’ into the sense electrodes (which are narrower), a 
phenomena described in Ref. 3 as the ‘short circuit’ effect. The asymmetry in the 
potential, which is induced by the piezoresistive effect, is also apparent in the figure.
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Figure 5: Arrows: Current density, Contours: Electric Potential, for a device driven by a 3 V 
bias with an applied pressure of 100 kPa.
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Application Library path: MEMS_Module/Sensors/
piezoresistive_pressure_sensor_shell

Modeling Instructions

From the File menu, choose New.
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N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Piezoresistivity>Piezoresistivity,

Shell.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

For convenience, the device geometry is inserted from an existing file. You can read the 
instructions for creating the geometry in the .

4 On the Geometry toolbar, click Insert Sequence.

5 Browse to the model’s Application Libraries folder and double-click the file 
piezoresistive_pressure_sensor_shell_geom_sequence.mph.

6 On the Geometry toolbar, click Build All.

The dimensions of this geometry are given in micrometers, so you need to change the 
length unit accordingly.

D E F I N I T I O N S

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Piezoresistor in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 9 only.

Piezoresistor 1
1 Right-click Piezoresistor and choose Duplicate.

2 In the Settings window for Explicit, type Connections in the Label text field.
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3 Locate the Input Entities section. Click Clear Selection.

4 Select Boundaries 3, 5, 6, 8, 13–15, and 18 only.

Box 1
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, type Membrane in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type -501.

5 In the x maximum text field, type 501.

6 In the y minimum text field, type -30.

7 In the y maximum text field, type 1000.

8 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Union 1
1 On the Definitions toolbar, click Union.

2 In the Settings window for Union, type Model boundaries in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, In the Selections to add list, choose Connections and Membrane.

6 Click OK.

Model boundaries 1
1 Right-click Model boundaries and choose Duplicate.

2 In the Settings window for Union, type Electric currents in the Label text field.

3 Locate the Input Entities section. In the Selections to add list, select Membrane.

4 Under Selections to add, click Delete.

5 Under Selections to add, click Add.

6 In the Add dialog box, select Piezoresistor in the Selections to add list.

7 Click OK.

Adjacent 1
1 On the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, type Fixed Edges in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
10 |  P I E Z O R E S I S T I V E  P R E S S U R E  S E N S O R ,  S H E L L



4 Under Input selections, click Add.

5 In the Add dialog box, select Membrane in the Input selections list.

6 Click OK.

7 In the Settings window for Adjacent, locate the Output Entities section.

8 From the Geometric entity level list, choose Adjacent edges.

Difference 1
1 On the Definitions toolbar, click Difference.

2 In the Settings window for Difference, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, select Model boundaries in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog box, select Membrane in the Selections to subtract list.

10 Click OK.

11 In the Settings window for Difference, type Fixed Boundaries in the Label text field.

Rotated System 2 (sys2)
1 On the Definitions toolbar, click Coordinate Systems and choose Rotated System.

2 In the Settings window for Rotated System, locate the Settings section.

3 Find the Euler angles (Z-X-Z) subsection. In the α text field, type -45[deg].

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Piezoresistivity>n-Silicon (single-crystal, lightly doped).

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Piezoresistivity>p-Silicon (single-crystal, lightly doped).

3 Click Add to Component in the window toolbar.
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4 On the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

p-Silicon (single-crystal, lightly doped) (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click p-

Silicon (single-crystal, lightly doped) (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Electric currents.

S H E L L  ( S H E L L )

1 In the Model Builder window, under Component 1 (comp1) click Shell (shell).

2 In the Settings window for Shell, locate the Boundary Selection section.

3 From the Selection list, choose Model boundaries.

4 Locate the Thickness section. In the d text field, type 20[um].

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1)>Shell (shell) click 

Linear Elastic Material 1.

2 In the Settings window for Linear Elastic Material, locate the Linear Elastic Material 
section.

3 From the Solid model list, choose Anisotropic.

4 From the Material data ordering list, choose Voigt (XX, YY, ZZ, YZ, XZ, XY).

Shell Local System 1
1 In the Model Builder window, expand the Linear Elastic Material 1 node, then click 

Shell Local System 1.

2 In the Settings window for Shell Local System, locate the Coordinate System Selection 
section.

3 From the Coordinate system list, choose Rotated System 2 (sys2).

Fixed Constraint 1
1 In the Model Builder window, right-click Shell (shell) and choose Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Edge Selection section.

3 From the Selection list, choose Fixed Edges.

Fixed Constraint 2
1 Right-click Shell (shell) and choose Face Constraints>Fixed Constraint.
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2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Fixed Boundaries.

Face Load 1
1 Right-click Shell (shell) and choose Face and Volume Loads>Face Load.

2 In the Settings window for Face Load, locate the Boundary Selection section.

3 From the Selection list, choose Membrane.

4 Locate the Force section. From the Load type list, choose Pressure.

5 In the p text field, type 100[kPa].

E L E C T R I C  C U R R E N T S ,  S H E L L  ( E C S )

1 In the Model Builder window, under Component 1 (comp1) click Electric Currents,

Shell (ecs).

2 In the Settings window for Electric Currents, Shell, locate the Boundary Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Electric currents.

5 Locate the Shell Thickness section. In the ds text field, type 0.4[um].

Current Conservation 1
1 In the Model Builder window, under Component 1 (comp1)>Electric Currents, Shell (ecs) 

click Current Conservation 1.

2 In the Settings window for Current Conservation, locate the Model Inputs section.

3 In the nd text field, type 1.45e20[1/cm^3].

4 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Rotated System 2 (sys2).

Piezoresistive Material 1
1 In the Model Builder window, under Component 1 (comp1)>Electric Currents, Shell (ecs) 

click Piezoresistive Material 1.

2 In the Settings window for Piezoresistive Material, locate the Boundary Selection section.

3 From the Selection list, choose Piezoresistor.

4 Locate the Model Input section. In the nd text field, type 1.32e19[1/cm^3].

5 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Rotated System 2 (sys2).

Ground 1
1 In the Model Builder window, right-click Electric Currents, Shell (ecs) and choose Ground.
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2 Select Edge 70 only.

Terminal 1
1 Right-click Electric Currents, Shell (ecs) and choose Terminal.

2 Select Edges 11 and 13 only.

3 In the Settings window for Terminal, locate the Terminal section.

4 From the Terminal type list, choose Voltage.

5 In the V0 text field, type 3.

Terminal 2
1 Right-click Electric Currents, Shell (ecs) and choose Terminal.

2 Select Edge 7 only.

Terminal 3
1 Right-click Electric Currents, Shell (ecs) and choose Terminal.

2 Select Edges 72 and 73 only.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Sequence type list, choose User-controlled mesh.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
60.

5 In the Minimum element size text field, type 0.5.

Size 1
1 Right-click Component 1 (comp1)>Mesh 1>Size and choose Duplicate.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Piezoresistor.

5 Locate the Element Size Parameters section. In the Maximum element size text field, type 
2.
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6 In the Minimum element size text field, type 0.1.

Size 2
1 Right-click Component 1 (comp1)>Mesh 1>Size 1 and choose Duplicate.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Selection list, choose Connections.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
6.

Size 3
1 Right-click Component 1 (comp1)>Mesh 1>Size 2 and choose Duplicate.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Edge.

4 Select Edges 27, 29, 38–44, and 51–53 only.

5 Locate the Element Size Parameters section. In the Maximum element size text field, type 
0.4.

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 right-click 

Free Triangular 1 and choose Move Down.

2 Right-click Component 1 (comp1)>Mesh 1>Free Triangular 1 and choose Move Down.

3 Right-click Component 1 (comp1)>Mesh 1>Free Triangular 1 and choose Move Down.

4 On the Home toolbar, click Compute.

R E S U L T S

Stress (shell)
The default plots show the von Mises stress, the undeformed geometry and the electric 
potential. Now create a plot of the total displacement to compare with .

Study 1/Solution 1 (sol1)
In the Model Builder window, expand the Results>Data Sets node.

Selection
1 Right-click Study 1/Solution 1 (sol1) and choose Duplicate.

2 On the Results toolbar, click Selection.

3 In the Settings window for Selection, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Boundary.
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5 From the Selection list, choose Membrane.

3D Plot Group 5
1 On the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Displacement in the Label text field.

3 Locate the Data section. From the Data set list, choose Study 1/Solution 1 (2) (sol1).

Surface 1
1 Right-click Displacement and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Model>Component 1>Shell>

Displacement>shell.disp - Total displacement.

Deformation 1
1 Right-click Results>Displacement>Surface 1 and choose Deformation.

2 On the Displacement toolbar, click Plot.

Now create a plot of the shear stress in the local coordinate system of the piezoresistor, to 
compare with .

3D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type In-Plane Shear Stress (Local 
Coordinates) in the Label text field.

3 Locate the Data section. From the Data set list, choose Study 1/Solution 1 (2) (sol1).

Surface 1
1 Right-click In-Plane Shear Stress (Local Coordinates) and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Model>Component 1>Shell>Stress>

Second Piola-Kirchhoff stress, local coordinate system>shell.Sl12 - Second Piola-

Kirchhoff stress, local coordinate system, 12 component.

In-Plane Shear Stress (Local Coordinates)
In the Model Builder window, under Results click In-Plane Shear Stress (Local Coordinates).

Max/Min Surface 1
1 On the In-Plane Shear Stress (Local Coordinates) toolbar, click More Plots and choose Max/

Min Surface.
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2 In the Settings window for Max/Min Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose shell.Sl12 - Second Piola-

Kirchhoff stress, local coordinate system, 12 component.

3 On the In-Plane Shear Stress (Local Coordinates) toolbar, click Plot.

Create a line plot of the shear stress in the local coordinate system of the piezoresistor, to 
compare with .

1D Plot Group 7
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type In-Plane Shear Stress (Local 
Coordinate System) in the Label text field.

Line Graph 1
1 Right-click In-Plane Shear Stress (Local Coordinate System) and choose Line Graph.

2 Select Edges 6 and 76 only.

3 In the Settings window for Line Graph, click Replace Expression in the upper-right corner 
of the y-axis data section. From the menu, choose Model>Component 1>Shell>Stress>

Second Piola-Kirchhoff stress, local coordinate system>shell.Sl12 - Second Piola-

Kirchhoff stress, local coordinate system, 12 component.

4 On the In-Plane Shear Stress (Local Coordinate System) toolbar, click Plot.

Now create a plot of the detailed current and voltage distribution, to compare with .

Selection
1 In the Model Builder window, under Results>Data Sets right-click Study 1/

Solution 1 (2) (sol1) and choose Duplicate.

2 In the Model Builder window, expand the Study 1/Solution 1 (3) (sol1) node, then click 
Selection.

3 In the Settings window for Selection, locate the Geometric Entity Selection section.

4 From the Selection list, choose Piezoresistor.

5 Click Zoom to Selection.

6 From the Selection list, choose Electric currents.

3D Plot Group 8
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Current and Voltage in the Label text 
field.
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3 Locate the Data section. From the Data set list, choose Study 1/Solution 1 (3) (sol1).

Contour 1
1 Right-click Current and Voltage and choose Contour.

2 In the Settings window for Contour, locate the Expression section.

3 In the Expression text field, type V.

4 Locate the Levels section. In the Total levels text field, type 40.

5 Locate the Coloring and Style section. From the Color table list, choose Thermal.

6 Select the Reverse color table check box.

Arrow Surface 1
1 In the Model Builder window, under Results right-click Current and Voltage and choose 

Arrow Surface.

2 In the Settings window for Arrow Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Model>Component 1>

Electric Currents, Shell>Currents and charge>ecs.tJx,...,ecs.tJz - Tangential current density.

3 Locate the Coloring and Style section. Select the Scale factor check box.

4 In the associated text field, type 2e-9.

5 In the Number of arrows text field, type 3000.

6 From the Color list, choose Blue.

7 On the Current and Voltage toolbar, click Plot.

Finally evaluate the current drawn by the device and the output voltage.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Model>Component 1>

Electric Currents, Shell>Terminals>ecs.I0_1 - Terminal current.

3 Click Add Expression in the upper-right corner of the Expressions section. From the 
menu, choose Model>Component 1>Electric Currents, Shell>Terminals>ecs.V0_2 -

Terminal voltage.

4 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

ecs.I0_1 mA Terminal current

ecs.V0_2-ecs.V0_3 mV Device Output
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5 Click Evaluate.
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Introduction

Almost all surface-micromachined thin films experience residual stress as a result of the 
fabrication process. The most common source of residual stress is thermal stress, which is 
caused by a change in temperature experienced during the fabrication sequence and also 
due to the difference in the coefficient of thermal expansion between the film and the 
substrate. This tutorial shows how to model thermal residual stress due to a temperature 
difference and how it changes the resonant frequency of a thin-film resonator. The 
substrate is not included in the model and it is also assumed that at a given state (which 
indicates a particular step of the process sequence), the temperature is uniform throughout 
the cantilever.

Figure 1: A thin-film resonator with four straight cantilever beam springs.

The tutorial investigates two design choices; a resonator with straight cantilevers 
(Figure 1) and another one with folded cantilevers (Figure 2). For each of the designs, the 
resonant frequency is computed for the cases when the structure is unstressed and when it 
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is subjected to a residual thermal stress. The results obtained are compared with analytical 
solutions.

Figure 2: A thin-film resonator with four folded cantilever beam springs.

Model Definition

This tutorial uses the dimensions and material properties presented in Table 1 and Table 2. 
These values were obtained from the example in Chapter 27.2.5 in Ref. 1. It calculates the 
length of the folded cantilever using the equivalent spring-constant relationship discussed 
later.

This simulation models thermal residual stress using the Thermal Expansion feature in the 
Solid Mechanics interface. The coefficient of thermal expansion is computed by assuming 
a residual stress of 50 MPa in the straight cantilevers, a film deposition temperature of 
605 °C (see Chapter 16.13.2.3 in Ref. 1) and a room temperature of 25 °C.

TABLE 1:  DIMENSIONS OF THE STRUCTURE.

PARAMETER STRAIGHT 
CANTILEVERS

FOLDED CANTILEVERS PLATE

L1 L2 L3

Length 200 μm 170 μm 10 μm 146 μm 250 μm

Width 2 μm 2 μm 2 μm 2 μm 120 μm

Thickness 2.25 μm 2.25 μm 2.25 μm 2.25 μm 2.25 μm
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In order to determine the eigenfrequencies for the case with residual stress, a Prestressed-
Eigenfrequency Study is used. This predefined study type first solves for a static thermal 
expansion problem to compute the residual stress. The solution of this static problem is 
then used to create a shift in the linearization point around which the eigenfrequencies are 
then computed. This approach accurately computes the shift in eigenfrequency by 
accounting for the stress-stiffening effect.

2 D  A N A L Y T I C A L  M O D E L

For a lateral resonator with four cantilever-beam springs, the first in-plane bending 
resonant frequency is given by Equation 1.

 (1)

Here m is the mass of the resonator plate, E is Young’s modulus, L is the length of each 
cantilever arm, b is its width, t is its thickness, and σr is the residual stress in each cantilever. 
In this tutorial, the stress is assumed to be purely because of temperature difference but in 
reality it could be a sum of external stresses, the thermal stress, and intrinsic components. 
Assuming the material is isotropic, the stress is constant through the film thickness, and 
the stress component in the direction normal to the substrate is zero (i.e. plane stress). The 
stress-strain relationship is then given by Equation 2. Here ν is the Poisson’s ratio.

 (2)

The strain comes from ε = αΔT where α is the thermal-expansion coefficient of the 
cantilever material and ΔT is the difference between the deposition temperature and the 
normal operating temperature.

TABLE 2:  MATERIAL PROPERTIES OF THE STRUCTURE.

PROPERTY VALUE

Material polysilicon

Young’s modulus 155 GPa

Poisson’s ratio 0.23

Density 2330 kg/m3

T0 605 oC

T1 25 oC

f0
1

2π
------ 4Etb3

mL3
-----------------

24σrtb
5mL

-------------------+≈

σr
E

1 ν–
------------ 
  ε=
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Thermal residual stress in thin-film spring structures is typically relieved by folding the 
flexures as shown in Figure 2. The flexures relieve axial stress because each is free to expand 
or contract in the axial direction.

The basic folded structure is a U-shaped spring. For springs in series, the equivalent spring 
constant is given by Equation 3.

 (3)

The first and third springs are cantilever beams. The equivalent spring constant for these 
can be computed as k = 3EI/L3, where I is the moment of inertia. For a beam with 
rectangular cross-section and for a rotation about the local y-axis of the beam (the axis 
parallel to the in-plane width), the moment of inertia is I = bt3/12, where b is the width 
and t is the structure’s thickness. You can treat the second spring as a column with a spring 
constant of k = AE/L, where A is the cross-sectional area A = bt. Assuming the spring 
thickness (t) and width (b) are the same everywhere, Equation 3 can be used to find the 
equivalent length of each set of folded springs. The equivalent length can be expressed in 
terms of the out-of-plane thickness (t) and the length of each of the three sections of a 
folded cantilever as shown in Equation 4.

,  (4)

Using the information provided in Table 1 and Table 2 and by using Equation 1 and 
Equation 2, one could compute the resonant frequency for the unstressed and stressed 
thin-film resonator with straight cantilever. Additionally by using Equation 4 along with 
the other information, one could also find the resonant frequency for the unstressed 
resonator with folded cantilevers. Note that the residual stress in the folded cantilevers are 
negligible by design and hence there is no need to compute the resonant frequency for this 
scenario. A summary of the analytical results are shown in Table 3 where they are 
compared with the solution obtained from the 2D plane-stress COMSOL model.

Results and Discussion

Table 3 summarizes the resonant frequencies for the first in-plane bending eigenmode. 
For the 2D COMSOL models this is the lowest (first) eigenmode. As the table shows, the 
resonant frequency for the straight cantilevers increases significantly when the model 
includes residual stress. The model results agree closely with the analytical estimates. As 

1
keq
-------- 1

k1
------ 1

k2
------ 1

k3
------+ +=

Leq
3 L1

3 t2L2
4

------------ L3
3+ +=
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expected, the stress sensitivity of the resonant frequency is reduced by folding the 
cantilevers.

Figure 3 and Figure 4 show the first in-plane bending resonance mode for the unstressed 
resonator with straight and folded cantilevers respectively.

Figure 3: The first in-plane bending eigenmode of the unstressed resonator with straight 
cantilevers.

TABLE 3:  RESONANT FREQUENCIES WITH AND WITHOUT RESIDUAL STRESS.

 STRAIGHT CANTILEVERS  FOLDED CANTILEVERS

ANALYTICAL 2D MODEL ANALYTICAL 2D MODEL

Without stress 14.99 kHz 14.82 kHz 14.97 kHz 14.11 kHz

With residual stress 33.08 kHz 32.05 kHz - 14.22 kHz
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Figure 4: The first in-plane bending eigenmode of the unstressed resonator with folded 
cantilevers.

Figure 5 and Figure 6 show the first in-plane bending resonance mode for the resonator 
with straight and folded cantilevers respectively when they have a residual thermal stress.
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Figure 5: The first in-plane bending eigenmode of the resonator with straight cantilevers 
having residual thermal stress.

Figure 6: The first in-plane bending eigenmode of the resonator with folded cantilevers having 
residual thermal stress.
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Figure 7 and Figure 8 show the residual thermal stress (von Mises stress) distribution in 
the resonator with straight and folded cantilevers respectively when they are cooled from 
605 °C to 25 °C. Figure 7 shows that the residual stress is almost uniform in the straight 
cantilever and is about 49 MPa. The maximum stress is about 55 MPa at the two ends of 
the cantilevers. Figure 8 shows that the folded configuration significantly reduces the 
residual stress build-up. In this case the residual stress is around 2 MPa in most part of the 
cantilever except near the fixed end where it is close to 39 MPa.

Figure 7: Residual thermal stress in the resonator with straight cantilevers when it is cooled 
from 605 °C to 25 °C.
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Figure 8: Residual thermal stress in the resonator with folded cantilevers when it is cooled from 
605 °C to 25 °C.

Reference

1. M. Gad-el-Hak, ed., The MEMS Handbook, CRC Press, London, 2002, ch. 16.12 and 
27.2.5.

Application Library path: MEMS_Module/Actuators/
residual_stress_resonator_2d

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.
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2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Eigenfrequency.

6 Click Done.

Load in the required global parameters. As well as defining some model variables, these 
values are used later for comparison between the model and the analytical solution.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
residual_stress_resonator_2d_parameters.txt.

First create a component to model the resonator with straight cantilevers. For 
convenience, the device geometry will be inserted from an existing file. You can read 
the instructions for creating the geometry in the .

G E O M E T R Y  1

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
residual_stress_resonator_2d_geom_sequence.mph.

3 In the Insert Sequence from File dialog box, click OK.

4 On the Geometry toolbar, click Build All.

Next set up the required solid mechanics physics for the problem by adding a Thermal 

Expansion sub-feature and specifying the fixed boundaries.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, locate the 2D Approximation section.

3 From the list, choose Plane stress.

4 Locate the Thickness section. In the d text field, type thickness.
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Thermal Expansion 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) right-

click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Model Input section.

3 In the T text field, type T0.

4 Locate the Thermal Expansion Properties section. In the Tref text field, type T1.

Fixed Constraint 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 5,9,15,19 in the Selection text field.

5 Click OK.

Now add a new material to the component in order to define the required physical 
properties of the device.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

Configure a suitable mesh, a Mapped mesh is appropriate for this device geometry.

Property Name Value Unit Property 
group

Young’s modulus E E1 Pa Basic

Poisson’s ratio nu nu1 1 Basic

Density rho rho1 kg/m³ Basic

Coefficient of thermal expansion alpha daT 1/K Basic
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M E S H  1

Distribution 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Mapped.

2 Right-click Mapped 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Boundary Selection section.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 6,8,16,18 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 In the Number of elements text field, type 2.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extra fine.

4 Click Build All.

Add a second component to model the resonator with folded cantilevers. As with the 
first component, the device geometry will be imported for convenience.

R O O T

On the Home toolbar, click Component and choose Add Component>2D.

G E O M E T R Y  2

1 In the Model Builder window, under Component 2 (comp2) click Geometry 2.

2 On the Geometry toolbar, click Insert Sequence.

3 Browse to the model’s Application Libraries folder and double-click the file 
residual_stress_resonator_2d_geom_sequence.mph.

4 In the Insert Sequence from File dialog box, select Geometry 2 in the 
Select geometry sequence to insert list.

5 Click OK.

6 On the Geometry toolbar, click Build All.

Now the solid mechanics physics can be configured, as with the first component. In 
addition, a material will be added to define the required properties of the second device 
and an appropriate mesh will be created.
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A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Structural Mechanics>Solid Mechanics (solid).

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Physics to close the Add Physics window.

S O L I D  M E C H A N I C S  2  ( S O L I D 2 )

1 In the Model Builder window, under Component 2 (comp2) click 
Solid Mechanics 2 (solid2).

2 In the Settings window for Solid Mechanics, locate the 2D Approximation section.

3 From the list, choose Plane stress.

4 Locate the Thickness section. In the d text field, type thickness.

Thermal Expansion 1
1 In the Model Builder window, under Component 2 (comp2)>Solid Mechanics 2 (solid2) 

right-click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Model Input section.

3 In the T text field, type T0.

4 Locate the Thermal Expansion Properties section. In the Tref text field, type T1.

Fixed Constraint 1
1 In the Model Builder window, right-click Solid Mechanics 2 (solid2) and choose 

Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 28,30,42,44 in the Selection text field.

5 Click OK.

M A T E R I A L S

Material 2 (mat2)
1 In the Model Builder window, under Component 2 (comp2) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.
14 |  R E S I D U A L  S T R E S S  I N  A  T H I N - F I L M  R E S O N A T O R — 2 D



3 In the table, enter the following settings:

M E S H  2

Distribution 1
1 In the Model Builder window, under Component 2 (comp2) right-click Mesh 2 and choose 

Mapped.

2 Right-click Mapped 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Boundary Selection section.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 4,8,10,11,28,30,38,42,44,45,60,62 in the 
Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 In the Number of elements text field, type 2.

Size
1 In the Model Builder window, under Component 2 (comp2)>Mesh 2 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extra fine.

4 Click Build All.

In order to perform the required computations four studies are required. The first two 
studies, one for each of the components, are for the case of zero-stress. These studies 
require one Eigenfrequency solver step, which will be used to calculate the 
eigenfrequency and mode of each resonator.

S T U D Y  1

1 In the Model Builder window, right-click Study 1 and choose Rename.

Property Name Value Unit Property 
group

Young’s modulus E E1 Pa Basic

Poisson’s ratio nu nu1 1 Basic

Density rho rho1 kg/m³ Basic

Coefficient of thermal expansion alpha daT 1/K Basic
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2 In the Rename Study dialog box, type Study 1 - Straight Cantilever, No Stress 
in the New label text field.

3 Click OK.

S T U D Y  1  -  S T R A I G H T  C A N T I L E V E R ,  N O  S T R E S S

Step 1: Eigenfrequency
1 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 

section.

2 In the table, clear the Solve for check box for the Solid Mechanics 2 (solid2) interface.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Eigenfrequency
1 In the Model Builder window, under Study 2 click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Solid Mechanics (solid) interface.

4 In the Model Builder window, right-click Study 2 and choose Rename.

5 In the Rename Study dialog box, type Study 2 - Folded Cantilever, No Stress 
in the New label text field.

6 Click OK.

The second two studies require two study steps: an initial Stationary study step is used 
to calculate the residual thermal stress due to the difference between the fabrication and 
operation temperatures; the solution to this step is then used to shift the linerization 
point around which the eigenfrequenies are computed in a subsequent Eigenfrequency 
study step. Prestressed Analysis, Eigenfrequency studies are used as this study type 
contains the required study steps by default.
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A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  3

Step 1: Stationary
1 In the Model Builder window, under Study 3 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for the Solid Mechanics 2 (solid2) interface.

Step 2: Eigenfrequency
1 In the Model Builder window, under Study 3 click Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Solid Mechanics 2 (solid2) interface.

4 In the Model Builder window, right-click Study 3 and choose Rename.

5 In the Rename Study dialog box, type Study 3 - Straight Cantilever, Residual 
Stress in the New label text field.

6 Click OK.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  4

Step 1: Stationary
1 In the Model Builder window, under Study 4 click Step 1: Stationary.
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2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for the Solid Mechanics (solid) interface.

Step 2: Eigenfrequency
1 In the Model Builder window, under Study 4 click Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Solid Mechanics (solid) interface.

4 In the Model Builder window, right-click Study 4 and choose Rename.

5 In the Rename Study dialog box, type Study 4 - Folded Cantilever, Residual 
Stress in the New label text field.

6 Click OK.

The studies can now be solved and the results visualized.

S T U D Y  1  -  S T R A I G H T  C A N T I L E V E R ,  N O  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid)
1 In the Model Builder window, under Results right-click Mode Shape (solid) and choose 

Rename.

2 In the Rename 2D Plot Group dialog box, type Straight Cantilever, No Stress in 
the New label text field.

3 Click OK.

4 On the Straight Cantilever, No Stress toolbar, click Plot.

S T U D Y  2  -  F O L D E D  C A N T I L E V E R ,  N O  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid2)
1 In the Model Builder window, under Results right-click Mode Shape (solid2) and choose 

Rename.

2 In the Rename 2D Plot Group dialog box, type Folded Cantilever, No Stress in the 
New label text field.
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3 Click OK.

4 On the Folded Cantilever, No Stress toolbar, click Plot.

S T U D Y  3  -  S T R A I G H T  C A N T I L E V E R ,  R E S I D U A L  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid)
1 In the Model Builder window, under Results right-click Mode Shape (solid) and choose 

Rename.

2 In the Rename 2D Plot Group dialog box, type Straight Cantilever, Residual 
Stress in the New label text field.

3 Click OK.

4 On the Straight Cantilever, Residual Stress toolbar, click Plot.

S T U D Y  4  -  F O L D E D  C A N T I L E V E R ,  R E S I D U A L  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid2)
1 In the Model Builder window, under Results right-click Mode Shape (solid2) and choose 

Rename.

2 In the Rename 2D Plot Group dialog box, type Folded Cantilever, Residual 
Stress in the New label text field.

3 Click OK.

4 On the Folded Cantilever, Residual Stress toolbar, click Plot.

2D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Model Builder window, right-click 2D Plot Group 5 and choose Rename.

3 In the Rename 2D Plot Group dialog box, type Residual Stress in Straight 
Cantilever in the New label text field.

4 Click OK.

5 In the Settings window for 2D Plot Group, locate the Data section.
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6 From the Data set list, choose Study 3 - Straight Cantilever, Residual Stress/

Solution Store 1 (7) (sol4).

Surface 1
1 Right-click Residual Stress in Straight Cantilever and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid.mises.

4 On the Residual Stress in Straight Cantilever toolbar, click Plot.

2D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Model Builder window, right-click 2D Plot Group 6 and choose Rename.

3 In the Rename 2D Plot Group dialog box, type Residual Stress in Folded 
Cantilever in the New label text field.

4 Click OK.

5 In the Settings window for 2D Plot Group, locate the Data section.

6 From the Data set list, choose Study 4 - Folded Cantilever, Residual Stress/

Solution Store 2 (12) (sol6).

Surface 1
1 Right-click Residual Stress in Folded Cantilever and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid2.mises.

4 On the Residual Stress in Folded Cantilever toolbar, click Plot.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 Click Done.
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G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 250.

4 In the Height text field, type 120.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2.

4 In the Height text field, type 200.

5 Locate the Position section. In the x text field, type 100.

6 In the y text field, type 120.

Array 1 (arr1)
1 On the Geometry toolbar, click Transforms and choose Array.

2 Select the object r2 only.

3 In the Settings window for Array, locate the Size section.

4 In the x size text field, type 2.

5 In the y size text field, type 2.

6 Locate the Displacement section. In the x text field, type 48.

7 In the y text field, type -320.

8 Click Build All Objects.

R O O T

On the Home toolbar, click Component and choose Add Component>2D.

G E O M E T R Y  2

1 In the Model Builder window, under Component 2 (comp2) click Geometry 2.

2 In the Settings window for Geometry, locate the Units section.
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3 From the Length unit list, choose µm.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 250.

4 In the Height text field, type 120.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2.

4 In the Height text field, type 172.

5 Locate the Position section. In the x text field, type 100.

6 In the y text field, type 120.

Rectangle 3 (r3)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 12.

4 In the Height text field, type 2.

5 Locate the Position section. In the x text field, type 100.

6 In the y text field, type 290.

Rectangle 4 (r4)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2.

4 In the Height text field, type 148.

5 Locate the Position section. In the x text field, type 110.

6 In the y text field, type 144.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Click the Zoom Extents button on the Graphics toolbar.

3 Select the objects r3, r2, and r4 only.
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4 In the Settings window for Mirror, locate the Input section.

5 Select the Keep input objects check box.

6 Locate the Point on Line of Reflection section. In the x text field, type 125.

Mirror 2 (mir2)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the objects mir1(1), r3, mir1(3), r2, r4, and mir1(2) only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the y text field, type 60.

6 Locate the Normal Vector to Line of Reflection section. In the x text field, type 0.

7 In the y text field, type 1.

8 Click Build All Objects.
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Introduction

Almost all surface-micromachined thin films experience residual stress as a result of the 
fabrication process. The most common source of residual stress is thermal stress, which is 
caused by a change in temperature experienced during the fabrication sequence and also 
due to the difference in the coefficient of thermal expansion between the film and the 
substrate. This tutorial shows how to model thermal residual stress due to a temperature 
difference and how it changes the resonant frequency of a thin-film resonator. The 
substrate is not included in the model and it is also assumed that at a given state (which 
indicates a particular step of the process sequence), the temperature is uniform throughout 
the cantilever.

Figure 1: A thin-film resonator with four straight cantilever beam springs.

The tutorial investigates two design choices; a resonator with straight cantilevers 
(Figure 1) and another one with folded cantilevers (Figure 2). For each of the designs, the 
resonant frequency is computed for the cases when the structure is unstressed and when it 
is subjected to a residual thermal stress. The results obtained from these 3D models can 
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be compared with analytical solutions by referring to the Application Libraries tutorial 
Residual Stress in a Thin-Film Resonator—2D.

Figure 2: A thin-film resonator with four folded cantilever beam springs.

Model Definition

This tutorial uses the dimensions and material properties presented in Table 1 and Table 2. 
These values were obtained from the example in Chapter 27.2.5 in Ref. 1. This simulation 
models thermal residual stress using the Thermal Expansion feature in the Solid Mechanics 
interface. The coefficient of thermal expansion is computed by assuming a residual stress 
of 50 MPa in the straight cantilevers, a film deposition temperature of 605 °C (see 
Chapter 16.13.2.3 in Ref. 1) and a room temperature of 25 °C.

TABLE 1:  DIMENSIONS OF THE STRUCTURE.

PARAMETER STRAIGHT 
CANTILEVERS

FOLDED CANTILEVERS PLATE

L1 L2 L3

Length 200 μm 170 μm 10 μm 146 μm 250 μm

Width 2 μm 2 μm 2 μm 2 μm 120 μm

Thickness 2.25 μm 2.25 μm 2.25 μm 2.25 μm 2.25 μm
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In order to determine the eigenfrequencies for the case with residual stress, a Prestressed-
Eigenfrequency Study is used. This predefined study type first solves for a static thermal 
expansion problem to compute the residual stress. The solution of this static problem is 
then used to create a shift in the linearization point around which the eigenfrequencies are 
then computed. This approach accurately computes the shift in eigenfrequency by 
accounting for the stress-stiffening effect.

Results and Discussion

Table 3 summarizes the resonant frequencies for the first in-plane bending eigenmode. 
The solutions from the 3D models are compared with those obtained from a 2D plane-
stress model available in the Application Libraries tutorial Residual Stress in a Thin-Film 
Resonator—2D. As the table shows, the resonant frequency for the straight cantilevers 
increases significantly when the model includes residual stress. As expected, the stress 
sensitivity of the resonant frequency is reduced by folding the cantilevers. The results from 
the 3D models agree closely with those obtained from the 2D models. This indicates that 
such thin-film resonators can be efficiently modeled using a 2D plane-stress approach.

Note that for the 2D models, the first (lowest) eigenmode is the in-plane bending mode. 
However for the 3D models, the first (lowest) eigenmode is an out-of-plane torsional 
mode that you see in the default plot when you solve the Eigenfrequency study. The 
desired in-plane bending mode is the second eigenmode in the list of computed solutions. 
Hence, the main advantage of the 3D model is in finding any eigenmode where the 
resonator deforms largely in the out-of-plane direction.

TABLE 2:  MATERIAL PROPERTIES OF THE STRUCTURE.

PROPERTY VALUE

Material polysilicon

Young’s modulus 155 GPa

Poisson’s ratio 0.23

Density 2330 kg/m3

T0 605 oC

T1 25 oC

TABLE 3:  RESONANT FREQUENCIES WITH AND WITHOUT RESIDUAL STRESS.

 STRAIGHT CANTILEVERS  FOLDED CANTILEVERS

2D MODEL 3D MODEL 2D MODEL 3D MODEL

Without stress 14.82 kHz 14.91 kHz 14.11 kHz  14.18 kHz

With residual stress 32.05 kHz  32.25 kHz 14.22 kHz  14.29 kHz
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Figure 3 and Figure 4 show the first in-plane bending resonance mode for the unstressed 
resonator with straight and folded cantilevers respectively.

Figure 3: The first in-plane bending eigenmode of the unstressed resonator with straight 
cantilevers.
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Figure 4: The first in-plane bending eigenmode of the unstressed resonator with folded 
cantilevers.

Figure 5 and Figure 7 show the first in-plane bending resonance mode for the resonator 
with straight and folded cantilevers respectively when they have a residual thermal stress.
6 |  R E S I D U A L  S T R E S S  I N  A  T H I N - F I L M  R E S O N A T O R — 3 D



Figure 5: The first in-plane bending eigenmode of the resonator with straight cantilevers 
having residual thermal stress.

Figure 6: Residual thermal stress in the resonator with straight cantilevers when it is cooled 
from 605 °C to 25 °C.
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Figure 6 and Figure 8 show the residual thermal stress (von Mises stress) distribution in 
the resonator with straight and folded cantilevers respectively when they are cooled from 
605 °C to 25 °C. Figure 6 shows that the residual stress is almost uniform in the straight 
cantilever and is about 49 MPa. Figure 8 shows that the folded configuration significantly 
reduces the residual stress build-up. In this case the residual stress is around 2 MPa in most 
part of the cantilever except near the fixed end where it is close to 44 MPa.

Figure 7: The first in-plane bending eigenmode of the resonator with folded cantilevers having 
residual thermal stress.
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Figure 8: Residual thermal stress in the resonator with folded cantilevers when it is cooled from 
605 °C to 25 °C.

Reference

1. M. Gad-el-Hak, ed., The MEMS Handbook, CRC Press, London, 2002, ch. 16.12 and 
27.2.5.

Application Library path: MEMS_Module/Actuators/
residual_stress_resonator_3d

Modeling Instructions.

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.
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2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Eigenfrequency.

6 Click Done.

Load in the required global parameters. As well as defining some model variables, these 
values are used later for comparison between the model and the analytical solution.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
residual_stress_resonator_3d_parameters.txt.

First create a component to model the resonator with straight cantilevers. For 
convenience, the device geometry will be inserted from an existing file. You can read 
the instructions for creating the geometry in the .

G E O M E T R Y  1

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
residual_stress_resonator_3d_geom_sequence.mph.

3 In the Insert Sequence from File dialog box, click OK.

4 On the Geometry toolbar, click Build All.

Next set up the required solid mechanics physics for the problem by adding a Thermal 

Expansion sub-feature and specifying the fixed boundaries.

S O L I D  M E C H A N I C S  ( S O L I D )

Thermal Expansion 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) right-

click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Model Input section.

3 In the T text field, type T0.
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4 Locate the Thermal Expansion Properties section. In the Tref text field, type T1.

Fixed Constraint 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 7,15,21,29 in the Selection text field.

5 Click OK.

Now add a new material to the component in order to define the required physical 
properties of the device.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

Configure a suitable mesh, a Mapped and swept mesh is appropriate for this device 
geometry.

M E S H  1

Mapped 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Mapped.

2 In the Settings window for Mapped, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 4,9,14,23,28 in the Selection text field.

Property Name Value Unit Property 
group

Young’s modulus E E1 Pa Basic

Poisson’s ratio nu nu1 1 Basic

Density rho rho1 kg/m³ Basic

Coefficient of thermal expansion alpha daT 1/K Basic
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5 Click OK.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Edge Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 16,21,44,49 in the Selection text field.

5 Click OK.

6 In the Settings window for Distribution, locate the Distribution section.

7 In the Number of elements text field, type 2.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extra fine.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

5 Click Build All.

Add a second component to model the resonator with folded cantilevers. As with the 
first component, the device geometry will be inserted for convenience.

R O O T

On the Home toolbar, click Component and choose Add Component>3D.

G E O M E T R Y  2

1 In the Model Builder window, under Component 2 (comp2) click Geometry 2.

2 On the Geometry toolbar, click Insert Sequence.

3 Browse to the model’s Application Libraries folder and double-click the file 
residual_stress_resonator_3d_geom_sequence.mph.

4 In the Insert Sequence from File dialog box, select Geometry 2 in the 
Select geometry sequence to insert list.

5 Click OK.
12 |  R E S I D U A L  S T R E S S  I N  A  T H I N - F I L M  R E S O N A T O R — 3 D



6 On the Geometry toolbar, click Build All.

Now the solid mechanics physics can be configured, as with the first component. In 
addition, a material will be added to define the required properties of the second device 
and an appropriate mesh will be created.

A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Structural Mechanics>Solid Mechanics (solid).

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Physics to close the Add Physics window.

S O L I D  M E C H A N I C S  2  ( S O L I D 2 )

Thermal Expansion 1
1 In the Model Builder window, under Component 2 (comp2)>Solid Mechanics 2 (solid2) 

right-click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Model Input section.

3 In the T text field, type T0.

4 Locate the Thermal Expansion Properties section. In the Tref text field, type T1.

Fixed Constraint 1
1 In the Model Builder window, right-click Solid Mechanics 2 (solid2) and choose 

Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 46,48,68,70 in the Selection text field.

5 Click OK.

M A T E R I A L S

Material 2 (mat2)
1 In the Model Builder window, under Component 2 (comp2) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.
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3 In the table, enter the following settings:

M E S H  2

Mapped 1
1 In the Model Builder window, under Component 2 (comp2) right-click Mesh 2 and choose 

More Operations>Mapped.

2 In the Settings window for Mapped, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 4,9,13,18,22,27,36,41,45,50,54,63,67,
72,76,81,88,93,97,102,106 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Component 2 (comp2)>Mesh 2>Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Edge Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 12,21,26,30,73,78,104,113,118,122,161,
166 in the Selection text field.

5 Click OK.

6 In the Settings window for Distribution, locate the Distribution section.

7 In the Number of elements text field, type 2.

Distribution 1
1 In the Model Builder window, right-click Mesh 2 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

Property Name Value Unit Property 
group

Young’s modulus E E1 Pa Basic

Poisson’s ratio nu nu1 1 Basic

Density rho rho1 kg/m³ Basic

Coefficient of thermal expansion alpha daT 1/K Basic
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Size
1 In the Model Builder window, under Component 2 (comp2)>Mesh 2 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Extra fine.

4 Click Build All.

In order to perform the required computations four studies are required. The first two 
studies, one for each of the components, are for the case of zero-stress. These studies 
require one Eigenfrequency solver step, which will be used to calculate the 
eigenfrequency and mode of each resonator.

S T U D Y  1

1 In the Model Builder window, right-click Study 1 and choose Rename.

2 In the Rename Study dialog box, type Study 1 - Straight Cantilever, No Stress 
in the New label text field.

3 Click OK.

S T U D Y  1  -  S T R A I G H T  C A N T I L E V E R ,  N O  S T R E S S

Step 1: Eigenfrequency
1 In the Model Builder window, expand the Study 1 - Straight Cantilever, No Stress node, 

then click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Solid Mechanics 2 (solid2) interface.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Eigenfrequency
1 In the Model Builder window, right-click Study 2 and choose Rename.
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2 In the Rename Study dialog box, type Study 2 - Folded Cantilever, No Stress 
in the New label text field.

3 Click OK.

S T U D Y  2  -  F O L D E D  C A N T I L E V E R ,  N O  S T R E S S

Step 1: Eigenfrequency
1 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 

section.

2 In the table, clear the Solve for check box for the Solid Mechanics (solid) interface.

The second two studies require two study steps: an initial Stationary study step is used 
to calculate the residual thermal stress due to the difference between the fabrication and 
operation temperatures; the solution to this step is then used to shift the linerization 
point around which the eigenfrequenies are computed in a subsequent Eigenfrequency 
study step. Prestressed Analysis, Eigenfrequency studies are used as this study type 
contains the required study steps by default.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  3

Step 1: Stationary
1 In the Model Builder window, right-click Study 3 and choose Rename.

2 In the Rename Study dialog box, type Study 3 - Straight Cantilever, Residual 
Stress in the New label text field.

3 Click OK.

S T U D Y  3  -  S T R A I G H T  C A N T I L E V E R ,  R E S I D U A L  S T R E S S

Step 1: Stationary
1 In the Settings window for Stationary, locate the Physics and Variables Selection section.

2 In the table, clear the Solve for check box for the Solid Mechanics 2 (solid2) interface.
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Step 2: Eigenfrequency
1 In the Model Builder window, under Study 3 - Straight Cantilever, Residual Stress click 

Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Solid Mechanics 2 (solid2) interface.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Prestressed Analysis, Eigenfrequency.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  4

Step 1: Stationary
1 In the Model Builder window, right-click Study 4 and choose Rename.

2 In the Rename Study dialog box, type Study 4 - Folded Cantilever, Residual 
Stress in the New label text field.

3 Click OK.

S T U D Y  4  -  F O L D E D  C A N T I L E V E R ,  R E S I D U A L  S T R E S S

Step 1: Stationary
1 In the Settings window for Stationary, locate the Physics and Variables Selection section.

2 In the table, clear the Solve for check box for the Solid Mechanics (solid) interface.

Step 2: Eigenfrequency
1 In the Model Builder window, under Study 4 - Folded Cantilever, Residual Stress click 

Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Solid Mechanics (solid) interface.

The studies can now be solved and the results visualized.
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S T U D Y  1  -  S T R A I G H T  C A N T I L E V E R ,  N O  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid)
1 In the Model Builder window, under Results right-click Mode Shape (solid) and choose 

Rename.

2 In the Rename 3D Plot Group dialog box, type Straight Cantilever, No Stress in 
the New label text field.

3 Click OK.

4 In the Settings window for 3D Plot Group, locate the Data section.

5 From the Eigenfrequency (Hz) list, choose 1.493E4.

6 On the Straight Cantilever, No Stress toolbar, click Plot.

S T U D Y  2  -  F O L D E D  C A N T I L E V E R ,  N O  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid2)
1 In the Model Builder window, under Results right-click Mode Shape (solid2) and choose 

Rename.

2 In the Rename 3D Plot Group dialog box, type Folded Cantilever, No Stress in the 
New label text field.

3 Click OK.

4 In the Settings window for 3D Plot Group, locate the Data section.

5 From the Eigenfrequency (Hz) list, choose 1.42E4.

6 On the Folded Cantilever, No Stress toolbar, click Plot.

S T U D Y  3  -  S T R A I G H T  C A N T I L E V E R ,  R E S I D U A L  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid)
1 In the Model Builder window, under Results right-click Mode Shape (solid) and choose 

Rename.
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2 In the Rename 3D Plot Group dialog box, type Straight Cantilever, Residual 
Stress in the New label text field.

3 Click OK.

4 In the Settings window for 3D Plot Group, locate the Data section.

5 From the Eigenfrequency (Hz) list, choose 3.229E4.

6 On the Straight Cantilever, Residual Stress toolbar, click Plot.

S T U D Y  4  -  F O L D E D  C A N T I L E V E R ,  R E S I D U A L  S T R E S S

On the Home toolbar, click Compute.

R E S U L T S

Mode Shape (solid2)
1 In the Model Builder window, under Results right-click Mode Shape (solid2) and choose 

Rename.

2 In the Rename 3D Plot Group dialog box, type Folded Cantilever, Residual 
Stress in the New label text field.

3 Click OK.

4 In the Settings window for 3D Plot Group, locate the Data section.

5 From the Eigenfrequency (Hz) list, choose 1.43E4.

6 On the Folded Cantilever, Residual Stress toolbar, click Plot.

3D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Model Builder window, right-click 3D Plot Group 5 and choose Rename.

3 In the Rename 3D Plot Group dialog box, type Residual Stress in Straight 
Cantilever in the New label text field.

4 Click OK.

5 In the Settings window for 3D Plot Group, locate the Data section.

6 From the Data set list, choose Study 3 - Straight Cantilever, Residual Stress/

Solution Store 1 (7) (sol4).

Surface 1
1 Right-click Residual Stress in Straight Cantilever and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid.mises.
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4 On the Residual Stress in Straight Cantilever toolbar, click Plot.

3D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Model Builder window, right-click 3D Plot Group 6 and choose Rename.

3 In the Rename 3D Plot Group dialog box, type Residual Stress in Folded 
Cantilever in the New label text field.

4 Click OK.

5 In the Settings window for 3D Plot Group, locate the Data section.

6 From the Data set list, choose Study 4 - Folded Cantilever, Residual Stress/

Solution Store 2 (12) (sol6).

Surface 1
1 Right-click Residual Stress in Folded Cantilever and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid2.mises.

4 On the Residual Stress in Folded Cantilever toolbar, click Plot.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.
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Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 250.

4 In the Height text field, type 120.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2.

4 In the Height text field, type 200.

5 Locate the Position section. In the xw text field, type 100.

6 In the yw text field, type 120.

Array 1 (arr1)
1 On the Work Plane toolbar, click Transforms and choose Array.

2 Select the object r2 only.

3 In the Settings window for Array, locate the Size section.

4 In the xw size text field, type 2.

5 In the yw size text field, type 2.

6 Locate the Displacement section. In the xw text field, type 48.

7 In the yw text field, type -320.

Plane Geometry
1 On the Work Plane toolbar, click Build All.

2 In the Model Builder window, click Geometry 1.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.
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3 In the table, enter the following settings:

4 Click Build All Objects.

R O O T

On the Home toolbar, click Component and choose Add Component>3D.

G E O M E T R Y  2

1 In the Model Builder window, under Component 2 (comp2) click Geometry 2.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 250.

4 In the Height text field, type 120.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2.

4 In the Height text field, type 172.

5 Locate the Position section. In the xw text field, type 100.

6 In the yw text field, type 120.

Rectangle 3 (r3)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 12.

4 In the Height text field, type 2.

Distances (µm)

2.25
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5 Locate the Position section. In the xw text field, type 100.

6 In the yw text field, type 290.

Rectangle 4 (r4)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2.

4 In the Height text field, type 148.

5 Locate the Position section. In the xw text field, type 110.

6 In the yw text field, type 144.

Mirror 1 (mir1)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 Click the Zoom Extents button on the Graphics toolbar.

3 Select the objects r3, r4, and r2 only.

4 In the Settings window for Mirror, locate the Input section.

5 Select the Keep input objects check box.

6 Locate the Point on Line of Reflection section. In the xw text field, type 125.

Mirror 2 (mir2)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 Select the objects mir1(3), r3, mir1(2), mir1(1), r4, and r2 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the yw text field, type 60.

6 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.

7 In the yw text field, type 1.

8 In the Model Builder window, click Geometry 2.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

Distances (µm)

2.25
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4 Click Build All Objects.
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Introduction

This model analyzes an RF MEMS switch consisting of a thin micromechanical bridge 
suspended over a dielectric layer. A DC voltage greater than the pull-in voltage is applied 
across the switch, causing the bridge to collapse onto the dielectric layer with a resulting 
increase in the capacitance of the device. A penalty based contact force is implemented to 
model the contact forces as the bridge comes into contact with the dielectric.

Model Definition

Figure 1 shows the device geometry. The switch consists of a square polysilicon plate 
suspended 0.9 μm above a 0.1 μm thick thin film of Silicon Nitride (relative dielectric 
constant 7.5). Beneath the substrate is a silicon counter-electrode that is grounded. The 
plate is structurally anchored to the substrate by four rectangular flexures at its corners but 
is electrically isolated from it. Initially a small potential of just 1 mV is applied to the 
polysilicon. This voltage is sufficient to measure the DC capacitance of the device. After 
25 μs the applied voltage is increased by 5 V with a step function that has a rise time of 
10 μs. The applied voltage is greater than the pull-in voltage of the structure and the 
switch pulls down onto the nitride. This process results in an abrupt and significant change 
in the capacitance of the device. Due to the symmetry of the device, it is possible to model 
only a single quadrant of the structure. The electromechanics interface explicitly meshes 
the gap between the polysilicon and the nitride. Since it is not possible to collapse the mesh 
to zero thickness the mesh is compressed into the nitride layer as the structure deforms. 
The nitride layer itself is consequently not represented explicitly within the geometry, but 
instead is represented by means of a spatially varying function for the dielectric constant 
within the gap. The dielectric constant in the gap is represented by a smoothed step 
function. The mid point of the step is chosen to be slightly above the height of the 
dielectric, so that when the polysilicon is in contact with the nitride the dielectric constant 
in the gap takes the value of the nitride dielectric constant for throughout the gap.
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Figure 1: Top: Device geometry showing anchor points and symmetry planes. Bottom: Model 
geometry. Due to symmetry only one quadrant of the device needs to be modeled. 

The contact between the polysilicon and the nitride is handled by an approximate penalty 
or barrier method, as described in Ref. 1. Stiff, nonlinear springs are used to represent the 
surface of the nitride. When the polysilicon is away from the nitride surface these springs 
have low stiffness and consequently have a negligible influence on the deformation. As the 
gap is reduced and approaches a predefined distance the spring becomes much stiffer and 
resists further closure. The contact forces Fc are given by:

where tn is the input estimate of the contact force, en is the penalty stiffness, g is the gap, 
that is, the distance between the polysilicon and the nitride. Note that when this method 

Device Geometry
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is employed it is important to correctly tune the elastic stiffness and the contact force. The 
technique is an approximate one and does not correctly reproduce the details of the 
dynamics of contact. However the model is primarily concerned with estimating the time 
the switch takes to make contact and with computing the initial and final capacitance of 
the switch.

Results and Discussion

Figure 2 shows the spatial dependence of the total displacement when the device is pulled 
in. Most of the structure is in contact with the nitride and the bending occurs primarily in 
the flexures and in the vicinity of their attachment points. The form of the contact 
pressure, shown in Figure 3, is consistent with this observation and it is interesting to note 
that the largest forces occur in the vicinity of the flexures.

Figure 2: Displacement of the polysilicon when pulled in. Most of the polysilicon structure is in 
contact with the silicon nitride with a displacement of 0.9 μm.
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Figure 3: Contact forces acting on the polysilicon when the structure is pulled in.

Figure 4 shows the displacement of the switch as a function of time. The switch takes 
significantly longer to close than the timescale on which the voltage changes, primarily due 
to its inertia. Figure 5 shows the capacitance of the device as a function of time. The 
capacitance increases by a factor of approximately 55. Note that the capacitance changes 
on a significantly shorter timescale than the displacement.
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Figure 4: Displacement of the center of the device as a function of time.

Figure 5: Capacitance of the device as a function of time. The transients in this plot that occur 
after the point of contact are not physical. The capacitance of the structure changes from 0.1 pF 
to 1.5 pF as a result of the pull-in.
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Electromechanics (emi).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

D E F I N I T I O N S

Variables 1
1 On the Home toolbar, click Variables and choose Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 110.

4 In the Height text field, type 5.

5 Locate the Position section. In the xw text field, type -60.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

Name Expression Value Description

V0 1[mV] 0.001 V Initial voltage

Vstep 5[V] 5 V Voltage step

insheight 100[nm] 1E-7 m Insulator height

airheight 900[nm] 9E-7 m Air height

en 1e15[Pa/m] 1E15 N/m³ Spring stiffness

tn 5e5[Pa] 5E5 Pa Contact force

Name Expression Unit Description

gap airheight+w m

contactpressure (gap<=0)*(tn-en*gap)+(gap>
0)*tn*exp(-gap*en/tn)

N/m²

Va V0+Vstep*step2(t/1[s]) V
8 |  P U L L - I N  O F  A N  R F  M E M S  S W I T C H



2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 50.

4 In the Height text field, type 60.

5 Locate the Position section. In the yw text field, type -10.

Rectangle 3 (r3)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 110.

4 In the Height text field, type 60.

5 Locate the Position section. In the xw text field, type -60.

6 In the yw text field, type -10.

Rectangle 4 (r4)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 110.

4 In the Height text field, type 10.

5 Locate the Position section. In the xw text field, type -60.

6 In the yw text field, type -2.5.

7 In the Model Builder window, click Geometry 1.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

4 Right-click Extrude 1 (ext1) and choose Build Selected.

Form Union (fin)
1 On the Geometry toolbar, click Build All.

2 Click the Wireframe Rendering button on the Graphics toolbar.

Distances (µm)

1

2

4
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D E F I N I T I O N S

Step 1 (step1)
1 On the Home toolbar, click Functions and choose Local>Step.

2 In the Settings window for Step, locate the Parameters section.

3 In the Location text field, type 1.05*insheight.

4 Click to expand the Smoothing section. In the Size of transition zone text field, type 
0.05*insheight.

Step 2 (step2)
1 On the Home toolbar, click Functions and choose Local>Step.

2 In the Settings window for Step, locate the Parameters section.

3 In the Location text field, type 3e-5.

4 Click to expand the Smoothing section. In the Size of transition zone text field, type 1e-
5.

Define selections.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Model Builder window, right-click Explicit 1 and choose Rename.

3 In the Rename Explicit dialog box, type Bridge in the New label text field.

4 Click OK.

5 Select Domains 8, 23, 26, and 29 only.

Box 1
1 On the Definitions toolbar, click Box.

2 In the Model Builder window, right-click Box 1 and choose Rename.

3 In the Rename Box dialog box, type Gap in the New label text field.

4 Click OK.

5 In the Settings window for Box, locate the Box Limits section.

6 In the z maximum text field, type 1.1.

7 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Adjacent 1
1 On the Definitions toolbar, click Adjacent.
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2 In the Model Builder window, right-click Adjacent 1 and choose Rename.

3 In the Rename Adjacent dialog box, type Bridge surface in the New label text field.

4 Click OK.

5 In the Settings window for Adjacent, locate the Input Entities section.

6 Under Input selections, click Add.

7 In the Add dialog box, select Bridge in the Input selections list.

8 Click OK.

Box 2
1 On the Definitions toolbar, click Box.

2 In the Model Builder window, right-click Box 2 and choose Rename.

3 In the Rename Box dialog box, type Base in the New label text field.

4 Click OK.

5 In the Settings window for Box, locate the Geometric Entity Level section.

6 From the Level list, choose Boundary.

7 Locate the Box Limits section. In the z maximum text field, type 0.1.

8 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 3
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Box Limits section. In the z minimum text field, type 0.9.

5 In the z maximum text field, type 1.1.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Intersection 1
1 On the Definitions toolbar, click Intersection.

2 In the Model Builder window, right-click Intersection 1 and choose Rename.

3 In the Rename Intersection dialog box, type Bridge lower side in the New label text 
field.

4 Click OK.

5 In the Settings window for Intersection, locate the Geometric Entity Level section.
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6 From the Level list, choose Boundary.

7 Locate the Input Entities section. Under Selections to intersect, click Add.

8 In the Add dialog box, In the Selections to intersect list, choose Bridge surface and Box 3.

9 Click OK.

Box 4
1 On the Definitions toolbar, click Box.

2 In the Model Builder window, right-click Box 4 and choose Rename.

3 In the Rename Box dialog box, type Symmetry x in the New label text field.

4 Click OK.

5 In the Settings window for Box, locate the Geometric Entity Level section.

6 From the Level list, choose Boundary.

7 Locate the Box Limits section. In the x minimum text field, type 45.

8 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 5
1 On the Definitions toolbar, click Box.

2 In the Model Builder window, right-click Box 5 and choose Rename.

3 In the Rename Box dialog box, type Symmetry y in the New label text field.

4 Click OK.

5 In the Settings window for Box, locate the Geometric Entity Level section.

6 From the Level list, choose Boundary.

7 Locate the Box Limits section. In the y minimum text field, type 45.

8 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Load the materials.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.
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A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select MEMS>Semiconductors>Si - Polycrystalline Silicon.

3 Click Add to Component in the window toolbar.

4 On the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Si - Polycrystalline Silicon (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Si -

Polycrystalline Silicon (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Bridge.

Material 3 (mat3)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Gap.

4 Click to expand the Material properties section. Locate the Material Properties section. 
From the Material type list, choose Nonsolid.

5 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R O M E C H A N I C S  ( E M I )

In the Model Builder window, expand the Electromechanics (emi) node.

Linear Elastic Material 1
1 Right-click Component 1 (comp1)>Electromechanics (emi) and choose 

Linear Elastic Material.

2 In the Settings window for Linear Elastic Material, locate the Domain Selection section.

3 From the Selection list, choose Bridge.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 7.5-step1(z)*6.5 1 Basic
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Fixed Constraint 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Structural>Fixed Constraint.

2 Select Boundary 24 only.

Symmetry 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose Symmetry x.

Symmetry 2
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose Symmetry y.

Boundary Load 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Boundary Load.

2 Select Boundaries 26, 79, 89, and 99 only.

3 In the Settings window for Boundary Load, locate the Force section.

4 Specify the FA vector as

Prescribed Mesh Displacement 2
1 Right-click Electromechanics (emi) and choose the boundary condition Deformed Mesh>

Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection 
section.

3 From the Selection list, choose Symmetry x.

4 Locate the Prescribed Mesh Displacement section. Clear the Prescribed y displacement 
check box.

5 Clear the Prescribed z displacement check box.

0 x

0 y

contactpressure z
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Prescribed Mesh Displacement 3
1 Right-click Electromechanics (emi) and choose the boundary condition Deformed Mesh>

Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection 
section.

3 From the Selection list, choose Symmetry y.

4 Locate the Prescribed Mesh Displacement section. Clear the Prescribed x displacement 
check box.

5 Clear the Prescribed z displacement check box.

6 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Terminal.

Define the voltage applied to the bridge lower side.

Terminal 1
1 In the Settings window for Terminal, locate the Boundary Selection section.

2 From the Selection list, choose Bridge surface.

3 Locate the Terminal section. From the Terminal type list, choose Voltage.

4 In the V0 text field, type Va.

5 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Terminal.

Define the voltage applied to the base.

Terminal 2
1 In the Settings window for Terminal, locate the Boundary Selection section.

2 From the Selection list, choose Base.

3 Locate the Terminal section. From the Terminal type list, choose Voltage.

4 In the V0 text field, type 0.

5 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Terminal.

Add another Terminal to the bridge lower side. This terminal is used for the first 
(Stationary) study step. It will be disabled in the transient step which will make Terminal 

1 active.

Terminal 3
1 In the Settings window for Terminal, locate the Boundary Selection section.

2 From the Selection list, choose Bridge surface.
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3 Locate the Terminal section. From the Terminal type list, choose Voltage.

4 In the V0 text field, type V0.

M E S H  1

Mapped 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Mapped.

2 Select Boundaries 10, 20, 30, 40, 50, 63, 73, 83, 93, and 103 only.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Domain Selection section.

4 From the Selection list, choose Gap.

5 Locate the Distribution section. In the Number of elements text field, type 8.

6 Click Build All.

Define the study steps. The first step (Stationary) is used to define the initial conditions 
of the transient problem (Step 2).

S T U D Y  1

Step 2: Time Dependent
1 On the Study toolbar, click Study Steps and choose Time Dependent>Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Times text field, type range(0,5e-7,5e-5).

4 Locate the Physics and Variables Selection section. Select the 
Modify physics tree and variables for study step check box.

5 In the Physics and variables selection tree, select Component 1 (comp1)>

Electromechanics (emi)>Terminal 3.

6 Click Disable.

Change the default solver to a Fully CoupledDirect solver and use BDF time stepping.

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node, then click Time-

Dependent Solver 1.
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3 In the Settings window for Time-Dependent Solver, click to expand the Time stepping 
section.

4 Locate the Time Stepping section. From the Method list, choose BDF.

5 From the Steps taken by solver list, choose Intermediate.

6 Right-click Study 1>Solver Configurations>Solution 1 (sol1)>Time-Dependent Solver 1 and 
choose Fully Coupled.

7 In the Settings window for Fully Coupled, click to expand the Method and termination 
section.

8 Locate the Method and Termination section. From the Nonlinear method list, choose 
Automatic (Newton).

9 In the Model Builder window, under Study 1>Solver Configurations>Solution 1 (sol1)>

Time-Dependent Solver 1 right-click Direct and choose Enable.

10 In the Settings window for Direct, locate the General section.

11 From the Solver list, choose PARDISO.

12 Click Compute.

Create the mirror solutions.

R E S U L T S

Mirror 3D 1
1 On the Results toolbar, click More Data Sets and choose Mirror 3D.

2 In the Settings window for Mirror 3D, locate the Plane Data section.

3 In the x-coordinate text field, type 50.

Mirror 3D 2
1 Right-click Mirror 3D 1 and choose Duplicate.

2 In the Settings window for Mirror 3D, locate the Data section.

3 From the Data set list, choose Mirror 3D 1.

4 Locate the Plane Data section. From the Plane list, choose xz-planes.

5 In the y-coordinate text field, type 50.

Displacement (emi)
1 In the Model Builder window, under Results click Displacement (emi).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Mirror 3D 2.
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4 On the Displacement (emi) toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

Potential (emi)
1 In the Model Builder window, under Results click Potential (emi).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Mirror 3D 2.

4 On the Potential (emi) toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

Displacement (emi) 1
1 In the Model Builder window, under Results right-click Displacement (emi) and choose 

Duplicate.

2 Right-click Displacement (emi) 1 and choose Rename.

3 In the Rename 3D Plot Group dialog box, type Contact force (emi) in the New label 
text field.

4 Click OK.

Surface 1
1 In the Model Builder window, expand the Results>Contact force (emi) node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type contactpressure.

4 On the Contact force (emi) toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

1D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 4 and choose Rename.

3 In the Rename 1D Plot Group dialog box, type Displacement in the New label text field.

4 Click OK.

Point Graph 1
1 Right-click Displacement and choose Point Graph.

2 Select Point 70 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.
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4 In the Expression text field, type w.

5 On the Displacement toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 5 and choose Rename.

3 In the Rename 1D Plot Group dialog box, type Capacitance in the New label text field.

4 Click OK.

Global 1
1 Right-click Capacitance and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Click to expand the Legends section. Clear the Show legends check box.

5 On the Capacitance toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

Expression Unit Description

4*emi.Q0_1/emi.V0_1 F Capacitance
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Introduction

A surface acoustic wave (SAW) is an acoustic wave propagating along the surface of a solid 
material. Its amplitude decays rapidly, often exponentially, with the depth of the material. 
SAWs are featured in many kinds of electronic components, including filters, oscillators, 
and sensors. SAW devices typically use electrodes on a piezoelectric material to convert an 
electric signal to a SAW, and back again.

In this model, you investigate the resonance frequencies of a SAW gas sensor. The sensor 
consists of an interdigitated transducer (IDT) etched onto a piezoelectric LiNbO3 
(lithium niobate) substrate and covered with a thin polyisobutylene (PIB) film. The mass 
of the PIB film increases as PIB selectively adsorbs CH2Cl2 (dichloromethane, DCM) 
from air. This causes a shift in resonance which slightly lowers the resonance frequency for 
the same SAW mode.

Model Definition

Figure 1 shows a conceptual view of the gas sensor in this model.

Figure 1: SAW gas sensor, showing the IDT electrodes (in black), the thin PIB film (light 
gray), and the LiNbO3 substrate (dark gray). For the sake of clarity, the dimensions are not 
to scale and the IDT has fewer electrodes than in common devices. A slice of the geometry is 
removed to reveal the modeled unit cell (in white).
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IDTs used in SAW devices may have hundreds of identical electrodes, and each electrode 
can be about 100 times longer than it is wide. You can therefore neglect the edge effects 
and reduce the model geometry to the periodic unit cell shown in Figure 2. The height of 
this cell does not have to extend all the way to the bottom of the substrate but only a few 
wavelengths down, so that the SAW has almost died out at the lower boundary. 

Figure 2: The geometry of the SAW unit cell used in this model. A 500 nm PIB film covers two 
1 μm-wide electrodes on top of the LiNbO3 substrate. The substrate domain has a total height 
of 12 μm.

Set up the model using the predefined Piezoelectric Devices multiphysics interface. In 2D, 
a Plane Strain assumption is used for the Solid Mechanics interface. Hence the out-of-
plane strain component is zero. This should be a valid assumption, considering that the 
SAW is generated in the plane of the model and hence any variation in the out-of-plane 
direction can be considered minimal.

B O U N D A R Y  C O N D I T I O N S

In order to define the model, you need to apply structural and electrical boundary 
conditions.

As one can assume that the surface wave dies off within two to three wavelengths from the 
surface, the lower boundary is fixed. This enforces a zero structural displacement but does 
not contribute to any significant reflection from the lower boundary back into the bulk of 
the substrate as long as we are observing surface waves and in particular Rayleigh waves. 
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The electrodes have a much higher electrical conductivity compared to PIB and LiNbO3. 
Hence, one can expect each of the electrodes to be isopotential. This is why you do not 
need to model the domains that constitute the electrodes but can simply use appropriate 
boundary conditions on all the outer boundaries of each electrode to indicate what type 
of isopotential state it is in. The boundaries of the left terminal is set to electrical ground, 
and those of the right terminal are assigned to a Floating Potential with zero surface charge 
accumulation. This combination of electrical boundary conditions corresponds to an open 
circuit configuration, which is typically suitable for sensing applications.

Use periodic boundary conditions to dictate that the electric potential and displacements 
are the same along both vertical boundaries of the geometry. When using periodic 
boundary conditions, one needs to ensure that the mesh on the vertical boundaries on the 
left of the unit cell and the vertical boundaries on the right of the unit cell are identical. 
This is achieved by first creating the mesh on the vertical boundaries on the left and then 
using the Copy Edge feature to create the exact same mesh on the vertical boundaries on 
the right.

All other boundaries are left to the default boundary conditions which are Free for the 
Solid Mechanics interface and Zero Charge for the Electrostatics interface, respectively.

M A T E R I A L  P R O P E R T I E S

The substrate used in the simulation is YZ-cut LiNbO3 with the following properties 
(cited in Ref. 2):

• Elasticity matrix:

2.424e11 0.752e11 0.752e11 0 0 0
2.03e11 0.573e11 0 0.085e11 0

2.03e11 0 0.085e– 11 0
0.752e11 0 0.085e11

0.595e11 0
0.595e11
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• Coupling matrix:

• Relative permittivity:

The density of the PIB film is from Ref. 1. The Poisson’s ratio is considered to be 0.48, 
and the Young’s modulus is set to 10 GPa.

The adsorption of DCM gas is represented as a slight increase of the overall density of the 
PIB film as shown in the following expression.

In this model, you use a parameter, switch, whose value can be either 0 or 1. This allows 
to solve the model for two cases; once without the effect of adsorbed gas and once with 
the effect of the adsorbed DCM gas in PIB.

When the sensor is exposed to 100 ppm of DCM in air at atmospheric pressure and room 
temperature, the “partial density” of DCM in the PIB film can be calculated from

where K = 10l.4821 (Ref. 1) is the air/PIB partition coefficient for DCM, M is its molar 
mass, and c 

is its concentration in air. The DCM concentration, c in moles/m3 is computed using the 
Gas Law. Here c0 is the concentration in parts per million, p is the pressure, T is the 
temperature, and R is the gas constant. Any effects of the DCM adsorption on the material 
properties other than the density are neglected.

1.33 0.23 0.23 0 0 0
0 0 0 2.5– 0 3.7
0 2.5– 2.5 0 3.7 0

28.7 0 0
85.2 0

85.2

ρ ρPIB switch ρDCM PIB,⋅+=

ρDCM PIB, KMc=

c c0p( ) RT( )⁄=
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Most of the material properties and factors affecting them have been parametrized as 
shown in Table 1. This easily allows the model to be adapted for other materials and 
operating conditions.

E S T I M A T I N G  T H E  S AW  F R E Q U E N C Y

The use of periodic boundary condition implies that the frequencies of interest correspond 
to wavelengths that are integer fractions of the width of the geometry. The lowest SAW 
eigenmode has its wavelength equal to the width of the geometry, that is, 4 μm. Using this 
along with the Rayleigh wave velocity for the given piezoelectric substrate material, one 
can find an estimate of the resonance frequency of interest. The information can be used 
in the eigenfrequency solver, which helps it to find out the resonance frequencies close to 
this estimated number. In this model, you use a YZ-cut LiNbO3 whose Rayleigh wave 
velocity (vR) is around 3488 m/s. This gives an estimate of the lowest SAW frequency (f0) 
to be 872 MHz.

TABLE 1:  LIST OF PARAMETERS

NAME EXPRESSION DESCRIPTION

p 1[atm] Air pressure

T 25[degC] Air temperature

c0 100 DCM concentration in ppm

c_DCM_air 1e-6*c0*p/(R_const*T) DCM concentration in air

M_DCM 84.93[g/mol] Molar mass of DCM

K 10^1.4821 PIB/air partition constant for DCM

rho_DCM_PIB K*M_DCM*c_DCM_air Mass concentration of DCM in PIB

rho_PIB 0.918[g/cm^3] Density of PIB

E_PIB 10[GPa] Young's modulus of PIB

nu_PIB 0.48 Poisson’s ratio of PIB

eps_PIB 2.2 Relative permittivity of PIB

switch 0 Switch for adding DCM density

vR 3488[m/s] Rayleigh wave velocity

width 4[um] Width of unit cell

f0 vR/width Estimated SAW frequency

t_PIB 0.5[um] PIB thickness
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Results and Discussion

The anti-resonance and resonance frequencies evaluate to approximately 850 MHz and 
855 MHz, respectively. Figure 3 and Figure 4 show the corresponding SAW modes. 
Figure 5 and Figure 6 show the electric potential distribution characteristics for these 
solutions.

Exposing the sensor to a 100 ppm concentration of DCM in air leads to a resonance 
frequency shift of approximately 200 Hz downwards. This is computed by evaluating the 
resonance frequency before and after adding the density of adsorbed DCM to that of the 
PIB domain.

Note that the computational mesh is identical in both these solutions. This implies that 
the relative error of the frequency shift is similar to that of the resonance frequency itself. 
Thus, the shift is accurately evaluated despite being a few magnitudes smaller than the 
absolute error of the resonance frequency.
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Figure 3: Deformed shape plot of the anti-resonance SAW mode.

Figure 4: Deformed shape plot of the resonance SAW mode.
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Figure 5: Electric potential distribution and deformations at anti-resonance, anti-symmetric 
with respect to the center of each electrode.

Figure 6: Electric potential distribution at resonance, symmetric with respect to the center of 
each electrode.
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Application Library path: MEMS_Module/Sensors/saw_gas_sensor

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>

Eigenfrequency.

6 Click Done.

G L O B A L  D E F I N I T I O N S

For quicker modeling, load the parameters from a file.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.
10 |  S U R F A C E  A C O U S T I C  W A V E  G A S  S E N S O R



4 Browse to the model’s Application Libraries folder and double-click the file 
saw_gas_sensor_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type width.

4 In the Height text field, type 3*width+t_PIB.

5 Locate the Position section. In the y text field, type -3*width.

6 Click to expand the Layers section. In the table, enter the following settings:

7 Select the Layers on top check box.

8 Clear the Layers on bottom check box.

9 Right-click Rectangle 1 (r1) and choose Build Selected.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type width/4.

4 In the Height text field, type 0.4*t_PIB.

5 Locate the Position section. In the x text field, type width/8.

6 Right-click Rectangle 2 (r2) and choose Build Selected.

Copy 1 (copy1)
1 On the Geometry toolbar, click Transforms and choose Copy.

2 Select the object r2 only.

3 In the Settings window for Copy, locate the Displacement section.

4 In the x text field, type width/2.

Layer name Thickness (µm)

Layer 1 t_PIB
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5 Click Build All Objects.

Before creating materials, define the domains where each physics apply.

S O L I D  M E C H A N I C S  ( S O L I D )

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.

2 In the Settings window for Piezoelectric Material, locate the Domain Selection section.

3 Click Clear Selection.

4 Select Domain 1 only.

E L E C T R O S T A T I C S  ( E S )

On the Physics toolbar, click Solid Mechanics (solid) and choose Electrostatics (es).

The electrical equations are not solved in the aluminum electrodes because they are 
assumed to be perfect conductors compared to LiNbO3 and PIB, and hence we consider 
them to be equipotential regions.

1 In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

2 Select Domains 1 and 2 only.

Charge Conservation, Piezoelectric 1
1 In the Model Builder window, under Component 1 (comp1)>Electrostatics (es) click 

Charge Conservation, Piezoelectric 1.

2 Select Domain 1 only.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type LiNbO3 in the Label text field.

3 Locate the Geometric Entity Selection section. Click Clear Selection.

4 Select Domain 1 only.
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5 Locate the Material Contents section. In the table, enter the following settings:

Alternately, you can click the Edit button below the Output properties table and use the 
matrix inputs to enter cE, e, and epsilonrS according to the material data shown 
under the Model Definition section.

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type PIB in the Label text field.

3 Select Domain 2 only.

4 Locate the Material Contents section. In the table, enter the following settings:

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

Property Name Value Unit Property 
group

Elasticity matrix 
(Ordering: xx, yy, zz, 
yz, xz, xy)

cE {242.4[GPa],
75.2[GPa],203[GPa],
75.2[GPa],57.3[GPa],
203[GPa],0,0,0,
75.2[GPa],0,8.5[GPa],
-8.5[GPa],0,
59.5[GPa],0,0,0,
8.5[GPa],0,59.5[GPa]}

Pa Stress-charge 
form

Coupling matrix eES {1.33,0,0,0.23,0,
-2.5,0.23,0,2.5,0,
-2.5,0,0,0,3.7,0,3.7,
0}

C/m² Stress-charge 
form

Relative permittivity epsilonrS {28.7,85.2,85.2} 1 Stress-charge 
form

Density rho 4647 kg/m³ Basic

Property Name Value Unit Property 
group

Young’s modulus E E_PIB Pa Basic

Poisson’s ratio nu nu_PIB 1 Basic

Density rho rho_PIB+switch*
rho_DCM_PIB

kg/m³ Basic

Relative permittivity epsilonr eps_PIB 1 Basic
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3 In the tree, select Built-In>Aluminum.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Aluminum (mat3)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Aluminum (mat3).

2 Select Domains 3 and 4 only.

3 On the Home toolbar, click Add Material to close the Add Material window.

S O L I D  M E C H A N I C S  ( S O L I D )

On the Physics toolbar, click Electrostatics (es) and choose Solid Mechanics (solid).

Fixed Constraint 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Solid Mechanics (solid) and choose Fixed Constraint.

2 Select Boundary 2 only.

Periodic Condition 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose Connections>

Periodic Condition.

2 Select Boundaries 1, 3, 16, and 17 only.

This defines periodic condition for the Solid Mechanics physics. By default, the 
periodicity type is set to Continuity for all dependent variables.

E L E C T R O S T A T I C S  ( E S )

Ground the left electrode by applying boundary condition on its edges.

Ground 1
1 In the Model Builder window, under Component 1 (comp1) right-click Electrostatics (es) 

and choose Ground.

2 Select Boundaries 6–9 only.

Apply a Floating Potential on the edges of the right electrode.

Floating Potential 1
1 In the Model Builder window, right-click Electrostatics (es) and choose Floating Potential.

2 Select Boundaries 11–14 only.

Define periodic boundary condition for the Electrostatics physics.
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Periodic Condition 1
1 Right-click Electrostatics (es) and choose Periodic Condition.

2 Select Boundaries 1, 3, 16, and 17 only.

M E S H  1

Edge 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Edge.

2 Select Boundaries 1 and 3 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Edge 1 and choose Distribution.

2 Select Boundary 3 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 4.

Edge 1
Define an increasing mesh size along the thickness of the piezoelectric substrate.

Distribution 2
1 Right-click Edge 1 and choose Distribution.

2 Select Boundary 1 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution properties list, choose Predefined distribution type.

5 In the Number of elements text field, type 25.

6 In the Element ratio text field, type 25.

7 Select the Reverse direction check box.

8 Click Build Selected.

Copy Edge 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Copy Edge.

2 Select Boundaries 1 and 3 only.

3 In the Settings window for Copy Edge, locate the Destination Boundaries section.

4 Select the Active toggle button.

5 Select Boundaries 16 and 17 only.
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Free Quad 1
1 Right-click Mesh 1 and choose Free Quad.

2 In the Settings window for Free Quad, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 2–4 only.

Size 1
1 Right-click Component 1 (comp1)>Mesh 1>Free Quad 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. Select the Maximum element size check box.

5 In the associated text field, type t_PIB/4.

Mapped 1
1 In the Model Builder window, right-click Mesh 1 and choose Mapped.

2 In the Settings window for Mapped, click Build All.

S T U D Y  1

Set up a Parametric Sweep to solve the model with and without the adsorbed species on 
the sensor. The parameter switch is used to solve the model once without adding the 
density of DCM and once with the added density of adsorbed DCM in PIB.
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Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Search for eigenfrequencies near the estimated resonance frequency.

Step 1: Eigenfrequency
1 In the Model Builder window, under Study 1 click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Search for eigenfrequencies around check box.

4 In the associated text field, type f0.

5 On the Study toolbar, click Compute.

R E S U L T S

Mode Shape (solid)
The default plot shows the anti-resonance SAW mode near 850 MHz. Adjust the 
deformed shape plot to see the effect of the wave localization near the surface.

1 In the Model Builder window, under Results click Mode Shape (solid).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (switch) list, choose 0.

4 In the Model Builder window, expand the Mode Shape (solid) node.

Deformation
1 In the Model Builder window, expand the Results>Mode Shape (solid)>Surface 1 node, 

then click Deformation.

2 In the Settings window for Deformation, locate the Scale section.

3 Select the Scale factor check box.

4 In the associated text field, type 100.

5 On the Mode Shape (solid) toolbar, click Plot.

Parameter name Parameter value list Parameter unit

switch 0 1
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6 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot to that in Figure 3.

Mode Shape (solid)
Plot the second mode shape near 855 MHz, which is the resonance SAW mode.

1 In the Model Builder window, under Results click Mode Shape (solid).

2 Click Plot.

3 In the Settings window for 2D Plot Group, locate the Data section.

4 From the Eigenfrequency (Hz) list, choose 8.555E8.

5 On the Mode Shape (solid) toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot to that in Figure 4.

Electric Potential (es)
To visualize the electric potential distribution for the eigenmodes, follow these steps.

Surface 1
1 In the Model Builder window, expand the Results>Electric Potential (es) node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color table list, choose WaveLight.

Electric Potential (es)
1 Right-click Results>Electric Potential (es)>Surface 1 and choose Height Expression.

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (switch) list, choose 0.

4 On the Electric Potential (es) toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

6 From the Eigenfrequency (Hz) list, choose 8.555E8.

7 On the Electric Potential (es) toolbar, click Plot.

8 Click the Zoom Extents button on the Graphics toolbar.

Derived Values
To see all computed eigenfrequencies as a table, follow these steps.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.
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2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 From the Table columns list, choose Outer solutions.

5 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Solver>freq - Frequency.

6 Click New Table.

TA B L E

1 Go to the Table window.

2 Click Full Precision in the window toolbar.

The first 6 digits of the eigenfrequency are the same. Subtracting the new value from 
the previous value shows that the eigenfrequency with gas exposure is lower by 200 Hz.
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Introduction

This example performs a static analysis on a piezoelectric actuator based on the movement 
of a cantilever beam, using the Piezoelectric Devices predefined multiphysics interface. 
Inspired by work done by V. Piefort (Ref. 1) and A. Benjeddou (Ref. 2), it models a 
sandwich beam using the shear mode of the piezoelectric material to deflect the tip.

Model Definition

G E O M E T R Y

The model consists of a 100-mm long sandwiched cantilever beam (Figure 1).

Figure 1: The shear bender geometry. Note that a piezoceramic material replaces part of 
the foam core.

This beam is composed of a 2-mm thick flexible foam core sandwiched by two 8-mm thick 
aluminum layers. Further, the device replaces part of the foam core with a 10-mm long 
piezoceramic actuator that is positioned between x = 55 mm and x = 65 mm. The 
cantilever beam is orientated along the global x-axis.

Piezoceramic

Foam

Aluminum
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B O U N D A R Y  C O N D I T I O N S

• Solid Mechanics: the cantilever beam is fixed at its surfaces at x = 0; all other surfaces 
are free.

• Electrostatics: The system applies a 20 V potential difference between the top and 
bottom surfaces of the piezoceramic domain (Figure 2). This gives rise to an electric 
field perpendicular to the poling direction (x direction) and thus induces a transverse 
shear strain.

Figure 2: Applied voltage through the piezoelectric material

M A T E R I A L  P R O P E R T I E S

The following table lists the material properties for the aluminum layers and the foam core:

Aluminum is available as a predefined material, whereas you must define the foam material 
manually.

PROPERTY ALUMINUM FOAM PIEZOCERAMIC

E 70 GPa 35.3 MPa -

ν 0.35 0.383 -

ρ 2700 kg/m3 32 kg/m3 7500 kg/m3
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The piezoceramic material in the actuator, PZT-5H, is already defined in the material 
library. Thus, you do not need to enter the components of the elasticity matrix, cE, the 
piezoelectric coupling matrix, e, or the relative permittivity matrix, εrS.

Results

The shear deformation of the piezoceramic core layer and the flexible foam layer induce a 
bending action. Figure 3 shows the resulting tip deflection. The model calculates this 
deflection as 83 nm, a result that agrees well with those of Ref. 1 and Ref. 2.

Figure 3: Tip deflection with the piezoceramic positioned at x = 60 mm.

Notes About the COMSOL Implementation

The matrix components for the piezoelectric material properties refer to a coordinate 
system, where the poling direction is the z direction. Because the poling direction of the 
piezoceramic actuator in this model is aligned with the x-axis, you need to use a local 
coordinate system in the material settings to rotate the piezoceramic material.
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More specifically, you define a local coordinate system that is rotated 90 degrees about the 
global y-axis. Then, you use this coordinate system in the piezoelectric material settings to 
rotate the material so that the polarization direction is aligned with the x-axis (Figure 4).

Figure 4: Definition of local coordinate system to define the piezoelectric orientation. The 
material is poled along the local x3 direction (blue arrow).
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Application Library path: MEMS_Module/Piezoelectric_Devices/shear_bender
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 100.

4 In the Depth text field, type 30.

5 In the Height text field, type 18.

6 Right-click Block 1 (blk1) and choose Build Selected.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 100.

4 In the Depth text field, type 30.

5 In the Height text field, type 2.

6 Locate the Position section. In the z text field, type 8.
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7 Click to expand the Layers section. Find the Layer position subsection. Select the Left 
check box.

8 Clear the Bottom check box.

9 In the table, enter the following settings:

10 Click Build All Objects.

11 Click the Zoom Extents button on the Graphics toolbar.

The model geometry is now complete.

12 Click the Transparency button on the Graphics toolbar.

The geometry in the Graphics window should now look like that in Figure 1.

13 Click the Transparency button on the Graphics toolbar.

D E F I N I T I O N S

Define a coordinate system whose third axis is aligned with the global x-axis, that is, the 
polarization direction of the piezoceramic material. Choose the second axis to be parallel 
to the global y-axis.

Base Vector System 2 (sys2)
1 On the Definitions toolbar, click Coordinate Systems and choose Base Vector System.

2 In the Settings window for Base Vector System, locate the Settings section.

3 Find the Base vectors subsection. In the table, enter the following settings:

Leave the other components at their default values. You will use this coordinate system 
in the piezoelectric material settings.

4 Find the Simplifications subsection. Select the Assume orthonormal check box.

E L E C T R O S T A T I C S  ( E S )

1 In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

2 In the Settings window for Electrostatics, locate the Domain Selection section.

Layer name Thickness (mm)

Layer 1 55

Layer 2 10

x y z

x1 0 0 -1

x3 1 0 0
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3 Click Clear Selection.

4 Select Domain 4 only.

S O L I D  M E C H A N I C S  ( S O L I D )

On the Physics toolbar, click Electrostatics (es) and choose Solid Mechanics (solid).

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.

2 In the Settings window for Piezoelectric Material, locate the Domain Selection section.

3 Click Clear Selection.

4 Select Domain 4 only.

5 Locate the Coordinate System Selection section. From the Coordinate system list, choose 
Base Vector System 2 (sys2).

M A T E R I A L S

For the aluminum layers, use a library material.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Metals>Al - Aluminum / Aluminium.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Al - Aluminum / Aluminium (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Al -

Aluminum / Aluminium (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 Click Clear Selection.

4 Select Domains 1 and 3 only.

For the foam core, specify the material properties by hand.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.
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2 In the Settings window for Material, type Foam in the Label text field.

3 Select Domains 2 and 5 only.

Foam (mat2)
Locate the Material Contents section. In the table, enter the following settings:

A D D  M A T E R I A L

1 Go to the Add Material window.

The piezoceramic PZT-5H is available as a predefined material.

2 In the tree, select Piezoelectric>Lead Zirconate Titanate (PZT-5H).

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Lead Zirconate Titanate (PZT-5H) (mat3)
1 In the Model Builder window, expand the Component 1 (comp1)>Materials>Foam (mat2) 

node, then click Component 1 (comp1)>Materials>Lead Zirconate Titanate (PZT-

5H) (mat3).

2 Select Domain 4 only.

3 On the Home toolbar, click Add Material to close the Add Material window.

S O L I D  M E C H A N I C S  ( S O L I D )

Fixed Constraint 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Solid Mechanics (solid) and choose Fixed Constraint.

2 Select Boundaries 1, 4, and 7 only.

E L E C T R O S T A T I C S  ( E S )

Electric Potential 1
1 In the Model Builder window, under Component 1 (comp1) right-click Electrostatics (es) 

and choose Electric Potential.

Property Name Value Unit Property group

Young’s modulus E 35.3[MPa] Pa Basic

Poisson’s ratio nu 0.383 1 Basic

Density rho 32 kg/m³ Basic
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2 Select Boundary 16 only.

3 In the Settings window for Electric Potential, locate the Electric Potential section.

4 In the V0 text field, type 20.

Ground 1
1 In the Model Builder window, right-click Electrostatics (es) and choose Ground.

2 Select Boundary 17 only.

M E S H  1

Distribution 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

5 Click Build All.

6 Click the Zoom Extents button on the Graphics toolbar.

The mesh consists of 198 hexahedral elements.

S T U D Y  1

On the Home toolbar, click Compute.
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R E S U L T S

Stress (solid)
Replace the default stress plot by displacement to reproduce the plot shown in Figure 3.

1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, type Displacement (solid) in the Label text 
field.

Surface 1
1 In the Model Builder window, expand the Results>Displacement (solid) node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>w - Displacement field,

Z component.

3 Locate the Expression section. From the Unit list, choose nm.

4 On the Displacement (solid) toolbar, click Plot.

5 Click Go to Default View.

Multislice 1
In the Model Builder window, expand the Electric Potential (es) node.

Surface 1
1 Right-click Multislice 1 and choose Delete.

2 In the Model Builder window, under Results right-click Electric Potential (es) and choose 
Surface.

3 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electrostatics>Electric>V -

Electric potential.

4 On the Electric Potential (es) toolbar, click Plot.

Zoom in to find a plot similar to Figure 2.

5 Click the Zoom In button on the Graphics toolbar.

6 Click the Zoom Extents button on the Graphics toolbar.

Show the base vector that defines the polarization of the piezoelectric material, shown 
on Figure 4.
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3D Plot Group 3
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type PZT coordinate system in the Label 
text field.

Coordinate System Volume 1
1 On the PZT coordinate system toolbar, click More Plots and choose 

Coordinate System Volume.

2 In the Settings window for Coordinate System Volume, locate the Coordinate System 
section.

3 From the Coordinate system list, choose Base Vector System 2 (sys2).

4 Locate the Positioning section. Find the x grid points subsection. From the Entry method 
list, choose Coordinates.

5 In the Coordinates text field, type 60.

6 Find the y grid points subsection. In the Points text field, type 1.

7 Find the z grid points subsection. In the Points text field, type 1.

8 On the PZT coordinate system toolbar, click Plot.
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Introduction

This benchmark model computes the damping force acting on a vibrating disc. The disc is 
in close proximity to a stationary surface and the damping results from the squeezing of a 
thin film of gas between the two surfaces. The squeezing action forces out the gas from 
between the two plates resulting in a damping force that acts to prevent mechanical 
contact between the two surfaces. The opposite effect takes place when the surfaces move 
away from each other as gas is drawn back into the bearing. 

This model examines the effect of the periodic motion of the disc on the flow developed, 
including the pressure in the gas and the resulting damping forces. Small amplitude 
motion is analyzed using a linear frequency domain simulation. A nonlinear transient 
analysis is performed for small to large amplitude motion. The calculated film pressure and 
load carrying capacity are compared with analytical results.

Model Definition

The Thin-Film Flow, Edge interface is used to model the gas film on a flat circular plate. 
The model is 1D axisymmetric since the film pressure only varies radially. When Thin-Film 
Flow is assigned to a boundary, this boundary represents a reference surface in the physical 
device. In practice a small gap exists at the boundary and two impermeable structures, the 
wall and the base, are located either side of it. Figure 1 shows the configuration of the base 
and the wall in an arbitrary problem, and defines a number of terms used in the interface.

In this example, the model geometry is 1D axisymmetric and consists of a single line, with 
length set to the radius of the circular disc. The line is located at the origin and aligned 
with the r-axis. The base is coincident with the reference surface. A pressure is generated 
in the bearing by a periodic velocity of the wall in a direction normal to the wall.
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Figure 1: An example illustrating a typical configuration for thin-film flow.

For non-slip boundary conditions at the wall and the base, the modified Reynolds 
equation takes the following form for a general frequency domain problem:

 (1)

where ρ is the fluid density, μ is its viscosity, h0 is the mean film height, pf is the pressure 
developed as a result of the flow (this is the dependent variable in COMSOL) and ptot is 
the total pressure (ptot=pA+pf, where pA is the ambient pressure). Other terms are defined 
in Figure 1. A reference surface with normal nref sits in a narrow gap between a wall and 
base. In COMSOL the vector nref points into the base and out of the wall. The wall moves 
with a displacement from its initial position with displacement uwall and velocity vwall. 
Similarly the base moves from its initial position with displacement ubase and velocity 
vbase. The compression of the film results in an excess pressure, pf, above the ambient 
pressure, pA, and a gas velocity in the gap. At a point on the reference surface the average 
value of the film velocity along a line perpendicular to the surface is given by the in plane 
vector vave. The motion of the gas results in forces on the wall (Fwall) and the base 
(Fbase). The height of the wall above the reference surface is hw whilst the base is a 
distance hb below the reference surface. The total size of the gap is h=hw+hb. At a given 
point in time hw=hw1–nref · nwall and hb=hb1–nref · nwall where hw1 and hb1 are the 
initial heights of the wall and base, respectively.

Reference surface

base

wall

Fwall

Fbase

uwall vwall

ubase vbasenref
hb

hw

h
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                                  ptot vw ∇thw⋅ vb ∇thb⋅+( )– 0=

vav
1
2
--- I nrnr

T
–( ) vw vb+( )

h0
2

12μ
----------∇tpf–=
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Note that the frequency formulation assumes a small amplitude first order harmonic 
variation of film pressure, film height and wall velocity at the frequency of interest. The 
boundary conditions for this model are vanishing pressure due to the flow (pf = 0) at r = 
r0, where r0 is the disc radius and symmetry/zero pressure gradient (dpf/dr = 0) at r = 0.

For the case of a 1D axisymmetric problem Equation 1 can be greatly simplified to derive 
a simple closed form analytical solution. Note that these simplifications are not made in 
the simulation itself and consequently there are slight deviations from the analytic results 
in the model—these cannot be seen in the plots shown here and are not significant (strictly 
speaking the simulation is more accurate than the analytic results since no assumptions are 
made). The motion of the disc is in the vertical direction only, and the gap size is uniform 
across the disc, so a number of the terms in Equation 1 are zero. In this example, the term 
iωhpf is quite small compared to other terms and can be neglected for the purpose of 
deriving an analytical solution. The ambient pressure is 1 atmosphere and correspondingly 
pf«pA. so ptot≈pA. Making these assumptions the modified Reynold’s equation reduces to:

 (2)

Where vw is the velocity of the wall in the z-direction. With the boundary conditions pf = 
0 at r = r0, and dpf/dr = 0 at r = 0, Equation 2 can be solved for pf and is given by (see 
Ref. 1 for complete derivation):

 (3)

The total analytical vertical load on the disc is then given by (see Ref. 1 for complete 
derivation):

A frequency domain analysis is appropriate for small amplitude periodic motion of the 
bearing wall. For large amplitude periodic motion (where the amplitude of the motion 
becomes comparable to the gap size), a transient analysis is necessary, to capture the 
nonlinearities in the model. Again approximations are required to derive an analytic result 
for the transient simulation (but are not necessary for the model).

For a transient model the modified Reynolds equation takes the form:

1
r
--- d

dr
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 (4)

For periodic motion of the wall, the total film height h is h(t)=h0+Δhsin(2πft), where Δh 
is the amplitude and f is the frequency of wall periodic motion. The wall velocity vw is then 
given by vw(t) = (2πfΔh)cos(2πft). Once again making the assumption that ptot≈pA and 
noting that a number of these terms are zero for vertical motion of a parallel disc:

Following the derivation of total analytical vertical load for the frequency domain analysis, 
the total vertical load on the disc for the transient model is given by

The model compares the analytical values of film pressure and total vertical load against 
the values computed by using the Thin-Film Flow, Edge interface. The results are found 
to be in agreement with the analytical solutions.

Results and Discussion

The values of radial film pressure in the gas film for the frequency domain analysis are 
plotted in Figure 2. As expected, film pressure magnitude is maximum at the center of the 
circular disc and drops off to zero where the gas film exits the bearing geometry. Figure 2 
also compares the numerical radial film pressure values with analytical values calculated 
using Equation 3. The calculated results agree well with the analytical results. Figure 3 
shows an arrow plot of the fluid load per unit area on the circular disc. These values 
correspond to the film pressure since the vertical load is significantly larger than the radial 
load. Figure 4 shows the variation of film height (gap) with respect to time for different 
values of the amplitude of harmonic film height. The corresponding variation of film 
pressure and total vertical load on the circular disc is shown in Figure 5 and Figure 6, 
respectively. For larger amplitude of harmonic film height the response in terms of both 
film pressure and total load are nonlinear with respect to the applied harmonic motion of 
the circular plate. Such nonlinearity is appropriately calculated by performing a transient 
analysis. Figure 6 also compares analytical and calculated time dependent values of the 
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total load on the circular disc. The plot indicates that the calculated values agree well with 
the analytical values.
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Figure 2: Film pressure vs radial distance from the center of the circular disc. The results 
computed by COMSOL are shown as the continuous curve and the analytical result is shown 
with green symbols.

Figure 3: Radial distribution of the film load on the wall
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Figure 4: Film height variation vs time for different values of amplitude of harmonic film 
height.

Figure 5: Film pressure vs time for different values of amplitude of harmonic film height. For 
higher values of film height amplitude the film pressure varies nonlinearly with respect to the 
film height.
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Figure 6: Total vertical load on the circular disc vs time. for different values of amplitude of 
harmonic film height. The results computed by COMSOL are shown by solid continuous curve 
and the analytical result is shown by dashed continuous curves. Similar to the film pressure, 
for higher values of film height amplitude the total load varies nonlinearly with respect to the 
film height.

Reference

1. B.J. Hamrock, S.R. Schmid, and B.O. Jacobson, Fundamentals of Fluid Film 
Lubrication, Marcel Dekker, 2004. 

This model is based on the discussion entitled Parallel-Surface Bearing of infinite width 
in section 12.2 of the above reference.

Application Library path: MEMS_Module/Sensors/squeeze_film_disc

Modeling Instructions

From the File menu, choose New.
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N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Fluid Flow>Thin-Film Flow>Thin-Film Flow, Edge (tffs).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Bézier Polygon 1 (b1)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 2, set r to r0.

5 Click Build All Objects.

6 Click the Zoom Extents button on the Graphics toolbar.

Name Expression Value Description

r0 1[mm] 0.001 m Disc radius

h0 10[um] 1E-5 m Gap height

dh dhND*h0 1E-7 m Change in gap height

dhND 0.01 0.01 Fractional gap height change.

mu0 1e-5[Pa*s] 1E-5 Pa·s Gas viscosity

f0 1000[Hz] 1000 Hz Vibration frequency
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D E F I N I T I O N S

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Click in the Graphics window and then press Ctrl+A to select all boundaries.

5 Locate the Advanced section. Select the Compute integral in revolved geometry check 
box.

Variables 1
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Analytic 1 (an1)
1 On the Definitions toolbar, click Analytic.

2 In the Settings window for Analytic, type Pan in the Function name text field.

3 Locate the Definition section. In the Expression text field, type -6*pi*mu0*f0*dh*
(r0^2-rf^2)/h0^3.

4 In the Arguments text field, type rf.

5 Locate the Units section. In the Arguments text field, type m.

6 In the Function text field, type Pa.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

Name Expression Unit Description

Ftot intop1(tffs.fwallz) N Total force on disc

Ftotan -3*pi*mu0*vf*r0^4/(2*h0^3) N Analytic expression

vf 2*pi*f0*dh m/s Disc velocity

Ftotantime -6*pi^2*mu0*f0*r0^4*dh*
cos(2*pi*f0*t)/(2*(h0+dh*
sin(2*pi*f0*t))^3)

N Analytic expression
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3 In the table, enter the following settings:

The density is not required because the modified Reynolds equation is solved.

T H I N - F I L M  F L O W,  E D G E  ( T F F S )

1 In the Model Builder window, under Component 1 (comp1) click Thin-Film Flow,

Edge (tffs).

2 In the Settings window for Thin-Film Flow, Edge, locate the Equation Type section.

3 From the Equation type list, choose Modified Reynolds equation.

Fluid-Film Properties 1
Reverse the direction of the geometry normal. Note that this is necessary to ensure that 
the wall load acts in the vertical direction. See  for more details on the orientation of the 
wall and base with respect to the geometric and reference surface normals. To view the 
orientation of the reference normal, show the default solver settings and then compute 
only to the dependent variables stage in the study sequence. Then plot the reference 
surface normal.

1 In the Model Builder window, under Component 1 (comp1)>Thin-Film Flow, Edge (tffs) 
click Fluid-Film Properties 1.

2 In the Settings window for Fluid-Film Properties, click to expand the 
Reference surface properties section.

3 Locate the Reference Surface Properties section. From the Reference normal orientation 
list, choose Opposite direction to geometry normal.

4 Locate the Wall Properties section. In the hw1 text field, type h0.

5 From the uw list, choose None.

6 From the vw list, choose User defined. Specify the vector as

Fluid-Film Properties 2
1 Right-click Component 1 (comp1)>Thin-Film Flow, Edge (tffs)>Fluid-Film Properties 1 and 

choose Duplicate.

2 Click in the Graphics window and then press Ctrl+A to select all boundaries.

Property Name Value Unit Property group

Dynamic viscosity mu mu0 Pa·s Basic

0 r

vf z
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3 In the Settings window for Fluid-Film Properties, locate the Wall Properties section.

4 From the uw list, choose User defined. Specify the associated vector as

5 From the vw list, choose Calculate from wall displacement.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Element size list, choose Extra fine.

4 Click Build All.

5 Click the Zoom Extents button on the Graphics toolbar.

S T U D Y  1

Step 1: Frequency Domain
1 In the Settings window for Frequency Domain, locate the Study Settings section.

2 In the Frequencies text field, type 1000.

3 Locate the Physics and Variables Selection section. Select the 
Modify physics tree and variables for study step check box.

4 In the Physics and variables selection tree, select Component 1 (comp1)>Thin-Film Flow,

Edge (tffs)>Fluid-Film Properties 2.

5 Click Disable.

6 In the Physics and variables selection tree, select Component 1 (comp1).

7 On the Home toolbar, click Compute.

R E S U L T S

1D Plot Group 2
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Plot Settings section.

3 Select the x-axis label check box.

4 In the associated text field, type Radial distance (m).

5 Select the y-axis label check box.

0 r

dh*sin(2*pi*f0*t) z
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6 In the associated text field, type Pressure (Pa).

7 Click to expand the Legend section. From the Position list, choose Upper left.

Line Graph 1
1 Right-click 1D Plot Group 2 and choose Line Graph.

2 Click in the Graphics window and then press Ctrl+A to select all boundaries.

3 In the Settings window for Line Graph, click to expand the Legends section.

4 Select the Show legends check box.

5 From the Legends list, choose Manual.

6 In the table, enter the following settings:

Line Graph 2
1 In the Model Builder window, under Results right-click 1D Plot Group 2 and choose 

Line Graph.

2 Click in the Graphics window and then press Ctrl+A to select all boundaries.

3 In the Settings window for Line Graph, locate the y-Axis Data section.

4 In the Expression text field, type Pan(r).

5 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose None.

6 Find the Line markers subsection. From the Marker list, choose Cycle.

7 Locate the Legends section. Select the Show legends check box.

8 From the Legends list, choose Manual.

9 In the table, enter the following settings:

10 On the 1D Plot Group 2 toolbar, click Plot.

11 Click the Zoom Extents button on the Graphics toolbar.

1D Plot Group 2
1 Right-click 1D Plot Group 2 and choose Rename.

2 In the Rename 1D Plot Group dialog box, type Radial Pressure in the New label text 
field.

Legends

COMSOL

Legends

Analytic Solution
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3 Click OK.

Arrow Line 1
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Model Builder window, right-click 2D Plot Group 3 and choose Arrow Line.

3 In the Settings window for Arrow Line, click Replace Expression in the upper-right corner 
of the Expression section. From the menu, choose Component 1>Thin-Film Flow, Edge>

Fluid loads>tffs.fwallr,tffs.fwallz - Fluid load on wall.

4 Locate the Coloring and Style section. In the Number of arrows text field, type 30.

5 Select the Scale factor check box.

6 Use the slider to adjust the arrow length.

7 On the 2D Plot Group 3 toolbar, click Plot.

8 Click the Zoom Extents button on the Graphics toolbar.

Line 1
1 In the Model Builder window, under Results right-click 2D Plot Group 3 and choose Line.

2 In the Settings window for Line, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose Component 1>Thin-Film Flow, Edge>

Fluid loads>Fluid load on wall>tffs.fwallz - Fluid load on wall, z component.

3 Locate the Coloring and Style section. Select the Reverse color table check box.

4 On the 2D Plot Group 3 toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

2D Plot Group 3
1 Right-click 2D Plot Group 3 and choose Rename.

2 In the Rename 2D Plot Group dialog box, type Wall Load in the New label text field.

3 Click OK.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 Click Evaluate.

Expression Unit Description

abs(Ftot) N
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Global Evaluation 2
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>Definitions>

Variables>Ftotan - Analytic expression.

3 Click Table 1 - Global Evaluation 1 (abs(Ftot)).

R O O T

The agreement between the total force computed by COMSOL and the analytic 
expression is excellent.

Next add a study to solve the problem in the time domain.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Time Dependent.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Time Dependent
1 In the Model Builder window, under Study 2 click Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 Click Range.

4 In the Range dialog box, type 1/(40*f0) in the Step text field.

5 In the Stop text field, type 5/f0.

6 Click Replace.

7 In the Settings window for Time Dependent, click to expand the Study extensions section.

8 Locate the Study Extensions section. Select the Auxiliary sweep check box.

9 Click Add.
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10 In the table, enter the following settings:

11 On the Home toolbar, click Compute.

R E S U L T S

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Point Graph 1
1 Right-click 1D Plot Group 5 and choose Point Graph.

2 Select Point 1 only.

3 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-axis data section. From the menu, choose Component 1>Thin-Film Flow,

Edge>Wall and base properties>tffs.hw - Height of wall above reference plane.

4 On the 1D Plot Group 5 toolbar, click Plot.

5 Click to expand the Legends section. Select the Show legends check box.

1D Plot Group 5
1 In the Model Builder window, under Results click 1D Plot Group 5.

2 In the Settings window for 1D Plot Group, click to expand the Axis section.

3 Select the Manual axis limits check box.

4 In the y minimum text field, type 0.

5 Locate the Legend section. From the Position list, choose Lower right.

6 On the 1D Plot Group 5 toolbar, click Plot.

7 Right-click Results>1D Plot Group 5 and choose Rename.

8 In the Rename 1D Plot Group dialog box, type Wall height vs time in the New label 
text field.

9 Click OK.

10 On the Wall height vs time toolbar, click Plot.

Parameter name Parameter value list Parameter unit

dhND 0.01 0.1 0.2 0.3
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11 Click the Zoom Extents button on the Graphics toolbar.

The wall height varies sinusoidally, as expected. Except in the case when dhND is 0.01, 
the height varies by a significant fraction of the gap. This means that the equation 
system is non-linear.

1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Point Graph 1
1 Right-click 1D Plot Group 6 and choose Point Graph.

2 Select Point 1 only.

3 On the 1D Plot Group 6 toolbar, click Plot.

1D Plot Group 6
1 In the Model Builder window, under Results right-click 1D Plot Group 6 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Pressure vs time in the New label text 
field.

3 Click OK.

4 On the Pressure vs time toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

Once the wall height varies by a significant fraction of the gap non-linear effects become 
important. The pressure does not vary sinusoidally any more and it is no longer possible 
to model the equation straightforwardly in the frequency domain.

When the height variations are small direct comparison with the frequency domain 
solution is possible. Do this by comparing the maximum value of the pressure in the 
time domain with the amplitude of the pressure computed in the frequency domain.

Point Evaluation 1
1 On the Results toolbar, click Point Evaluation.

2 Select Point 1 only.

3 In the Settings window for Point Evaluation, locate the Expressions section.
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4 In the table, enter the following settings:

5 Click Evaluate.

Point Evaluation 2
1 On the Results toolbar, click Point Evaluation.

2 In the Settings window for Point Evaluation, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

4 From the Parameter selection (dhND) list, choose From list.

5 In the Parameter values (dhND) list, select 0.01.

6 Select Point 1 only.

7 Locate the Data Series Operation section. From the Operation list, choose Minimum.

8 Click Evaluate.

TA B L E

1 Go to the Table window.

In this case the time and frequency domain analyses are in good agreement.

R E S U L T S

1D Plot Group 7
1 On the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Global 1
1 Right-click 1D Plot Group 7 and choose Global.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Definitions>Variables>

Ftot - Total force on disc.

Global 2
1 In the Model Builder window, under Results right-click 1D Plot Group 7 and choose 

Global.

Expression Unit Description

abs(pfilm) Pa
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2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Definitions>Variables>

Ftotantime - Analytic expression.

3 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose Dashed.

1D Plot Group 7
1 In the Model Builder window, under Results click 1D Plot Group 7.

2 In the Settings window for 1D Plot Group, locate the Axis section.

3 Select the Manual axis limits check box.

4 In the x minimum text field, type 0.003.

5 In the x maximum text field, type 0.005.

6 Locate the Legend section. From the Position list, choose Lower left.

7 Right-click Results>1D Plot Group 7 and choose Rename.

8 In the Rename 1D Plot Group dialog box, type Total force on disc vs time in the 
New label text field.

9 Click OK.

10 On the Total force on disc vs time toolbar, click Plot.

11 Click the Zoom Extents button on the Graphics toolbar.

The agreement between the COMSOL result and the analytic expression is good. The 
force acting on the disc remains periodic but has higher harmonic components at large 
displacements relative to the gap size.
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Introduction

This example shows how to model a surface micromachined accelerometer in COMSOL, 
using the electromechanics interface. The example is based on the case study in Ref. 1. The 
model also demonstrates the new geometry feature of Linked Subsequences, first 
introduced in COMSOL 5.0. A collection of geometric building blocks can be stored in a 
source model file as Subsequences. Thereafter other model files can re-use the same 
building blocks by linking to the Subsequences in the source model file. Each Subsequence 
can take arguments to generate a building block with specific dimensions and/or number 
of features. In this model a surface micromachined accelerometer is created from three 
building blocks, two of which are used multiple times by calling the corresponding 
Subsequence with different arguments.

Model Definition

The surface micromachined accelerometer is composed of a released proof mass supported 
by anchored springs at its two ends, together with sensing and self test electrodes 
extending to the sides. When the device is subject to an acceleration, the restoring force 
from the springs gives a displacement of the proof mass in proportion to the acceleration. 
The displacement causes a change in the capacitance between the fixed and moving 
electrodes. This change in capacitance can be measured with a number of standard circuits.

For acceleration along the axis of the accelerometer, symmetry allows modeling only half 
of the geometry for faster computation. The three geometric building blocks are the proof 
mass with attached electrodes (Figure 1), the folded spring (Figure 2), and the fixed 
electrode array (Figure 3). These building blocks are implemented as Subsequences that 
take arguments to specify dimensions, orientation, position, and number of features. For 
example, the proof mass shown in Figure 1 has 7 sense electrodes at the center and 3 self 
test electrodes at each end. The actual model on the other hand is built with 21 sense 
electrodes, by calling the same Subsequence with the corresponding argument 21. As 
another example, Figure 4 shows an electrode array built from the same Subsequence as 
in Figure 3, with a different set of arguments, resulting in different number of electrodes, 
dimensions, and orientation of the anchor pads.
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Figure 1: Building block for the proof mass with attached electrodes. Grid scales are in 
micrometers.

Figure 2: Building block for the folded spring. Grid scales are in micrometers.

Figure 3: Building block for the fixed electrode array. Grid scales are in micrometers.
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Figure 4: Example of an electrode array built from the same Subsequence as in Figure 3, with 
a different set of arguments. Grid scales are in micrometers.

The geometry sequence begins by calling the proof mass Subsequence, followed by calling 
the folded spring Subsequence twice to attach a spring at each end of the proof mass. 
Subsequently 6 calls to the fixed electrode array Subsequence are made to construct the 
sense and self test fixed electrodes.

Each Subsequence call contributes to a domain and a boundary selection. This allows easy 
assignment of domain physics and boundary conditions in the physics interface.

The model uses polysilicon for the building material and includes a rectangular air domain 
surrounding the polysilicon. The Electromechanics interface models the electric field 
within the deforming gaps between the electrodes, and applies the appropriate 
electrostatic forces to the solids, which creates a corresponding structural deformation. 
The narrowing electrostatics domain results in nonlinear geometrical effects which are 
included in the Electromechanics interface by default.

The entire polysilicon solid is subject to an acceleration using the Body Load domain 
physics feature. The (mechanically) fixed electrodes are set at constant potentials, and the 
proof mass (and its attached electrodes) is at a floating potential whose value will be 
determined by the position-dependent capacitance (and the applied voltages on the fixed 
sense electrodes).

Results and Discussion

The first study illustrates the normal operation of the accelerometer by sweeping the 
applied acceleration from -50 to +50 g and computing the resulting displacement of the 
proof mass. Figure 5 shows the displacement of the polysilicon domains when the applied 
acceleration is 50 g. The proof mass (and the attached moving electrodes) moves by about 
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0.07 micrometer. The anchored spring bases and the fixed electrodes have very little 
movement. The folded springs have varying displacement along its length as expected.

Figure 5: Displacement of the polysilicon domains when the applied acceleration is 50 g. The 
proof mass moves by about 0.07 micrometer. The anchored spring bases and the fixed electrodes 
have very little movement. The springs have varying displacement along its length as expected.
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Figure 6: Displacement vs acceleration.

Figure 6 shows the linear relationship between the displacement and the applied 
acceleration. The displacement is measured via the capacitive coupling between the 
moving and the fixed sense electrodes. In the real device, during normal operation, the 
proof mass with its attached moving electrodes is floating at a potential close to one half 
of the supply voltage, and a high frequency square wave swinging between zero and the 
full supply voltage is applied with opposite phase to the fixed sense electrodes on each side 
of the moving electrodes. The fixed self test electrodes are biased at one half of the supply 
voltage. When the proof mass moves as a result of the acceleration, an alternating voltage 
in proportion to the displacement is induced due to the capacitive coupling between the 
fixed and moving electrodes. This arrangement nulls the average electrostatic force 
between the fixed and moving sense electrodes, and facilitates easier signal processing in 
the attached circuitry. In this example the stationary part of the square wave is modeled 
using a stationary study, so that the problem solves relatively quickly. The bias is shifted to 
zero for convenience, and the amplitude of the square wave is divided by an artificial factor 
of 1000 to reduce the electrostatic force between the fixed and moving sense electrodes 
(in practice the time average of the force will be zero due to the high frequency excitation). 
For a 5 V supply in the physical device, this corresponds to applying a +/-2.5 mV on the 
right-side and left-side fixed sense electrodes in the model. In post processing the artificial 
factor of 1000 is multiplied back to the sensed voltage of the proof mass. Figure 7 shows 
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the linear relationship between the sense voltage and the acceleration. This signal is fed 
into an amplifier that in the real device was built on the same substrate as the mechanical 
structure.

Figure 7: Sensed voltage vs. applied acceleration.

The accelerometer in the model was designed with self test electrodes that could be 
employed to calibrate the device in the factory. The second study illustrates the self testing 
by applying a bias of 2 V on the fixed self test electrodes, which are at the side of the 
moving electrodes attached to the proof mass. The electric field between the fixed and the 
moving electrodes exerts an electrostatic force that causes the proof mass to move. 
Figure 8 shows the displacement of the polysilicon domains when 0 V is applied to the 
fixed self test electrodes on the left-hand side of the moving electrodes attached to the 
proof mass, and 2 V to those on the right-hand side. The proof mass moves by about 
0.02 μm, which is large enough in magnitude for the self test purpose (compared to the 
0.07 μm of full range displacement shown in Figure 5 and Figure 6).
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Figure 8: Displacement of the polysilicon domains when 0 V is applied to the fixed self test 
electrodes on the left-hand side of the moving electrodes attached to the proof mass, and 2 V to 
those on the right-hand side. The proof mass moved by about 0.02 μm, which is large enough in 
magnitude for the self test purpose (compared to the 0.07 μm of full range displacement shown 
in Figure 5 and Figure 6).

Figure 9 compares the displacement obtained from applying the self test voltage to each 
side of the fixed electrodes. The displacement values have the same magnitude with 
opposite signs, as expected from symmetry.
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Figure 9: Displacement vs. applied self test voltage.
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Application Library path: MEMS_Module/Sensors/
surface_micromachined_accelerometer

Modeling Instructions

Load the geometry file.

R O O T

1 From the File menu, choose Open.
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2 Browse to the model’s Application Libraries folder and double-click the file 
surface_micromachined_accelerometer_geom_sequence.mph.

The model geometry has been set up using parts in a linked file. It is easier to visualize 
with wireframe rendering.

C O M P O N E N T  1  ( C O M P 1 )

1 Click the Wireframe Rendering button on the Graphics toolbar.

2 Click the Zoom Extents button on the Graphics toolbar.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component 1.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select MEMS>Semiconductors>Si - Polycrystalline Silicon.

3 Click Add to Component 1.

M A T E R I A L S

Si - Polycrystalline Silicon (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Si -

Polycrystalline Silicon (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Polysilicon.

4 On the Home toolbar, click Add Material to close the Add Material window.

E L E C T R O M E C H A N I C S  ( E M I )

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromechanics (emi) and choose Linear Elastic Material.

2 In the Settings window for Linear Elastic Material, locate the Domain Selection section.

3 From the Selection list, choose Polysilicon.

4 In the Model Builder window, collapse the Electromechanics (emi) node.
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5 In the Model Builder window, expand the Electromechanics (emi) node.

Body Load 1
1 Right-click Electromechanics (emi) and choose the domain setting Structural>Body Load.

2 In the Settings window for Body Load, locate the Force section.

3 Specify the FV vector as

4 Locate the Domain Selection section. From the Selection list, choose Polysilicon.

Symmetry 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose Symmetry plane.

Fixed Constraint 1
1 Right-click Electromechanics (emi) and choose the boundary condition Structural>

Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 From the Selection list, choose Anchor plane.

Ground 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Ground.

2 Select Boundary 45 only.

Terminal 1
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Terminal.

2 In the Settings window for Terminal, locate the Terminal section.

3 From the Terminal type list, choose Voltage.

4 In the V0 text field, type -2.5[mV].

5 Click the Zoom Extents button on the Graphics toolbar.

acceleration*emi.rho*g_const x

0 y

0 z
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6 Locate the Boundary Selection section. From the Selection list, choose 
Sense left boundaries.

7 Right-click Component 1 (comp1)>Electromechanics (emi)>Terminal 1 and choose 
Rename.

8 In the Rename Terminal dialog box, type Sense Terminal L in the New label text field.

9 Click OK.

Terminal 2
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Electrical>Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.

3 From the Selection list, choose Sense right boundaries.

4 Locate the Terminal section. From the Terminal type list, choose Voltage.

5 In the V0 text field, type 2.5[mV].

6 Right-click Component 1 (comp1)>Electromechanics (emi)>Terminal 2 and choose 
Rename.

7 In the Rename Terminal dialog box, type Sense Terminal R in the New label text field.

8 Click OK.

Floating Potential 1
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Electrical>Floating Potential.

2 In the Settings window for Floating Potential, locate the Boundary Selection section.

3 From the Selection list, choose Proof mass boundaries.

Terminal 3
1 Right-click Electromechanics (emi) and choose the boundary condition Electrical>

Terminal.

2 In the Settings window for Terminal, locate the Terminal section.

3 From the Terminal type list, choose Voltage.

4 In the V0 text field, type VtestL.

5 Right-click Component 1 (comp1)>Electromechanics (emi)>Terminal 3 and choose 
Rename.

6 In the Rename Terminal dialog box, type Self Test Terminal L in the New label text 
field.

7 Click OK.
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8 In the Settings window for Terminal, locate the Boundary Selection section.

9 From the Selection list, choose Self test left boundaries.

Terminal 4
1 In the Model Builder window, right-click Electromechanics (emi) and choose the 

boundary condition Electrical>Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.

3 From the Selection list, choose Self test right boundaries.

4 Locate the Terminal section. From the Terminal type list, choose Voltage.

5 In the V0 text field, type VtestR.

6 Right-click Component 1 (comp1)>Electromechanics (emi)>Terminal 4 and choose 
Rename.

7 In the Rename Terminal dialog box, type Self Test Terminal R in the New label text 
field.

8 Click OK.

M E S H  1

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Meshing plane.

4 Click Build Selected.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Domain Selection section.

4 Click Clear Selection.

5 Select Domain 3 only.

6 Click Build All.

S T U D Y  1

1 In the Model Builder window, right-click Study 1 and choose Rename.
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2 In the Rename Study dialog box, type Study 1: Normal Operation in the New label 
text field.

3 Click OK.

S T U D Y  1 :  N O R M A L  O P E R A T I O N

Step 1: Stationary
1 In the Model Builder window, expand the Study 1: Normal Operation node, then click 

Step 1: Stationary.

2 In the Settings window for Stationary, click to expand the Study extensions section.

3 Locate the Study Extensions section. Select the Auxiliary sweep check box.

4 Click Add.

5 Click Range.

6 In the Range dialog box, type -50 in the Start text field.

7 In the Step text field, type 25.

8 In the Stop text field, type 50.

9 Click Add.

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

3 In the Model Builder window, expand the Study 1: Normal Operation>

Solver Configurations>Solution 1 (sol1)>Stationary Solver 1>Segregated 1 node.

4 In the Model Builder window, expand the Study 1: Normal Operation>

Solver Configurations>Solution 1 (sol1)>Stationary Solver 1>Iterative 1 node, then click 
Study 1: Normal Operation>Solver Configurations>Solution 1 (sol1)>Stationary Solver 1>

Segregated 1>Segregated Step 1.

5 In the Settings window for Segregated Step, locate the General section.

6 From the Linear solver list, choose Iterative 1.

7 In the Model Builder window, under Study 1: Normal Operation>Solver Configurations>

Solution 1 (sol1)>Stationary Solver 1>Iterative 1 click Multigrid 1.

8 In the Settings window for Multigrid, locate the General section.

9 From the Solver list, choose Geometric multigrid.

10 On the Study toolbar, click Compute.
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R E S U L T S

Point Graph 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 3 and choose Point Graph.

3 In the Settings window for Point Graph, locate the Selection section.

4 Select the Active toggle button.

5 Select Point 65 only.

6 Click Replace Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromechanics (Solid Mechanics)>Displacement>

Displacement field (material and geometry frames)>u - Displacement field, X component.

1D Plot Group 3
1 In the Model Builder window, under Results right-click 1D Plot Group 3 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Displacement vs. Acceleration in 
the New label text field.

3 Click OK.

4 In the Settings window for 1D Plot Group, locate the Plot Settings section.

5 Select the x-axis label check box.

6 In the associated text field, type Acceleration (g).

7 On the Displacement vs. Acceleration toolbar, click Plot.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 4 and choose Global.

3 In the Settings window for Global, locate the y-Axis Data section.

4 In the table, enter the following settings:

5 Click to expand the Legends section. Clear the Show legends check box.

6 On the 1D Plot Group 4 toolbar, click Plot.

Expression Unit Description

emi.V0_fp1*1000 mV Raw sense voltage
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1D Plot Group 4
1 In the Model Builder window, under Results right-click 1D Plot Group 4 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Sense V vs. Acceleration in the 
New label text field.

3 Click OK.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study.

S T U D Y  2

Step 1: Stationary
1 On the Home toolbar, click Add Study to close the Add Study window.

2 In the Model Builder window, under Study 2 click Step 1: Stationary.

3 In the Settings window for Stationary, locate the Study Extensions section.

4 Select the Auxiliary sweep check box.

5 Click Add.

6 In the table, enter the following settings:

7 Click Add.

8 In the table, enter the following settings:

9 From the Run continuation for list, choose No parameter.

10 In the Model Builder window, right-click Study 2 and choose Rename.

11 In the Rename Study dialog box, type Study 2: Self Test in the New label text field.

12 Click OK.

Parameter name Parameter value list Parameter unit

VtestL 2 0

Parameter name Parameter value list Parameter unit

VtestR 0 2
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S T U D Y  2 :  S E L F  TE S T

Solution 2 (sol2)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 2 (sol2) node.

3 In the Model Builder window, expand the Study 2: Self Test>Solver Configurations>

Solution 2 (sol2)>Stationary Solver 1>Segregated 1 node.

4 In the Model Builder window, expand the Study 2: Self Test>Solver Configurations>

Solution 2 (sol2)>Stationary Solver 1>Iterative 1 node, then click Study 2: Self Test>

Solver Configurations>Solution 2 (sol2)>Stationary Solver 1>Segregated 1>

Segregated Step 1.

5 In the Settings window for Segregated Step, locate the General section.

6 From the Linear solver list, choose Iterative 1.

7 In the Model Builder window, under Study 2: Self Test>Solver Configurations>

Solution 2 (sol2)>Stationary Solver 1>Iterative 1 click Multigrid 1.

8 In the Settings window for Multigrid, locate the General section.

9 From the Solver list, choose Geometric multigrid.

10 On the Study toolbar, click Compute.

R E S U L T S

Displacement (emi) 1
Click the Zoom Extents button on the Graphics toolbar.

Slice 1
1 In the Model Builder window, expand the Potential (emi) 1 node, then click Slice 1.

2 In the Settings window for Slice, locate the Plane Data section.

3 In the Planes text field, type 8.

4 On the Potential (emi) 1 toolbar, click Plot.

1D Plot Group 7
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2: Self Test/Solution 2 (sol2).

Point Graph 1
1 Right-click 1D Plot Group 7 and choose Point Graph.
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2 Select Point 65 only.

3 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-axis data section. From the menu, choose Component 1>

Electromechanics (Solid Mechanics)>Displacement>

Displacement field (material and geometry frames)>u - Displacement field, X component.

4 Locate the x-Axis Data section. From the Parameter list, choose Expression.

5 In the Expression text field, type VtestR.

6 On the 1D Plot Group 7 toolbar, click Plot.

1D Plot Group 7
1 In the Model Builder window, under Results right-click 1D Plot Group 7 and choose 

Rename.

2 In the Rename 1D Plot Group dialog box, type Displacement vs. Self Test V in the 
New label text field.

3 Click OK.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Electromechanics (emi).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Stationary.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Geometry Parts
1 In the Model Builder window, right-click Global Definitions and choose Geometry Parts.

2 On the Geometry toolbar, click Parts and choose Load Part.
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3 Browse to the model’s Application Libraries folder and double-click the file 
surface_micromachined_accelerometer_geom_subsequence.mph.

4 In the Load Part dialog box, In the Select parts list, choose Proof mass with fingers, 
Spring and anchor, and Electrode array.

5 Click OK.

E L E C T R O M E C H A N I C S  ( E M I )

In the Model Builder window, collapse the Component 1 (comp1)>Electromechanics (emi) 
node.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
surface_micromachined_accelerometer_parameters.txt.

G E O M E T R Y  1

Proof mass with fingers 1 (pi1)
1 On the Geometry toolbar, click Parts and choose Proof mass with fingers.

2 In the Settings window for Part Instance, type Part Link: Proof mass in the Label 
text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

l_PM l_PM 4.48E-4 m Proof mass length

w_PM w_PM 1E-4 m Proof mass full width

t_PM tSi 2E-6 m Proof mass thickness

l_f l_f 1.14E-4 m Length of finger

w_f w_f 4E-6 m Width of finger

n_st n_st 3 Number of self test fingers

n_f n_f 21 Number of sense fingers

g_f g_f 1E-6 m Gap between sense fingers

g_st g_st 3E-6 m Gap between self test fingers
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4 Click Build All Objects.

5 Click the Zoom Extents button on the Graphics toolbar.

Spring and anchor 1 (pi2)
1 On the Geometry toolbar, click Parts and choose Spring and anchor.

2 In the Settings window for Part Instance, type Part Link: Spring 1 in the Label text 
field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

Part Link: Spring 1.1 (pi3)
1 Right-click Part Link: Spring 1 and choose Duplicate.

2 In the Settings window for Part Instance, type Part Link: Spring 2 in the Label text 
field.

x_st x_st 1E-5 m Starting position of self test fingers

x_f x_f 7.2E-5 m Starting position of sense fingers

w_eh w_eh 4E-6 m Etch hole size

p_eh p_eh 1.8E-5 m Etch hole period

Name Expression Value Description

l_sp l_sp 2.8E-4 m Spring length

w_sp w_sp 2E-6 m Spring width

g_sp g_sp 1E-6 m Spring gap

w_sp_conn w_sp_conn 4E-6 m Spring connection width

w_f w_f 4E-6 m Guard finger width

l_anch_base l_anch_base 1.7E-5 m Anchor base length

w_anch_base w_anch_base 1.7E-5 m Anchor base width

r_anch r_anch 3E-6 m Anchor radius

x_anch x_anch 1.2E-5 m Anchor position

t_sp tSi 2E-6 m Spring thickness

t_anch tOx 1.6E-6 m Anchor thickness

x_sp l_PM 4.48E-4 m Position

Name Expression Value Description
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

Electrode array 1 (pi4)
1 On the Geometry toolbar, click Parts and choose Electrode array.

2 In the Settings window for Part Instance, locate the Input Parameters section.

3 In the table, enter the following settings:

4 In the Label text field, type Part Link: Sense Electrodes L.

5 Click Build All Objects.

6 Click the Wireframe Rendering button on the Graphics toolbar.

Part Link: Sense Electrodes L 1 (pi5)
1 Right-click Part Link: Sense Electrodes L and choose Duplicate.

2 In the Settings window for Part Instance, type Part Link: Sense Electrodes R in 
the Label text field.

Name Expression Value Description

mirror 0 0 0: no mirror. 1: mirror

l_sp l_sp+10[um] 2.9E-4 m Spring length

w_anch_base w_anch_base+10[um] 2.7E-5 m Anchor base width

x_sp 0[um] 0 m Position

Name Expression Value Description

LH 0 0 0: RH, 1: LH

l_e l_e_l 1.4E-4 m Electrode length

w_e w_f 4E-6 m Electrode width

l_p l_p 1.6E-5 m Pad length

w_p w_p 8E-6 m Pad width

r_an r_an 3E-6 m Anchor radius

t_e tSi 2E-6 m Electrode thickness

t_an tOx 1.6E-6 m Anchor thickness

n_e n_f+1 22 Number of electrodes

p_e 3*(w_f+g_f) 1.5E-5 m Periodicity

x_e x_f-w_f-g_f 6.7E-5 m x position

y_e w_PM/2+l_f-l_ovrlp 6E-5 m y position
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

Part Link: Sense Electrodes R 1 (pi6)
1 Right-click Component 1 (comp1)>Geometry 1>Part Link: Sense Electrodes R and choose 

Duplicate.

2 In the Settings window for Part Instance, type Part Link: Self Test Electrodes L 
1 in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

5 In the table, enter the following settings:

6 Click Build All Objects.

Part Link: Self Test Electrodes L 1.1 (pi7)
1 Right-click Component 1 (comp1)>Geometry 1>Part Link: Self Test Electrodes L 1 and 

choose Duplicate.

2 In the Settings window for Part Instance, type Part Link: Self Test Electrodes L 
2 in the Label text field.

Name Expression Value Description

LH 1 1 0: RH, 1: LH

l_e l_e_s 1.2E-4 m Electrode length

x_e x_f-2*(w_f+g_f) 62 µm x position

Name Expression Value Description

LH 0 0 0: RH, 1: LH

n_e n_st 3 Number of electrodes

p_e 3*w_f+2*g_f+g_st 1.7E-5 m Periodicity

x_e x_f-2*(w_f+g_f) 62 µm x position

Name Expression Value Description

x_e x_st-w_f-g_f 5E-6 m x position
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

Part Link: Self Test Electrodes L 2.1 (pi8)
1 Right-click Component 1 (comp1)>Geometry 1>Part Link: Self Test Electrodes L 2 and 

choose Duplicate.

2 In the Settings window for Part Instance, type Part Link: Self Test Electrodes R 
1 in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

Part Link: Self Test Electrodes R 1.1 (pi9)
1 Right-click Component 1 (comp1)>Geometry 1>Part Link: Self Test Electrodes R 1 and 

choose Duplicate.

2 In the Settings window for Part Instance, type Part Link: Self Test Electrodes R 
2 in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click Build All Objects.

5 Click Go to Default View.

Name Expression Value Description

l_e l_e_l 140 µm Electrode length

x_e l_PM-(x_st+w_f+g_f)-
(n_st-1)*(3*w_f+2*
g_f+g_st)-w_f

3.95E-4 m x position

Name Expression Value Description

LH 1 1 0: RH, 1: LH

x_e x_st-w_f-g_f+2*(w_f+g_f) 1.5E-5 m x position

Name Expression Value Description

l_e l_e_s 120 µm Electrode length

x_e l_PM-(x_st+w_f+g_f)-
(n_st-1)*(3*w_f+2*
g_f+g_st)-w_f+2*(w_f+
g_f)

4.05E-4 m x position
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Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Air box in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type l_polySi+40[um].

4 In the Depth text field, type hw_polySi+20[um].

5 In the Height text field, type 50[um].

6 Locate the Position section. In the x text field, type -l_spAssm-20[um].

7 In the z text field, type -tOx.

Air box (blk1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Air box (blk1).

2 In the Settings window for Block, click to expand the Layers section.

3 In the table, enter the following settings:

4 Click Build All Objects.

5 In the Model Builder window, click Geometry 1.

6 In the Settings window for Geometry, locate the Units section.

7 From the Length unit list, choose µm.

8 In the Model Builder window, click Air box (blk1).

9 In the Settings window for Block, click Build All Objects.

10 Click Go to Default View.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Ground plane in the Label text field.

3 Locate the Plane Definition section. In the z-coordinate text field, type -tOx.

Plane Geometry
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1>

Ground plane (wp1) click Plane Geometry.

2 Click the Zoom Extents button on the Graphics toolbar.

Layer name Thickness (m)

Layer 1 tOx

Layer 2 tSi
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Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type l_PM.

4 In the Height text field, type w_PM/2+l_f.

5 Click Build Selected.

6 In the Model Builder window, click Geometry 1.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

4 Click Build Selected.

Part Link: Proof mass (pi1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Proof mass (pi1).

2 In the Settings window for Part Instance, click to expand the Domain selections section.

3 Locate the Domain Selections section. Click to select row number 1 in the table.

4 Click New Cumulative Selection.

5 In the New Cumulative Selection dialog box, type Polysilicon in the Name text field.

6 Click OK.

7 In the Settings window for Part Instance, click to expand the Boundary selections section.

8 Locate the Boundary Selections section. Click New Cumulative Selection.

9 In the New Cumulative Selection dialog box, type Proof mass boundaries in the Name 
text field.

10 Click OK.

11 In the Settings window for Part Instance, locate the Boundary Selections section.

12 Click to select row number 1 in the table.

Distances (µm)

tOx
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13 In the table, enter the following settings:

Part Link: Spring 1 (pi2)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Spring 1 (pi2).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

5 In the table, enter the following settings:

Part Link: Spring 2 (pi3)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Spring 2 (pi3).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

5 In the table, enter the following settings:

Part Link: Sense Electrodes L (pi4)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Sense Electrodes L (pi4).

2 In the Settings window for Part Instance, locate the Domain Selections section.

Name Contribute to Keep Physics

Proof Mass + Fingers Seq csel2 √

Name Contribute to Keep Physics

Spring + anchor csel1 √

Name Contribute to Keep Physics

Spring + anchor csel2 √

Name Contribute to Keep Physics

Spring + anchor csel1 √

Name Contribute to Keep Physics

Spring + anchor csel2 √
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3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

5 Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type Sense left boundaries in the Name 
text field.

7 Click OK.

Part Link: Sense Electrodes R (pi5)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Sense Electrodes R (pi5).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

5 Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type Sense right boundaries in the 
Name text field.

7 Click OK.

Part Link: Self Test Electrodes L 1 (pi6)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Self Test Electrodes L 1 (pi6).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 Click New Cumulative Selection.

4 In the New Cumulative Selection dialog box, type Self test left boundaries in the 
Name text field.

5 Click OK.

6 In the Settings window for Part Instance, locate the Boundary Selections section.

7 Click to select row number 1 in the table.

Name Contribute to Keep Physics

Electrode array csel1 √

Name Contribute to Keep Physics

Electrode array csel1 √
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8 In the table, enter the following settings:

9 In the Model Builder window, expand the Component 1 (comp1)>Geometry 1>

Cumulative Selections node.

G E O M E T R Y  1

Part Link: Self Test Electrodes L 2 (pi7)
1 In the Model Builder window, expand the Component 1 (comp1)>Definitions node, then 

click Component 1 (comp1)>Geometry 1>Part Link: Self Test Electrodes L 2 (pi7).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 Click to select row number 1 in the table.

4 Locate the Domain Selections section. Click to select row number 1 in the table.

5 In the table, enter the following settings:

6 In the table, enter the following settings:

Part Link: Self Test Electrodes R 1 (pi8)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Self Test Electrodes R 1 (pi8).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

5 Locate the Boundary Selections section. Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type Self test right boundaries in the 
Name text field.

Name Contribute to Keep Physics

Electrode array csel5 √

Name Contribute to Keep Physics

Electrode array csel1 √

Name Contribute to Keep Physics

Electrode array csel5 √

Name Contribute to Keep Physics

Electrode array csel1 √
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7 Click OK.

8 In the Settings window for Part Instance, locate the Boundary Selections section.

9 Click to select row number 1 in the table.

10 In the table, enter the following settings:

Part Link: Self Test Electrodes R 2 (pi9)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Self Test Electrodes R 2 (pi9).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

5 In the table, enter the following settings:

Part Link: Self Test Electrodes L 1 (pi6)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Part Link: Self Test Electrodes L 1 (pi6).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 Click to select row number 1 in the table.

4 In the table, enter the following settings:

Ground plane (wp1)
1 In the Model Builder window, collapse the Component 1 (comp1)>Geometry 1>

Ground plane (wp1) node.

2 In the Model Builder window, collapse the Component 1 (comp1)>Geometry 1>

Cumulative Selections node.

Name Contribute to Keep Physics

Electrode array csel6 √

Name Contribute to Keep Physics

Electrode array csel1 √

Name Contribute to Keep Physics

Electrode array csel6 √

Name Contribute to Keep Physics

Electrode array csel1 √
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G E O M E T R Y  1

In the Model Builder window, collapse the Component 1 (comp1)>Geometry 1 node.

D E F I N I T I O N S

Box 1
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Box Limits section. In the y minimum text field, type -0.1.

5 In the y maximum text field, type 0.1.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

7 In the Label text field, type Symmetry plane.

Box 2
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, type Anchor plane in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the z minimum text field, type -tOx*1.01.

5 In the z maximum text field, type -tOx*0.99.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.

Box 3
1 On the Definitions toolbar, click Box.

2 In the Settings window for Box, type Meshing plane in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the z minimum text field, type -tOx*0.01.

5 In the z maximum text field, type tOx*0.01.

6 Locate the Output Entities section. From the Include entity if list, choose 
Entity inside box.
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Introduction

High quality factor MEMS resonators are the key components in the emerging MEMS 
timing industry. In these applications a MEMS resonator is driven at its resonant frequency 
by a feedback loop to produce a circuit that oscillates at a fixed frequency. Such frequency 
references are used in a huge range of electronic devices, from CPU clocks to mobile 
phones. For oscillator applications the quality factor of the resonator, together with the 
stability of the resonant frequency, determines the ultimate performance achievable. 
Higher quality factor resonators have a sharper peak in their frequency spectrum at the 
resonant frequency and therefore pick out a particular frequency with higher fidelity. For 
many resonant modes the limit to the achievable quality factor is determined by 
thermoelastic damping.

To understand thermoelastic damping consider the stretching of a thermally isolated 
elastic rod. When such a rod is stretched uniformly and reversibly its temperature drops. 
The drop in temperature compensates for the increase in entropy caused by the stress in 
the rod (since the process is reversible the entropy remains constant). Similarly on 
compression the rod heats up. When a structure vibrates in a more complex normal mode 
there are some regions of compression and some of extension. Depending on the timescale 
of the vibration heat flows from the warmer parts of the structure to the cooler parts. Since 
heat flow is an irreversible process, this heat flow is associated with energy loss from the 
vibrational mode, and corresponding damping for the resonant mode. Thermoelastic 
damping is particularly important in smaller MEMS structures, in which regions of 
compression and expansion are in close proximity.

Model Definition

The model consists of a single beam vibrating in its fundamental mode, perpendicular to 
its long axis. The model geometry is shown in Figure 1. The two ends of the beam are 
fixed and are assumed to be connected to a much larger body (for example a contact pad) 
which acts as a thermal reservoir.
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Figure 1: Symmetric model geometry. The geometry consists of a silicon beam 12 μm thick and 
400 μm long. The beam width is 20 μm but since the geometry is symmetric only half of the 
beam width is shown and the symmetry boundary conditions is used.The two ends of the beam 
are assumed to be clamped to a body with a large thermal mass, such as a contact pad.

This analysis computes the resonator quality factor, assuming that thermoelastic damping 
is the dominant damping mechanism. The coupled equations of thermoelasticity are 
solved within the resonator.

D E R I V A T I O N  O F  T H E  T H E R M O E L A S T I C I T Y  E Q U A T I O N S

References 1 to 7 provide useful background information.

The equations of thermoelasticity are derived from the first law of thermodynamics, which 
can be stated as follows:

 (1)

where dU is the change in internal energy, dQ' is the heat flow into the system (the prime 
indicates an inexact differential in this case) and dW' is the work done on the system. For 
a small part of a solid (sufficiently small that the stresses and strains are uniform), with an 
initial reference density, ρ0, the first law can be rewritten in the following form (assuming 
that the differential changes occur between equilibrium states):

 (2)

where Ta is the absolute temperature, s is the entropy per unit mass, σ is the elastic part 
of the second Piola-Kirchhoff stress (in general a rank 2 tensor), ε is the material strain 

Ud dQ' dW'+=

du Tads 1
ρ0
------σ: εd+=
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(also a tensor). In general the second Piola-Kirchhoff stress tensor, p, must be split into 
elastic (σ) and inelastic (τ) parts such that:

The elastic part of the stress tensor, σ, does work σ:dε during a change in the strain. The 
inelastic part of the strain tensor, τ, generates heat at a rate τ:(dε/dτ) when the strain is 
changing and is identified with internal or material damping. These internal damping 
mechanisms are associated with microscopic phenomena such as dislocation movement.

From Equation 2 it is possible to make the following identifications for Ta and σ:

Next the entropy balance equation must be derived. Because thermoelasticity involves 
irreversible processes, the assumption of equilibrium required to derive Equation 2 is no 
longer valid. Instead an assumption of ‘local’ equilibrium is made. It is assumed that 
although the system is not in equilibrium, there exists within small elements a state of local 
equilibrium, for which the local entropy per unit mass, s, is the same function of the 
internal energy, strain, and particle number as it was in equilibrium. This assumption is 
commonly employed in the modeling of transport phenomena and is justified only by the 
validity of conclusions derived from it and by results obtained from specific microscopic 
models, for near-equilibrium situations. For a small volume element in the material frame 
Equation 2 can then be written as

The rate of change of entropy can then be written as

 (3)

From the first law (Equation 1) the rate of change of internal energy is given by:

where w is the work done per unit volume and q is the heat accumulated per unit volume. 
The heat accumulated can be written as the sum of the heat sources and the divergence in 
the material frame heat flux:

p σ τ+=

Ta S∂
∂u
 
 

ε
= σ ρ0 ε∂

∂u
 
 

S
=

ρ0 sd 1
Ta
-------ρ0 ud 1

Ta
-------σ: εd–=

ρ0
ds
dt
------ ρ0

1
Ta
-------du

dt
------- 1

Ta
-------σ:dε

dt
------–=

ρ0
du
dt
------- dq

dt
------- dw

dt
--------+=
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where Q represents the heat source per unit volume and τ is the inelastic part of the stress 
tensor. The rate of doing work (per unit reference volume) by a linear elastic material is 
given by the elastic part of the second Piola-Kirchhoff stress contracted with the rate of 
material strain. Per unit volume the following equation is obtained:

so Equation 3 reduces to

The definition of the material thermal conductivity gives

where κ is the thermal conductivity, defined in the material frame.

Therefore the equation is

 (4)

It is now necessary to derive an expression for the rate of change of entropy with respect 
to time. In order to do this an assumption of local equilibrium is used once again. Using 
Equation 2 the equation is written

which defines a new thermodynamic potential, the Gibbs free energy per unit mass, given 
by

Changes in the Gibbs free energy per unit mass take the form

dq
dt
------- ∇ q⋅( )– Q τ:

td
dε

+ +=

dw
dt
-------- σ:dε

dt
------=

ρ0
ds
dt
------ 1

Ta
-------∇ q⋅–

1
Ta
-------Q 1

Ta
-------τ:

td
dε

+ +=

q κ Ta∇–=

Taρ0
ds
dt
------ ∇ κ Ta∇( )⋅ Q τ:

td
dε

+ +=

d u Tas–
1
ρ0
------σ:ε– 

  sdTa–
1
ρ0
------ε: σd–=

g u Tas 1
ρ0
------σ:ε+–=

dg sdTa–
1
ρ0
------ε:dσ–=
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which leads to the relations

By differentiating each of the above equations a second time, it is possible to derive the 
following Maxwell relation

 (5)

It is now possible to derive an expression for the entropy of the solid. Assuming that the 
elastic stress is an invertible function of the strain, we can write s=s(σ,Ta). Thus,

Using the Maxwell relation in Equation 5 gives

so that

By definition the heat capacity of the solid at constant stress is given by

Thus,

 (6)

Substituting Equation 6 into Equation 4 gives the following equation for thermoelasticity:

 (7)

s
Ta∂

∂g
 
 –=

σ
ε ρ0 σ∂

∂g
 
 –

Ta

=

σ∂
∂s
 
 

Ta

1
ρ0
------

Ta∂
∂ε
 
 =

σ σ Ta∂

2

∂
∂ g

–=

ds
σ∂

∂s
 
 

Ta

:dσ
Ta∂

∂s
 
 

σ
dTa+=

ds 1
ρ0
------

Ta∂
∂ε
 
 

σ
:dσ

Ta∂
∂s
 
 

σ
dTa+=

ds
dt
------ 1

ρ0
------

Ta∂
∂ε
 
 

σ
:dσ
dt
-------

Ta∂
∂s
 
 

σ

dTa

dt
-----------+=

cp T∂
∂q
 
 

σ
Ta T∂

∂s
 
 

σ
= =

ds
dt
------ 1

ρ0
------

Ta∂
∂ε
 
 

σ
:dσ
dt
-------

cp

Ta
-------

dTa

dt
-----------+=

ρ0cp

dTa
dt

----------- ∇ κ Ta∇( )⋅ Q τ:
td

dε Ta Ta∂
∂ε
 
 

σ
:dσ
dt
-------–+ +=
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An additional heat source term is present in Equation 7, compared to the standard heat 
transfer equations in solids. This term couples the structural problem with the heat transfer 
problem. In turn the heat transfer equation couples back into the structural problem 
through the constitutive relationship. COMSOL solves a linearized form of the 
anisotropic thermoelasticity equations given in Equation 7.

In the particular case of a linear elastic material (in the absence of damping) the stress and 
strain are related by Duhamel-Hooke’s law:

where C is the elasticity tensor, σi is the initial stress, εi is the initial strain and Tref is the 
reference temperature at which the strain and stresses take the initial values.

This equation couples the heat transfer equation to the structural problem. Given a 
temperature independent thermal expansivity, and no material damping, Equation 7 takes 
the form

which is the usual form of the equation for linear thermoelasticity.

Results and Discussion

Figure 2 shows the mode shape and the corresponding temperature distribution within 
the beam. The mode has an eigenfrequency of 63.3 kHz and a quality factor of 10700. In 
Ref. 4 Zener derived an approximate analytic expression for the quality factor of a thin 
isotropic beam vibrating in its fundamental mode, by considering only the thermal 
gradients in the direction of flexure. Zener’s expression is given by:

 (8)

where E is the Young’s modulus of the beam, α is the isotropic thermal expansivity, ω is 
the mechanical angular resonant frequency and τ is the thermal relaxation time constant 
of the system, given by:

σ σi–( ) C: ε εi– α Ta Tref–( )–( )=

ρ0cp

dTa
dt

----------- ∇ κ Ta∇( )⋅ Q Taα:dσ
dt
-------–+=

1
Q
----

EαTa
ρ0cp

--------------- ωτ

1 ωτ( )2
+

------------------------=

τ
ρ0cph2

π2κ
------------------=
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where h is the beam thickness and κ is the thermal conductivity of the mode. The resonant 
frequency of the beam can also be computed analytically and is given by:

 (9)

Table 1 compares the COMSOL model with values computed using Equation 8 and 
Equation 9 and with experimental results, obtained from Ref. 7. Note that the COMSOL 
model has a slightly higher quality factor than the theoretical result, because some of the 
thermal gradients are removed by the isothermal boundary condition (the quality factor is 
reduced significantly if a thermal insulation boundary condition is applied to the end 
boundaries—in practice the real boundary condition is somewhere between these two 
extremes).

Figure 2: Fundamental mode shape and corresponding temperature distribution within the 
beam.

TABLE 1:  COMPARISON OF RESULTS FROM THE MODEL WITH THEORY AND EXPERIMENT

SOURCE RESONANT FREQUENCY (MHZ) QUALITY FACTOR

COMSOL Model 0.63 10.7×103

ω 22,373 h

L2
------ E

12ρ0
-------------=
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

Equation 8 and 
Equation 9

0.63 10.3×103

Experiment (Ref. 7) 0.57 10.3×103

TABLE 1:  COMPARISON OF RESULTS FROM THE MODEL WITH THEORY AND EXPERIMENT

SOURCE RESONANT FREQUENCY (MHZ) QUALITY FACTOR
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Thermoelasticity (te).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Eigenfrequency.

6 Click Done.

G E O M E T R Y  1

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 4e-4.

4 In the Depth text field, type 1.2e-5.

5 In the Height text field, type 1.2e-5.

6 In the Width text field, type 4e-4.

7 Click Build All Objects.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

E0 157[GPa] 1.57E11 Pa Young’s modulus

rho0 2330[kg/m^3] 2330 kg/m³ Density

nu0 0.3 0.3 Poisson’s ratio

alpha0 2.6e-6[1/K] 2.6E-6 1/K Coefficient of thermal 
expansion

Cp0 700[J/(kg*K)] 700 J/(kg·K) Heat capacity

kappa0 90[W/(m*K)] 90 W/(m·K) Thermal conductivity
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M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

T H E R M O E L A S T I C I T Y  ( T E )

Symmetry 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Thermoelasticity (te) and choose the boundary condition Solid Mechanics>Symmetry.

2 Select Boundary 2 only.

Fixed Constraint 1
1 In the Model Builder window, right-click Thermoelasticity (te) and choose the boundary 

condition Solid Mechanics>Fixed Constraint.

2 Select Boundaries 1 and 6 only.

Zero Temperature Deviation 1
1 Right-click Thermoelasticity (te) and choose Zero Temperature Deviation.

2 Select Boundaries 1 and 6 only.

Property Name Value Unit Property 
group

Young’s modulus E E0 Pa Basic

Poisson’s ratio nu nu0 1 Basic

Density rho rho0 kg/m³ Basic

Coefficient of thermal 
expansion

alpha alpha0 1/K Basic

Thermal conductivity k kappa0 W/(m·K) Basic

Heat capacity at constant 
pressure

Cp Cp0 J/(kg·K) Basic
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M E S H  1

Mapped 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Mapped.

2 Select Boundary 1 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Distribution.

2 Select Edges 4 and 6 only.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 70.

5 Click Build All.
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S T U D Y  1

Step 1: Eigenfrequency
1 In the Settings window for Eigenfrequency, locate the Study Settings section.

2 Select the Desired number of eigenfrequencies check box.

3 In the associated text field, type 1.

4 Select the Search for eigenfrequencies around check box.

5 In the associated text field, type 0.63e6.

6 From the Eigenfrequency search method around shift list, choose Larger real part.

7 On the Home toolbar, click Compute.

R E S U L T S

Temperature Deviation (te)
1 In the Model Builder window, under Results click Temperature Deviation (te).

2 On the Temperature Deviation (te) toolbar, click Plot.

Compare the default plot with .

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>

Thermoelasticity>Global>te.Q_eig - Quality factor for eigenvalue.

3 Click Evaluate.

Compare the result with that in .
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Introduction

AT cut quartz crystals are widely employed in a range of applications, from oscillators to 
microbalances. One of the important properties of the AT cut is that the resonant 
frequency of the crystal is temperature independent to first order. This is desirable in both 
mass sensing and timing applications. AT cut crystals vibrate in the thickness shear mode 
— an applied voltage across the faces of the cut produces shear stresses inside the crystal. 
This example considers the vibration of an AT cut thickness shear oscillator, focusing on 
the mechanical response of the system in the frequency domain. The effect of a series 
capacitor on the mechanical resonance is also considered. Adding a series capacitance is a 
technique frequently employed to tune crystal oscillators.

Model Definition

The model geometry is shown in Figure 1. The oscillator consists of a single (left-handed) 
quartz disc, supported so as not to impede the motion of the vibrational mode. There are 
two electrodes on the top and bottom surfaces of the geometry, one of which is grounded.

Figure 1: Model geometry.

In the first version of the model an AC voltage is applied to the top electrode. In the 
second version, the crystal is still driven by an AC voltage, but a capacitor is placed between 
the voltage source and the top electrode of the crystal.

D O M A I N  L E V E L  E Q U A T I O N S

Within a piezoelectric crystal there is a coupling between the strain and the electric field, 
which is determined by the constitutive relation:
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 (1)

Here, S is the strain, T is the stress, E is the electric field, and D is the electric displacement 
field. The material parameters cE, e, and εS, correspond to the material stiffness, the 
coupling properties, and the permittivity. These quantities are tensors of rank 4, 3, and 2 
respectively, but, since the tensors are highly symmetric for physical reasons, they can be 
represented as matrices within an abbreviated subscript notation, which is usually more 
convenient. Equation 1 is implemented by the Piezoelectric Effect branch located under 
the Multiphysics branch. This constitutive relation is used to couple the equations of Solid 
Mechanics and Electrostatics, which are solved within the material.

M A T E R I A L  O R I E N T A T I O N

The orientation of a piezoelectric crystal cut is frequently defined by the system introduced 
by the IRE standard of 1949 (Ref. 1). This standard has undergone a number of 
subsequent revisions, with the final revision being the IEEE standard of 1987 (Ref. 2). 
Unfortunately the 1987 standard contained a number of serious errors and the IEEE 
subsequently withdrew it. COMSOL Multiphysics therefore adopts the preceding 1978 
standard (Ref. 3), which is similar to the 1987 standard, for material property definitions. 
Most of the material properties in the material library are based on the values given in the 
book by Auld (Ref. 4), which uses the 1978 IEEE conventions. This is consistent with 
general practice except in the specific case of Quartz, where it is more common to use the 
1949 IRE standard to define the material properties. COMSOL Multiphysics therefore 
provides an additional set of material properties consistent with the 1949 standard for the 
case of Quartz. Note that the material properties for quartz are based on Ref. 5, which 
uses the 1949 IRE standard (the properties are appropriately modified according to the 
different standards).

The stiffness, compliance, coupling, and dielectric material property matrices are defined 
with the crystal axes aligned with the local coordinate axes. Note that the signs of several 
matrix components differ between the IRE 1949 and the IEEE 1978 standards (see 
Table 1). In the absence of a user-defined coordinate system, the local system corresponds 
to the global X, Y, and Z coordinate axes. When an alternative coordinate system is 
selected this system defines the orientation of the crystal axes. This is the mechanism used 
in COMSOL Multiphysics to define a particular crystal cut, and typically it is necessary to 
calculate the appropriate Euler angles for the cut (given the thickness orientation for the 
wafer). All piezoelectric material properties are defined using the Voigt form of the 
abbreviated subscript notation, which is universally employed in the literature (this differs 
from the standard notation used for Linear Elastic Material in the Solid Mechanics 

T cES eTE–=

D eS εSE+=
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interface). The material properties are defined in the material frame, so that if the solid 
rotates during deformation the material properties rotate with the solid.

Crystal cuts are usually defined by a mechanism introduced by the IEEE/IRE standards. 
Both standards use a notation that defines the orientation of a virtual slice (the plate) 
through the crystal. The crystal axes are denoted X, Y, and Z and the plate, which is usually 
rectangular, is defined as having sides l, w, and t (length, width, and thickness). Initially 
the plate is aligned with respect to the crystal axes and then up to three rotations are 
defined, using a right-handed convention about axes embedded along the l, w, and t sides 
of the plate. This model uses AT cut quartz, defined in the IEEE 1978 standard as: (YXl) 
−35.25°. The first two letters in the bracketed expression always refer to the initial 
orientation of the thickness and the length of the plate. Subsequent bracketed letters then 
define up to three rotational axes, which move with the plate as it is rotated. Angles of 
rotation about these axes are specified after the bracketed expression in the order of the 
letters, using a right-handed convention. For AT cut quartz only one rotation, about the 
l axis, is required. This is illustrated in Figure 2. Note that within the 1949 IRE Standard 
AT cut quartz is denoted as: (YXl) +35.25°. Table 2 summarizes the differences between 
the standards for the AT cut.

When defining the material properties of Quartz, the orientation of the 
X, Y, and Z axes with respect to the crystal differs between the 1978 IEEE 
standard and the 1949 IRE standard. A consequence of this is that both 
the material property matrices and the crystal cuts differ between the two 
standards. Table 1 summarizes the signs for the important matrix 
elements under the two conventions. Table 2 shows the different 
definitions of the crystal cuts under the two conventions.

TABLE 1:  SIGNS FOR THE MATERIAL PROPERTIES OF QUARTZ, WITHIN THE TWO STANDARDS COMMONLY 
EMPLOYED

IRE 1949 STANDARD IEEE 1978 STANDARD

MATERIAL 
PROPERTY

RIGHT HANDED 
QUARTZ

LEFT HANDED 
QUARTZ

RIGHT HANDED 
QUARTZ

LEFT HANDED 
QUARTZ

s14 + + - -

c14 - - + +

d11 - + + -

d14 - + - +

e11 - + + -

e14 + - + -
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When defining the material orientation it is necessary to consider the orientation of the 
plate with respect to the global coordinate system in addition to the orientation of the 
plate with respect to the crystallographic axes.

This model uses AT cut quartz, defined in the IEEE 1978 standard as shown in Figure 2. 
The definition of the appropriate local coordinate system depends on the desired final 
orientation of the plate in the global coordinate system. One way to set up the plate is to 
orientate its normal parallel to the Y axis in the global coordinate system. Figure 3 shows 
how to define the local coordinate system in this case (instructions for how to set up the 
crystal in this manner are provided in brackets in the step by step instructions).

Figure 4 shows how to define the local system such that the plate has its normal parallel to 
the global Z axis, which is the case for the crystal in this model.

Whatever crystal orientation is chosen, it is critical to keep track of the orientation of the 
local system with respect to the global system, which is defined depending on the desired 
orientation of the plate in the model.

There are also a number of methods to define the local coordinate system with respect to 
the global system. Usually it is most convenient to define the local coordinates with a 
Rotated System node, which defines three Euler angles according to the ZXZ convention 
(rotation about Z, then X, then Z again). Note that these Euler angles define the local 
(crystal) axes with respect to the global axes — this is distinct from the approach of 

TABLE 2:  CRYSTAL CUT DEFINITIONS FOR QUARTZ CUTS WITHIN THE TWO STANDARDS COMMONLY EMPLOYED 
AND THE CORRESPONDING EULER ANGLES FOR DIFFERENT ORIENTATIONS OF THE CRYSTAL THICKNESS

STANDARD REPRESENTATION AT CUT

IRE 1949 Standard (YXl) +35.25°

Y-thickness Euler angles (ZXZ: 0°,−35.25°,0°)

Z-thickness Euler angles (ZXZ: 0°,−125.25°,0°)

IEEE 1978 Standard (YXl) -35.25°

Y-thickness Euler angles (ZXZ: 0°, 35.25°,0°)

Z-thickness Euler angles (ZXZ: 0°,-54.75°,0°)
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defining the cut (global) axes with respect to the crystal (local) axes.

Figure 2: Definition of the AT cut of quartz within the IEEE 1978 standard. The AT cut is 
defined as: (YXl) −35.25°. The first two bracketed letters specify the initial orientation of the 
plate, with the thickness direction, t, along the crystal Y axis and the length direction, l, along 
the X axis. Then up to three rotations about axes that move with the plate are specified by the 
corresponding bracketed letters and the subsequent angles. In this case only one rotation is 
required about the l axis, of −35.25° (in a right-handed sense).
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Figure 3: Defining an AT cut crystal plate within COMSOL Multiphysics, with normal in 
the global Y-direction. Within the 1978 IEEE standard the AT cut is defined as (YXl) -
35.25°. Start with the plate normal or thickness in the Ycr direction (a) and rotate the plate 
−35.25° about the l axis (b). The global coordinate system rotates with the plate. Finally rotate 
the entire system so that the global coordinate system is orientated as it appears in COMSOL 
Multiphysics (c). The local coordinate system should be defined with the Euler angles (ZXZ - 
0, 35.25°, 0).(d) shows a coordinate system for this system in COMSOL Multiphysics.
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Figure 4: Defining an AT cut crystal plate within COMSOL Multiphysics, with normal in 
the global Z-direction. Within the 1978 IEEE standard the AT cut is defined as (YXl) −
35.25°. Begin with the plate normal in the Zcr-direction, so the crystal and global systems are 
coincident. Rotate the plate so that its thickness points in the Ycr-direction (the starting point 
for the IEEE definition), the global system rotates with the plate (b). Rotate the plate −35.25° 
about the l axis (d). Finally rotate the entire system so that the global coordinate system is 
orientated as it appears in COMSOL Multiphysics (d). The local coordinate system should be 
defined with the Euler angles (ZXZ: 0, -54.75°, 0). (e) shows a coordinate system for this system 
in COMSOL Multiphysics.
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E L E C T R I C A L  C I R C U I T

In the first part of the model an AC voltage is applied directly to the top plate of the 
oscillator, which is grounded. In the second part of the model, a capacitor is added 
between the voltage source and the oscillator, as shown in Figure 5. In COMSOL 
Multiphysics, the oscillator is coupled into the circuit using the External I Terminal feature. 
The terminal boundary condition within the model is set to Circuit and this feature then 
captures the charge generated by the circuit. 

Figure 5: Top left: Electrical circuit for the first part of the model. Top right: Electrical circuit 
for the second part of the model. Bottom: Circuit for the second part of the model as 
implemented in COMSOL Multiphysics.

Results and Discussion

Figure 6 shows the crystal displacement at its resonant frequency of 5.11 MHz. The form 
of the displacement shows clearly the shear nature of the resonance. The potential on cut 
slices through the plate is illustrated in Figure 7. The mechanical domain frequency 
response of the oscillator is shown in Figure 8. A clear anti-resonance is apparent, with a 
resonant frequency close to 5.11 MHz.

The addition of a series capacitance between the oscillator and the voltage source is 
expected to pull the resonant frequency to higher values. Figure 9 shows that this effect 
occurs as expected, with the resonant frequency increasing the most for smaller values of 
the series capacitance (in the limit of very large series capacitance the impedance of the 
series capacitor goes to zero and produces the result shown in Figure 8).

Series 
capacitor Cs

Series 
capacitor Cs

Ground

Ground

Ground

AC voltage 
source

AC voltage 
source

AC voltage 
source

External I 
terminal

Oscillator

Oscillator

V

VV
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Figure 6: Displacement of the crystal at resonance.

Figure 7: Electric potential inside the crystal at resonance.
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Figure 8: Mechanical response of the structure with no series capacitance.

Figure 9: Mechanical response of the structure with different series capacitances.
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>

Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Add parameters for the model geometry and series capacitance.

Parameters
1 On the Home toolbar, click Parameters.
12 |  T H I C K N E S S  S H E A R  M O D E  Q U A R T Z  O S C I L L A T O R



2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Create the geometry.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type R0.

4 In the Height text field, type H0.

If you wish to set up the material orientation using the alternative method shown in , 
change the Axis type to y-axis.

5 Click Build All Objects.

D E F I N I T I O N S

Set up a rotated system appropriate for AT cut Quartz.

Rotated System 2 (sys2)
1 On the Definitions toolbar, click Coordinate Systems and choose Rotated System.

2 In the Settings window for Rotated System, locate the Settings section.

3 Find the Euler angles (Z-X-Z) subsection. In the β text field, type -54.75[deg].

If you wish to set up the material orientation using the alternative method shown in , 
type 35.25[deg] in the β text field.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Piezoelectric>Quartz LH (1978 IEEE).

4 Click Add to Component in the window toolbar.

Name Expression Value Description

Cs 1[pF] 1E-12 F Series capacitance

R0 835[um] 8.35E-4 m Oscillator radius

H0 334[um] 3.34E-4 m Oscillator thickness
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M A T E R I A L S

Quartz LH (1978 IEEE) (mat1)
On the Home toolbar, click Add Material to close the Add Material window.

S O L I D  M E C H A N I C S  ( S O L I D )

Use the rotated system to define the orientation of the crystal.

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.

2 In the Settings window for Piezoelectric Material, locate the Coordinate System Selection 
section.

3 From the Coordinate system list, choose Rotated System 2 (sys2).

Add damping to the model.

Mechanical Damping 1
1 Right-click Component 1 (comp1)>Solid Mechanics (solid)>Piezoelectric Material 1 and 

choose Damping.

2 In the Settings window for Mechanical Damping, locate the Damping Settings section.

3 From the Damping type list, choose Isotropic loss factor.

4 From the ηs list, choose User defined. In the associated text field, type 1e-3.

E L E C T R O S T A T I C S  ( E S )

Add electrical boundary conditions to the model. First add a Terminal boundary condition 
that connects the electrode to an external circuit.

Terminal 1
1 In the Model Builder window, under Component 1 (comp1) right-click Electrostatics (es) 

and choose the boundary condition Terminal.

2 Select Boundary 4 only.

3 In the Settings window for Terminal, locate the Terminal section.

4 From the Terminal type list, choose Circuit.

Over-ride the preceding boundary condition with a constant potential boundary 
condition to compute the response of the device without a series capacitance. This node 
will be disabled in the study when the circuit is included in the model.
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Terminal 2
1 In the Model Builder window, right-click Electrostatics (es) and choose the boundary 

condition Terminal.

2 In the Settings window for Terminal, locate the Terminal section.

3 In the Terminal name text field, type 1.

4 Select Boundary 4 only.

5 From the Terminal type list, choose Voltage.

6 In the V0 text field, type 10.

Ground 1
1 Right-click Electrostatics (es) and choose Ground.

2 Select Boundary 3 only.

R O O T

In the second study in this model, the effect of a series capacitor on the device response 
will be investigated. Add an Electrical Circuit interface to model the capacitor.

A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select AC/DC>Electrical Circuit (cir).

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Physics to close the Add Physics window.

E L E C T R I C A L  C I R C U I T  ( C I R )

Features in the Electric Circuits interface are connected by specifying connecting node 
numbers for each port of the device.

Ground Node 1
A ground node is automatically added to the circuit, with the default node number of 0.

Next add a voltage source between the ground node and a (newly created) node with 
number 2.

Voltage Source V1
1 In the Model Builder window, right-click Electrical Circuit (cir) and choose Voltage Source.

2 In the Settings window for Voltage Source, locate the Node Connections section.
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3 In the table, enter the following settings:

4 Locate the Device Parameters section. From the Source type list, choose AC-source.

5 In the Vsrc text field, type 10.

Add a capacitor between the voltage source output (node 2) and a new node, 1.

Capacitor C1
1 Right-click Electrical Circuit (cir) and choose Capacitor.

2 In the Settings window for Capacitor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the C text field, type Cs.

Connect node 1 to the Terminal feature in the model using the External I-Terminal 
feature.

External I-Terminal 1
1 Right-click Electrical Circuit (cir) and choose External Couplings>External I-Terminal.

Couple the electric potential from the Terminal in the electrostatics interface back into 
the model.

2 In the Settings window for External I-Terminal, locate the Node Connections section.

3 In the Node name text field, type 1.

4 Locate the External Terminal section. From the V list, choose Terminal voltage (es).

M E S H  1

Create a swept triangular mesh.

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Free Triangular.

2 Select Boundary 4 only.

Label Node names

p 2

n 0

Label Node names

p 2

n 1
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Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 4.

5 Click Build All.

The mesh used here is somewhat coarse for the range of frequencies that are solved for. 
This is mainly to keep the computational time and RAM requirements as low as 
possible. Interested users are encouraged to solve the problem for finer mesh settings.

S T U D Y  1

Set up and solve a frequency dependent study.

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog box, type 5.095[MHz] in the Start text field.

5 In the Step text field, type 1[kHz].
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6 In the Stop text field, type 5.13[MHz].

7 Click Replace.

In the first study, disable the electrical circuit.

8 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

9 In the table, clear the Solve for check box for the Electrical Circuit (cir) interface.

10 On the Home toolbar, click Compute.

R E S U L T S

Instead of the stress plot, visualize the mode shape of the device at resonance. Note that 
this plot and subsequent plots will appear rotated compared to that shown in  if the 
alternative definition of the material orientation described in  is used.

Stress (solid)
1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, type Displacement in the Label text field.

3 Locate the Data section. From the Parameter value (freq (Hz)) list, choose 5.112E6.

Surface 1
1 In the Model Builder window, expand the Results>Displacement node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.

3 Locate the Expression section. From the Unit list, choose nm.

4 Click the Zoom Extents button on the Graphics toolbar.

5 On the Displacement toolbar, click Plot.

The second default plot shows the electric potential within the device. For a better view, 
plot 5 slices in xy planes.

Electric Potential (es)
1 In the Model Builder window, under Results click Electric Potential (es).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (Hz)) list, choose 5.112E6.
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Multislice 1
1 In the Model Builder window, expand the Electric Potential (es) node, then click 

Multislice 1.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the x-planes subsection. In the Planes text field, type 5.

4 Find the y-planes subsection. In the Planes text field, type 0.

5 Find the z-planes subsection. In the Planes text field, type 0.

6 On the Electric Potential (es) toolbar, click Plot.

Add a plot to show the mechanical response of the device.

1D Plot Group 3
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Mechanical Response in the Label text 
field.

Point Graph 1
1 Right-click Mechanical Response and choose Point Graph.

2 Select Point 8 only.

3 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-axis data section. From the menu, choose Component 1>Solid Mechanics>

Displacement>Displacement field (material and geometry frames)>u - Displacement field,

X component.

4 Locate the y-Axis Data section. From the Unit list, choose nm.

5 Locate the x-Axis Data section. From the Unit list, choose MHz.

6 On the Mechanical Response toolbar, click Plot.

Now set up a study to compute the frequency response of the device with different 
capacitors added in series.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.
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S T U D Y  2

Step 1: Frequency Domain
1 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog box, type 5.095[MHz] in the Start text field.

5 In the Step text field, type 1[kHz].

6 In the Stop text field, type 5.13[MHz].

7 Click Replace.

8 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

9 Select the Modify physics tree and variables for study step check box.

10 In the Physics and variables selection tree, select Component 1 (comp1)>

Electrostatics (es)>Terminal 2.

11 Click Disable.

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 In the Model Builder window, click Study 2.

6 In the Settings window for Study, locate the Study Settings section.

7 Clear the Generate default plots check box.

8 On the Study toolbar, click Compute.

R E S U L T S

Re-plot the mechanical response with the additional series capacitance.

Mechanical Response 1
1 In the Model Builder window, under Results right-click Mechanical Response and choose 

Duplicate.

Parameter name Parameter value list Parameter unit

Cs 0.1 0.4 1 pF
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2 In the Settings window for 1D Plot Group, type Mechanical response, Parametric 
in the Label text field.

3 Locate the Data section. From the Data set list, choose Study 2/

Parametric Solutions 1 (sol3).

4 Click to expand the Legend section. From the Position list, choose Upper left.

Point Graph 1
1 In the Model Builder window, expand the Results>Mechanical response, Parametric node, 

then click Point Graph 1.

2 In the Settings window for Point Graph, click to expand the Legends section.

3 Select the Show legends check box.

4 On the Mechanical response, Parametric toolbar, click Plot.

Note how the mechanical resonant frequency is ’pulled’ by the series capacitance.
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Introduction

Bulk acoustic wave (BAW) resonators can be used as narrow band filters in radio-frequency 
applications. Their chief advantage compared with traditional ceramic electromagnetic 
resonators is that they can be made smaller in size because they can be designed to have 
an acoustic wavelength smaller than the electromagnetic wavelength.

In addition to the desired bulk acoustic mode, the resonator structure may have many 
spurious modes with very narrow spacing. The design goal is usually to maximize the 
quality of the main component and to reduce the effect of spurious modes.

This tutorial shows how you can model thin-film BAW resonators in 2D using 
eigenfrequency and frequency-response analyses. The geometry used here is the same as 
that in Ref. 1 and Ref. 2.

Figure 1: Arbitrarily scaled geometry of a thin film BAW resonator.

Model Definition

Figure 1 shows the geometry of the resonator from Ref. 1. The lowest layer of the 
resonator is silicon. On top of that, there is an aluminum layer that operates as the ground 
electrode. Above the aluminum layer is the active piezoelectric layer made of zinc oxide 

ZnO
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(ZnO). The topmost layer of the resonator is an aluminum electrode. The material 
properties used in this model are obtained from the MEMS Module material library.

A large part of the silicon layer is etched away from the lower end of the central region of 
the resonator structure. This effectively reduces the thickness of the active central region 
thereby making the device a thin-film composite BAW resonator.

The thickness of the silicon layer at the central region is 7 μm. Both aluminum layers are 
0.2 μm thick, and the piezoelectric layer is 9.5 μm thick. The width of the rectangular top 
electrode is 500 μm. The thin silicon area is roughly 1.7 mm wide.

Figure 2: The 2D geometry (not drawn to scale) used in the tutorial.

This example is modeled in 2D, using the plane strain assumption where the out-of-plane 
thickness is specified to be 1.7 mm. The modeled geometry (Figure 2) is a symmetric 1-
mm section in the center of the resonator. The Perfectly Matched Layer (PML) domains 
used on the two sides effectively increase the length of the resonator and simulates the 
effect of propagation and absorption of elastic waves in the adjoining regions which are 
not resolved in the true geometric scale.

The absorption of elastic waves in the PML domains contribute to the damping of the 
structure. This is also known as anchor loss. Additionally, the model also incorporates 
mechanical and electrical losses in the piezoelectric zinc oxide layer by means of loss 
factors. A structural loss factor represents the hysteresis in a stress-strain curve and a 
dielectric loss factor represents the polarization loss, which manifests itself as the hysteresis 
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in the polarization versus electric field curve of the material. The structural and dielectric 
loss factors appear as the imaginary components of the mechanical stiffness and relative 
permittivity, respectively.

Ref. 3 gives the material quality Qm and the dielectric loss tangent tanδ for many 
materials. The magnitude of Qm is roughly 100–1000, and the magnitude of tanδ is 
roughly 0.001–0.01. Based on that data, the following values are used:

• Structural loss factor: ηcE = 0.001.

• Dielectric loss factor: ηεS = 0.01.

In this model, COMSOL Multiphysics solves for both structural and electrical equations 
in the piezoelectric layer but only solves for the structural equation in the other layers. The 
electrical equations are not solved in the metallic aluminum layers because the electrical 
conductivity of aluminum is several orders of magnitude higher than that of zinc oxide and 
hence the aluminum layers almost act as equipotential regions allowing extremely small 
conduction current through them. Therefore the electrical characteristics of aluminum do 
not have any significant effect on the response of the resonator. The dominant 
electromechanical coupling is exhibited by the piezoelectric layer only.

This tutorial shows two different analyses. In the first step, you compute and investigate 
the eigenmodes of the structure, with its lateral ends fixed. In the second step, you analyze 
the frequency response of the resonator within the desired bandwidth of 215 MHz to 
235 MHz.

Results and Discussion

Figure 3 shows the lowest BAW mode of the structure which occurs at 221.4 MHz. This 
plot was generated from the results of the eigenfrequency analysis. This is the fundamental 
longitudinal thickness mode. The plot shows scaled deformation only to be used for 
visualization of the mode shape. Note that COMSOL Multiphysics computes complex-
valued eigenfrequencies where the imaginary part gives a measure of the damping due to 
structural loss, polarization loss and anchor loss.
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Figure 3: The lowest bulk acoustic mode of the resonator identified from the solutions of the 
eigenfrequency analysis.

Figure 4:  The lowest bulk acoustic mode of the resonator identified from the solutions of the 
frequency domain analysis.
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Figure 4 shows the deformation of the resonator obtained from the frequency response 
analysis when the zinc oxide layer is excited with 1 volt (zero-to-peak voltage) at 
221.5 MHz. The maximum deflection is about 3 nm.

Figure 5:  Electric potential distribution in the zinc oxide layer at 235 MHz excitation.

Figure 5 shows the voltage distribution in the piezoelectric layer when excited at 
235 MHz.

COMSOL Multiphysics’ Terminal boundary condition which is used to specify the voltage 
on the piezoelectric material also automatically computes the admittance. The admittance 
is the ratio of the total current flowing through the piezoelectric material to the voltage 
across it. It is a complex-valued quantity for a lossy material. Typically the imaginary part 
reflects the displacement current and the real part reflects the conduction current as well 
as other losses in the structure. Figure 6 shows the absolute value of admittance as a 
function of frequency. Within the investigated range of 215 MHz to 235 MHz, the 
admittance is very similar to that shown in Ref. 2. Note that the highest peak in admittance 
occurs at the lowest BAW mode of 221 MHz.
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Figure 6:  Absolute value of the admittance vs. frequency.

Figure 7:  Quality factor vs. frequency.
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Figure 7 shows the quality factor of the device as a function of frequency. The quality 
factor or Q-factor indicates the number of cycles (at the given frequency) in which the total 
energy of the system decreases by a factor of e2π. This is also automatically computed by 
COMSOL Multiphysics. Figure 7 shows that the maximum value of Q ~ 1300 is obtained 
at around 221 MHz. This value obtained from the frequency-response analysis agrees well 
with the Q-factor computed by the eigenfrequency analysis. The results from the 
eigenfrequency analysis shows the Q-factor at 221.4 MHz to be 1326.

The eigenfrequency analysis also automatically computes the decay factor for each 
eigenfrequency. The inverse of the decay factor is the time required for the amplitude of a 
damped signal to reduce to e−1 of its initial amplitude. The decay factor at 221.4 MHz 
was computed to be 5.25 · 105 s−1.
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.
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3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>

Eigenfrequency.

6 Click Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 1000.

4 In the Height text field, type 16.7.

5 Locate the Position section. From the Base list, choose Center.

6 Click to expand the Layers section. In the table, enter the following settings:

7 Select the Layers to the left check box.

8 Select the Layers to the right check box.

9 Clear the Layers on bottom check box.

10 Right-click Rectangle 1 (r1) and choose Build Selected.

Rectangle 2 (r2)
1 Right-click Rectangle 1 (r1) and choose Duplicate.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Height text field, type 0.2.

4 Locate the Position section. In the y text field, type -1.25.

5 Right-click Component 1 (comp1)>Geometry 1>Rectangle 2 (r2) and choose 
Build Selected.

Layer name Thickness (µm)

Layer 1 50
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Rectangle 3 (r3)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 500.

4 In the Height text field, type 0.2.

5 Locate the Position section. From the Base list, choose Center.

6 In the y text field, type 8.45.

7 Click Build All Objects.

D E F I N I T I O N S

In the Model Builder window, expand the Component 1 (comp1)>Definitions node.

Axis
Change the aspect ratio to have a better view of the model, and make the domain 
selections easier.

1 In the Model Builder window, expand the Component 1 (comp1)>Definitions>View 1 
node, then click Axis.

2 In the Settings window for Axis, locate the Axis section.

3 From the View scale list, choose Automatic.

4 Click Update.
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5 Click the Zoom Extents button on the Graphics toolbar.

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

2 In the Settings window for Perfectly Matched Layer, locate the Domain Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1-3,8-10 in the Selection text field.

5 Click OK.

In this way you specify that the layers on the two sides of the geometry form a perfectly 
matched layer.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Semiconductors>Si - Silicon (single-crystal, anisotropic).

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.
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2 In the tree, select MEMS>Metals>Al - Aluminum / Aluminium.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Al - Aluminum / Aluminium (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Al -

Aluminum / Aluminium (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 2 5 7 9 in the Selection text field.

5 Click OK.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Piezoelectric>Zinc Oxide.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Zinc Oxide (mat3)
1 On the Home toolbar, click Add Material to close the Add Material window.

2 In the Model Builder window, under Component 1 (comp1)>Materials click 
Zinc Oxide (mat3).

3 In the Settings window for Material, locate the Geometric Entity Selection section.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 3 6 10 in the Selection text field.

6 Click OK.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, locate the Thickness section.

3 In the d text field, type 1.7[mm].

Piezoelectric Material 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) click 

Piezoelectric Material 1.
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2 In the Settings window for Piezoelectric Material, locate the Domain Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 3 6 10 in the Selection text field.

6 Click OK.

These are piezoelectric domains.

Mechanical Damping 1
1 In the Model Builder window, right-click Piezoelectric Material 1 and choose 

Mechanical Damping.

2 In the Settings window for Mechanical Damping, locate the Damping Settings section.

3 From the Damping type list, choose Isotropic loss factor.

4 From the ηs list, choose User defined. In the associated text field, type 0.001.

Dielectric Loss 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) right-

click Piezoelectric Material 1 and choose Dielectric Loss.

2 In the Settings window for Dielectric Loss, locate the Dielectric Loss Settings section.

3 From the ηεS list, choose User defined. In the associated text field, type 0.01.

Linear Elastic Material 2
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Material Models>Linear Elastic Material.

2 In the Settings window for Linear Elastic Material, locate the Domain Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1 4 8 in the Selection text field.

5 Click OK.

6 In the Settings window for Linear Elastic Material, locate the Linear Elastic Material 
section.

7 From the Solid model list, choose Anisotropic.

These are the silicon domains that are modeled as an anisotropic linear elastic material.

The remaining domains are the aluminum domains that are modeled as an isotropic 
linear elastic material.

Fixed Constraint 1
1 Right-click Solid Mechanics (solid) and choose Fixed Constraint.
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2 In the Settings window for Fixed Constraint, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1 3 5 27-29 in the Selection text field.

5 Click OK.

These are the boundaries of the perfectly matched layers. In this way you indicate that 
the device is fixed on its sides that are far away from the region that you are modeling.

E L E C T R O S T A T I C S  ( E S )

On the Physics toolbar, click Solid Mechanics (solid) and choose Electrostatics (es).

1 In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

2 In the Settings window for Electrostatics, locate the Domain Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 3 6 10 in the Selection text field.

6 Click OK.

7 In the Settings window for Electrostatics, locate the Thickness section.

8 In the d text field, type 1.7[mm].

Ground 1
1 Right-click Component 1 (comp1)>Electrostatics (es) and choose Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 6 13 25 in the Selection text field.

5 Click OK.

Terminal 1
1 In the Model Builder window, right-click Electrostatics (es) and choose the boundary 

condition Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 16 in the Selection text field.

5 Click OK.

6 In the Settings window for Terminal, locate the Terminal section.

7 From the Terminal type list, choose Voltage.
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M E S H  1

Distribution 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Mapped.

2 Right-click Mapped 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Boundary Selection section.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 2 21 in the Selection text field.

6 Click OK.

Distribution 2
1 Right-click Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 9 in the Selection text field.

5 Click OK.

6 In the Settings window for Distribution, locate the Distribution section.

7 In the Number of elements text field, type 100.

Distribution 3
1 Right-click Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 8 in the Selection text field.

5 Click OK.

6 In the Settings window for Distribution, locate the Distribution section.

7 In the Number of elements text field, type 2.

Distribution 4
1 Right-click Mapped 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 12 in the Selection text field.

5 Click OK.
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6 In the Settings window for Distribution, locate the Distribution section.

7 In the Number of elements text field, type 3.

8 Click Build All.

The mesh should look as shown in this figure.

S T U D Y  1

Step 1: Eigenfrequency
1 In the Model Builder window, under Study 1 click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Search for eigenfrequencies around check box.

4 In the associated text field, type 220[MHz]+i*150[kHz].

5 From the Eigenfrequency search method around shift list, choose Smaller imaginary part.

6 Right-click Study 1>Step 1: Eigenfrequency and choose Get Initial Value for Step.

7 In the Model Builder window, expand the Study 1>Solver Configurations node.

Solution 1 (sol1)
1 In the Model Builder window, expand the Study 1>Solver Configurations>Solution 1 (sol1) 

node, then click Eigenvalue Solver 1.
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2 In the Settings window for Eigenvalue Solver, locate the Values of Linearization Point 
section.

3 Find the Value of eigenvalue linearization point subsection. In the Point text field, type 
2e8.

4 Click Compute.

D E F I N I T I O N S

Axis
Set the view to the default scale type for the result plots.

1 In the Model Builder window, under Component 1 (comp1)>Definitions>View 1 click Axis.

2 In the Settings window for Axis, locate the Axis section.

3 From the View scale list, choose None.

4 Click Update.

5 Click the Zoom Extents button on the Graphics toolbar.

R E S U L T S

Mode Shape (solid)
1 In the Model Builder window, under Results click Mode Shape (solid).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Eigenfrequency (Hz) list, choose 2.214E8+8.361E4i.

4 On the Mode Shape (solid) toolbar, click Plot.

Compare this plot with .

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

S T U D Y  2

Step 1: Frequency Domain
1 On the Home toolbar, click Add Study to close the Add Study window.
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2 In the Model Builder window, click Step 1: Frequency Domain.

3 In the Settings window for Frequency Domain, locate the Study Settings section.

4 In the Frequencies text field, type range(215,0.1,235)[MHz].

5 On the Home toolbar, click Compute.

R E S U L T S

Stress (solid)
1 In the Model Builder window, click Stress (solid).

2 In the Settings window for 2D Plot Group, type Displacement (solid) in the Label text 
field.

3 Locate the Data section. From the Parameter value (freq (Hz)) list, choose 2.215E8.

Surface 1
1 In the Model Builder window, expand the Results>Displacement (solid) node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.

3 On the Displacement (solid) toolbar, click Plot.

4 Click the Zoom Extents button on the Graphics toolbar.

Compare this plot with .

Electric Potential (es) 1
1 In the Model Builder window, under Results click Electric Potential (es) 1.

2 On the Electric Potential (es) 1 toolbar, click Plot.

Compare this plot with .

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Admittance in the Label text field.

3 Locate the Data section. From the Data set list, choose Study 2/Solution 2 (sol2).

Global 1
1 Right-click Admittance and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.
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3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Unit list, choose MHz.

5 On the Admittance toolbar, click Plot.

6 Click the y-Axis Log Scale button on the Graphics toolbar.

Compare this plot with .

Admittance 1
1 In the Model Builder window, under Results right-click Admittance and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Quality Factor in the Label text field.

Global 1
1 In the Model Builder window, expand the Results>Quality Factor node, then click 

Global 1.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Solid Mechanics>Global>

solid.Q_freq - Quality factor for frequency.

3 Click the y-Axis Log Scale button on the Graphics toolbar.

4 On the Quality Factor toolbar, click Plot.

Compare this plot with .

The following steps show how to compute the quality factor and the decay factor for 
the resonance at 221.4 MHz from the eigenfrequency study. You will see that the value 
for the quality factor agrees well with that obtained from the frequency domain study 
at the same frequency.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, type Q-Factor in the Label text field.

3 Locate the Data section. From the Eigenfrequency selection list, choose From list.

4 In the Eigenfrequency (Hz) list, select 2.214E8+8.361E4i.

5 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Solid Mechanics>Global>solid.Q_eig -

Quality factor for eigenvalue.

6 Click Evaluate.

Expression Unit Description

abs(es.Y11) S Absolute value of admittance
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Q-Factor 1
1 Right-click Q-Factor and choose Duplicate.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>

Solid Mechanics>Global>solid.decay - Exponential decay factor.

3 In the Label text field, type Decay Factor.

4 Click Evaluate.
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